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Limited Warranty on Media and Replacement

If you discover physical defects in the manuals distributed with an Apple product or in the media on whicha
software product is distributed, Apple will replace the media or manuals at no charge 1o vou, provided vou
return the item o be replaced with proaf of purchase 1o Apple or an authorized Apple dealer during the #0-
day period after you purchased the software. In addition, Apple will replace damaged software media and
manuals for as long as the software product is included in Apple’s Media Exchange Program. While not an
upgrade or update method, this program offers additional protection for two years or more from the date of
vour original purchase. See yvour authorized Apple dealer for program coverage and details, In some countries
the replacement period may be different; check with your authonzed Apple dealer

ALL IMPLIED WARRANTIES ON THE MEDIA AN MANUALS, INCLUDING IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE, ARE LIMITED IN DURATION TO Ninety
(90 days FROM THE DATE OF THE ORIGINAL RETALL PURCHASE OF THIS PRODUCT.

Even though Apple has tested the software and reviewed the documentiation, APPLE MAKES NO WARRANTY
OR REPRESENTATION, ETTHER EXPRESSED OR IMPLIED, WITH RESPECT TO SOFTWARE, ITS QUALITY,
PERFORMANCE, MERCHANTABILITY, OK FITNESS FOR A PARTICULAR PURPOSE, AS A RESULT, THIS
SOFTWARE 18 SOLD "AS 1S, AND YOU, THE PURCHASER, ARE ASSUMING THE ENTIRE RISK AS TO ITS
QUALITY AND PERFORMANCE.

IN NO EVENT WILL APPLE BE LIABLE FOR DIRECT, INDIRECT, SPECIAL, INCIDENTAL, OR CONSEQUENTIAL
DAMAGES RESULTING FROM ANY DEFECT IN THE SOFTWARE OR ITS DOCUMENTATION, even if advised
of the possibility of such damages. In particular, Apple shall have no liability for any programs or data stored
in or used with Apple products, including the costs of recovering such programs or data,

THE WARRANTY AND REMEDIES SET FORTH ABOVE ARE ENCLUSIVE AND IN LIEU OF ALL OTHERS, ORAL

OR WRITTEN, EXPRESSED OR IMPLIED. No Apple dealer, agent, or employee is authorized to make any
modification, extension, or addition o this warranry,

Some states do not allow the exclusion or limitation of implied warranties or liability for incidental or
consequential damages, so the above limitation or exclusion may not apply to vou. This warranty gives vou
specific legal rights, and vou may also have other rights which vary from sate to state,
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This manual and the sofeware described in it are copyrighted, with all rights reserved. Under the copyright
laws, this manual or the software may not be copied, in whole or part, without written consent of Apple,
except in the normal use of the software or to make a backup copy of the software. The sume proprietary and
copyright notices must be affived to any permitted copies as were affived to the original. This exception does
not allow copies to be made for others, whether or not sold, but all of the matenial purchased (with all backup
copies) may be sold, given, or loaned to another person. Under the law, copying includes translating into
another language or format.

You may use the software an any computer owned by you, but extra copies cannot be made for this purpose.

The Apple logo is a registered trademark of Apple Computer, Inc. Use of the “kevboard” Apple logo (Option-
Shift-K) for commercial purposes without the prior written consent of Apple may constitute trademark
infringement and unfair competition in violation of federal and state laws,
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Radio and television interference

The equipment described in this manual generates and uses radio-frequency energy. If it is not
installed and used properly—that is, in strict accordance with Apple's instructions—it may cause
interference with radio and television reception.

This equipment has been tested and complies with the limits for a Class B computing device in
accordance with the specifications in Part 15 of FCC rules. These specifications are designed to
provide reasonable protection against such interference in a residential installation. However, there
is no guarantee that the interference will not occur in a particular installation,

You can determine whether vour computer is causing interference by turning it off. If the
interference stops, it was probably caused by the computer or one of the peripheral devices.

If your computer system does cause interference to radio or television reception, try to correct
the interference by using one or more of the following measures:

® Turn the television or radio antenna until the interference stops.
= Move the computer to one side or the other of the television or radio.
®  Move the computer farther away from the television or radio.

®  Plug the computer into an outler that is on 4 different circuit from the television or radio, (That
is, make certain the computer and the television or radio are on circuits controlled by different
circuit breakers or fuses.)

= Install a rooftop television antenna with a coaxial cable lead-in between the antenna and the
television,

If necessary, consult your authorized Apple dealer or an experienced radio/television technician for
acldfivional suggestions.

You may find helpful the following booklet, prepared by the Federal Communications
Commission: How to Identify and Resolve Radio-TV Interference Problems (stock number 004-000-
00345-4). This booklet is available from the U.S, Government Printing Office, Washington, DC 20402.

.. Important Changes or modifications to this product not authorized by Apple Computer, Inc.,
could void the FCC certification and negate vour authority to operate the product. This product was
tested for FCC compliance under conditions that included the use of shielded cables and connectors
between system components. It is important that you use shielded cables and connectors to reduce
the possibility of causing interference to radios, television sets, and other electronic devices, For
Apple peripheral devices, you can obtain the proper shielded cables from vour authorized Apple
dealer. For non-Apple peripheral devices, contact the manufacturer or dealer for assistance.



Preface About This Book

This manual tells you how to use System 6, system software for the Apple® Has® computer,

Svstem software enables vou and your Apple Lcs co er Lo co inicate.
Svstem softy 1ables vou and vy Apple 11 mputer [ communicat

This manual assumes that vou've set up your Apple 1lGs and that you've had some practice
with basic skills that give instructions to vour computer. It also assumes that vou're working
with at least two disk drives—either two 3.5-inch drives, or one hard disk and one 3.5-inch
drive. If vou haven't already, you should use the Apple Ilcs Owner's Guide 10 set up your
computer and complete the hands-on tutorial or use the tour disk, Your Tour of the Apple
He:s. You can use this manual when you want to do something that the other materials didn's

cover, when you want a quick reminder about a task you've already learned, or to get a

better sense of all the things you can do with your computer.



What's in this book

The Preface provides chapter descriptions and information about conventions used in this
book. Chapter 1 gives you an idea of what you can expect from System Software 6. The
other chapters contain reference material. The book is designed to help you locate what
you need, without having to search around when you have a question.

Here’s what you'll find in this book:

Chapter 1, “Overview of System 6,” tells vou about some of the important features of
vour system software, describes what's on your disks, and reviews some basic skills you
use to work with your computer.

Chapter 2, “Using the Installer,” begins the reference portion of the manual and
provides step-by-step instructions for using the Installer application to update or create
startup disks.

Chapter 3, “Using the System 6 Finder,” tells you about the Finder™ desktop and
explains how to work with menus, windows, and icons.

Chapter 4, “Working With Disks," explains how to prepare and work with the disks
you'll be using with your computer.

Chapter 5, "Working With Files and Folders,” describes the tasks you can do to organize
your files into folders.

Chapter 6, “Working With Applications,” gives you guidelines for working with the
software programs that you'll use to create your own files, It also includes a brief hands-
on tutorial to give vou some practice with an application.

Chapter 7, “Using the Desktop Control Panels,” explains the options you have for
customizing many aspects of the way vour computer works,

Chapter 8, “Using the Archiver,” tells you how to use the Archiver program, which
makes backup copies of your files, and how you can later restore files from the backups.
Chapter 9, "Using the Advanced Disk Utility,” explains the program that you can use to
perform maintenance operations on disks, especially hard disks,

Chapter 10, “Using Universal Access,” provides information about System 6 programs
specifically designed to make it easy for individuals with special needs to use the
Apple 11Gs.

Xiv  Preface  About This Book



* Chapter 11, “Controlling Multimedia Devices,” explains how to use System 6 media
control software to work with multimedia equipment connected to your computer.

*  Chapter 12, “Networking the Apple 11Gs," describes what you need to know about to use
the Apple 11Gs as part of a network of computers.

»  Chapter 13, “Troubleshooting,” describes how to solve some of the more common
problem situations encountered by new computer users.

= Appendix, “System Messages," describes the situations that generate some of the more
commonly encountered system messages.

Conventions used in this book

The following paragraphs illustrate several typographical conventions that are used in this
book to help make learning easier.

When a new term is defined, the term appears in boldface type. Such terms are defined
in the glossary as well. The glossary also defines many related terms that don't appear in
the text.

A Warning Warnings like this one alert you to situations in which you might damage your
equipment or lose data if you don't follow the instructions carefully. a

Important Material set off like this is essential; read it before continuing.

# By the way Paragraphs like this one contain interesting sidelights or information for
specific audiences. »

In illustrations of screens, a blue arrow is used to show the action of pressing, a blue check
mark is used to show the action of clicking, a double blue checkmark is used to show the
action of double-clicking, and a dotted blue line indicates something being dragged (see
Figure P-1).

Throughout the manual, keyboard shortcuts are often provided for selecting menu
commands. For example, to close a window, you'll be reminded that vou can use the

Conventions used in this hook  xv



Double-Clicking

Figure P-1 Symbols for the actions of clicking, pressing, and double-clicking, and a doted line
indicating dragging

kevhoard shortcut, Command-W, Such shortcuts involve pressing and holding down the
Command key (the key with an outline of an apple and this symbol: 88) while you press the
shortcut key.

You don't have to read the chaprers in this book in any particular order. The topics covered,
and the tasks associated with each topic, are described independently. Associated with each
task are the numbered steps ( printed in boldface type) describing the actions vou must
take to perform that task, If vou just want a quick refresher to help you complete a task you
haven't done lately, just read the bold type and do what it says. Some tasks are so basic that
all you need to know is how to do them. In other cases, vou'll find comments or
explanations in plain text following a step. You can decide whether you want—or need—to
read this information.

xvi Preface  Abour This Book



If you have other devices attached to vour computer, refer to the manuals that came with
those devices for instructions on using them correctly. Also, be sure to look through the
manual that came with the applications you'll be using with your computer.

Conventions used in this book xvii
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Overview of System 6

System 6 is the product of years of Apple* Il experience and provides you with a computing
environment that's easy to learn, easy 1o use, and flexible enough to encourage vour own

growth as a computer user.

Read this chapter to find out what vou can expect from Svstem 6, so that vou don't miss out

on any of the possibilities it provides for making the most of vour Apple 1Gs* computer,

This chaprer provides information on these topics

= getring 1o know Svstem 6

= earning about the System 6 disks
= exploring features and benehts of System 6

= reviewing software and computer techniques



Getting to know System 6

2

You can feel comfortable about learning to use Apple 11Gs System 6; it's designed 1o make
it easy and convenient to use a powerful computer—combining the best of the Apple
COMputing €nvironments.

Making it easy

The Apple 11Gs Finder™, a System 6 program, makes it easy to use your computer. Even if
you have experience with other computers, vou'll probably have to learn some new skills.
However, after vou've learned them, you'll use them every time you use your computer.
The Finder uses easy-to-understand visual symbols, called icons and menus, that allow
you to work with your computer in many of the same ways vou work at a desk.

The Finder also provides you with a Help window (see Figure 1-1), available whenever
you're working in the Finder desktop. If you need a reminder about how to perform a task
in the Finder, Help is only a couple of clicks away. You'll be able to start learning to use
applications to create your own documents right away—System 6 includes Teach, a word-
processing program that takes advantage of Svstem 6 features. For details about using
Teach, see Chapter 6, “Working With Applications,” on page 135,

SCi=———=— Finder Help

Topic| Using Help -l

To get information on different Finder features, |4r
choose a feature from the pop-up menu above. »

When there is more text thanwill fit in the

window, wou can use the seroll-bar on the right to
see the rest.

0

Figure 1-1 The System 6 Help window

Chapter I Overview of System 6



Making it convenient

Each person has a different working style and different tasks to accomplish. System 6 is
designed to accommaodate personal differences by allowing you to customize the way you
work with your computer.

= The System 6 Installer makes it possible for you to install either a basic set of computer
tools or a customized set that corresponds to the work you'll be doing and the
equipment you'll be using, For details about the Installer, see Chapter 2, “Using the
Installer,” on page 19.

» The Finder Preferences command lets you choose the way you want your computer to
perform certain tasks and display certain information. For details about Preferences, see
Chaprer 3, “Using the System 6 Finder,” on page 41.

® The System 6 Control Panels let vou set options that control everything from your
computer’s beep to a laserdisc player. For details about the Control Panels, see
Chapter 7, “Using the Desktop Control Panels,” on page 171.

= System 6 includes programs to ensure that individuals with special needs have full
access to the Apple 1lcs. For details about such programs, see Chapter 10, “Using
Universal Access,” on page 243.

Making it compatible

You may have an interest in using files from another system with your Apple 116s. If vou have
software from earlier Apple Il models or if you use files from a Macintosh* computer,
Svstem 6 makes it possible to use these files. All you have to do is use the Installer to add
the appropriate files to your startup disk; vou and your computer can then work with a wide
range of other computers as easily as vou work in your own Apple 1IGs environment. For
details about using the Installer, see Chapter 2, “Using the Installer,” on page 19. For details
about using other file systems, see Chapter 4, “Working With Disks," on page 85.

Getting o know System 6 3
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Making it last
System 6 is designed to accommodate your growth and to provide for expansion of your
system in the future.

® The Archiver and Advanced Disk Utility (ADU) programs give you the means to work

with and protect large volumes of files that you may accumulate over time. These
programs provide convenient ways 1o work with disks, especially hard disks. For
example, you might want to divide vour hard disk into sections for different uses, or vou
might want to make backup copies of all your valuable files. In any case, Archiver and
ADU provide vou with the capacity to deal with large amounts of stored information.
For more information on using the Archiver see Chapter 8, “Using the Archiver,”
starting on page 199. For more information on using the Advanced Disk Utility see
Chapter 9. “Using the Advanced Disk Utility,” starting on page 223.

You can choose from a wide range of cards and peripherals to use with your computer,
increasing its memory or capabilities as it suits you. To learn about the variety of devices
vou can use with vour Apple 11Gs, see the Apple llGs Owner's Guide that came with vour
computer.

System 6 itself is designed for growth. It works with other multimedia equipment and
file systems, making it possible for you to explore the options that allow you to use your
computer in other environments.

Chapter 1 Overview of System 6



Learning about the System 6 disks

System 6 comes stored on six 3.5-inch disks. This section lists the files you can expect to
find on each of them, and how you might want to use them.

Svstem.Disk

The System.Disk contains a minimum set of system files that allows you to start up vour
computer with a 3.5-inch disk. With the System.Disk you have a startup 3.5-inch disk with
many of the main features and functions of System 6. Although System. Disk doesn’t support
printing, you can add printer support by using the Installer. (For more information, see
Chaprer 2, “Using the Installer”, starting on page 19.)

Install

The Install disk contains a special application called the Installer, along with updates from
which you can choose to create or add to a startup disk. The Install disk also contains a
system that allows vou to start up the computer with the Install disk whenever yvou want
to add updates. For more detailed information about the Installer, see Chapter 2, “Using the
Installer,” on page 19.

SvstemTools1

The SystemTools] disk contains system files that the Installer will use to customize a svstem

on your disk. It also contains these additional files:

= Advanced Disk Utility (ADU) is an application that allows you to work with disks. For
details, see Chapter 9, “Using the Advanced Disk Utility,” on page 223.

®  BASIC.SYSTEM is an application you can use if vou want to run programs that have been

written in the Applesoft BASIC computer language, or if vou want to author your own
Applesoft BASIC program.

Learning about the System 6 disks 5
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SvstemTools2

The Systemlools2 disk contains additional system files that the Installer will use to
customize a system on your disk. It also contains these files:

®  Jeach is a word-processing program you can use to create your own documents or to
read documents created by others.

®  Read Me is a file that explains last-minute information about System 6. You can read it
and print it from the Teach application.

®  Shortcuts is a file that lists System 6 tips and shorteuts not described in this manual. You
can read it and print it from the Teach application.

= Archiver is an application that allows you to back up and restore files and volumes. For
details, see Chaprer 8, “Using the Archiver,” on page 199,

= Applelalk folder is a set of files vou'll need if vou work on a network. For details, see
Chapter 12, “Networking the Apple 11Gs,” on page 271.

Fonts

The Fonts disk contains Helvetica®, Times", and Courier fonts in large sizes, for use with a
variety of printers, Such fons are two to five times larger than the printed output. The
printer driver then scales them down to provide higher print quality.

The Fonts disk also contains a folder called Goodies. Inside Goodies, vou'll find
AppleBowl, the original bowling game for Apple Il computers. AppleBowl is included as an
interesting and entertaining bit of Apple Il history.

synthLAB

The synthLAB™ disk contains a support application for developers who are creating
programs using MIDI Synth™. It includes three basic parts: a synthesizer. a sequencer, and
a MIDI driver. The documentation for synthLAB is included in a Teach document on the
synthLAB disk.

Chapter 1 Overview of System 6



Exploring new features of System 6

Experienced Apple 11Gs users will note that System 6 contains a number of features that are
new to the Apple 11Gs. This section lists the principal new features or significant
enhancements,

System

System 6 includes the following operating system enhancements:

File system support: You can use Macintosh, ProDOS®, Pascal, or Apple 11 DOS 3.3
disks, exchanging data without conversion programs, For more information, see
Chapter 2, "Using the Installer,” on page 19.

Improved initializing and erasing: Dialog boxes that allow you to initialize and erase
disks have been simplified and enhanced for use with multiple file systems.
Improved system speed:  System 6 operates faster than previous versions.

Automatic disk insertion detection: The system accepts disks as you insert them,
without requiring vou to click OK after each insertion.

lab selection: You can use the Tab key to move between selections in dialog boxes.

Finder

A number of features are new to the Finder desktop. Unless otherwise noted, see
Chapter 3, “Using the System 6 Finder,” on page 41 for more information about these
features:

Help system: A window with a pop-up menu listing various topics that you may want
to learn more about.

Windows menu: A special menu allowing easy navigation between multiple open
windows on the desktop. You can even stack all open windows to order them quickly.

Preferences: New preference options provide flexibility in system setup. In addition to
the System 5.0 preference options, you can now do the following:

Exploring new features of Svstem 6 7



Designate whether the Finder checks for the presence of disks in 5.25-inch disk
drives when it starts up.
Customize the amount of information you see about items in a window.

»  Window information: Open windows show file system information in addition to
information about the size of the disk, tape, or folder. Depending on the preferences
options selected, windows can also display information about the available volume
space, name, kind, and size of files and folders shown in the window.

»  FExtensions: System 6 provides developers with support for extensions, or programs
that add functionality to the Finder. EasyMount (or “Create Server Alias”) is such a
Finder extension. Installed via the “Network: AppleShare” update, it allows network
users to log on to a server quickly and easily. For more information about EasyMount,
see Chapter 12, “Networking the Apple 11Gs,” on page 271.

Installer

The following features are new to the Installer application (for more information, see
Chapter 2, "Using the Installer,” on page 19):
»  Fasy Update: Asingle-button process simplifies installation

= New Scripts: A number of new options greatly increase system functionality

Applications

In addition to the Finder and BASIC.SYSTEM, five other applications are included with
System 6:

»  The Teach word-processing application includes styled text, and text editing and
search capabilities, For more information, see Chapter 6, “Working With Applications,”
on page 135.

= The Archiver buckup program is new to the Apple LGs. Especially useful for hard disks,
Archiver allows vou to back up information to tape, floppy disk, another hard disk, ora
file server (if you are connected to a network server). You can back up and restore an
entire volume or selected files from a volume. For more information, see Chapter 8,
"Using the Archiver,” on page 199,

8  Chapter 1 Overview of System 6



The Advanced Disk Utility (ADU), a disk preparation program, includes these new
features (for more information, see Chapter 9, “Using the Advanced Disk Utility,” on
page 223):

New interface: The ADU interface is simplified for easy operation.
= Extended format: ADU allows you to prepare a hard disk for use with both the
Macintosh Hierarchical File System (HFS) and ProDOS file systems.
The System 6 Program Launcher is built into the system. When the Finder is not used
as the startup application, the Program Launcher allows you to select and open
applications.

= spathLAB, a support program for MIDI developers, includes a synthesizer, a sequencer,

and MIDI driver. For more information, see the documentation included on the
synthLAB disk.

Desk Accessories

System 6 includes two new desk accessories, or mini-applications, that you can use without
leaving vour main application.

Find File: Helps you quickly locare files by searching all current volumes for files that
match, contain, start with, or end with the filename—or partial filename—that you
specify

Calculator: Provides a calculator with basic math functions as well as decimal and
hexadecimal conversion

Control Panels

A number of Control Panel features have been added to System 6. Individual Control Panels
now provide more efficient access to features of vour system. For more information about
these new Control Panels, see Chapter 7, “Using the Desktop Control Panels,” on page 171,

These Control Panels are part of System 6:

General: Combines a number of control panels to save disk and screen space

Namer: Allows AppleTalk® network users to easily rename network printers

Exploring new features of System 6 9



= SerStart: Lets you choose an application to open automatically at startup
*  FolderPriv: Allows you to specify default privileges for folders
= Network: Lets you select ProDOS 8 or G§/05* as the startup operating system

= Net Printer:  Allows network users to direct printing to a specific network printer

Reviewing computer techniques

This manual assumes that you've already looked at the tour that came with your computer
or worked through the hands-on tutorial in the manual that came with vour computer or
that vou're experienced with Apple 116s or Macintosh computers. If necessary, you can turn
1o the chapter of this book that contains reference material about specific tasks you want
to do with your computer.

Ifvou need reminders about the basic skills you use when working with the desktop and
the mouse, vou'll find them in the following section.

The desktop

When you're using the Finder, the colored or shaded area that appears on the screen is
called the desktop, because you use it in much the same way you use a desk. You can lay
out the electronic documents and folders you want to work with, move them around, put
some on top of others, and even discard the ones you no longer need. When you start up
your computer with System. Disk, the desktop looks like the illustration in Figure 1-2. (If you
start up from another disk you see a different disk icon or icon name.) The Finder is an
example of a desktop application; you can learn more about it in Chapter 3, “Using the
Svstem 6 Finder,” on page 41.

10 Chapter I Overview of System 6
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Figure 1-2 System 6 desktop after starting up from System.Disk

lcons

[cons are symbols on your computer desktop screen that correspond to the objects you use
at a desk (drawers, file folders, pencils, and paper) or to something else you can select for
an action, such as an application.

Disk icons are like drawers, Just as a desk drawer contains folders,

documents, rulers, and paper clips, a disk contains both your work and
the software tools vou use to create it. Disks come in three types: hard,
3.5-inch floppy, and 5.25-inch floppy. A unique icon indicates each type.

Folder icons are like file folders. You use folders to organize and store
your work with meaningful names so you can find it again later.

Application icons represent software programs. These are the tools you
use 10 do your work. The Teach icon at left is an example of an
application icon.

vour software programs. Many of them are shaped like a piece of paper
with one corner folded down.

j Document icons represent the documents, or files, that vou create with

Reviewing computer techniques 11



= A few icons, such as the Trash, have functions that don't fall into the
" | ” other categories, These icons have unique shapes.

Every company that creates products for the Apple 116s designs its own icons. You'll see a
new and different icon when vou first use such products.

Mouse techniques

You can do most everything you need to do with your computer by using just a few mouse
techniques. (Some programs, however, do not support use of the mouse. ) Insert the
Sstem . Disk disk into vour startup disk drive and switch on vour computer to practice these
techniques on the desktop of your Apple 11Gs computer.

Moving the mouse

When vou use the mouse, the end of the mouse where the cable is connected should be
painting away from you. Rest the heel of your hand on your desk. and move the mouse on
vour desk in the same direction that you want the arrow pointer 10 move on the screen.

The distances that the mouse and the pointer move are not necessarily the same. If the
mouse moves an inch on your desk, the pointer may move more than an inch on the
screen. This can be adjusted in the General Control Panel; see Chapter 7, “Using the
Desktop Control Panels,” on page 171 for more information.

If you run out of room to move the mouse, vou can pick it up and put it down
somewhere else. Moving the mouse in the air does not move the pointer on the screen.
See Figure 1-3.

12 Chapter 1 Overview of System 6
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Pointing

You point 1o an object on the deskrop by moving the arrow pointer until the tip of the arrow
is over the object,

Clicking

You cfick by first pointing to an object, and then pressing and releasing the mouse button
once. Don't move the mouse while you click. The action vou take is always the same:
Position the pointer, press the mouse button, and release it. Clicking is the way you select
an object upon which you want to perform an action.

Pressing

You press by first pointing to an object, and then pushing down steadily on the mouse
button without moving the mouse.

Chapter I Overview of System 6
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Dragging

You drag an object by first pointing to it, then pressing and holding down the mouse
button, and then moving the mouse in the direction you want to move the object. An
outline of the object moves along with the pointer. When you release the mouse button,
the ohject moves to the new location,

Double-clicking

You double-click by first pointing to an object, and then clicking the mouse button rwice,
Don't move the mouse while you double-click. Gerting the timing right sometimes takes
practice. The speed of the double-click is adjustable in the General Control Panel; see
Chapter 7, “Using the Desktop Control Panels,” on page 171, for more information. Double-
clicking a disk, folder, or application opens it.

When you double-click a disk or folder icon, its contents are displayed in a window. You
can close the window by clicking once in the small box at the upper-left corner of the
window. This box is called the close box (see Figure 1-6).When you double-click a
document icon in some applications, the Finder instructs the application to open the
document, (If the Finder can't locate the application, the system presents dialog boxes
that allow vou to locate the application. For more information, see “Starting up an
application,” on page 136.) Other applications do not support starting up by double-
clicking a document; vou'll have to launch the application first, and then open the
document.

To close a document, vou click its close box; however, the application remains open
until you quit it by following the rules of the application.

ot PIOoF) . -
Close box
] .

0 items

Figure 1-6 The close box of a window

16  Chapter I Overview of System 6



Menu commands

Menus are lists of actions, also called commands, that tell the computer what you want to
do. The menus that appear across the top of the computer screen vary with each
application.

To view a menu, you position the pointer on the menu title, then press and hold down
the mouse button. You can choose a command by dragging down through the menu to the
command you want, and then releasing the mouse button. For more information, see
*Working with menus,” on page 43.

There are several correct ways to do tasks on the Apple [Ics computer. In Chaprer 3, “Using
the System 6 Finder," Chapter 4, “Working With Disks” and Chapter 5, “Working With Files
and Folders,” you'll find information about the many ways you can ger things done, The
method you use is largely a matter of personal preference.

This chapter has given vou an overview of System 6 for the Apple 11Gs. The rest of the book

contains reference material in specific aspects of System 6. You can refer to the appropriate
chapter when you want to learn a particular task or operation.

Reviewing computer techniques 17
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Using the Installer

Ihis chapter explains how to use the Installer, a program on the Instail disk that lets you
customize startup disks, as well as install applications on any disk. You use the Installer to
create or update a startup disk to include support for specific devices and capabilities you

want 1o use with your computer. You also use it to remove capabilities you don't need. The

first section of this chapter explains the Installer options

east two disk drives. One of them

The instructions in this chapter assume that vou have at

must be a 3.5-inch drive, and the other can be a 3.3-inch drive or a hard disk
This chapter contains information on these topics:

= |earning about Installer options

= using the Easv Update option to create or update a startup disk

= using the Customized Installation option to install or remove capabilities




Learning about Installer options

To start up your computer, you need a disk with basic system software—that is, the
instructions necessary for the computer to start up and to work with the other components
in your computer system. Such a disk is called a startup disk or system disk. The Installer
program allows you to create a new startup disk, to update startup disks that have earlier
versions of system software, or toadd capabilities to existing System 6 startup disks. In each
case, you'll be using the Installer to select updates—hles that increase the computer’s
capability—to assemble the configuration you need. ( You can also use the Installer to
remove capabilities from existing System 6 startup disks.)

Creating a startup disk

System 6 includes a disk called System. Disk that contains a minimal set of files for you to
use as a startup disk. However, by using the Installer program on the Install disk, you can
create vour own custom system disk, with the particular files that you need. You can then
start up your new system disk, and in a few moments the computer is running the desktop
interface—the Finder, your “base of operations™ application. (For more information about
the Finder, see Chapter 3, “Using the System 6 Finder,” on page 41.)

If vou want to use a hard disk or a high-density (1.4 megabyie) floppy disk as vour
startup disk, you use the Customized Installation option of the Installer to install the
“System 6: Hard Disk or FDHD" update, For instructions, see page 31.

Ifyou plan to use an 800K (kilobyte) floppy disk as a startup disk, vou can use the Easy
Update feature of the Installer. It creates a minimal installation that includes support for
yvour monitor and floppy disk drives, If you install on a disk that already has support for
printing, the Easy Update option will also automatically update your printer driver.
However, if vou install on a disk that doesn't already include printer support, Easy Update
does not provide it. If you want support for printing, you'll need to use the Customized
Installation option of the Installer.

In the case of 800K startup disks, it’s especially important to note that the Finder is not
required for the functioning of Svstem 6. Because disk space is at a premium, you may want
to do without the Finder to make room 1o add other capabilities to your disk. When the
Finder is not present, the System 6 Program Launcher—built into the system—allows you
to launch vour applications. You can create a new system disk without the Finder by using
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the Customized Installation option to install the “System 6: No Start” update. You can
remove the Finder from an existing startup disk by selecting the Finder file in your System
folder and dragging it to the Trash. The disk from which you remove the Finder must not
be the start-up disk you are currently using.

Warning Be careful not to remove the Finder from your original System 6 startup disks,
only from backup copies you have made. That way, if you change your mind the application
is still available to vou. &

For instructions on using the Easy Update option, see page 28, For instructions on using
the Customized Installation option, see page 31.

+ Note Although you can also use the Easy Update option to create a minimum
installation on a hard disk, using the Customized Installation option allows vou to take full
advantage of System 6 features. o

Updating a startup disk

Ifyou purchased System 6 to upgrade vour Apple 116s and if you have a hard disk, you can
use the Easy Update option of the Installer to update the system software you already use
to start up your computer. The Installer is “smart™; it can tell what capabilities you use, and
it updates your existing system software with the appropriate new files.

If you are an upgrade purchaser and you don't have a hard disk, you probably should
create a new system disk, rather than updating your existing system disks. The System 6
files are larger than previous system files, and it's likely that there won't be enough room o
update your existing 800K startup disk.

If an application startup disk doesn't include support for the Finder, vou can install
Finder support—if there's enough room on the disk. However, before installing Finder
support on an application startup disk, be sure to read the following warning.
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A Warning On many application disks that don’t contain the Finder, the startup application

is called Start and is in the System Folder. If that's the case with your application disk,
installing the “System 6: On 800K Disk™ or “System 6: Hard Disk or FDHD" updates will
replace vour application with the new Start file. As a result, the disk will start up with the
Finder but will no longer contain your application. You can avoid the problem by installing
the “System 6: No Start” update. A

To update an existing startup disk, you use the Easy Update feature of the Installer. For
instructions, see “Using the Easy Update option,” on page 28. If vou are an AppleShare”
user, or if vou use additional peripherals, vou also need to add the appropriate updates to
vour startup disk; go on to the next section to read about adding specific capabilities.

Adding capabilities to a System 6 startup disk

An 800K 3.5-inch startup disk doesn't have room for system software to support all of the
peripheral devices that work with the Apple 11s, As you add capabilities to a startup disk,
the number of files loaded at startup time becomes larger and it takes longer to launch the
Finder (or the application). For that reason, most startup disks contain only the system
software necessary to support standard capabilities.

If you want optional capabilities that are not supported by the software on your startup
disk—for example, if you want to use a device such as a hard disk or a CD-ROM drive—you
use the Installer 1o add the necessary software update to the startup disk. If your startup
disk contains capabilities that vou don't need, you use the Installer to remove them.

If you want to add capabilities to—or remove them from—an existing System 6 startup
disk, you use the Customized Installation feature of the Installer. For more information,
read the next sections, describing the many capabilities that are available. Then go on to
“Using the Customized Installation option,” on page 31.

Using optional capabilities

Before vou use the Installer, vou must decide what capabilities you need on your startup
disk. The following checklists, grouped by category, will help you determine the
appropriate updates,
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Disk drives and storage devices

I vou bave an Apple UniDisk™ 3.5-inch disk drive® (as opposed to an Apple 3.5 Drive

-

or SuperDrive™), install the “Drive: UniDisk 3.5" update.

* The easiest way to tell the difference between UniDisk drives and Apple 3.5 Drives
or SuperDrives is by color: UniDisk 3.5-inch drives are white, Apple 3.5 Drives and
SuperDrives are platinum, the same color as the computer.

If vou have an Apple 5.25 Drive, install the “Drive: Apple Disk 5.25" update.

If you bave a SCSI hard disk, install the “Drive: SCSI Hard Disk” update.

If vou bave a SCSI tape drive, install the “Drive: SCSI Tape™ update.

If vou bave an AppleCD SC drive. install the “Drive: CD-ROM”™ update.

Ifvou bave an Apple It Memory Expansion Card installed in a standard slot (in slots 1—
7, not the Memory Expansion Slot), install the “Drive: Standard RAM Card” update.

Printers

Ifyou bave an ImageWriter* or ImageWriter Il printer connected directly to the printer
or modem port, install the “Printer: ImageWriter” update. If the printer is part of an
AppleShare network, install the “Printer: ATalk ImageWriter” update.

If vou bave an ImageWriter LQ printer connected directly to the printer or modem
port, install the “Printer: ImageWriter LQ" update. If the printer is part of an AppleShare
network, install the “Printer: ATalk ImageWriter LQ" update.

If you bave a LaserWriter® printer connected directly to the computer via a Local Talk*
cable, install the “Printer: LaserWriter” update.

If you have a StyleWriter® printer; install the “Printer; StvleWriter” update.

If vou bave an Epson or Epson-style printer connected to your computer through a
card in one of the internal slots, install the “Printer: Epson” update.

If vour Apple 11Gs is part of a network and you'll be using network printers, you need to
restart vour computer after installing the appropriate updates, and then select your printer
via the NetPrinter Control Panel. See Chapter 12, “Networking the Apple L16s,” on page 271,
for further information.
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Media devices

If vou have an AppleCD SC* drive and you want to control it via the Media Control
Panel and the Media Controller desk accessory, install the "Media Control: AppleCD
SC” update.

If you bave an AppleCD SC drive and you want to control it via the CD-Kemote desk
accessory, install the “Drive: CD-ROM" update.

If you bave an Apple Scanner; install the “Driver: Scanner” update.

If you bave a Pioneer laserdisc player, install the “Media Control: Pioneer 2000,” or the
“Mecdia Control: Pioneer 42007 update.

If vou bave all three of the available media control devices, install the “Media Control:
Everything” update.

If vou bave an Apple il Video Overlay Card, and you want to use the VideoMix desk
accessory to adjust the combination of graphics and video made possible by the card,
or to display television signals or VCR output, install the "Media: VideoMix" update.

If vou bave MIDI equipment and plan on using AppleMIDI, install the “Media: Apple
MIDI™ update. If vou'll be using the 6850 MIDI card, install the “Media: Card 6850 MIDI”
update,

For more information about the multimedia products and programs mentioned here, see
Chapter 11, “Controlling Multimedia Devices,” on page 261.

Applications

These updates can be installed in any folder—they need not be installed in the System
Folder, or even on a startup disk.

The “Application: Adv, Disk Utility” update places a copy of the Advanced
Disk Utility program on a disk. For information on using this program,

Adv.Disk.Util see Chapter 9, “Using the Advanced Disk Utility,” on page 223.

The “Application: Archiver” update places a copy of the Archiver disk
backup program on a disk. For information on using this program, see

Archiver Chapter B, "Using the Archiver,” on page 19).
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. The “Application: Teach” update places a copy of the Teach word-
processing application program on a disk. For information on using

Teach Teach, see “Using Teach to practice application tasks,” on page 150.
The “Application: AppleBowl” update places a copy of AppleBowl, the

first Apple [T bowling game, on a disk. Instructions for playing AppleBowl
Apple.Bowl  are included within the application.

T The "Application: synthLAB" update places a copy of the synthLAB MIDI
iy development program on a disk. Documentation for synthLAB is
synthLAB included in a Teach file on the syntbLAB disk.

Desk Accessories and Control Panels

These programs, sometimes called DAs, are "mini-applications” that you can use without

leaving your main application.

» The “Desk Acc: Calculator™ update installs the Calculator desk accessory, which
performs the math calculations you find on any basic pocket calculator, as well as
providing decimal/hexadecimal conversions.

* The “Desk Acc: Find File” installs the Find File desk accessory, which locates a file or
folder on your hard or floppy disk as well as any other storage device you have on your
desktop.

= The “Control Panel: Sounds” installs the Sounds desktop Control Panel, which permits
a variety of sounds to be selected and linked to various computer events.

File System Translators

File System Translators (FSTS) make it possible for you to work with data from other file

systems. They belong to one of two categories:

= Aread/write FST allows vou to read information from a disk into the computer's
memory and also to write information from the computer to the disk in the same file
system.

= A read-only FST allows you to read a file from a disk to memory, However, you cannot
write information from the computer to the disk in the same file system. To write
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information to disk, you must either copy the file to a read/write file system, or use an
application to read the file, modify it. and then write it to a read/write file system.

The following updates are available:

®* The “File System: HFS FST" update installs a read/write FST for the hierarchical file
system used by the Macintosh computer.

®  The “File System: DOS 3.3 FST™ update installs a read-only FST for files created under
the Apple 11 DOS 3.3 operating system,

= The "File System: Pascal FST" update installs a read-only FST for files created in the
Apple Pascal development environment.

For more information on FSTS, see “Using file formats and translators,” on page 109.

Fonls

The Font updates provide font sizes two to five times larger than the size displaved on the
screen. Although System 6 attempts to scale fonts to the size you request via your
application, installing these larger fonts allows you to get better quality output from your
printer. The chart below illustrates the relationship of the larger fonts to the size you see on
your screen for each specific printer.

Table 2-1 Font sizes used for various printers

Printer Funluw Screen size 10 pl.  Screen size 12 pt.
ImageWriter 2x 20 24
ImageWriter 1O I an 0
LaserWiriter 4x 40 #
StvleWriter Sx 50 ol

The following updates are available:

= The “Fonts: All" update installs Courier 9-42, Geneva 10-24, Helvetica 9-96,
Shaston 16, Times 9-96, and Venice 12, 14, and 24.

* The “Fonts: Stanclard™ update installs Courier 9-24, Geneva 1024, Helvetica 9-24,
Shaston 16, Times 9-24, and Venice 12-24.

26 Chapter 2 Using the Installer



® The “Fonts: Minimum™ update installs Courier 10 and 12, Geneva 10 and 12,
Helvetica 10 and 12, Shaston 16, Times 10 and 12, and Venice 14.

@ Note If vou are using an 800K startup disk, you will not have room to install fonts.
Shaston 8, built into your computer, is the font you'll use for printing, e

Special Aids

These updates install programs designed to make it easier for people with special needs to

use a computer. The following updates are available:

®  The “Special Aids: CloseView” update installs the CloseView desk accessory, which
magnifies the screen by as much as twelve times,

= The “Special Aids: Easy Access” update installs Stickv Kevs and Mouse Kevs, programs
that assist people who have difficulty typing or with manipulating the mouse.

*  The “Special Aids: VideoKeyboard” update installs the Video Keyboard desk accessory,
which provides a fully capable on-screen keyboard.

Network support

The system tools disks contain several updates specifically for network users. Before vou
install any of these updates, refer to Chapter 12, “Networking the Apple 16s,” on page 271,
for advice on which updates vou'll need, as well as for more detailed descriptions of the
updares.

These are the updates that pertain to network use:

= The “Network: AppleShare” update installs networking software on i hard disk. It must
be installed along with the “System 6: Hard Disk or FDHD" update.

* The “Network: AppleShare, 3.5" Disk” update installs networking and system software
on an 800K floppy disk. The installation does not include the Finder.

® The “Printer: ATalk ImageWriter” update installs support for networked ImageWriter
printers.

®  The “Printer: ATalk TmageWriter LQ" update installs support for networked ImageWriter
LQ printers.

® The "Printer: LaserWriter” update installs support for networked LaserWriter printers.
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* The "Network: Local Startup” update installs networking and system software that
allows you to start up over the network, assisted by a local disk.

®  The “Network: Aristotle Update” updates Aristotle menu management software on the
network server so that it starts up over the network more efficiently with System 5.0 or
later. It should be installed by the network administrator.

* The “Network: Printer Namer” update provides software for naming network printers.
It should be installed by the network administrator.

* The “Network: Server Startup” update provides software for starting up from a network
server withour using a local disk. It should be installed by the network administrator.

= The "Network: Server Quick Logoff ™ update provides software that allows users who
start up over the network to log off by quitting their applications. It should be installed
by the network administrator.

If your Apple 1Gs is part of a network and vou'll be using network printers, vou need to
restart your computer after installing the appropriate updates, and then select vour printer
via the NetPrinter Control Panel (see Chapter 12, “Networking the Apple I1G8," on

page 271).

Using the Easy Update option

Ifyou're creating a new startup disk on an Apple SuperDrive or a hard disk, the Installer
Easv Update provides all the software Apple recommends for using an Apple 3.5-inch
(800K) or 5.25-inch disk drive, a SCSI hard disk drive, the ImageWriter printer, and a modem
with your Apple IlGs. If vou're creating a new B00K startup disk, Easy Update provides
support for floppy disk drives.

If you're using other peripheral devices, turn to “Using the Customized Installation
option,” on page 31, for instructions on how to install additional capabilities. If you're
working on a network, turn to Chapter 12, “Networking the Apple 1168,” on page 271,

Before you begin the installation process, have these disks handy:
= Install

= Systemlools]
= Systemlools2
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® a35.inch disk (unless vou're installing on a hard disk), or an existing startup disk with
an earlier version of system software. (If the disk is write-protected, remove the write
protection. For instructions, see “Write-protecting a disk,” on page 94.)

Important You cannot install system software on a disk that is currently being used as the
startup disk. The Install disk is a system disk; use it to start up vour computer when you
want to update system disks. (If you want to update a system on a startup hard disk, you
can direct your computer to start up from a floppy drive. For information, see “Changing
the startup drive,” on page 194. You can then start up your computer from the Instafl disk.)

The Install disk must be named Install, and the system tools disks must be named
Systemools] and SystemTbols2 when they're being used with the Installer. If you've
renamed either disk, you must change the names back before vou can successfully use the
Installer.

To prevent unintentional damage, always install new system files on a backup copy of
vour startup disk, not on the original.

Follow these steps to use the Easy Update option:

Start up the computer with the Apple 11Gs Install disk.

In a few moments you see the Easy Update screen.

Baele

Click "Eosy Updote” to install Apple 1165 —
System Softwore version 6.0 on the disk e ——
*FOHD Disk”

Click "Chonge Disk® if "Cosy Update® it
disobled. "Eosy Update” con't medify the

corrent startup disk, the Installer
disks, or non-ProD0S disks.

v e )
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If you're creating or updating a system on a floppy disk, insert your disk into an
empty drive,

If you're creating a new system, and the disk is not formatted. you'll see a dialog box,
asking if vou want to initialize vour blank disk.

B5/05 con't r; this disk (in device .IlPPl!IllSK;jBl. [
you wont to iniviolize it?

v Yo

Follow these steps to initialize a blank disk:

1. Click Initialize.

2. Tvpe a name for the disk. (Follow the naming rules on page 91.)
3. Accept the default option, the ProDOS file system.

4. Click Ininialize.

Once the disk has been formatted, you return to the Easy Update screen.

Click Easy Update.

You'll be prompted to insert disks as they are needed. Simply follow the instructions on the
screen. A series of messages and a “thermometer” indicator keep vou informed of the
progress of the installation. The Installer will tell vou if there is not enough room on the
disk to perform the update.

+ Tip for two drive systems When swapping disks during the installation procedure,
it's most efficient to leave the disk that's being updated in a drive at all times, and swap the
Install disk and svstem tools disks as needed. o

When the Easy Update procedure is complete, you see a dialog box letting you know
whether the installation process was successful. If the installation process fails, the dialog
box indicates the reason.
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S Click Quit (or choose Quit from the File menu) to quit the Installer, or click
Customize to install additional updates.

If you click Quit, you see the System 6 Program Launcher, listing the contents of all the
available volumes. To use your new or updated system disk, click Cancel. Choose Shut
Down from the File menu; then, after the disks are ejected and the computer shuts down,
insert your disk in the startup drive (if you've created or updated a floppy disk), and click
Restart.

If vou installed on a hard disk, you must reset your startup slot to your hard disk.
(For more information, see “Changing vour startup drive” on page 194.) Then click
Restart.

If vou installed on a floppy disk, insert it in the startup drive and click Restart,

If vou click Customize, you see the Installer Customized Installation window. Go on to
“Using the Customized Installation option,” next in this chapter.

Using the Customized Installation option

This section explains how to use the Customized Installation option of the Installer to add
and remove updates. Although the two procedures work independently, you can do both
once vou're in the Installer. (In other words, if you want to add some updates and remove
others, you don't need to quit the Installer after adding updates and then start again from
scratch to remove updates, or vice versa,)

Updates that add system software capabilities are called system updates. You can
install system updates on a hard disk, a hard disk partition, a 3.5-inch disk, or a file
server volume. You can't install on a CD-ROM disc; the contents of the CD-ROM disc can't
be changed. (Remember, ROM stands for Read-Only Memory.) Nor should vou try to install
system updates on the following:

a 5.25-inch disk (there’s not enough room for the updates you would need)

= 1 RAM disk (a RAM disk loses its memory when you shut off the power to vour
computer)

= an Apple 11 DOS 3.3 disk (Apple I1 DOS 3.3 is a read-only environment)

= 2 Pascal disk (Pascal is a read-only environment)
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Apple 1165 Instoller v2.0 - Customized Installotion
Oisk to updote: :FOHDDisk

m B: Hord Disk or FORD

em B Ho "Stort" Update
#Sustem 6: On S00K Disk !
Rpplicotion: Adv. Disk Utility Q0
Rpplication: Apple Bowl
Rpplicotion: Archiver
fpplicotion: sunthLAB
Update Selection

—Hfpplication Falder Selection =
( Disk )N Lt ]
{ Ejeot YO M Folder. )
sired pdate and the dick or folder whers you wont to

Figure 2-1 Installer customized installation screen

Updates that add applications (or update applications already on a disk) are called
application updates. The application updates are Advanced Disk Utility, Archiver,
svnthLAB, Teach, AppleBowl, and the network software management application, Aristotle.

The Installer automatically places system updates in the appropriate location, so you
needn't worry about specifving the correct destination. Application updates, on the other
hand. can be installed anvwhere on any disk (except svnthLAB), provided vou have the
necessary disk space. When you're installing an application update, the window on the right
side of the Installer Customized Installation screen (see Figure 2-1) lets vou specify a
destination for the update. You'll learn more about using this window in step 7 of *Adding
capabilities,” on page 33.

Important You cannot install system updates on a disk that is currently being used as the
startup disk. The Install disk is a system disk; use it to start up your computer when you
want to create or update system disks,

The Install, SystemToolsl, Systemlools2, Fonts, and synthLAB disks must carry their
original names while they ‘re being used with the Installer. If vou've renamed any disk, vou
must change its name back before vou can successfully use the Customized Installation
option.

When you use the Installer to add or remove updates on floppy disks, be sure that
you're using a backup copy of the disk you're updating. When you're adding or removing
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updates on a hard disk, make sure you've backed up your stored files. That way, your data
will be intact if something goes wrong during the installation process.

Before vou begin the installation process, have these disks handy:

= Install

»  Systemlools!

»  Systemilbols2

= fonls

»  sythLAB (if vou intend to install the application)

» 4 disk on which to install the system updates (If the disk to be updated is write-
protected, remove the write protection. For instructions, see “Write-protecting a disk,”
on page 94.)

Adding capabilities
Once you've decided what capabilities you want to add, follow these steps to install the

necessary updates:

Start up the computer with the /nstall disk.

In a few moments, you see the Installer Easy Update window,

Apple 1165 Instal ler - Eosy Update

Click "Easy Update” to install Apple 1165 _
Sustem Softwore version 6.0 on the disk
*:FOHD Disk".

Click "Change Disk” if "Eosy Update® is Change Disk

disabled. "Eosy Update" con't modify the
current stortup disk, the Instoller Eivct
disks, or non-ProD0S disks

w0
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o

Click Customize to see the Customized Installation window.

You can also press the Right Arrow key to get to the Customized Installation window from
the Easy Update window.

On the left, the updarte selection list displays an alphabetical list of the available updates.

Hpple 1165 Instal ler w2.0 - Customized Instal lation
Disk to update: (FOHD Disk

sSustem 6 Hord Disk or FOHD
#Sustem b: No "Stort” Update
+System b On 800K Disk |
Rpplication; Adv. Disk Utilivy
fpplication: Rpple Bowl |
fpplicotion: Rrchiver
fpplication: sunthLAB

lipdate Selection —Rpplication Folder Selection =

sk (. B )
Easy Update Gt )(Tm e

[Py Please select the desired update ond the disk or folder where yo

! install the update.

If necessary, insert the disk you want to update in an empty drive,

If the disk is not formatted, you see a dialog box, asking if you want to initialize vour blank

disk. Follow these steps:

1. Click Initialize.

2. Type a name for the disk. (Follow the naming rules on page 91.)

3. Select the ProDOS file system (unless you are not installing system updates)

4. Select a file format. (For information about disk formats, follow the guidelines on
page 92.)

5. Click Initialize.

If the disk vou insert is not blank and you want to erase it, follow these steps:

I Click the Disk button until the name of vour disk appears.

-t

2. Choose Erase from the File menu.
3. Type a name for the disk. (Follow the naming rules on page 91.)

4, Select the ProDOS file system.
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5. Select a file format. (For information about disk formats, follow the guidelines on
page 92.)

In a moment, you return to the Customized Installation window.

If necessary, click the Disk button until the name of the disk on which you want
to install updates appears to the right of the words, “Disk to Update”.

You can also press Command-Tab to choose another disk to update.

Select the updates you want to install.

1o select a single update, simply click its name in the window on the left, ( You can also type
the first letter of its name to jump to the updates starting with that letter, or use the Up and
Down Arrows to move the selection up and down the list.)

1o get information about an update, select it, and then click the Help button, choose
Installer Help from the Help menu, or press Command-?.

To select wo or more consecutive updates, click the first name and then hold down one of
the Shift kevs while vou click the last name.

1o select updates that aren't grouped together, click the first name and then hold down the
Command kev while vou click each additional name.

If you've selecred any application updates, a directory of the selected disk appears in the
window on the right. You can press Tab to move between the update selection list and the
application folder selection list. (If you haven't selected application updates, skip to step 7.)

If you've selected application updates, open any necessary folders until the name
of the folder in which you want to store your application appears above the
window on the right.

To open a folder, click its name or icon in the window on the right and then click the Open
button. Or just double-click the name or icon.

(You can also press Command-Down Arrow to open a folder, and Command-Up Arrow to
close a folder. Command-Ese takes you to the root level of the list.)

Using the Customized Installation option 35



36

You can create a new folder in which to install updates by clicking the New Folder button.
Adialog box appears asking you to provide a name for the new folder. Trpe a name and click
OK.

Home the new folder:

| Megan Folder |

CueeD CTO)

Ifyou've selected more than one application update, select a single folder in which to install
all of them. (Ifyou want application updates to be in different folders, you must install them
separately.)

< Note Installing applications in a folder is not required. If you don’t open or create a
folder, your applications will be installed at the root level. o

Click Install.

You're prompted to insert the Instalf disk and the system tools disks as they are needed. A
series of messages and a “thermometer” indicator keep vou informed about the progress
of the installation.

# Tip for two-drive systems When swapping disks during the installation procedure,
it's most efficient to leave the disk that's being updated in a drive at all times, and swap the
Install disk and system tools disks as needed, »

When all the update procedures you selected are complete, you see a dialog box letting vou
know whether the installation process was successful. If the installation process can't finish,
the dialog box indicates the reason.

8 Click OK.
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9 Click Quit (or choose Quit from the File menu) to quit the Installer, or select
additional updates to install or remove.

If you click Quit, and if you started the computer with the Install disk, you see the System
6 Program Launcher.
* [fyou created or updated a startup disk, click Cancel, then choose Shut Down from
the File menu. After the disks eject and the computer shuts down,
If vou installed on a hard disk, you must reset your startup slot to your hard disk.
(For more information, see “Changing the startup drive,” on page 194.) Then click
Restart,

o If vou installed on a floppy disk, insert it in the startup drive and click Restart.

» [fyou've installed updates other than system udpates, click Yolumes to see all the
volumes vou have on line. Select a volume and click Open (or double-click the volume
name), Then select an application you want to use, and click Open (or double-click the
application name).

If vou want to install or remove updates, you must launch the Installer again. From the

Program Launcher, select Installer, double-click to launch the Installer, then start from step

2, or go on to the next section, “Removing capabilities.”

Removing capabilities

The more system updates vou include on a startup disk, the longer it takes the computer
to start up from that disk. And when you're working with 800K 3.5-inch disks, space is likely
to be ata premium. For both of these reasons, you may want to remove capabilities that you
use infrequently or not at all,

Important Don't remove any updates from the Install or system tools disks. You may
need to use these disks as the sources of updates in the furure.

The procedure for removing capabilities is similar to that for installing them:

1 rollow steps 1 through 4 under “Adding capabilities” (on page 33).
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Select the updates you want to remove.

16 select a single update, simply click its name. (You can also type the first letter of its name
to jump to the updates that start with that letter, or use the Up and Down Arrows to move
the selection up and down the list.)

1o select two or more consecutive updates, click the first name and then hold down one of
the Shift keys while you click the last name.

To select updates that aren’t grouped togetber, click the first name and then hold down the
Command key while you click each additional name,

If you've selected any application updates, a directory of the selected disk appears in the
window on the right. If you haven't selected application updates, skip to step 4.

Apple 165 Installer 2.0 - Customized Installotion

Roplication folder: :WodeDisk:Hegon Folder:
| =S Megan.Folder -
*Sustem b: fard Disk or FORD |47 T3 Fple ow) I
'gustn 2::U ;gﬁﬂn“ lpdote - =
*System 6:0n Disk 1T
Application: Adv. Disk Utility [I}
Rpplization: Apple Bowl Dy
Rpplication; Arohiver il ,3
Application: sunthLAB
lpdate Selection — Rpplication Folder Selection =
i T
Fasu Update (_ Ejeet ) WewFolder.. )

Important Some updates cannot be removed. If you select one of these, the Remove
button will be dimmed and you cannor click it.

Open any necessary folders until the name of the folder you want to remove an
update from appears above the window on the right.

To open a folder, click its name or icon in the window on the right and then click the Open
button. Or just double-click the name or icon.

( You can also press Command-Down Arrow to open a folder, and Command-Up Arrow to
close 4 folder. Command-Ese takes vou to the root level of the list,)
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Click Remove.
A series of messages keeps you informed of the progress of each removal.

When the removal procedure is complete, vou see a dialog box letting you know whether
the removal was successful. If the removal can't be completed, the dialog box indicates the
reason,

Click OK.

Click Quit (or choose Quit from the File menu) to quit the Installer, or select
additional updates to add or remove.

If you click Quit, vou see the System 6 Program Launcher. Click Volumes to see all the
volumes you have on line. Double-click a volume name to see its contents, You can then
select an application to use or vou can click Cancel, and choose Shut Down from the File
menu.

If vou want to install or remove updates, vou must launch the Installer again. From the
Program Launcher, select Installer, double-click to launch the Installer, then return to step
2 of these instructions.

All the items you remove from your startup disks still exist on the system tools disks, which
vou should store in a safe place. Removing them from your startup disk does not mean you
won't have access to them in the future. If vou keep vour System. Disk, Install. and system
tools disks secure, you always have the ability 1o create a new system configuration for your
computer.
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Using the System 6 Finder

Ifvou haven't used the features of the Finder before, you'll want o read this chapter. It tells
vou how to give instructions to the computer, arrange the items on your desktop in the way
that's most convenient for you, manipulate files and folders, and rename icons. Even if
you've used an Apple 11GS or a Macintosh computer, this chapter contains information
about desktop features that are not included in earlier Apple I1Gs systems or in the
Macintosh. (For information about features new to System 6, see Chapter 1, “Overview of
System 6.") This chapter also provides a handy reference when you need a reminder about

how to perform desktop management tasks.

This chapter contains information on these topics:
= using the Finder

= working with menus

* ysing menu commands

»  working with windows

* working with icons



Using the Finder

The term desktop refers to the area you see on your screen when you start up the Finder
application. You get 1o the Finder by starting up with System. Disk or with another hard or
floppy disk on which you have installed the appropriate system update. (For information
about installing system updates, see Chapter 2, “Using the Installer,” on page 19.) The
desktop has a menu bar at the top, a work area, assorted icons representing disks, folders,
documents, and applications, as well as the Trash. The desktop is the place where vou
organize vour work: what you want to keep, where vou want to keep it, what you want to
work with, what you want to duplicate or rename, and what vou want to discard.

Figure 3-1 shows the Finder desktop.

The Finder manages all these tasks that you'll be doing regularly:

* organizing files and folders on the desktop

= manipulating files, folders, and disks

= gjecting disks

= initializing and erasing disks

= Jaunching applications

= getting information about your documents, folders, disks, and applications

= shutting down or restarting your computer

W file Edit Windows View [ick Speciol Lol

0= Sustenlisk B aSustem Disk
| Profiis Yitems  TulKused 58K free
Prof0s Sustem Teons
[}
BRSIC System )
<al =

Trash

Figure 3-1 The Finder Desktop

42 Chapter 3 Using the System 6 Finder



You work in the Finder by selecting and dragging icons, by double-clicking, by choosing
commands from menus in the Finder menu bar, and by typing kevboard commands that
activate menu items, Just as other applications let vou create and manipulate words,
pictures, or numbers, the Finder lets you manipulate documents, folders, disks, and
applications.

Working with menus

-2

The Finder lets you work with your computer without having to memorize commands, All
the commands vou need are available to vou in the Finder menus, and vou can pull down
a menu at any time 1o see which commands are there.

Pulling down a menu

Follow these steps to see the commands in a menu:

Position the pointer on the title of a menu in the menu bar at the top of the
screen.

[ # Filey Edit Windows View Disk Special Calor

Press and hold down the mouse button.

The menu comes into view. As long as vou hold down the mouse button, the menu remains
visible.

!tnulen AN

Dpen 40
FHIRE

Clase & |
Clesefll

Duplicote. &0

Fat Bl i

Volidate
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Release the mouse button.

The menu disappears.

For a summary of the commands in each menu, see “Using menu commands,” on page 45.

Choosing a command from a menu

Follow these steps to choose a command from a4 menu:

Position the pointer on the title of a menu in the menu bar at the top of the
screen.

Press and hold down the mouse button.

The menu comes into view. (See step 2 on the previous page,) As long as you hold down
the mouse button, the menu remains visible,

Drag down through the menu until the name of the desired command is
highlighted.

If a command name is dimmed—that is, if it appears gray instead of black—the command
can't be chosen. Commands are dimmed whenever they would have no effect; for example,
if there's nothing in the Trash, the Empty Trash command in the Special menu is dimmed.

Speciol
Cleon Up
tmpty Trash 0

Preferances..

lzon Infa 1

Shut Down_.

Ll

Release the mouse button.

The command you have chosen flashes and takes effect immediately.
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¢ Keyboard shortcuts Many commands have kevboard shortcurts that let you give the
command without pulling down a menu and choosing the command name. These
shortcuts are listed to the right of the corresponding command names in the Finder menus.

To use a keyboard shortcut, simply hold down the Command (38) key while you press
and then release the appropriate letter. To give the Icon Info command, for example, you
can press Command-1. (You'll find a listing of other tips and shorteuts in the Shorteuts file
on the SystemIbols2 disk. You can use the Teach application to read the file.) »

Using menu commands

The Finder menus allow you to do all your desktop-related rasks. Until you know the
content of the menus by heart use the following pages to help you learn the location and
function of each command.

The Apple menu
This section briefly describes each command in the Apple menu. In
Rbout the Finder . : ,
Helo #]  addition to the three commands described here, the Apple menu lists
Ciasiat Pedals any other desk accessories that vou install on your startup disk. Desk
accessories are “mini-application” programs that you can use without
leaving the application you're using. They are available through the
Apple menu, either in the Finder or in other desktop programs that
support the Apple menu.
About the Finder

Displays a box showing useful information about how system memory is currently
allocated. This box shows you the total memory used by the computer and the total
memory available for your use. It also itemizes the memory allocated to the Finder, System,

Using menu commands 45



desk accessories, and setup files. The authors, version numbers of the Finder and System,
and the copyright information are also displayed.

50 About the Apple 11gs Finder” e
[2|_, Finder 6.0 by Andy Nicholas and Dave Lyons
& ‘EE System 6.0 Copyright 1987-92, Apple Computer, Inc.
Total Hemory: 1926k  Available Hemory: 162K
Finder 284K Desk Accessories 214K
Sustem 418K Setup files 294K

1o make the box disappear, click in the close box, the tiny box at the upper-left corner of

the window,

Help

Displays a window containing a pop-up menu of help information about Finder operations.

SO0=—— Finder Help

Topic | Using Help -}

To get information on different Finder features, |[{F
choose a feature from the pop-up menu above.

When there is more text thanwill fit in the
window, wou can use the scroll-bar on the right to

see the rest.

0

oy use the menu, position the pointer on the Topic box, and then press and hold the mouse
button to see your options. Drag the mouse to the option you want, and then release the
mouse button. You'll see a window describing the option you chose. Some of the
information is too extensive to fit into the window; use the up and down arrows to the right
of the text to see all of the information, When vou finish reading the information, click the
closebox at the upper-left corner of the window. You now return to the Finder,

¢ Shortcuts  The Shorteus file on the SystemTools2 disk lists shortcuts you can use with
System 6 software, Use the Teach application to read the file. #
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Control Panels

Displays the desktop Control Panels, which let you customize many features of your
computer. For information on how to make changes in the desktop Control Panels, see
Chapter 7, "Using the Desktop Control Panels,” on page 171.

FO0==Lontrol Pone s ==
s :
Printer Port m
%]
Time
5] 10

The File menu

m This section gives a brief explanation of each command in the File menu.

Ooen 40 These commands help vou manipulate desktop items; vou use the File
Frint 1 % # =
Close o] menu 1o create new folders, open icons, close windows, duplicate files
i and folders, print files from the Finder, and check desktop items for
Duplicate., 40 AT e
e tlamage.
Validate

New Folder

Places an empty folder in the active window. The folder can then be used to hold
documents, applications, or other folders. If no windows are active, the New Folder
command is dimmed. For instructions on using this command, see “Creating a new folder,”
on page 120.

Open

Opens the selected icon or icons. If the icon represents an application, opening it usually
gives you a new, untitled document. For instructions on using this command, see “Opening
icons,” on page 72.
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Print

Allows vou to select document icons from the Finder for printing. The command launches
the application that produced the document and instructs it to print to a connected printer.
Note that many applications don't support printing from the Finder. In such cases, you must
first open the application. and then open and print your document. (Remember, if you are
working with an 800K startup disk, you must install the appropriate printer update. For
information about installing updartes, see Chapter 2, “Using the Installer,” on page 19.)

Close

Closes the active window back down to its icon—which remains selected. The next open
window, if there is one, becomes the active window. For instructions on using this
command, see “Closing a window,” on page 66.

Close All

Closes all windows. For instructions on using this command, see “Closing a window,” on
page 66.

Duplicate

Makes a duplicate copy of the selected file or folder and places it in the same window as the
original. Duplicates items are shown with a 2 after the name of the original. Duplicating a
folder duplicates the folder and all its contents. For instructions on using this command,
see “Placing duplicate copies of files and folders in the same window,” on page 123.

Put Away

Returns all selected files on the desktop or in the Trash window to the window from which
they were most recently moved. The Put Away command also removes disk icons from the
desktop (if they are removable), Choosing Put Away sends a selected removable disk icon
to the Trash, causing it to eject. For instructions on using this command, see “Putting away
desktop icons,” on page 75.
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Validate

Lets you check a disk, a folder, ora file for damage. For instructions on using this command,
see “Validating files,” on page 132.

The Edit menu

This section gives a brief explanation of each command in the Edit menu.

{inda i
a = Many of these commands—the ones that help vou edit text—can’t be
- used in the Finder (except in Finder Help or the Icon Info Comment
tle Card) but can be used with most desk accessories in which you can type
gl | text. Many graphics-based programs have similar or identical commands
L in their Edit menus.

Undo

Reverses your last action. The Undo command is used in applications and desk accessories.

Cut

Removes the selected material and places it in 4 holding area called the Clipboard
(replacing whatever was there before). The Cut command is for use in applications, desk
accessories, and Icon Info comments.

Copy

Places a copy of the selected material on the Clipboard (replacing whatever was there
before) without removing the selected material from the original location. The Copy
command is used in applications, desk accessories, Icon Info comments, and Finder Help.

Faste

Places a copy of the contents of the Clipboard at the insertion point without removing the
contents from the Clipboard. You can paste the same item as many times as vou like—until
vou cut or copy a new selection onto the Clipboard. The Paste command is used in
applications, desk accessories, and Icon Info comments,
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Clear

Removes the selected material without placing a copy on the Clipboard—whatever is on the
Clipboard remains intact. The Clear command is used in applications, desk accessories, and
Icon Info comments.

Select All

Selects all icons in the active window (or, if no windows are displayed, all icons on the
desktop). For instructions on using this command, see “Selecting icons,” on page 68.

Show Cliphoard

Displays a window showing the current contents of the Clipboard. The Show Clipboard
command is used in applications, desk accessories, and Icon Info comments,

The Windows menu

The Windows menu lists all the windows you open as you work with the
desktop (and includes the Stack Windows command described later in
this section), The Windows menu gives you a quick way to find a
particular window when you have several windows open on the desktop.
You can check the Windows menu to see all currently open windows in
alphabetical order. The active, or frontmost, window displays a check
mark next to its menu listing,

Gtock Windows

¢ Note Desk accessory windows are not listed in the Windows menu, nor are they
stacked by the Stack Windows command e

To bring a window to the front, making it the active window, simply select the window from
the menu. Note that if no windows are open, the menu will be dimmed and you will not be
able to select any items from the menu.
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Stack windows

Stacks all the windows you have open on the desktop, using the order in which you worked
with them, That is, the window that was active when you chose the Stack windows
command will be on top, the window that was most recently active before that will be
behind the first, and so on with each successive window.

The View menu

This section gives a brief explanation of each command in the View

y :: ;:L Tcon menu. These commands let you change the way directory information is
by Hame displaved in a window. The current view is always indicated in the View
i menu by a check mark. For instructions on using the commands in the
oL View menu, see “Changing vour view of a window,” on page 65.

If no windows are open, the menu will be dimmed and you will not be able to select any
items in the menu.

By Icon

Displays the contents of the active window as full-sized icons, with the icon name below the
icon,

By Small Icon

Displays the contents of the active window as small icons, with the icon name to the right
of the icon. Viewing by small icon is useful when you have many items in a window and want
to be able to see more of the icons at once.

By Name

Lists the contents of the active window alphabetically by name.
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By Date

Lists the contents of the active window chronologically by date of last modification. The
item most recently changed is listed first, For folders, the modification date indicates when
vou last added or removed an item. If you've never added or removed any items, the date
vou created the folder is shown. Modification dates are shown in this view even if you have
indicated, via the Preferences command, that dates not be shown in windows. For
information about Preferences, see page 55.

By Size

Lists the contents of the active window by size. The largest item is listed first. This view is
particularly useful for seeing which files are taking up the most room on a disk. Selecting
this view overrides the Preferences command to not show sizes in windows.

By Kind

Lists the contents of the active window alphabetically by tvpe of item, If the window
contains any files, this view orders them by whar kind of file each one is—a BASIC
application, a ProDOS 8 application, and so on. Selecting this view overrides the
Preferences command to not show kinds in windows.

The Disk menu

- This section gives a brief explanation of each command in the Disk
i menu. These commands let you perform basic procedures with your

disks. For instructions on using any of these commands, see Chapter 4,
“Working With Disks,” on page 85.

If no disks are selected, the menu will be dimmed and you will not be able to select any
items in the menu.
Initialize

Initializes the disk represented by the selected icon. Initializing a disk is somewhat like
constructing a parking lot with numbered parking spaces. When the computer stores
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information on the disk it uses these “parking spaces” to organize the information for easy
retrieval.

A Warning D not attempt to initialize a disk that contains information that you want to
keep without first backing up the files on the disk. For more details, see Chapter 4,
“Working with Disks,” on page 85 or Chapter 8, “Using the Archiver,” on page 199. 4

Erase

Erases all information on the disk represented by the selected icon.

A Warning D not attempt to erase a disk that contains information that you want to keep
without first backing up the files on the disk. For more details, see Chapter 4, “Working with
Disks,” on page 85 or Chapter 8, “Using the Archiver,” on page 199. A

Verify

Lets you determine whether there is physical damage to the disk represented by the
selected icon. The command allows you to find out whether there are any bad blocks on
the disk. (A block is a unit of measure used to specify the size of disks and files.) If a disk
has bad blocks, you can then copy any files vou can to a good disk and discard the disk with
the bad blocks. Choosing Validate from the File menu tells you which files are affected by
bad blocks. If the disk with bad blocks is a hard disk or a hard disk partition, see your
authorized Apple dealer.

Eject

Ejects the 3.5-inch disk represented by the selected icon. This command does not, however,
remove the disk's icon or its window from the desktop. (To remove the icon from the
desktop, you must drag the icon into the Trash or choose Put Away from the File menu.)

If vou select the icon of a disk that can't be ejected—such as a hard disk, a hard disk
partition, or a 5.25-inch disk, which must be removed manually—the Eject command will be
dimmed.
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¢ Hard disk users If you have not installed the HFS file system translator, when you try
to mount a hard disk that contains an HFS partition, you'll see 2 message asking vou if you
want to initialize the partition or eject it. If you select the Initialize option, your partition will
be reformatted with the ProDOS file system. If vou select the Eject option, vour partition
won't mount. (That is, you won't see it on your desktop.) &

¢ CD-ROM users You can use the Eject command to eject CD-ROMs, If a CD-ROM has
partitions, you select all the partition icons and then choose Eject in order to eject the disc.
To clear your workspace, you can “eject” CD ROM partitions by using the Put Away
command, the Eject command, or dragging them to the Trash. (If the CD-ROM has
partitions initialized for more than one file system, the Eject command doesn’t work unless
vou have installed the appropriate FST for each partition—for example, the CD-ROM
Explorer® disc that comes with the AppleCD SC drive includes both HFS and ProDOS
PArttions.) «

The Special menu

The Special menu lets vou perform a variety of tasks: aligning icons,
permanently discarding anything vou've dragged to the Trash, setting
special preferences for Finder operations, getting information about
icons, and shutting down the computer.

Cleon Un

fmpty Tragh ol

Preferences..

Ieon Infe ol

Clean Up

Aligns all icons in the active window in an invisible grid of rows and columns, This command
can be used on windows only when you're viewing the contents by icon or by small icon, If
no windows are displaved, this command aligns the icons on the desktop. For instructions
on using this command, see “Cleaning up the icons in a window or on the desktop,” on
page 74.
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Empty Trash

Permanently deletes any files and folders in the Trash and frees up the space they occupied
on their disks, For instruction on using this command, see “Discarding files and folders into
the Trash,” on page 128. If nothing is in the Trash, this command will be dimmed and you
will not be able to select it,

Finder Preferences

Displays a dialog box that lets vou set special preferences for certain Finder operations.
When an option is turned on, an X appears in the box next to the option's name. When an
option is turned off, the box next to the option name is empty. (All options are preset to be
on.) Click the box to add or remove the X.

Finder Preferences
5'"i“ Views T [ Save Finder information onto disk
5"“"" d‘_‘“ . EHide invisible files
| Show size ! [)when starting up, check 5.25" drives
psiShowkind Color selected icon’s background
: B2 Show disk info : instead of its outline
¢ inheader
(Caneel ) ( Recest )

Click Accept to confirm the change and make the Finder Preferences dialog box
disappear. Click Cancel if you made no changes or if you want to cancel any changes you
made in the Finder Preferences dialog box.

The options in the list on the right side of the Finder Preferences dialog box are:

= Save Finder information onto disk: When vou close a window on a disk that isn't
write-protected, the Finder keeps track of the position and size of the window and the
position and color of the icons in the window. The next time vou open the window,
everything will look the same as when vou closed it. Similarly, when vou eject a disk that
isn't write-protected, the Finder keeps track of which windows were displayed; the next
time you insert the disk, the same windows will automatically be displayed.
If you don't want the Finder to keep track of this information—for example, if you want
the changes you make to window size or position to be only temporary—turn this
option off.
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= Hide invisible files: Several types of files containing data of use only to the Finder or
the operating system are marked as “invisible.” Normally, the Finder hides such files
from view,
If vou want to see those files, turn this option off.

s When starting up, check 5.25-inch drives: When the Finder is starting up, it checks all
drives. If you want to eliminate the annoyance of attempts to read these drives, turn this
option off.

= Color selected icon’s background instead of its outline: For an explanation of this
option, see “Changing the color of icons,” on page 80.

The List Views box on the left of the Finder Preferences dialog box lets you customize the

amount of information vou see about items in a window. When you set these options, vou

effectively create your own display criteria for all the windows you open. However, you can
always override vour List View preferences for an active window by using the View menu.

(See “The View menu,” on page 51.) These are the options:

= Show date: When viewing a window by name, size, or kind, you will also see date
information. If you prefer to omit date information, turn this option off,

»  Show size: When viewing a window by name, date, or kind, you will also see size
information. If you prefer to omit size information, turn this option off.

*  Show kind: When viewing a window by name, date, or size, you will also see
information about the kinds of items in the window. If vou prefer to omit such
information, turn this option off.

= Show disk info in beader: When viewing a window, you will see the file system name,
the number of items in the window, and the space on disk displaved in the window
header. If you have the window view set to other than Icon and prefer to omit the disk
informartion to make more room for window contents, turn this option off.

lcon Info

Displays a window showing information about the selected icon. For instructions on using
this command, see “Getting information about icons,” on page 78.
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Shut Doun

Prepares the computer to be switched off and then gives you the option of switching off the
power, restarting the computer, or returning to the application (if any) from which you
started the Finder. For instructions on using this command, see “Shutting down the
computer,” on page 149.

The Color menu

The Color menu lets you change the color of the selected icon's background and outline.
For instructions on using this menu, see “Changing the color of icons,” on page S0.

The Extras menu

The Extras menu appears only when you have installed upcates that include Finder
extensions—programs that extend the functionality of the Finder. (EasyMount, or “Create
Server Alias”, is such a Finder extension. Installed via the “Nerwork: AppleShare” update, it
allows network users to log on to a server quickly and easily. For more information about
EasyMount, see Chapter 12, “Networking the Apple I1Gs,” on page 271.)
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Figure 3-2 An annotated window
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Windows give you a visual representation of the contents of a disk, a folder, or a document
vou create with an application. You may need to manipulate windows in order to see the
information they contain. Figure 3-2 shows the parts of a window.

Making a window active

When you have two or more windows displayed on the desktop, only one window can be
the active window—the location of vour next action,

There are four ways to make a window active:

® You can simply click anywhere in the window. (It may be necessary to move other
windows first so that a portion of the window you want to make active is visible.)

= You can choose the window you want from the Windows menu. (For more information
about the Windows menu, see page 50.)

* You can double-click the icon of the folder or storage device to open it.

= You can choose a window from the pop-up shortcut. (For more information, see “Using
the window pop-up shortcut,” on page 61.)
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Figure 3-3 Four ways to make a window active

Note that when a window is active, the title bar at the top of the window displays ruled lines

on either side of the title. When a window is inactive, the title bar displays only the title. See
Figure 3-4.

Moving an active window

To move an active window, drag the window by its title bar to a new location. As vou drag,
an outline of the window follows the pointer. See Figure 3-5.
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Figure 3-5 Moving an active window

To cancel the move, drag the pointer into the menu bar at the top of the desktop before
releasing the mouse button; the border line will disappear, and when you release the mouse

button the window will remain in its original position.

Moving an inactive window
Follow these steps to move an inactive window without making it active:

If necessary, move any other windows until you can see the title bar of the

inactive window to be moved.
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2 Hold down the Command key while you drag the window by its title bar to a new
location.

As you drag, an outline of the window follows the pointer.

Holding down the Command key prevents the window from becoming active when you
drag it. To cancel the move, drag the pointer into the menu bar at the top of the desktop
before releasing the mouse button,

Using the window pop-up shortcut

When vou have 4 number of windows open on the desktop, it's not always easy to
remember where each of them came from—that is, the path of folders you opened to get
to each window. The window pop-up shorteut allows you to see this hierarchical path for
the active window, and to move quickly up and down it.

To use the window pop-up shortcut, follow these steps:

1 Hold down the Command key while you click anywhere in the title of the open
window.
The titles of the windows vou opened to get to the currently active window appear in a pop-
up menu, You can see at a glance how you got to the active window.

| System,Disk |

Appledisl  Suort.65.08 65.05 frror Hsg

65.05.Oev F&Ts Drivers
&= | 1] G

./ Choose any of the items in the menu to make it the active window.

The window that was active when vou used the shortcut becomes inactive; it doesn't close.

Working with windows 61



Changing the size of a window

There are two ways to change the size of a window: by using the size box or by zooming.
Using the size box allows vou to make the window any size you want; zooming gives you
only two possible sizes, but is faster than using the size box.

Using the size box

Follow these steps to change the size of a window using the size box:

1 1f the window you want to resize isn't active, click anywhere inside it to make it
active, or choose it from the Windows menu.

I~

If necessary, move the window until the size box in the lower-right corner is
visible.

5 Drag the size box.

As you drag, an outline of the window follows the pointer, Dragging horizontally changes
the window's width, dragging vertically changes its height, and dragging diagonally changes
hoth,

The new dimensions take effect when you release the mouse button.
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Zooming

Follow these steps to change the size of a window by zooming:

If the window you want to resize isn’t active, click anywhere inside it to make it
active, or choose it from the Windows menu.

If necessary, move the window until the zoom box in the upper-right corner is
visible.

Click the zoom box,

sed 39K free-
1

Error Msg

The window expands automatically to fill all but the rightmost inch of the desktop. If you
click the zoom box again, the window returns to its previous size. (If you've moved or
resized the window in the meantime, the second click of the zoom box will take you back
to the most recent size and position—not the original size and position.)

Changing what's visible in a window

The scroll arrows, scroll bars, and proportional scroll boxes of 2 window let you change
what portion of a window vou see when the window is too small to display its entire
contents at one time, When a window's complete contents are visible, both scroll bars are
white, and you can't scroll.

There are five scrolling techniques. The technique you use depends on whether you want
to scroll by small increments, by the windowful, by large increments, continuously, or
continuously by large increments.

= Toscroll by small increments, click the scroll arrow that points in the direction of the
drea you want to see.
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Figure 3-6 Scrolling techniques

= o scroll a windowful at a time, click one of the gray areas of the scroll bar near the
arrow that points in the direction of the area you want 1o see.

» o scroll by large increments, drag the proportional scroll box to the point in the scroll
bar that represents the approximate position of the area you want o see.

» Joscroll continuously, press the scroll arrow that points in the direction of the area you
want to see. As long as vou hold the mouse button down, the window will scroll
continuously by small increments in the direction of the arrow.
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» [0 scroll continuously in large increments, press the gray area of the scroll bar in the
direction of the area you want to see. The window will scroll in window-size increments
until the mouse button is released.

Figure 3-6 shows scrolling by small increments, large increments, and by the windowful.

Changing your view of a window

There are six possible views for a window: By Icon, By Small Icon, By Name, By Date, By
Size, and By Kind. The view you use depends on personal preference or what file
information is most valuable to you. You can further customize the view you use by
selecting options via the Preferences command in the Special menu (see page 54).
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Figure 3-7 The System.Disk window displaved in each of the six views
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The two icon views graphically represent the application or, in the case of documents,
usually indicate the application that was used to create them. The remaining views display
the contents of the window as a list and may include the size of each item listed and the
date it was last modified.

Follow these steps to change your view of a window:

If the window you want to change the view of isn't active, click anywhere inside
it to make it active, or choose it from the Windows menu.

Choose the desired view from the View menu.

Note that when you view by Name, Date, Size, or Kind, the current view

fodnel will be displaved in boldface in the window header.

by Small Tcon

by Dote
by Size
by Kind

Closing a window

You can close one window at a time, or you can close all windows on the desktop at once.

Closing a single window

There are several techniques for closing a single window. The technique you use depends
on your personal preference. These techniques assume that the window you want to close
is the active window.

Here are the techniques:

*  Click the window's close box.

*  Choose Close from the File menu.

*  Press Command-W (the keyboard shortcut for the Close command).

#+ Note If the window you want to close is not active, press Option while choosing the
window's title from the Windows menu. This closes the window without first making it
active.
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Figure 3-8 The three techniques for closing a window

When you close the active window, the next open window (if there is one) becomes the
active window.

Closing all windows at once

There are three techniques for closing all the windows at once. The technique you use
depends on your personal preference.

Here are the three techniques:

= Choose Close All from the File menu

*  Press Command-Option-W

= Hold down the option key while clicking the close box of the active window
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Icons give you a visual representation of the files, folders, disks, or applications you can
work with on the Finder desktop. Working with these icons is a basic part of performing
tasks on your Apple 11Gs.

Selecting icons

You must select an icon before you tell the computer what action to take on the icon. There
are several techniques for selecting icons. The technique you use depends on whether you
want to select:

= asingle icon

= several icons that are grouped together

= several icons that are not grouped together

* all the icons in a window

= all the icons on the desktop

Selecting a single icon

To select a single icon, click the icon. The icon becomes highlighted, indicating that it is
selected.

\A -

Y N
System

L. Click an icon 2, The icon becomes highlighted

Figure 3-9 Sclecting a single icon
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Selecting several icons that are grouped together

Follow these steps to select several icons that are grouped together:
Position the pointer outside one corner of a group of icons.

Drag to the opposite corner of the group.

As you drag, a black outline of a rectangle forms around the icons.

Predos “%'I [““_;]
=

Release the mouse button.

All icons that were fully or partially within the rectangle’s outline are selected immediately.

Selecting several icons that are not grouped together

Follow these steps to select several icons that are not grouped together:
Click the first icon to select it.

Hold down one of the Shift keys while you click the next icon to select it.
This process is called Shift-clicking.

Shift-click each additional icon to select it.
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Selecting all the icons in a window

Follow these steps to select all the icons in a window:
Click the appropriate window to make it the active window.

Choose Select All from the Edit menu. (Or press Command-A.)

Command-A is the kevboard shortcut for the Select All command.

Selecting all the icons on the desktop

Follow these steps to select all the icons on the desktop:

Close all the open windows on the desktop.

You can hold down the Option key while you click the close box of the active window on
the desktop to close all windows, or you can choose Close All from the File menu.

For more information, see “Closing a window,” on page 66.

Choose Select All from the Edit menu. (Or press Command-A.)

Command-A is the kevboard shortcut for the Select All command,

Deselecting icons

If you change your mind about taking an action on an icon (or group of icons). or if you
select an icon by mistake, vou'll need to deselect the icon, There are two techniques for
deselecting icons. The technique you use depends on whether you want to deselect all

selected icons or only some selected icons.

Deselecting all selected icons

To deselect all selected icons, click anywhere on the desktop except on an icon or press the
Esc key.
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Deselecting some selected icons

To deselect some selected icons but leave others selected, hold down one of the Shift keys
while you click each icon that you want to deselect.

Moving icons

You will frequently rearrange icons into new folders as you purchase new applications and
create new document files.

Follow these steps to move icons from one place to another on the screen:
Select one or more icons.

Drag the icon or icons to the desired location on the screen.

As you drag, an outline of the icon or icons follows the pointer. Don't release the mouse
button until the pointer is in the desired location. If you're dragging items into another
window, for example, release the mouse button when the pointer is within the window,

& e
- -

Be aware of the following:

» Ifvou drag onto a disk or folder icon, the files will be moved into that icon.
* [fyou drag into the menu bar, the icons will return to their original position.

«  Ifyou drag the icons onto another disk they will be copied to that disk and the icons
will remain in their original position.
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Opening icons

There are three techniques for opening icons. The technique vou use depends on your
personal preference. Figure 3-10 shows the techniques.

Here are the three techniques:

= Select the icon and choose Open from the File menu.

» Select the icon and press Command-O (the keyboard shorteut for the Open command).
* Double-click the icon.

V

Wew Folder 3K

Open il

Print
Clowe
Close ALl
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Choosing Open Pressing Command-O Double-click icon

Figure 3-10 Three techniques for opening icons

What happens when you open an icon depends on the type of icon (see Figure 3-11):

»  When you open a 5.25-inch disk drive icon, another icon (representing the disk in that
drive) appears on the desktop along with the disk drive icon.

* When you open a disk or folder icon, a window displaying the contents of that disk or
folder appears on the desktop.

= When vou open an application icon, the Finder starts up the application and you leave
the Finder.

= When vou open a document icon, the Finder starts up the application that was used to
create the document, and then displays the document on your screen. This technique
does not work with all applications; some require you to start up the application first,
presenting you with an empty desktop and then vou need to open the document from
within the application,
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Figure 3-11 Tipes of icons

If the Finder isn't able to locate an application tor the document—for example, if the
application disk isn't in any of vour disk drives—you'll see the following dialog box:

The opplicotion “Teoch” con't be found for this
document,

(Try Again ) l Locate... ,

After making sure that the application disk is on line, click Try Again. If the Finder still can't
locate vour application, follow these steps:

1. Click Locate to see the Volumes dialog box.

2. Click Volumes to see all the volumes vou have on line.

3. Select the volume where the application is located

4. Select the application and click OK.

The next time you try to open the document in the Finder, vou should be successful. If not,
start up the application by opening its icon rather than by opening a document.

For more informarion, see “Starting up an application,” on page 136.
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Cleaning up the icons in a window or on the desktop

Until you move them, icons in a window or on the desktop are aligned horizontally and
vertically in an invisible grid. But when you move icons, you may not always realign them
perfectly. You can realign them using the Clean Up command in the Special menu.

You can clean up only one window—or the desktop—at a time.

Cleaning up the icons in a window

Follow these steps to clean up the icons in a window:

| click the appropriate window to make it the active window.

I~

Choose Clean Up from the Special menu.

The icons move into alignment.

fmptd Traah 11

Preferences

Cleaning up the icons on the desktop

Follow these steps to clean up the icons on the desktop:

I close all the open windows on the desktop.

You can hold down the Option key while vou click the close box of the active window on
the desktop to close all windows, or vou can choose Close All from the File menu.

For more information, see “Closing a window,” on page 66.

| ]

Choose Clean Up from the Special menu.

The icons move into alignment.
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Putting away desktop icons

If you find yourself needing some extra space on the desktop, you can move file or folder
icons from a window directly onto the desktop and then close the window. (Moving file and
folder icons onto the desktop can also be convenient when items are nested several folders
deep.)

When you're ready to return icons to the appropriate windows, you can have the computer
automatically put away file and folder icons vou've moved to the desktop.

The Put Away command also removes icons from the desktop (if they are removable).
Choosing Put Away moves a selected removable disk icon to the Trash, causing the disk to
eject.

Follow these steps to use the Put Away command:
Select the icons you want to put away.
Choose Put Away from the File menu. (Or press Command-Y.)

- The icons return to their previous locations—even if their windows
o & aren't displayed on the desktop. (If the icon represents a removable disk,

frint

Close  di it moves to the Trash and the disk ejects.)

CloseRll

Duplicate.. 40

# Network users If vour Apple 11cs is part of a network that includes ane or more
AppleShare file servers, you can't move file icons from a file server onto your desktop
because other network users may need access to those files. For more information about
AppleShare file servers, see Chapter 12, “Networking the Apple 11GS,” on page 271.

Renaming icons

You can give a new name to any disk icon or any icon in a window—unless it's write-
protected or locked.
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¢ Network users I your Apple I1Gs is part of a network that includes one or more
AppleShare file servers, you must have the appropriate access privileges in order to rename
icons. For more information, see *Setting access privileges for a folder,” on page 289. o

Whenever you rename an icon using the Finder, you must edit text (or type new text), And
if you're using applications that include text—for example, word-processing programs—you
use the same text-editing techniques that you use in the Finder. For more information
about text editing, see “Using Teach to practice application tasks,” on page 150.

Important Do not rename the System folder icon or any other icons in the System folder.
The system looks for such files by name; if it doesn't find them, the system may not function
properly.

Follow these steps to change the name of an icon:

1 Click the icon or its name.

The icon and its name become highlighted.

I~

Type a new name or edit the name that’s there,

Be sure to keep the following rules in mind:

= No two icons in the same window can have the same name.
= No two disk icons on the desktop can have the same name.
For the ProDOS format, follow these rules:

= Start the name with a letter.

= Use no more than 15 characters.

= Don't use spaces.

= Don't use characters other than letters, numbers, or periods.
For the HFS format, follow these rules:

= [Use no more than 27 characters for disks or 31 characters for files or folders.

»  Don't use colons.
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Important [f you use the Apple llas file system translators (FST8) to work with files from
another system, be sure to follow the file naming rules of the other system when
appropriate. For more information about FSTs, see “Using file formats and translators,” on

page 109. -

¢ Network users [f your Apple 11Gs is part of a network that includes one or more
AppleShare fle servers, the naming rules for items vou store on a file server are the same
as the HFS rules, However, if you plan to open vour files from ProDOS 8 applications, follow
ProDOS naming conventions, ¢

Press Return to confirm the new name.

The icon displays its new name, If you change vour mind about the name you typed—or
realize that you selected the name of another icon uninteéntionally—you can cancel the
renaming operation by pressing the Esc (for Escape) key or by clicking anvwhere outside
the icon’s name.

If the name you typed doesn't follow the appropriate rules, you see a message indicating
that you provided an unacceptable file name. Click Edit New Name and then rename the
icon with an appropriate name,

Sometimes vou may want to change only a portion of the name in order to have several
icons with similar names. To change only part of the name of an icon follow these steps:

Click the icon or its name.
Position the pointer at one end of the part of the name you want to change.
= Note that the pointer becomes an I-beam when it's positioned within

Prctice DisH the word. (If it does not become an I-beam the disk may be write-
protected, or locked.)
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Drag across the part of the name you want to change.

The text becomes highlighted as you drag across it, indicating that it has

=
TR Disk been selected.
Type the new text.

Press Return to confirm the new icon name.

#+ By the way Ifvouwant to change one complete word of the disk icon name, select the
icon and then simply double-click the word vou want to change. The word becomes
highlighted, indicating that it has been selected. Type the new word. Be sure to double-click
the name and not the icon itself. (Double-clicking an icon is a shortcut for opening the
icon.)

For more detailed instructions on editing text, see the sections on working with text on
page 154 through page 165,

Getting information about icons

Follow these steps to get information about an icon:
Select one or more icons.

Choose Icon Info from the Special menu. (Or press Command-1.)

Speciol
Cleon Up
bt Yeash 117

Preferences..

Command-1 is the keyboard shortcut for the Icon Info command.

Infa

Shut Down... 00
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When you choose Icon Info, a window representing a spiral-bound book of index cards
appears on the desktop. The first card displays general information about the icon,

EO=== Infa 0n "Mottlistory* =ice——|
D Matt History Locked [] I

Kind: File Tupe Homes
Size: 9,105 butes, 10K on disk

Created: Fri. Jon 18, 1091, 5:36 PH
Hodified: Fri, Dec 13, 1001, 2.00 PH

| General [T Where ]| Comment |

3 For information on the icon’'s location, click the tab labeled WHERE near the
bottom of the window.

A new card appears on the desktop. This card lists the icon’s physical location and its
pathname, which is the route you take to get to the icon, (In the example, the icon is on a
disk in the first 3.5-inch drive; the disk is called Practice.Disk and the file is called

Matt History. This is stored in the computer as a single name: Practice Disk:Mart. History. )

(=== Infoon "Hott Histony" S"iebQFceees

e e e T e e

Device: APPLEDISK3.SA

Path; :ProcticeDisk:Matt.History

[ General || Where [[ Comment |

4 To add a comment about the icon, or to see a comment you've written, click the
tab labeled Comment near the bottom of the window.

A new card appears on the desktop, displaying an Add Comment button.Clicking the Add
Comment button presents 4 warning that, unless the file is placed on a server, adding
comments to it will make it unusable by ProDOS 8 applications. If you want to go ahead,
click Attach. An insertion point appears on the card, and you can attach your comment to
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the icon. You can write anything that might help identify or explain the icon (within the limit
of 199 characters).

EOS=== Info on "Natt History* S|

Matt's history report on the antics of Mark Twain
and his RiverBoat friends|

Comment

|_General J|_ Where |

¢ Network users f vour Apple [las is part of a network and you choose Icon Info after
selecting an icon on an AppleShare file server, you'll see another tab (labeled Access) at the
bottom of the window. This tab lets vou see an additional information card. For details. see
Chapter 12, “Setting access privileges for a folder.”

Note that the system does not always permit a Comment Card for icons on a local disk.
For example, a Comment Card will not appear for folders on local disks.

Changing the color of icons

If you have a color monitor, vou can change the background and outline color of file, folder,
and 5.25-inch disk icons. If you have a monochrome monitor, you can choose among black,
white, and 14 shades of gray for the background and outline. See Figure 3-12.

Unless you want to use the same color for more than one icon, yvou should select a
single icon in the following procedures.

(i

Sarah.Folder Gregory.Folder

Figure 3-12 Background and outline colors
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+ Note You may not be able to change the color of certain icons, An application icon that
comes already colored by its publisher is an example of such an icon.

Changing an icon’s background color

Follow these steps to change the color of an icon’s background:
Click the icon to select it.

Choose the desired color from the Color menu.

The icon becomes the chosen color.
Changing an icon’s outline color
Follow these steps to change the color of an icon’s outline:

Click the icon to select it.

Hold down the Control key while you choose a color from the Color menu.

The outline of the icon becomes the chosen color.,

Reversing the background and outline procedures

1fyou change icon outlines more often than icon backgrounds, vou may want to reverse the
commands used to perform the two coloring procedures. Follow these steps:

Choose Preferences from the Special menu.
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Click the box next to the “Color selected icon’s background instead of its outline™
option to remove the X.

Finder Preferences
i List Views -

=] Save Finder information onto disk

(EIshowdote | Eige invisible files

| B0 Show size 2 hen starting up, oheck 5,25 drives
§ <l Show kind ~ | [CItelor selected icon's background

: =) Show disk info | instead of its outline

i inheoder

( Cancel il Hccept I

3 Click Accept.

Now, whenever you choose a color from the Color menu, thar color will be applied to the
selected icon's outline. And whenever vou hold down the Control kev while choosing a
color from the Color menu, that color will be applied to the selected icon’s background.

Locking an icon

Ifyou lock an icon, the system will not allow yvou to accidentally remove, replace, or rename
it. If you lock a document file, vou cannot make changes to it, but you can move it to
another location. If vou lock a folder, vou can still change files inside it, and vou can move
it to another location. For information about locking, or write-protecting, disks, see

page 94.

@ Note You cannot lock an HFS folder; the HFS file system doesn't support this
function. e

Follow these steps to lock an icon:
Select the file or folder icon you want to lock.

Choose Icon Info from the Special menu. (Or press Command-I, the keyboard
shortcut.)
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You see the General card for the icon.

[ECJ===== Info on "Gregory Folder"

E’ Gregory Folder Locked G2

Kind: Folder
Size: use coleulote icon...

Contents: use coleulote icon...
Created: Tue, Jon 21,1982, Y:08 PH
Moditied: Tue, Jon 20, 1992, 408 PH e

| General [T Where |

Click the Locked check box.
An X appears in the check box, indicating that the file or folder is now locked.

You can also check the box by typing L; typing L again removes the check.

Close the Icon Info window.

A lock symbol now appears to the left of the icon's name.

Unlocking an icon

Follow these steps to unlock an icon;
Select the icon you want to unlock.

Choose Icon Info from the Special menu.

You see the General Card for the icon.

Click the Locked check box to remove the X.

The X disappears from the box.

Close the Icon Info window.

The icon is now locked,
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Working With Disks

Almost everyone will refer to this chapter from time to time., [t explains how to prepare vour

disks, work with them. and take care of them. It also tells vou about file system translators
which let vou use disks from several hile systems—and how o use part of vour compurer’s

memory as a cisk. If vou're a new user, the first four sections are basic—although even

experienced users will find them handy for reference. The last two sections help you make

the most of your Apple I1Gs computer, This chapter contains information on these topics:

* understanding hard and Hoppy disks

= preparing to use disks

= working with disks on the desktop

* taking care of disks and diagnosing disk problems
= using file formars and translators

= using memorv as a RAM disk



Understanding hard and floppy disks

86

Both hard and floppy disks store information so you and vour computer can have access to
it. Hard dlisks are sealed inside a case; floppy disks can be inserted into and ejected from a
disk drive. Both kinds of disks show up as icons on your desktop, and vou work with them
in exactly the same way.

The major difference between hard and floppy disks is their capacity—the amount of
information they can hold. Disk capacity is measured in two units:

= Akilobyte is 1024 bytes, and is represented by the abbreviation KB—or just K.
= Amegabyte is 1024 kilobytes, and is represented by the abbreviation MB.

A convenient rule of thumb is that a full page of text takes up roughly four kilobvtes
(4K).

A hard disk provides a large amount of room to store information—anywhere from five
megabytes to hundreds of megabytes. If vou have a hard disk and you want to learn how to
protect large volumes of information by making copies, see Chapter 8, “Using the Archiver,”
on page 199,

The types of floppy disks that you may use with your computer are 3.5-inch disks and
5.25-inch disks. The Apple 11Gs supports two kinds of 3.5-inch disks: 800K disks and high-
density (1.4 MB) disks. (High density disks are used only in the Apple SuperDrive, and
require an Apple 11 3.5 Controller Card installed in the Apple I1Gs.)

800K and high-density floppy disks are physically the same size, and the differences
between them are subtle. Figure 4-1 shows how vou can tell them apart.

You'll have no trouble distinguishing a 5.25-inch disk, which is not only larger physically
but is flexible,

It's important to know which type of disk vou're working with, because not all types can
be used in all floppy disk drives. As the chart shows, a floppy disk drive can take disks of the
corresponding capacity, plus any smaller-capacity disks of the same type. That is, a high-
density disk drive (SuperDrive) can take both 1.4 MB and 800K disks. But larger-capacity
disks can’t be used in smaller-capacity drives. You can't use a high-density disk in an 800K
drive,
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Figure 4-1 Comparison of high-density and 800K floppy disks

Disk Drive Model Compatible Disks
SuperDrmve HD I I BUK ir
lmi m
800K Drive | 800K |

Preparing to use disks

This section explains three tasks that you perform when using disks:

= inserting the disk

= initializing the disk

= write-protecting the disk

Initializing is something you generally need to do only once for each disk. Write-protecting
a disk is optional, although it's recommended practice to write-protect your system disks
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to protect them from being altered accidentally. (Don't write-protect a disk, and then try to
initialize it; it won't work. )

Inserting a disk

When inserting a disk, make sure you're inserting it right side up and with the proper end
entering the disk drive first.

3.5-inch disks

Follow these steps to insert a 3,5-inch disk:
I Hold the disk with the label side up and the metal slider toward the disk drive,

2 Slide the disk into the disk drive, metal end first.

When the disk is almost all the way into the disk drive, the drive draws the disk the rest of
the way in. You'll hear it click into place.
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3.25-inch disks

Follow these steps to insert 4 3.25-inch disk:
1 Make sure the disk drive door is open.
2 Hold the disk with the label side up and the oval cutout toward the disk drive.

3 slide the disk into the disk drive.

A  Warning Use care when inserting the disk to ensure that the disk doesn’t bend and
become jummed in the drive. &

4  Close the disk drive door:
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Initializing a disk

Before you can save information on a disk, the disk must be initialized. Initializing a disk

does two things:

= Itestablishes a physical format on the disk. That is, it divides the disk into sections—
somewhat like parking spaces in a parking lot—where information can be stored.

*  [twrites a file system on the disk. That is, it creates a system that organizes the sections
so that the computer can keep track of where data is stored.

The Finder initializes disks in either the Professional Disk Operating System
(ProDOS) format or the Hierarchical File System (HFS). the Macintosh formar. If vou
want to be able to use disks from the Macintosh environment, you can use the Installer to
add the HFS file system translator (FST) to your startup disk. Then vou can use ProDOS and
HFS disks with equal ease. Keep in mind, however, that your startup disk must always be
initialized in the ProDOS format; you install the HFS file system translator on a disk
initialized for ProDOS. (If you're working on a network, see Chapter 12, “Networking the
Apple IlGs,” on page 271 for startup options.)

By the way, there are some definite advantages to using the HFS file system.

= Naming rules are more flexible; names can be longer and include spaces.

= Volumes can exceed the ProDOS 32 MB limit.

® You can easily move files between vour computer and any Macintosh computer.

# Note 5.235-nch disks cannot be initialized in the HES file format.

[fyou don't need to use disks on both your 11Gs and a Macintosh computer, you can ignore
references to HFS in the sections that follow, For more information about GS/0S and file
system translators, see page 109.

There are two occasions when you'll want to use the Finder to initialize a disk:

= when the disk has never been used before

= when you want to change a disk format from one file system to another ( You can also
do this by erasing a disk. For instructions, see “Erasing a disk,” on page 103.)

You can also use the Advanced Disk Utility (ADU) program to initialize disks, It's more
convenient to use the Finder to initialize disks unless vou're already running the ADU
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program. For instructions on initializing with the Advanced Disk Utility, see “Initializing,” on

page 225.

Initializing for the first time

Follow these steps to use the Finder to initialize a disk in the ProDOS or HFS format for the

first time:

Insert the disk you want to initialize in an empty disk drive. (If the disk is a 5.25-
inch disk, you must also open the 5.25-inch disk drive icon.)

You see the Initialize dialog box.

65705 con’t read this disk (in device APPLEDISK3SB). Do
youwant to initiolize it?

{  Eiect B (Initiolize)

Click Initialize,

Or, if you change vour mind about initializing the disk, click Eject.

When vou click Initialize, you see a dialog box asking you to name your disk.

Type a name for the disk.

For ProDOS, keep the following rules in mind:

= Start the name with a letter.

* Use no more than 15 characters.

= Don't use spaces.

= Don't use characters other than letters, numbers, or periods.
= No two disk icons on the desktop can have the same name.
For HFS, keep these rules in mind:

= Use no more than 27 characters.

= Don't use colons.
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= Nowwo disk icons on the desktop can have the same name.,

® A 5.25-inch disk cannor be initialized in the HFS formar.

4 i necessary, select a file system and a disk format.

The list on the left of the dialog box shows the file systems available on the startup disk.
(Unless you have installed a file system translator for the HFS operating svstem, vou'll see
only ProDOS here. For information about file svstem translators, see page 109.)

The list on the right shows disk formats or disk sizes, depending on the type of disk you're
trving to initialize.

When initializing a 3.5-inch disk in an Apple 3.5 Drive, vou're given a choice of two formats:
800K 2;1 and 800K 4:1. The 2:1 and 4:1 labels refer to the number of rotations used to read
data from the disk.

o [l yvoull be using the disk primarily in an Apple 3.5 Drive, accept the highlighted
option, 800K 2:1,

o fvou'll be using the disk in both Apple 3.5 Drives aned UniDisk 3.5-inch drives, select
the 800K 4:1 option.

» [fvou'll be using the disk primarily in a UniDisk drive, select the 800K 4:1 option.

¢ By the way The easiest way to tell the difference between Apple 3.5 and UniDisk
drives is by the color: UniDisk drives are white, and Apple 3.5 Drives are platinum (the same
color as the computer). Each tvpe of drive is also identified on its underside. &

Ifyou have an Apple SuperDrive connected o an Apple 11 3.5 Controller Card in your Apple
[1GS, you will also be able to format vour disk at 1.4 MB.

When initializing a high-density floppy disk or a hard disk, you have a choice of two formats:
l:1and 2:1. The 1:1 option is more efficient; select the 2:1 option only if you're using an
Apple SuperDrive (connected to an Apple 11 3.5 Controller Card) or an earlier model SCSI
card (such as the Apple 11 SCSI Card). If you're using the Apple I1 High-Speed SCSI Card for
vour hard drive, select 1:1. (If vou're not sure about your card's requirements, check the
manual that came with the card.)
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Click Initialize or press Command-Return.

If vou change your mind about initializing, vou can cancel the operation by pressing the
Escape key (Esc), pressing Command-Period (), or clicking Cancel.

When the initialization is complete, the disk icon appears on the desktop with the name
you provided in step 3.

Reinitializing

Follow these steps to reinitialize a disk that has already been initialized for use with the

ProDOS, HFS, or another file system:

Insert the disk you want to reinitialize in an empty disk drive.

If the disk is a hard disk, a hard disk partition, or a RAM disk, skip this step.

Select the disk icon.

If the disk is a 3.25-inch disk, you must first open the 5.25-inch disk drive icon.

Choose Initialize from the Disk menu.

You see the naming dialog box for previously initialized disks.

Initiolize device APPLEDISKI 5B
os TR |

ProDi§

& This operationwill destroy all of the
information on this dish.

If you want to, type a new name for the disk.

Be sure to follow the naming rules on page 91.
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5 Select a disk format.

The list on the right shows disk formats or disk sizes, depending on the type of disk you're
trying to initialize. Follow the guidelines on page 92.

6 Click Initialize or press Command-Return.

If you change vour mind about initializing the disk, click Cancel.

When the initialization is complete, the disk's name changes 1o the name vou provided in
step 4.

Write-protecting a disk

If vou have disks with contents that vou don’t want to change—for example, the system
disk. the installation disk, the system tools disks, application disks, or data disks with
documents that don't need changes—you can write-protect the disk to prevent anvone
from altering the contents, Figure 4-2 shows how to write-protect 3.5-inch and 5.25-inch
disks.

3.5-inch disks

To write-protect a 3.5-inch disk, slide the write-protect tab to uncover the square opening
in the corner of the disk. If you change your mind about write-protection later, slide the
write-protect tab back to cover the square opening again.

3.25-inch disks

Toy write-protect a 5.25-inch disk, cover the notch on the side of the disk with the special
adhesive label that came with the disk. If vou change your mind about write-protection
later, remove the label from the notch,

If an application disk doesn't have a write-protect notch, the disk has been permanently
write-protected by the manufacturer.
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Locked Unlocked

Figure 4-2 Write-protecting floppy disks

Note that write-protection on 5.25-inch disks is different from that on 3.5-inch disks. On
5.25-inch disks, you cover the notch to write-protect the disk. On 3.5-inch disks you
uncover the hole to write-protect the disk.
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Working with disks and disk icons
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This section describes several tasks you can perform with disks on the desktop.
= opening a disk icon or disk drive icon

® copying a disk

» crasinga disk

= gjecting a disk

Opening a disk icon or disk drive icon

Three techniques allow you to open disk and disk drive icons to see their contents:

= Select the icon and choose Open from the File menu.

= Select the icon and press Command-O (the keyboard shortcut for the Open command).

»  Double-click the icon.

Print
Close
Close 11

VAR YLY
-

Choosing Open Pressing Command-0 Double-clicking floppy and hard disk icons

Figure 4-3 Techniques for opening disk and disk drive icons

You can use the Finder to see the contents of 3.5-inch disks, 5.25-inch disks, hard disks,
RAM disks, hard disk partitions, file server volumes, CD-ROMs, and CD-ROM partitions.
Figure 4-4 shows the icon for each type of disk.
Note that Figure 4-4 shows a 5.25-inch disk drive icon as well as a 5.25-inch disk icon. If you
have a 5.25-inch disk drive, the Finder displays the drive icon even when there’s no disk in
the drive.

To see the contents of a 5.25-inch disk, open the disk drive icon first. Then you see the
disk icon, and you can open it as vou would open anv other icon.
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Floppy disk 5.25inch disk 5.25-disk drive Har disk Hard disk partinon

2 (@

RAM disk File servier valume: CD-ROM CD-ROM partition

Figure 4-4 Types of disk icons

+ Missing icons? It a disk icon (or a 5.25-inch disk drive icon) doesn't appear on the
desktop as expected, see the troubleshooting information on page 317.

Copying a disk

It's important to make a spare copy, called a backup copy, of any disk that contains
information you don't want to lose, Be sure to make backup copies of your application and
data disks.

¢ Can't copy an application disk? Most applications are protected by copyright, soit’s
illegal to copy them (except to make a backup copy for your own use), Some software
manufacturers rely on an honor system, but others copy-protect their disks to prevent
illegal copying and distribution of the application. If you have a copy-protected application,
the manufacturer generally provides one backup copy or offers replacement of damaged
disks free or at a nominal cost. e

The disk vou're making a copy of is called the source disk, and the disk that will
contain the new copy is called the destination disk. Your source disk and your destination
disk don't have to be the same size—but the destination disk must be large enough to
accommodate the contents of the source disk.
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Copying to a disk of the same size

When copving the contents ofa disk to another disk of the same size, the Finder completely
replaces the contents of the destination disk with the complete contents of the source disk
unless you specify otherwise. If vou don't want the complete contents of the destination
disk to be replaced, see “Using special copying options,” on page 101 for alternative
procedures,

Follow these steps to copy the contents of a disk to another disk of the same size:

Insert both the source disk and the destination disk into your disk drives,

Make sure that your source disk is locked so that you will not inadvertently erase your
source material. The icons of both disks must be displaved on the desktop.

1f vou have only one 3.5-inch disk drive, follow these steps:

. Insert the source disk.

P

Eject the source disk manually by pressing the eject button,

Insert the destination disk.

S S ¥

f vou have only one 3.25-inch disk drive, follow these steps:

1. Insert the source disk.

[ S

Open the disk drive icon.

Eject the source disk by opening the disk drive door and removing the disk.

B

Insert the destination disk and close the door of 2 3.25 disk drive.

N

Open the disk drive icon.

Drag the source disk icon on top of the destination disk icon.

=
lode Tl

lﬂ#m

If the destination disk window is displaved, you can also drag the source disk icon into the
destination disk window,
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You see a dialog box asking vou to confirm that you want to replace everything on the
destination disk with what's on the source disk.

Completely reploce the mmeuts of “Proctice Disk® with
the contents of "Wode 0i

A Warning Copyinga disk erases everything on the destination disk and replaces it with the
contents of the source disk. Before you proceed with the copying operation, be sure that
the destination disk doesn't contain any information you need. A

5 Click Replace.
Or, if you change vour mind about copying, click Cancel.
A “thermometer” indicator shows the progress of the copying procedure.

If vou're using only one disk drive for the copying procedure, the Finder displays a dialog
box whenever it's necessary to swap disks. Follow the directions on the screen whenever
you're prompted to insert a disk.

If vou want to cancel the copying procedure while it's in progress, click Stop.

Important Because the Finder erases everything on the destination disk before it begins
copying from the source disk, vou won't be able to rescue the original contents of the
destination disk by clicking Stop. And because the Finder copies information by blocks
(rather than by files), the new information on the destination disk won't be in a usable form
if you click Stop.

Copying to a disk of a larger capacity

When it copies the contents of a disk to a disk of a larger capacity, the Finder normally
places the contents of the source disk in a folder on the destination disk. The folder will
have the same name as the source disk, and the other contents of the destination disk
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remain intact. If you want the complete contents of the destination disk to be replaced or
if you don't want the contents of the source disk to be placed in a folder, see “Using special
copying options,” on page 101 for alternative procedures.

Follow these steps to copy the contents of a disk o a folder on a larger disk:

| Insert both the source disk and the destination disk into your disk drives.

3]

Drag the source disk icon on top of the destination disk icon.

-

ade U5k}

If the destination disk window is displayed, vou can also drag the source disk icon into the
destination disk window.

You see a dialog box asking you to confirm that vou want to place the contents of the source
disk in a folder on the destination disk.

5 Click OK to continue.
Or, if you change your mind about copying, click Stop.

A dialog box appears with a “thermometer” indicator that shows the progress of the
copying procedure. The dialog box also shows how many files and folders remain 1o be
copied.

If a folder with the same name as the source disk already exists on the destination disk, you
see the dialog box shown here. Click the button that corresponds to your preference.

Iy The item "Wode Disk” alreody exists, Reploce this item ond
all remaining duplicates?

+ This Ttem Only - | il Dlnlimu-!_

G| | ) |

- (Retoce) | | Cheploce )
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If a locked folder with the same name as the source disk already exists on the destination
disk, vou see the dialog box shown here. Click the button that corresponds to your
preference.

The ites "Wade Disk® already exists ond is locked (or
contains items that ore locked). Reploce it anwwoy?

) ()

If the destination disk doesn't have enough room for all the files on the source disk, you
see this dialog box.

The disk is full. This operation can't be
eted

compl
Ca)

Using special copying options

When copying disks, the Finder can add the contents of the source disk to the contents of
the destination disk without erasing the existing contents of the destination disk.

If you want the Finder to use such a procedure, follow these steps:

Insert both the source disk and the destination disk into your disk drives.
The icons of both disks must be displayed on the desktop.
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2 Hold down the Option key while you drag the source disk icon on top of the
destination disk icon (or into the destination disk window., if it is open).

You see the Disk Copy Alternatives dialog box,

Disk Copy Rlternatives
@) Put the contents of “Wade Disk™ in o folder on "Proctice. Disk”.

O Replace the contents of "Practice Disk” with the contents of

"Wade Disk”,
O Rdd the contents of “Made Disk™ te the contents of
“Proctice Disk"
[ Concel ) ' 0K '

3 Click the button next to the third option to add the contents of the source disk
to the contents of the destination disk.

If you want the contents of the source disk placed in a folder on the destination disk, select
the first option.

If vou decide to replace the contents of the destination disk with the contents of the source
disk, select the second option.

4 Click OK.

A dialog box appears with a “thermometer” indicator that shows the progress of the
copving procedure.

If there are items on the destination disk with the same names as items being copied, vou
see this dialog box for each such item.

The item "Wode Disk" elready exists. Reploce Lhis item ond
all remaining duplicotes?

¢ This Iten I||l|||--i A1l Duplicates -
G ) o )

Click the button that corresponds to vour preference. Note that the Cancel button cancels
the entire copying procedure.
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If there are locked items on the destination disk with the same name as items being copied,
vou see this dialog box for each such item.

The item “Wade.Disk” already exists and is locked Cor
contoins items that are locked). Replace it anwwaoy?

1f you click Replace, the locked item will be replaced with the item on the source disk that
has the same name. If vou click Skip, that item will not be copied.

Note that the Cancel button cancels the entire copying procedure,

Erasing a disk

If you want to remove all the fles from a disk and you plan to use the disk again with an
Apple LGS, vou should erase the disk.

Important Do not erase vour disk unless vou have backed up all of the data vou want to
keep.

+ About erasing When you erase a disk, an empty directory—or empty file list—is
written to the disk. When you open the disk icon on the desktop, it appears that there are
no longer any files on the disk because it is the directory that lets vou see files on a disk.
The files are still there, but without a directory they're invisible—and inaccessible, unless
you know how to gain access to the data on a disk without a disk directory.

[f you want to completely destroy the data on a disk so that no amount of manipulation
can ever recover it, you should reinitialize the disk (if it's a floppy disk) or zero the disk. For
information on zeroing, see “Zeroing,” on page 230. +

Follow these steps to erase a disk:

1 Select the icon of the disk you want (o erase.
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2 Choose Erase from the Disk menu.

You see the Erase dialog box.

Erase device APPLEDISK3.5E

& This operation will destroy all of the
information on this disk,

)\ If you want to, specify a new name for the disk.

If you want to change the disk’s name as part of the erasing process, type the new name.

1 Select a file system from the box on the left.

Unless you have installed a file system translator for the HFS file system, vou see only
ProDOS here. (For more information about file system translators, see page 109.)

N

Click Erase.
Or, if you change your mind about erasing the disk, click Cancel.

When the erasing is complete, the disk’s name changes to the name you provided in step 3
(if vou changed its name),

Ejecting a disk
There are two occasions when you use the Finder to eject disks:
* when you no longer need to work with the disk

= when you want to work with the disk later in the same work session
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Choosing Eject Pressing the Eject button

Figure 4-5 Ejecting a 3.5-inch disk from a disk drive

Ejecting a disk when you've finished working with it

To eject a disk you no longer want to use in this work session, drag its icon to the Trash.
Dragging a disk icon to the Trash doesn't affect the information you put on the disk.
However, it allows the Finder to write information to the disk, so that—assuming you have
selected the Preferences option for saving Finder information—the next time you insert the
disk, windows and icons will be open and located where they were when you ejected the
disk. For more information about Finder Preferences, see Chapter 3, “Using the System 6
Finder,” on page 41.

If you're ejecting a 5.25-inch disk, you also need to open the disk drive door and remove
the disk.

Ejecting a disk without removing its icon from the desktop

You sometimes may want to have a disk icon on the desktop as part of a procedure you're
following, for example, when you're copying disks using only one disk drive,

There are two ways to eject a 3.5-inch disk without removing its icon from the desktop:

= Select the icon of the disk you want to eject and choose Eject from the Disk menu.
= Press the eject button on the disk drive itself. See Figure 4-5.

Regardless of the method you use, the icon of the 3.5-inch disk remains on the desktop in
dimmed form. If one or more windows for that disk are open, the icons in the windows will
be dimmed.
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Follow these steps to eject a 5.25-inch disk without removing its icon from the desktop:

1 1f necessary, open the 5.25-inch disk drive icon.
The disk icon is then displayed on the desktop.

I

Open the disk drive door and remove the disk.

The icon of the 5.25-inch disk remains on the desktop. Unlike the icon of a 3.5-inch disk
that has been gjected, however, the icon is not dimmed.

Taking care of disks and diagnosing disk problems

This section describes how to store and handle disks to prevent damage and how to find
out whether a disk has been physically damaged.

Handling and storing disks

It's important to take good care of your disks so that you don't damage them (or the data

stored on them). When handling and storing disks, alwavs follow these guidelines:

®  Keepvour disks in a location where the temperature is between 50° F (10° C) and 1257
F (527 C). Be sure to keep your disks away from very hot places (such as the dashboard
of your car on a sunny day).

®  Keep vour disks away from magnets (do not place them on top of a monitor or a
telephone—both of which use magnets).

®  Protect your disks from dust. Store them upright and covered. in a plastic disk holder,
a shoebox, or a similar container.

= Keep your disks dry. Don't water plants nearby or place a beverage within spilling range.

= Don't touch the exposed part of the disk itself. On 3.5-inch disks, the disk is exposed
when you slide open the metal “doorway.” On 5.25-inch disks, there are cutaways on
each side of the disk jacket where the disk is exposed.
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SO°F (10°C)

Figure 4-6 Proper care and handling of disks

= Donuse a pencil or a ballpoint pen to write on a disk label athxed 1o a 5.25-inch disk.
{ The pencil or pen might scratch the disk jacket and damage the disk itself if you press
too hard.) If vou need to write on a label that's already affixed, use a felt-tip pen.

= Don'tuse an eraser or correction Huid on a disk label athxed to a disk. (Eraser “crumbs”
or flakes of correction Huid can easily get inside the disk jacket or casing and damage
the disk.) If possible, remove the label and replace it with a new one; otherwise, attach
anew label on top of the existing one.

= Don't bend, fold, or curl 3.25-inch disks.
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Verifying a disk

If you have problems storing information on a disk or retrieving information from a disk,
there may be physical damage to the disk. You can find out by using the Verify command.

Follow these steps to verify a disk:

1 Select the icon of the disk you want to verify.

| g

Choose Verify from the Disk menu.

A dialog box appears with a “thermometer” indicator that shows the progress of the
verifying procedure. The dialog box also shows how many blocks remain to be verified, (A
block is a unit of measure used to specify the size of disks and files.)

When the verifying process is complete, you see another dialog box indicating whether
there were any bad blocks on the disk.

3 If there were no bad blocks, click OK to return to the desktop.

+.hx

If there were bad blocks, either click OK (to see which blocks are affected) or
Cancel (if you don’t care which blocks are affected).

Ifa disk has bad blocks, copy any files you can to a good disk and then discard the disk with
bad blocks. (Try the Validate command to find out which files are affected by the bad blocks,
For instructions, see “Validating files,” on page 132.) If the disk with bad blocks is a hard
disk or a hard disk partition, see your manual for that disk drive or your authorized service
provider:
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Using file formats and translators

GS/0S can recognize ProDOS disks and disks initialized for some other file systems. If you
want 1o use disks initialized for other file systems, modules called file systems translators
(FSTs) make it possible. Use the Installer to add FSTs to your system software (see
Chapter 2, “Using the Installer,” on page 19, for instructions).

FSTs provide a broad range of compatibility with your Apple 11Gs; they allow you to use
file systems from earlier models of the Apple 1T computer, from the Macintosh file system,
or from networking and CD-ROM environments, It's important to remember, however, that
FSTs transfer data; they don't translate applications. For example, with the HFS FST
installed, you can insert a Macintosh disk, then read and work with the data it contains. You
cannot, however, work with a Macintosh application; yvou work with your data by using one
of the GS/0S applications you use with your Apple 1IGs computer.

Although you can use your HFS disks in a ProDOS environment, you probably won't be
using ProDOS disks on the Macintosh unless you have a Macintosh LC with an Apple Ile
Card installed. (o learn about other options for using ProDOS disks in the Macintosh
environment, see the Macintosh User's Guide. ) Similarly, if you're working with the HFS file
system so that vou can also use your data on a Macintosh computer, you can't give an HFS
disk ro a friend who uses an Apple Ile computer (which uses the ProDOS 8 system).

FSTs belong to one of two categories: Read/write FSTs and read-only FSTs. A read/write FST
allows the computer to read information from a disk and also to write information to the
dlisk. That is, you can make changes to the disk such as creating, deleting, and renaming
files. At present, three read/write file systems are available under GS/0S:

= ProDOS, used by most Apple I applications

= HFS, used by Macintosh computers

= AppleShare, used by AppleShare file servers (a networking FST)

A read-only FST allows you only to read a file from disk. You can then either copy it to a read-
write file system, or use another application to read it and—if you modify it—write it to a
read-write file system. You cannot write information from the computer to the disk in these
file systems. Three read-only FSTS are available:

* Pascal, used on early Apple Il computers

= DOS 3.3, also used on early Apple Il computers

= High Sierra/ 1SO 9660, used on CD-ROM drives
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GS/05 is designed to support other file systems as the appropriate FSTs become available.

Using memory as a RAM disk

This section explains how 1o use part of your computer’s memory as a RAM disk. There are
two ways of making RAM disks:

+  Using system memory from your computer.

+  Using an expansion card that you can install in one of your computer’s slots. An example
of such a disk is the Apple Lle Memory Expansion Card.

In most ways, a RAM disk is like other disks, but some important differences are explained
here.

Understanding RAM disks

When you designate a portion of the computer’s memory as a RAM disk, the computer
treats that memory as if it were a physical disk. The advantage of using a RAM disk is that
the computer can get information from it much faster than from a disk in a disk drive.

Disadvantages include the fact that anything stored on the RAM disk is lost when vou
switch off the computer’s power. That is, the RAM disk can only be used for the current
work session, Also, your application does not have access to the memory currently assigned
to RAM disk.

Many applications require a great deal of RAM, some need as much as a megabvte
(1024K). Before you designate any memory as a RAM disk, refer to the manuals that came
with your applications to learn how much memory thev require. When setting RAM disk
size (as explained in the next section), be sure to leave enough memory available for vour
application,

If an application needs more memory than your RAM disk setting has left available, you
see a message to that effect. If something vou try to store on the RAM disk needs more
memory than you've assigned to the RAM disk, you see a message to that effect. In either
case, you may want to resize the RAM disk for future work sessions. (Changes 1o RAM disk
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size don't take effect until you shut down and switch off the computer, and then start up
again.)

#® Note RAM disks are initialized. by default, as ProDOS volumes. You can, if vou want,
reformat the RAM disk as a HFS volume. See “Initializing a disk,” on page 90.

Warning Anvthing you store on the RAM disk will be lost when you switch off the
computer’s power. Make sure you save a copy of all documents on a floppy disk or a hard
disk before you resize the RAM disk or before you switch off the computer. A

Setting RAM disk size

Before you can use any of the computer's memory as a RAM disk, you must use the RAM
Control Panel to specify how much memory vou want to set aside. Follow these steps:

Choose Control Panels from the Apple menu to get to the desktop Control Panels.

FO==lontrol Panels ==

Ahbaut the Finder

Help 47 -|:|
] -

Printer Part

T

You can also use the text Control Panel. For instructions, see the manual that came with
your computer.
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L Select the RAM icon in the Control Panels.

You may have to scroll through the Control Panels to find the RAM disk icon.

Sl F——
i

AW Disk:  RAM Coche:

&)
stk B ok (I
£a [ O]

Memory in use: 1614K
Availoble memory: 561K
Hax block size: GBIk
[CIResize after reset

3) Set the RAM disk size.

Drag the scroll box in the RAM Disk scroll bar to the location vou want. (Clicking the scroll
arrows or the gray areas above and below the scroll box will also change the setting, )

You can change the size of the RAM disk in increments of 32K.

A

Close the RAM Control Panel window by clicking its close box, and then close the
Control Panels window.

Quit any application you're using.

Shut down and switch off the computer.

If vou're in the Finder, you can use the Shut Down command in the Special menu. For
instructions on using this command see, “Shutting down the computer,” on page 149.

If you're in the System 6 Program Launcher; click Cancel and choose Shut Down from the
File menu.

If neither of these options are available, simply turn off your computer.

[/ Start up your computer in the usual way.

When vou start up, the new RAM disk size will be in effect. You can select your RAM disk
icon and choose Get Icon Info from the Special menu to check the size of your RAM disk.
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Specifying the location of the RAM disk

ProDOS § applications will ask for the location of vour RAM disk by slot and drive number.
Ifyou don't use ProDOS 8 applications, vou can probably skip this section,

The RAM disk always appears to be in slot 3, just as a 3.5-inch drive connected to the disk

drive port does. The following rules explain how to determine the drive number of your

RAM disk.

= Your first 3.3-inch disk drive is drive 1.

= The RAM disk takes precedence over all but the first 3.5-inch disk drive. (However,
should the RAM disk be used for startup, the RAM disk is drive 1.)

= [Fyou have a total of three “slot 5" devices, slot 2 acts as an overflow slot (unless it
contains an active disk card), so that the third device appears to be in slot 2, drive 1.
For example, if vou have two 3.3-inch disk drives and a RAM disk, vour first 3.3-inch
drive is drive 1, the RAM disk is drive 2, and your second 3.5-inch drive is slot 2, drive 1.

= Ifyourapplication doesn't recognize vour disk drive, contact the application publisher
to find out whether a more recent version is available,

Using the RAM disk

You use the RAM disk in much the same way you use any other disk, You can copy
applications and documents to it and run applications from it.

This section describes the special steps you need to follow when using a RAM disk and
the ways in which a RAM disk functions differently from other disks. All the instructions in
this section assume that you've already set up a RAM disk, as explained in “Setting RAM disk
size,” on page 111,

¢ By the way Some applications include copy protection schemes that require you to
insert your master copy of the program before you can copy to the RAM disk.

Running an application from the RAM disk

Running an application from the RAM disk allows the application to run faster and reduces
the number of times you need to swap disks during saving or copying operations.
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Follow these steps to run an application from the RAM disk:

1 Copy an application (and its startup files) to the RAM disk.

Drag all the icons (except document icons) from the application disk onto the icon (or into
the window) of the RAM disk.

ERe——— ¢
ProllS _ Gitems  77used  20kiree| (D

mr‘zw-@
& €& & =

-
Rrehiver [Teach Shortouts  [LV] -
=l W= [2) asystentools?

If you copy more than one application’s files to the RAM disk, you might want to put the
files for all but one application in separate folders. (This avoids the problem of duplicate
file names in the main directory of the RAM disk.)

I~

If necessary, open the RAM disk icon.

R

Open the application icon.

The application starts up in the usual manner.

Storing documents on the RAM disk

You can store documents on your RAM disk the same way you save them on a regular disk.
Just remember that the RAM disk is only a temporary storage media.

A Warning Save any documents on the RAM disk on to a 3.5-inch disk, a 5.25-inch disk, or
a hard disk before you switch off the computer’s power, or vour documents will be lost. &
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= [fyourapplication presents a directory dialog box when you give a save command, click
the Volumes burton, select the RAM disk from the list of volumes, give the document a
name (or accept the existing name), and save the document.

= Ifyour application asks for the slot and drive number, refer to the guidelines in
“Specifying the location of the RAM disk,” on page 113 earlier in this chapter.

= [Fthe application asks for a pathname, type a slash, the name of your RAM disk,
another slash, and the name of the document, for example, /NAME/DOC. (If you didn't
rename the RAM disk, its name is RAM3.) If you want to save the document in a folder
on the RAM disk, add the folder name to the pathname, thus:

/RAM.DISK.NAME/FOLDER.NAME/DOCUMENT.NAME

This chapter has provided basic information about disks. When you're ready to learn more
about disks, turn to Chapter 8, “Using the Archiver,” on page 199, and Chapter 9, “Using
the Advanced Disk Utility,” on page 223. Chapter 8 teaches you how to make backup copies
of your files, and then restore them from the backups. Chapter 9 explains how to perform
various operations on disks (especially hard disks).
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5 Working With Files and Folders

If you're not vet familiar with using files and folders in the Finder to organize information
on disks, this chapter explains the skills vou'll use. It's also a handy reference about how to

perform any file and folder management task.

This chapter contains information on these topics:
* opening and closing folders
* creating new folders

= moving and copving files and folders

discarding hiles and folders

* protecting hles and folders



Opening and closing folders

Files are collections of information stored on disks. They can be documents that vou create
with applications. They can also be applications, or even system software,

Each file has a name, and you can organize your files into accessible groups of
information by collecting them into folders.

Putting files in desktop folders is like putting paper documents in file folders: it focuses
your attention on a subset of related information so that vou don't have 1o search through
everything on a disk to find the documents you need. Figure 5-1 shows a representative
sample file hierarchy.

In some Apple IGs applications, vou may encounter the term subdirectory, A
subdirectory is the same as a folder,
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Figure 5-1 Three levels of folders and documents on a floppy disk
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Opening a folder icon

Folder icons can be opened to see what's inside.

There are three techniques you can use to open an icon:

«  Select the folder icon and choose Open from the File menu.

s Select the folder icon and press Command-O (the kevboard shortcut for the Open
command).

= Double-click the folder icon.

Fram
Close
Close A1l

2
<

Choose Open Press Command-0 Double-click icon

Figure 5-2 Three technigues for opening an icon

Regardless of the technique you use, a window with the same name as the folder icon
appears on the desktop. Inside the folder window, you see either icons with names under
them or a list of names representing all the items in the folder.

Closing a folder window

When you no longer want to see what's in a folder, vou can close the folder window using
one of the following techniques (see Figure 5-3). These techniques assume that the window
vou want to close is the active window.

»  Click the window's close box,
= (Choose Close from the File menu.

= Press Command-W (the kevboard shorteut for the Close command).

# Note [fyou want to close an inactive folder window without selecting it, press the
Option key while you choose the title of the open window from the Windows menu. +
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Figure 5-3 Three techniques for closing a folder window

Regardless of the technique you use to close the folder, the window collapses back into its
icon.

Opening a folder by tunneling

Tunneling is a shortcur that lets vou work faster on the desktop. Basically, it allows vou to
do two tasks at one time: You close the active folder’s window at the same time vou open
another folder

To open a folder by tunneling, press the Option key and hold it down while vou double-
click the folder you want to open. The active window closes, and the window for the
selected folder opens.

Creating a new folder

Follow these steps to create a new folder:

1 Open the disk icon and any folders necessary to display the window in which you
want to create the new folder.

When the window you want is the active window, you're ready to create the folder.
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Choose New Folder from the File menu (or press Command-N:)

A folder called Untitled appears in the active window. ( You may need to scroll or enlarge
the window to see it.)

g Fractice Jisk S=S—=p|
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Duplicote. 50
Pt = =
Validate

¢ By the way If there was already a folder called Untitled in the window, the new folder
will be called Untitled A. This process continues until the Finder reaches Untitled Z If all
possible names through Untitled.Z are taken, vou can't create any more new folders in the
window without first renaming one of the untitled folders. o

Type a new name or edit the name Untitled.

Be sure to follow the naming rules on page 91.

¢ Network users [f vour Apple I1Gs is part of a network that includes one or more
AppleShare file servers, follow the ProDOS naming rules for items vou store on a file server
to retain the ability to copy the file back to your Apple 116s without changing the name of
the file. »

Press Return to confirm the name.
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Moving and copying files and folders

2

You can move a file or a folder to another location on the same disk, or 1o a different disk.
When vou move a file or folder to another disk, the file or folder will actually be copied.
Throughout this section, you see the terms source disk, source folder. destination disk,
and destination folder. The source disk or folder contains the item(s) you're copying. The
destination disk or folder will contain the item(s) after vou move or copy it (them).

Moving files and folders to another location on the same disk

Follow these steps to move one or more items to another location on the same disk:

Open the disk and any folders necessary to see the items vou want to move.

Make sure the destination folder or window is visible.

If you're moving more than one item, hold down the Shift key while you click
cach item you want to move.

All items to be moved must be in the same window. If you want to move items from
different windows, you must repeat the procedure for each window,

Drag the selected items to the destination folder icon or into the disk window.

When the destination folder icon becomes highlighted, or when the pointer is within the
window, release the mouse button. The highlighting tells vou that the items you're moving
will be placed inside the folder.

L M
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If the destination folder already contains items with the same name as items you're moving,
you see this dialog box.

The item “Juliona Report” already exists. Reploce

this itea?

If the destination folder already contains locked items with the same name as items you're
moving, vou see this dialog box,

—
-—

The item “Juligna Report™ olredy exists and is locked Cor
contains items thot ore locked). Reploce it onywoy?

(@=D

Click the button that corresponds to your preference. Note that the Cancel button cancels
the entire moving procedure.

Placing duplicate copies of files and folders in the same window

Making duplicate copies of items can be useful in two ways: making backup copies of files
and folders, and creating a hle that you can revise without changing the original.

Follow these steps to place duplicate copies of files or folders in the same window:

Open the disk icon and any folders necessary to see the items you want to
duplicate,

Select the item(s) you want to duplicate.

All the items you duplicate must be in the same window. If you want to duplicate items in
more than one window, you must repeat the procedure for each window.
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j Choose Duplicate from the File menu. (Or press Command-D, the keyboard
shortcut for the Duplicate command.)

You see the Duplicate dialog box.

ew Folder AN Duplicating the (Lem "Renee Story®.

Upen a0

tlose o] New nome: |
" G Cx )

41 you like, type a new name or edit the name that's there.

Be sure to follow the naming rules on page 91.

S

Click OK or press Return.

If vou selected only one item in step 2, the Duplicate dialog box disappears and a few
moments later vou see both the original and the duplicate copy in the window. The
duplicate copy appears diagonally below and to the right of the original, You can skip step 6.

If vou selected more than one ftem in step 2, the Duplicate dialog box disappears and a few
moments later reappears for the next selected item. Go on to step 6.

6 Repeat steps 4 and 5 each time the Duplicate dialog box appears.

If you change your mind about duplicating one of the selected items, click Skip instead of
OK when the Duplicate dialog box for that item appears. If you change your mind about
duplicating all the selected items, click Cancel.

When the Duplicate dialog box disappears after the last duplication, you see the duplicate
Copies.
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Placing copies of files and folders on a different disk

When vou copy items onto another disk, you can place the copies either in the disk
directory or in a folder on the disk. Follow these steps:

If you're copying the items into a folder. make sure the destination folder icon
or window is visible.

If your destination disk is a floppy disk, you must first insert it in any empty drive, Ifitis a
5.25-inch disk, open the disk drive icon.

Open the source disk icon and any folders necessary to see the items to be
copied.

If the source disk is a floppy disk, you must first insert it. If it is a 5.25-inch disk, open the
disk drive icon.

If you have only one disk drive of the appropriate size, you must eject the destination disk
manually—by pressing the eject button (for 3.5-inch drives) or by opening the disk drive
door and removing the disk (for 5.25-inch drives)—before inserting the source disk.

Warning Do not open the door of a 5.25-inch drive if the red “in-use” light on the drive
is illuminated; you may damage your disk. A

If you're copying more than one item, hold down the Shift key while you click
each item you want to copy.

All items to be copied must be in the same window. If you want to copy items from different
windows, you must repeat this procedure for each individual window.
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‘4 Drag the items you want to copy onto the icon (or into the window) of the
destination folder or disk.

When the destination folder or disk icon becomes highlighted, release the mouse button.
The highlighting tells vou that the copies will be placed inside the folder or disk.

Jitemy use ki d
Soroh Folder Gregoryfolder Huun.;nidn Wade Disk
Hatt History [ITITRITE EM‘H
0]
&l &

If you're using only one disk drive for the copying procedure, the Finder displays a dialog
hox whenever it's necessary to swap disks. Follow the directions on the screen whenever
vou're prompted to insert a disk.

If the destination folder or disk already contains items with the same name as items you're
copying, you see this dialog box,

The item "ReneeStory™ alreody exists. Replace this

item?

If the destination folder or disk already contains locked items with the same name as items
vou're copying into that folder or disk, vou see this dialog box.

The ivem "Renee.Story” already exists ond is locked (or
contains items that ore locked) Replace it anuwou?

D @)

Click the button that corresponds to your preference. Note that the Cancel button cancels
the entire copying procedure
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Using special moving options

When moving items, the Finder normally displays the dialog boxes shown in the previous

steps the first time it encounters an item in the destination folder that has the same name

as an item vou're moving. If you want to, you can give the Finder instructions for handling

files and folders with duplicate names before you begin the moving procedure. You can

select from the following options:

= The Finder can prompt vou each time it encounters a duplicate name.

= The Finder can keep you from replacing duplicate items.

* The Finder can replace all items with duplicate names. (This is what the Finder does
unless vou specify otherwise.)

* The Finder can allow you to cancel a moving procedure.

To select the copying option you want to use, follow these steps:

1 Hold down the Option key while you drag the items you want to move on top of
the icon (or into the window) of the destination folder or disk, and release the
mouse button.

You'll see the File Copy Alternatives dialog box.

File Copy Rlternatives

(__ Replace items cose by case )

(___ Skipall duplicateitems )

' Reploce all duplicate items '

2 Choose an option and click OK.

If you change your mind, click Cancel,
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Discarding files and folders

I~

The Finder lets you discard a file or folder whenever its icon is visible on the desktop. To
discard a file or folder you simply drag it to the Trash icon.

Discarding files and folders into the Trash

Follow these steps to discard items into the Trash:
If necessary, open the folder or disk that contains the items you want to discard.

If you want to discard more than one item, select all the items to be discarded.

All items to be discarded must be in the same window. If you want to discard items from
different windows, repeat this procedure for each window.

Drag the items you want to discard on top of the Trash icon or into the Trash
window.

When the Trash icon becomes highlighted, release the mouse button. The highlighting tells
you that the items you're discarding will be placed in the Trash.

When vou've dragged the items to the Trash, the Trash icon has bulging sides, indicating
that there’s something in the Trash,

fe———n————F
ProQ05 3 items 15K used J26K free|

Sorah.Folder GregoryFolder WegonFolder

& R

If you attempt to discard a locked file or folder, you are warned that the file or folder is
locked before vou're permitted to discard the item. See “Locking a file or folder,” on
page 131.
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Recovering files and folders from the Trash

When you discard an item into the Trash, it stays there until;

* you choose the Empty Trash command from the Special menu
* the Finder automatically empties the Trash

As long as an item is still in the Trash, you can recover it,

The Finder may empty the Trash if you do any of the following:

» throw away something else

= ppen an application

= copy files

= eject a disk (by dragging the disk icon to the Trash)

* shut down or restart the computer

Warning Even if vou don't do any of the above tasks, the Finder will empty the Trash when
it needs the disk space allocated to items in the Trash. You see no warning; items in the
Trash are considered ready to be discarded. If vou change your mind after dragging a file or
folder to the Trash, recover the item immediately. a

Follow these steps to recover items from the Trash:
Open the Trash icon.
If necessary, scroll until you can see the items you want to recover.

Select all the items you want to recover.
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4 Choose Put Away from the File menu.

- The icons return to their original locations.
ow Falder :

Open a0
Print

close o] If you prefer, vou can drag the icons to different locations instead of
CloseAll ;
using the Put Away command.

Duplicate..

Put Fwoy i

Emptying the Trash

As long as an item remains in the Trash, the disk space that the item occupies remains
unavailable. If you want to free up that disk space, you can empty the Trash. Once you do
50, the items that were in the Trash are removed permanently.

To empty the Trash, select the Empty Trash command from the Special
menu (or press Command-T, the keyboard shortcut). The Trash icon no
longer has bulging sides, indicating that it is now empty.

Empry Trash , &

Preferences ”

Protecting files and folders and diagnosing problems

This section describes how to lock files and folders to prevent removing, renaming, or
replacing them; how to unlock files and folders; and how to find out whether files are
damaged.

Although you cannot rename, replace, or remove a locked file or folder, you can move
it to another location, You can also put files inside a locked folder.

If you have a hard disk that is partitioned, vou can lock the individual partitions; if your
hard disk is not partitioned, however, you cannot lock the disk itself. Note that locking disks
(also called write-protecting disks) is not the same as locking files and folders. For
information about write-protecting disks, see page 94.

130 Chapter 5 Working With Files and Folders



| R

Locking a file or folder

Locking a file or folder ensures that you won't accidentally remove, replace, or rename it. If
you drag a locked file into the Trash, or try to replace it during a copying or moving
operation, the Finder displays a dialog box asking you to confirm your decision.

The Finder will not permit vou to change the name of a locked icon.

Follow these steps to lock a hle or folder:

Select the file or folder you want to lock.

Note that the HFS file system allows you to lock files, but not folders.

Choose Icon Info from the Special menu (or press Command-1, the keyboard
shortcut).

You see the General card for the icon.

Click the Locked checkbox.
[E0===== Info on "Negun.Folder”
D Wegan.Folder Locked [

Kind: Folder
Size: use caloulote icon..

Contents: use colculote 1con..
Created: Tue, Jan 21,1902, 411 PH
Wodified: Thu, Jan 23, 1992, 7:35PH

| _General [ Where |

An X appears in the checkbox, indicating that the file or folder is now locked. Another way
to check the box is to press the L key. If you press it again, the X disappears.

4 Close the Icon Info window.
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Unlocking a file or folder

Follow these steps to unlock a locked file or folder:
Select the icon of the file or folder you want to unlock.
Choose Icon Info from the Special menu.

Click the Locked checkbox to remove the X.

Or press the L key for the same effect.

Close the Icon Info window.

Validlating files
If you're having trouble opening a file, or if a file’s information is difficult to read, you may

want to use the Validate command to check for other bad files on the disk.

Follow these steps to validate files:

Select the items you want to validate.

You can select fle icons, folder icons, disk icons, or any combination, When you select a
folder or disk icon, the Finder will validate all the files in that folder or on thar disk.

Choose Validate from the File menu.

A dialog box appears with a “thermometer” indicator that shows the
i progress of the validating procedure. The dialog box also shows how
bl many files remain to be validated, (If you want to cancel the validation
process, click Cancel,)

Close
Close ALL

Duplicate.
Pl oy
Volidate

When the validation is complete. vou see another dialog box indicating
whether there were anv bad files on the disk.

If there were no bad files, click OK.
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4 If there were bad files, click either OK (to see a list of the files) or Cancel (if you
don’t want to see a list).

Move any good files to another disk, and then throw away the floppy disk with the bad files.
If vou validated a hard disk, see the manual that came with your hard disk.

# Note The Validate command makes a limited check of the files. If you are having
trouble with a disk, and Validate indicates the files are OK, vou should use the Verify
command to check the disk blocks, For information about the Verify command, see
“*Verifying a disk,” on page 108,
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6 Working With Applications

Applications are programs that perform a specific function, such as word processing,

database management, graphics, or telecommunication, Documents are the products of

the work you do with applications on vour Apple 11Gs computer. This chapter includes a
short hands-on tutorial using Teach, a word-processing application that comes on the

Svstem 6 SystemTools2 disk

Not all applications work in exactly the way described in this chapter, so be sure to read the

manual that came with each program for specific instructions

This chapter contains information on these topics:
= starting up an application

= switching applications

®  saving documents

= printing documents

= ending a work session

= using Teach to practice application tasks



Starting up an application

This section explains how to start up applications and how to switch from one application
to another. You can perform each of these tasks whether or not you're using the Finder.

Later in this chapter, you have the opportunity to practice these tasks by using an actual
application. Or you can turn now to the hands-on exercise, “Using Teach to practice
application tasks,” on page 150, and come back to the rest of this chapter for reference as
you need it.

When you're using the Finder

The Finder lets you start up applications quickly and easily without having to restart the
computer (which takes more time).

The easiest way to start up an application is from the Finder. If your application disk
doesn't include the Finder, vou may prefer to launch the program directly from its startup
disk rather than using a Finder-based startup disk.

There are two ways to start up an application from the Finder:

*  Open the application icon,

_ When you open an application icon (the Teach icon in this example), the
Finder starts up the program.

After a few moments, you see the opening screen of your application. Some
applications present a new, untitled document as the opening screen. Others present a
title screen. Still others present a blank desktop.
Refer to the manual that came with your application for instructions on using the
program.

*  Open the icon of a document created with the application.

. When you open a document icon, the Finder tries to start up the
e application used to create the document. If the Finder is successful, the
program will start up in a few moments, and you'll see the document you
opened.
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You won't always be able to start up an application from a document icon. If the disk
containing the application used to create the document is not in one of vour disk drives, or
ifit's ina 5.25-inch disk drive whose icon has not been opened, vou see one of the following
dialog boxes. You also see one of these dialog boxes if the application has been renamed or
moved to a different disk or folder and the Finder has been unable to locate it.

The opplicotion “Teach” con't be found for this
document.

(Try Agoin i| Locots... ]

fin applicotion can't be found for this

document.

If the application won't open, trv one of the following solutions:

*  Make sure that the disk containing the application is in one of your disk drives. Then
click Try Again.

= [fthe program is in a 5.25-inch disk drive, click Cancel. Make sure that the disk drive
door is closed and that you have opened the disk drive icon to display the disk icon on
the desktop. Then try opening the document again.

* Ifyou don't have the necessary application available, click Cancel,

& Note Some applications do not support starting up by double-clicking a document. If
none of the procedures here work, check the documentation that came with the
application. e

If the Finder is unable to associate the document with the application used to create it, you
see this message:

o The ooplicotion *Teach® con't be found for this
document.

(radgoin) (Locare )
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If vou see this message, follow either of the following sets of steps:

1 click Locate.
The Volumes dialog box appears.

2 Click Volumes,

The available volumes are displayed.

3 Select the volume where the application is located.

N =

Select the application and click OK.
The next time you try to open the document in the Finder, vou should be successful. If not,
continue to start up the application by opening its icon rather than by opening a document.
For a second method, follow these steps:

| clickok.

2 Start up the application by opening its icon.

3 Open the document from within the application.

The next time you try to open the document in the Finder, vou should be successful. If not,
continue to start up the application by opening its icon rather than by opening a document.

When you're not using the Finder

If you are working with a System 6 startup disk that doesn't include the Finder, vou start up
to the System 6 Program Launcher, built into your system software.

Follow these steps to start an application from the Program Launcher:

1 Click Volumes to see all volumes you have on line.

Make sure you've inserted the disk that contains your application.
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2 Open the volume where the application is located.

You can double-click the volume name or click it once and then click Open.

3 Open the application.

Double-click the application name or click it once and then click Open.

Important Many application disks, particularly those with older applications, don't
include the Finder or System 6. Such a disk is still a startup disk, however, and you can start
the program directly from the disk. With your computer switched off, insert the application
disk in your startup drive, and then switch on the computer. For information on how to
proceed from this point, see the manual that came with your application.

Switching applications

Switching applications is particularly easy when you're using the Finder. But you can also
switch from one program to another when you're not using the Finder.

Switching applications when vou're using the Finder

Follow these steps to switch from one application to another when you're using the Finder:

1 save any documents you've been working with.

For information on saving, see “Saving documents,” on page 142 in this chapter, or refer to
the manual that came with your application.
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Quit the application.

o 5 Choose the Quit command from the File menu. You return to the Finder

Eﬂ_l ' desktop. (You may be prompted to insert the system disk or the
e

S 48 application disk before you return to the Finder.)

Save 0s...
Sove Copy 04
Close £l |

(3

e s

o
W

3 Eject the current application disk.

To eject a 3.5-inch disk, drag its icon to the Trash. To eject a 5.25-nch disk, drag its icon o
the Trash, then open the disk drive door and remove the disk.

a-'-w

Insert the new application disk.

# Unexpected message? You may see a message saving that GS/0S recognizes the file
system on the disk as one for which you have not installed the file system translator (FST).
Ifyou see such a message, your application probably uses the Pascal or Apple 11 DOS 3.3 file
system—two older operating systems for which GS/0S has file system translators. Or you
may have inserted an HFS disk (a disk initialized for the Macintosh operating system), for
which GS/0S also has a file system translator. To work with data from HFS files by using a
ProDOS application, you can install the required translator on your startup disk. Use the
appropriate customized installation update of the Installer. (You cannot, however, use
Macintosh applications on the Apple 11Gs.)

For information about installing FST updares, see Chapter 2, “Using the Installer.”
starting on page 19. For more information about FSTs, see “Using file formats and
transkators,” on page 109. o

S

Open the disk and any necessary folders until the window containing the
application icon is displayed.

See the manual that came with the application to identify the application icon,
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Open the new application.

In a few moments vou see the opening screen of the application.

Switching applications when you're not using the Finder

If you are working with a System 6 startup disk that doesn't include the Finder, you switch
applications by using the System 6 Program Launcher, built into your system software.

Follow these steps to switch applications from the Program Launcher:

Save any documents you've been working with.

For information on saving, see “Saving documents,” on page 142 in this chapter, or refer to
the manual that came with your application.

Quit the application.
For the appropriate command, refer to the manual that came with vour application.

When the application quits, you see the System 6 Program Launcher.

Click Volumes to see all volumes you have on line.

Make sure you've inserted the disk that contains the application you want to use.

Open the volume where the application is located.

You can double-click the volume name or click it once and then click Open.

Open the new application.

Double-click the application name or click it once and then click Open.

Important Many application disks, particularly those with older applications, don't
include the Finder or System 6. Such a disk is still a startup disk, however, and you can start
the program directly from the disk. To switch applications, eject the startup disk after saving
any documents vou've been working with. Then insert the next application disk in the
startup drive, and press Command-Control-Reset to restart the computer (see Figure 6-1).
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Figure 6-1 Restarting the computer by pressing Command-Control-Reset

That is, hold down Command (the key marked with both the outline of an apple and this
symbol: 38) and Control, then press and then release Reset (the key marked with a triangle
A); when you hear a beep, release Command and Control, (Be sure to hold down the
Command and Control kevs until vou hear the beep. Otherwise, the procedure won't
work.)

In a few moments you see the opening screen for vourapplication. For information on how
10 proceed from here, see the manual that came with your application.

Saving documents

While you're working with a document, the information you enter is stored in the
computer's RAM. But because RAM is temporary memory, you could lose that information,
for example, if there's a power failure or if you accidentally pull the power cord out of the
outlet. That's why it's important to save your work at regular intervals.
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You save your work on a disk. It can be a 3.5-inch disk, a 5.25-inch disk, a hard disk, a
hard disk partition, or a file server volume. If there’s room on your application disk, you
may want to save documents there. Or you might prefer to keep documents on separate
disks, called data disks.

To save a document on a disk, you choose the Save command from the appropriate menu
in vour application. When vou do so, the program asks vou where vou want to save the
document. There are three ways that a program is likely to ask for this information:

= [f the application uses the desktop interface. it will probably present a directory dialog
box, which lets vou move about in the different levels of folders on your disk to specify
the desired location.

» [fthe application is text-based. it may ask you to specify a slot and drive number, or it
may ask you to specify a pathname—that is, a series of names listing the path the
computer must follow to reach the desired location.

When you save a document, you can give it any name vou like, provided there isn't
already a document by that name on the same disk or in the same folder, and provided the
name conforms to the ProDOS, HFS, or application’s rules for naming documents. You
should be able to find the rules for your program in the manual that came with it.

Ifyou don't know the ProDOS, HFS, or application’s rules for naming documents, follow
the naming rules on page 91.

Saving by using a directory dialog box

In most graphics-based applications, vou're presented with a directory dialog box when you
give a Save or Save As command. Directory dialog boxes generally have four main features:
= anicon and pathname indicating the currently selected disk or folder

= alist showing the directory of the currently selected disk or folder

= 2 box where you type the name of the document to be saved

= aset of buttons that let you give commands to the computer

Follow these general steps to save a document using a directory dialog box. Different
applications implement the features of the directory dialog box in different ways. If these
steps don't correspond to what you see on the screen, refer to the manual that came with
vour application.
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1 Choose Save As from the File menu.

The directory dialog box appears.

=& systemTools? (ProD0S)

19 free of 800K, (Volmes )

A .' Bl MM (e Folder )
Save the file oz € Gowe )
| Cae

The first time vou save a document, you also have the option to use the Save comman. In
gither case, vou will be able to name your document, (When you make further changes to
a named document, vou use the Save command; you use the Save As command only if you
want to rename or relocate your document. )

|

Click the Volumes button to see a list of all the available volumes.

The list shows you all the disks you have available.

3 Select the disk on which you want to save your document, and click Open.

You see a list of the available folders on the selected volume,

4 uf necessary, open the folder where you want to save the document. (If the folder
is nested inside other folders, you have to open all the necessary folders.)

To open a folder, click its name or icon in the directory window and then click the Open
button. Or just double-click the name or icon.

# Network users If your Apple 11Gs is part of a network that includes an AppleShare file
server, you can't use this dialog box to save a document in someone else's drop folder.
Instead, you must save and close the document and use the Finder to drag the document’s
icon into the drop folder icon, For more information on drop folders, see “Using folders on
a file server volume,” on page 289 in Chapter 12. »
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'3 Give the document a name,

The name of the document may already be highlighted (“Untitled” for a new document), If
it is, and if this is the first time you're saving the document—or if you want to save an
existing document with a new name—type the new name in the box provided. If the text
box is not already highlighted, vou must click the text box to position the insertion point
hefore you start to type. Follow the naming conventions on page 91 for the appropriate file
format, If you are making changes to an existing document, you won't have to retype it
unless you want to change the name.

6 Click the Save button.

Your document is saved on the disk.

Saving by using a pathname

Some text-based applications let you save documents in folders. To do so, you supply a
pathname, which begins with the name of the disk on which the file is stored. followed by
the names of any folders in which the file is nested, and ends with the name of the file itself

GS/0S allows you to use pathnames beginning with a slash (/) or a colon (:) separator.
If you're using a ProDOS 8 application, however, you must use a slash.

Important The separator character you use to begin a pathname must be the same as the
character vou use to separate the parts of that pathname. For example, if you use a colon at
the beginning of a pathname, you must use colons to separate all parts of the pathname.

The pathname /Personnel/Sales/Sanchez/Status Report, for example, corresponds to a
document called Status Report in a folder called Sanchez, which is stored in a folder called
Sales on the disk called Personnel.

If you don't use folders, the pathname for a document is formed from the disk name
and the document name, For example, the pathname for a document called Fujiko. 10.28.91
on a disk called Letters would be /Letters/Fujiko.10.28.91,

To cut down on vour typing time—and on the opportunities for typing errors—many
applications let you specify a prefix. As the name suggests, a prefix is the first part of a
pathname. The prefix can be just the disk name, or it can include one or more folder names
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as well. The manual that came with vour application will tell vou whether you can use
prefixes and how to set a prefix,

Saving by using slot and drive number

If an application asks for a slot number and a drive number when vou choose its Save
command, it's asking which slot corresponds to the drive that contains the destination disk,
and whether that drive is the first or second drive connected.

+ By the way Applications that ask for the slot and drive number do not let you save a
document in a folder. The document is automatically saved in the disk roor directory. &

Disk drives connected to the disk drive port

If the disk where vou want to save your document is in a drive connected to the disk drive
port, specify slots as follows;

= slot 5 fora 3.5-inch drive

= slot 6 fora 3.25-inch drive

For each type of drive, the drive connected directly to the computer is drive 1. The second
drive, if there is one, is drive 2.

If vou're using some of the computer’s memory as a RAM disk, the RAM disk corresponds
toslot 5. The drive numbers of 3.3-inch drives may be different from the above description:
for more information, see “Setting RAM disk size,” on page 111.

#+ More than two 3.5-inch drives? If you have more than two 3.5-inch drives
connected to the disk drive port, slot 2 can act as an “overflow" slot for the additional drives.
The third 3.5-inch drive corresponds to slot 2, drive 1, and the fourth 3.5-inch drive
corresponds to slot 2, drive 2. »
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Disk drives connected to controller cards in internal slots

If the disk to which you want to save your document is in a drive connected to a card in an
internal slot, specify the number of the slot that contains the card. The drive connected
directly to the card is drive 1, The second drive, if there is one, is drive 2. If you are using
partitions, the first partition is drive 1 and the second partition is drive 2.

Printing documents

When you're working with documents in an application, the application determines the
way vou do such basic tasks as creating, saving, and printing documents. The procedures
for such tasks can vary greatly from application to application. You usually print your
documents from within the application you use to create them. For specific instructions,
refer to the manual that came with your application.

# Network users If your Apple 11Gs is part of a network and you use printers on the
network, be sure to read "Printing over the network™ in Chapter 12.

Ending a work session

This section describes the procedures vou follow when you're ending a work session:
®  quitting an application

= shutting down
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Quitting an application
When you're ready to conclude a work session with a particular application, follow these
steps [o quit:

1 save any documents you've been working with.

See “Saving documents,” on page 142 or refer to the manual that came with your
application,

I~

Quit the application.
Choose the Quit command from the File menu.

If you started the application from the Finder, you return to the Finder desktop. If you
started the application directly from a disk that doesn't include the Finder, the System 6
Program Launcher will start up.

If your application doesn’t have a Quit command, try one of these methods. Start with the
first method in the list, and try the methods in sequence until you find one that works.

= Press Command-Q (for Quit),

= Press Control-Q.

= Press Q.

= Check your application manual for other methods,

* Insert a different startup disk in your startup drive and press Command-Control-Reset.

If none of these methods works, eject all disks, switch off the computer, and then switch on
the computer again.
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Shutting down the computer

When you're using the Finder and are ready to end a work session at the computer, follow
these steps to shut down the computer:

Choose Shut Down from the Special menu.

If you will be shutting down from the Program Launcher, click Cancel, then select Shut
Down from the File menu.

You see the dialog box shown, The option labeled “Shut Down (turn off system power)" is
selected.

Clean lhp
Emots Trosk

Preferences

Pindr Bhon Doon Opodons

@) Shut Down (turn of f sustem power)
O Restart
O Quit te previous opplication

( tongel Il DK '

Ieon Info 41

Click OK.

The computer ejects any disks in vour 3.3-inch disk drives {and CD-ROM drives), and a
message appears letting vou know that it's safe to switch off the power.

[fyou change your mind about shutting down after you've clicked OK, reinsert your startup
disk and click the Restart button on the screen. The computer starts up again from the
startup disk.

Switch off the computer and the monitor.

Shutting down by the using the Shut Down commiand is the proper way to end a work
session. The Shut Down command allows the system to save information necessary to
maintain a well-ordered deskrop,
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Using Teach to practice application tasks

Teach is a word-processing application that comes with your system software, It lets you
read, write, edit, save, and print your own text documents. You can also use it with the
instructions in this hands-on tutorial to learn the basic tasks of working with an application.
The Teach program is on the Apple 11GS SystemTools2 disk.

¢ By the way Teach also provides a means for Apple Computer and other software
developers to make sure that the information you get about a new product is as up-to-date
as possible. When vou see a Read Me document on your screen, it contains last-minute
information that couldn't be included in the manual. You use Teach to gain access to this
Read Me information, «

In the following sections, you'll be using Teach to learn how to do these tasks, common to
most applications:

= starting an application

= ¢reating a document

= saving yvour work

= editing text

= printing from within an application

= importing files from other applications

Before you start working with Teach, copy the application from the SystemTools2 disk to a

blank, formatted disk; name the new disk “Teach.” For instructions, see “Initializing a disk,”
on page 90, and “Moving and copying files and folders,” on page 122.
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Starting the Teach application

After copying Teach to a new disk, follow these steps to start up the program:
Start up your computer with your startup disk.

Insert the newly-created disk that contains Teach.
If you are using only one drive, you'll have to eject the startup disk before you insert the

Teach disk.

Open the Teach icon by double-clicking it.

P You can also select the icon, and then choose the Open command from
the File menu.

Like most applications, Teach has its own menus and its window has a title bar, close box,
size box, zoom box, and scroll bars. Also like many applications, Teach always opens with an
“Untitled” window when you launch Teach. You create whatever you want with the
application and then name the document when you save it.

wEl

Creating a document

Now that you've started Teach, vou can create a document.
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On the screen, a blinking vertical bar marks the insertion point, where text you type will be
inserted. If you make a mistake, use the Delete key to erase characters back to where the
mistake is, and then start typing again.

| Use the keyboard to type this sample paragraph:
The excitement of using a computer for the first time is
no longer unigue in this age of technolegy. In the years
to come, more people will be using computers on a daily
basis. Computers can currently be found in almost every
office. The computer revolution has just begun.

I~

As you type, do not press the Return key when you get to the end of a line.

Most applications that let vou enter and edit text—such as word-processing applications—
start the new lines for you. It's a feature called “word wrap,” so called because if a word is
too long 1o fit at the end of one line, the word wraps around 1o the next line automatically.

You'll have a chance later to learn more about adding and editing text, but now give the
document a name and save it.

Saving vour work

This procedure gives the document a name of its own and puts a copy of it (with that name)
on the selected disk. It is stored there, as is, until vou decide to rename it, change it, or
delete it.

1 Choose Save As from the File menu.

The directory dialog box appears prompting vou to type the name of vour document in the
text box. Because the text box is selected (highlighted), the name you type will replace
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“Untitled” automatically. There's no need to use the mouse to position the pointer in the

text box,

Impart file...
Save 5|

Sawve Copy o5
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Poae Setup..
Print, ap

Teach (ProD0S)
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e i
3
Save the file gs: i Save )
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Type Memo 1 in the text box.

Click the Save button.

Your document is saved on the disk just as it appears on the screen. After the computer
saves the document, the title bar shows the name vou just gave it.

With your work saved on the disk, you can quit the Teach application and return to the

deskrop.

& Note Some applications, notably HyperCard 11Gs, save automatically during the work
session. Check the documentation that came with your program to see if it has an
automatic save feature. &

Choose Quit from the File menu.
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The desktop appears again. But now the icon of your new document appears in the window
of your disk.

This new icon represents the document you created, and below it is the name vou gave it.
When you work on this document again, vou select and open the icon just like any other
icon.
Most documents you create will have an icon particular to the application you used to
create them, so vou can tell which application you used to create each of your documents.
Now you've created and saved a document. In the next section vou'll learn how to

modify a document by revising the memo you've written,

Inserting text

When you want to add text to what's already there, vou can make insertions without
disturbing the existing text.

Follow these steps to insert text:

1 Open the Memol icon.

Opening the document you want to work on also starts the Teach application you need to
do the work. You don’t have to open the application first and then open the document.

If the Finder is unable to find the appropriate application on disk, follow the steps on
page 138.

The Teach program starts, and the document you saved earlier reappears, just as it was
when you saved it.

2 Position the insertion point in front of the ¢ in the word computer, then click.

You're moving the insertion point to where you want to add text, The blinking vertical bar,
called the insertion point, marks where the text you type will be inserted. If vou make a

154 Chapter 6 Working With Applications



mistake in positioning the insertion point, vou can reposition it either by clicking
somewhere else or by pressing the arrow key to move the insertion point left or right.

The excitement of using acomputer for the first time is no longer unique in
this oge of technologu. In the years to come, more people will be using
computers on o daily basis. Computers con currently be found in almest
every office. The computer revolution hos just begun

T}'pe personal.

The excitement of using o personol icomputer for the first time is no longer [t
unigue in this cae of technology In the yeors Lo come, more peaple will be

using computers on o doily bosis. Computers con currently be found in

alsest every office. The computer revelution hos just begun

What vou tvpe appears at the insertion point. (Don't forget to add a space after personal.)
You probably noticed that when vou added text, the words on the other lines rewrapped o
accommodate the extra word

Selecting text

You select text in order to delete it or replace it. In certain applications, such as word
processors, you also select text in order to copy it or to modify some aspect of it (such as
its size or tvpeface)

There are four techniques for selecting text:

= dragging

= clicking and Shift-clicking

= double-clicking

»  choosing Select All from the Edit menu (Or Command A, the kevboard shortcur)

You'll probably use different techniques depending on the length of the text to be selected

The first two techniques work in all circumstances, so vou can stick to one of those methods

if vou find it convenient. The last technique selects all the text in the entire document, so

use it carefullv,
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Dragging to select text
This technique is best suited 1o selecting parts of words or short passages.

Follow these steps to select text by dragging:

| Position the pointer at one end of the text to be selected.

Note that the pointer becomes an I-beam when it’s positioned within the text window.

I~

Drag across the text.

The text becomes highlighted as you drag across it, indicating that it has been selected.

The excitement af using a persanal computer|{TRN TR TREE LY LT
unigue in this age of technology. In the years to come, more people will be

using computers on a doily basis. Computers con current ly be found in
almast every office. The computer revolution has just begun

‘1) Release the Mouse button.

Clicking and Shift-clicking to select text
This technique is best suited to selecting long passages.

Follow these steps to select text by clicking and Shift-clicking:

| Click at the beginning of the text to be selected.

I~

Hold down one of the Shift keys while you click at the other end of the text to
be selected.

All the text between the point of clicking and the point of Shift-clicking becomes
highlighted, indicating that it has been selected.

jl Release the Shift key.
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Double-clicking to select text

This technique is used when vou want to select complete words. If the text to be selected
is part of a word—or begins or ends in the middle of a word—you must use one of the other
methods of selecting text.

To select a word, double-click it. The word becomes highlighted, indicating that it has
been selected.

To add an adjacent word to what you've already selected, hold down one of the Shift
keys while vou click the adjacent word. The highlighting extends to include the adjacent
word as well. (You can continue adding adjacent words indefinitely by repeating this
technique.) Dragging will also select adjacent characters, as long as vou hold down the Shift
key while you drag,

Choosing Select All to select test

This technique is used to select all the text in a document.

Choase Select All from the Edit menu. All the text of the memo is now
highlighted. Click anvwhere in the memo to deselect all the text.

Editing text by cutting and pasting

Follow these steps to modify a document by cutting and pasting:

If necessary, open the Memol icon.
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2 Select the entire second sentence by positioning the I-beam after the period that
follows the word technology and dragging to the end of the sentence.

ulml every ofﬁu The computer revolution hos just hm

Move the insertion point to the beginning of the phrase you want to copy and click. Drag
the mouse to the right and down until you have selected all the text you want. (Be sure you
include the period at the end of the sentence.) If you move the pointer off the sentence,
you might select more than just the sentence. If this happens, just reposition the insertion
point and start dragging again.

j Choose Cut from the Edit menu.

The sentence vanishes. Whenever vou choose Cut or Copy from the Edit
menu, whatever you cut or copy is put in a holding place called the

Clipboard, ready for you to paste to a different location if you want. You
use Copy when you want to leave the selected text where it is and put a

copy of it somewhere else, Copy works just like Cut, except it leaves the
text vou selected in the document.

'l Move the insertion point by clicking after the period that follows the word office

J

Choose Paste from the Edit menu.

£t | The contents of the Clipboard—in this case, the sentence vou just cut—
are pasted into the location vou selected.

Select AIL 4R

Find o
Find Same b1
Begloce W
Reploce Same OF
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The contents also stay on the Clipboard until you replace them by choosing Cut or Copy
again (or shut down the computer). This means you can continue to paste them. You can
paste within one document, between two documents created with the same application, or
between documents created with different applications. For example, you can draw a
picture with a graphics program and use it in a report you create with a word-processing
program.

Deleting text

Follow these steps to delete text:

Select the text you want to delete.

See “Selecting text,” on page 155 eardier in this chapter for review,

Press the Delete key.

You can also use the Clear key or Control-X.

In addition to the standard procedure, there are three keystroke commands that let vou
make specific kinds of deletions:

= To delete the character to the left of the insertion point, simply press Delete.

= o delete the character to the right of the insertion point, press Control-F.

= Todelete all the text to the right of the insertion point, press Control-Y.

Replacing text

Follow these steps to replace existing text with new text:
Select the text you want to replace.

Type the new text.

When vou type the first character of the new text, the selected text disappears, What you
type replaces it.
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Changing the font, size, or style of document text

You may want to change the look of your document by changing the font (the tvpeface), or
the size and style of the text. In this section, you practice changing the look of your memo.
These steps assume the Memol file is open and the window is active

1 Choose Select All from the Edit menu.

All the text of the memo is now highlighted.

I~

Sclect Choose Font from the Fonts menu.
A dialog box appears, listing options you have for fonts, font style, and font size. The font
vou're using now is already highlighted, the Plain style is selected, and the 8-point font size

is selected.

Font:
Fmturirr Iy
L]
::::’:: Helvetica
Helvetica
Times
 ihavton Venice
i Style
¥ r
— i E)Plain 's;fl
{C]8ald i
;%ltlm
{ ] Underline |
{CJoutline |
([ Shadow _ | K

5 Change your font options.

If the Fonts update is not installed on your startup disk, vou won't be able to select a new
font. Go on to the next section. (For information about installing the Fonts updare, see
Chapter 2, "Using the Installer,” starting on page 19.)
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1. Double-click the Venice font to select it.

e

Click in the box to the left of the word Bold.

3. Click in the Size text box to position the insertion point, and type “10.”

Click OK to confirm your font selections.

When vou return to your memo, clicking outside the highlighted area deselects the text that
you highlighted in step 1. Notice that the typeface is different, the size of the type is larger,

and the memo is displaved in boldface.

O Memol

The excitzment of using o personal computer for the first time is no
longer unique in this oge of technology. Computers cun currently be
found in almost ewery office. In the years to come, more people will be
using computers on o daily basis. The computer revolution has just
begua.

Bl
it

Position the pointer at the beginning of the word /o in the first sentence and drag
to the end of the word //me.

MMMnjumgummmwmm#m
forger unique in this nge of technology, Computers can currently be
found in almost wery office. In the years to come, more people will be
wsing computers on o daily basis. The computer revolution has just
begua.

This time, choose Italic from the Style menu.

The excitement of using o personal computer for the first timeis no
longer unique in this age of technology. Computers can rurrently be
found in almost wery office. In the years to come, more people will be
wsing computers on o doily bosis. The compuler revolution has just
begun.

The phrase for the first time, is now further emphasized in your memo.
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You may want to experiment with other fonts, stvles, or sizes that change the look of vour
memo. You can change font style and size by choosing the Choose Font command in the
Fonts menu, or by choosing the appropriate commands in the Style and Size menus.

Changing all occurrences of a word

Sometimes vou may want to change all occurrences of a word or a string of words in vour
documents. Many applications allow you make such changes easily with replacement tools,
This section explains how to use the Replace command of the Teach application 1o make all
the changes at the same time, instead of making them one by one. These steps assume you
have the Memol file open and the window is active.

1 ciick once in your memo to make sure no text is selected.

I~

Choose Replace from the Edit menu.

A dialog box appears, prompting vou for the word or string of words vou want to replace.

W_—— Find what string?

:::1 :: I Cose sensitive [ Start of document
Paste Bl | Replaoce with what string?

Cleor L I
Select il sal ( Reploce A11 )( Coneel I' Replace l
Find i

Tind Some 46

| Reploce Same 3]

5 Type computer= in the first text box.

In this case, it's notimportant whether the word computers begins with an upper- or lower-
case letter; don't select the “Case sensitive” box.

Click "Start of document” to have Teach start its search at the beginning of your file.
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4 Type personal computers in the second text box.

Find what string?
Fc-wt«s ]
[ case sensitive B Start of document

Reploce with what string?
i_p!rs.onnl computers

(Reatace i1 )( Tancel ]-

D Click Replace All
Clicking Replace All changes all occurrences of the word computers o personal computers

Clicking Replace would change only the first occurrence. You could then choose Replace
Same from the Edit menu to make the same change on the next occurrence.

The pxcitement of wsing & personal compular for the first timzis o [
longer unique in this nge of technology. personal compulers can
currently be found in almost wery office. I the years to come, more
people will be using personal computers on o daily basis. The computer
revolution has just begun.

Remember that different applications may handle replacement functions in a different way.
Refer to the manual that comes with vour application.

Finding words or strings of words

In some cases, you may want to find certain words or strings of words in your document
without necessarily making changes to them. In this section, you use the Find command of
the Teach program to locate a word, and then you can decide whether to make a change or
not

] Click once in your memo to make sure no text is selected.
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2 Choose Find from the Edit menu.

Find what string?
[ |

[CJCase sensitive (] Stort of document

Select A1l

Reploce..

A dialog box appears, prompting vou for the word or string of words vou want to find.

L

Type personal computers in the text box.

It's not important whether the words personal computers begin with an upper- or lower-
case letter; don't select the “Case sensitive”™ box. '

th

Click "Start of document” to have Teach start its search at the beginning of your file.

4  Click Find.

il

When Teach finds the first occurrence of the phrase, decide whether to delete the
word personal before computers.

If you want to, position the insertion point before the word computers, and then use the
Delete key to delete the word personal and a space.

Or, you may not want to make any change.

§ Choose Find Same from the Edit menu to locate the next occurrence of the word
and decide whether to change it.

L You can repeat this process as many times as vou need to go through
vour entire document.

SelectAll 8
Find 5
Reploce A
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Saving a document under a different name

Now that vou've edited vour original memo, vou need to save your revision. When you're
finished making changes to a document, vou have three choices for saving: Save, Save As.
and Save Copy As.

You can choose Save from the File menu, and the revised document is saved with the
same name you gave the original. That's fine if vou don’t want to keep a separate copy of
the original document. But vou may want to save the revision and keep the original, too.
(For example, vou may have a form letter that you keep as a template; you can personalize
the letter and save different versions with new names.) To do this, vou choose the Save As
command from the File menu. The Save As command can also be used to save vour
document to a different folder or disk.

Use the Save Copy As commuand to create a copy of your active document, and then
continue working on the document without having changed its name. To do this, you
choose the Save Copy As command, name the copy. and save it on disk. You then return 1o
vour active document, which still has its original name. You can also use the Save Copy As
command to save documents in different file formas.

Follow these steps to save vour document with a different name:

Choose Save As from the File menu.

How BT m Teach (Prob0S)

Dpen_ ] free of 800K olumes
Imgort file 3 Menad ir

Save 4% Ly Teach b —m
Seve Dopwes

Close = Cliese )
Popesew Save the file o C e )
tielle [z | o)

The directory dialog box appears. The name of the original document appears highlighted
in the text box.

You can edit the names of documents just as you would other text. Or if you prefer. you can
just tvpe a new name for the document rather than edit the old one.
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2 Position the pointer in the word Memo! between the o and the / then click and
drag to the end of the title.

The text becomes highlighted.

(=) Teach (Pro00S)
TH7 free of BOOK. ( Volmes )

L i
= (CTtlese )
Save the file s @
[Nencl] | G )
5 Type -.

Teping over the selected text replaces it automatically,

4 Click the Save button.

You've saved the revised memo with a new name. Notice that the title bar changed to show
the name you just gave the revised memo. Your original document is still stored, unaltered,
with its own name,

Printing a document from within an application

To print a document from within an application, the program must be open and the
document must appear in an active window. Your saved memo is now ready for printing,
assuming you have a printer connected to your computer and the appropriate printing
software installed on vour startup disk. (1f you're working with an 800K startup disk, vou
must install the appropriate printer updates. For information about installing updates, sce
Chapter 2, “Using the Installer.”)
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Follow these steps to print your memo:

Choose Page Setup from the File menu to set printing options such as page
orientation and paper size.

The Page Setup Dialog box appears. After setting vour printing options, click OK.

Imageliriter / Printer w2
Dpen...
areary- e Paper Type: | USLetter.. 8.3"¢ll"
Save 45
Soveos
Save Copy ne... Reduction:

Cloze

L — Height: [IMa Vertical Gops
Page Setup [IVertical Condense

B &

Choose Print from the File menu.

Drientation:

In most programs, one or more dialog boxes appear. You can click the various options o
control the way your printed document will look. What the options allow, and how you use
them, depends on the application you're using. Refer to the manual that came with the
application.

Important Inorder to print vou must first select the appropriate printer from the desktop
Control Panel. See Chaprer 7, "Using the Desktop Control Panels,” starting on page 171.
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Importing files from other applications

If you like working in the Teach program, vou may want to bring text from documents you
have created in other programs into Teach. You can import documents from any of the
following applications:

= AppleWorks® GS

= AppleWorks 3.0

= MacWrite* 3.0 (from AppleShare or if vou have installed the HFS FST)

While you have Teach running, follow these steps to import files from one of the supported
applications:

1 Choose Import File from the Teach application’s File menu.

A dialog box appears, listing the import options and prompting you to locate and select a
file.

Newt BL Select file to Import.
"" 1 i =1 & Tronsfer Disk (HFS)
mport file.. |
e ]
Bave a3
Save Copy as... iy
Close o
'
2
) Ropleblorks 3.0 () fippleblorks 65
(@ Mochlrite 5.0 (CIALL Three Tupes

I~2

Select the application that created the file you want to import, and then locate
and select the file from the list.

r‘q—)‘J

Click Open.

The document appears, and you can work with it in the Teach application.
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Quitting Teach

When you've finished working with an application, quitting closes all windows and takes
vou completely out of the program, If vou have forgotten to save your work, vou usually see
one or more dialog boxes that remind vou to do so.

To quit Teach or any other application, choose Quit from the File menu, You return to the
desktop, where you see both the icon for vour original document and an icon for the
revised memo with the name vou just gave it.

Keep in mind that this chapter provides only a basic introduction on how to use

applications. Remember to consult the manual that comes with any application vou
purchase; each one will have its own rules and conventions.
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Using the Desktop Control Panels

The desktop Control Panels let vou customize various aspects of the Apple TGS computer
to suit vour own needs and preferences. You can change the volume level of the computer’s
sound, the pitch of the computer’s beep, the responsiveness of both the mouse and the

kevs on the kevboard, the flashing of the pointer or insertion point, and many other

features, You can also use the Control Panels to set up connections to other equipment you

use with vour computer. The Control Panels even let vou track the date and time.

This chapter contains information on these topics:
= opening the Control Panels

» making changes to the Control Panels settings
* working with individual Control Panels

* leaving the Control Panels



About the Control Panels

The desktop Control Panels feature is a new desk accessorv (NDA)—that is, a “mini-
application” that's available when you are using most applications. The settings for many of
its options are stored in special, battery-powered RAM and some are stored on the startup
disk. Unlike ordinary RAM, the battery-powered memory retains what's stored in it even
after the computer’s power is switched off. As a result, the changes you make to Control
Panel settings are saved for future sessions.

~. Important If the battery is running low, the Control Panel automatically restores the
original settings, If this happens, have your authorized Apple service provider replace the
battery, then you can change the settings back to your preferences.

Although this chapter details only the desktop Control Panels, there is another way to set
Control Panel options: The text Control Panel is a classic desk accessory (CDA) that
operates in the text environment. To get to the text Control Panel, hold down the
Command and Ctrl (Control) keys while vou press and then release the Esc (Escape) key.
If you need information about the text Control Panel, refer to the owner’s guide that came
with vour computer.

The next two sections explain how to open the desktop Control Panels and how to
make changes to the settings. The remainder of the chapter explains all the options you can
set in the desktop Control Panels and what the different settings mean.

Opening the desktop Control Panels

You can open the desktop Control Panels from the Finder or from any application that has
an Apple menu.

Follow these steps to get to the desktop Control Panels:

1 start up the computer.
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2 When the Finder desktop (or your application desktop) appears, choose Control
Panels from the Apple menu.

In a moment the Control Panels window appears,

FO==Lintrol Panels ==

Rbout the Finder_..
Help a?

Contrel Pomels

Printer Port |

-4

The column on the left shows the icons of the various Control Panels, The icons that appear
depend on which updates you've added to vour startup disk by using the Installer.

» [fvou've installed the SOOK update or the AppleShare, 3.5 Disk update on a tloppy disk
(via the Customized Installation), most of the Control Panels described in this section
won't appear. Because of space constraints, these updates install an abbreviated version
of system software that doesn't include most of the Control Panel categories. You see
only the AppleShare and RAM Control Panels, as well as the Control Panel for the
network printer update you installed (if any).

Ifyou want to make changes to Control Panels that don't appear, you may be able to use
the text Control Panel. For information about the text Control Panel, refer to the
owner's guide that came with your computer.

v fyou've installed the AppleShare, Applelalk ImageWriter, AppleTalk ImageWriter 10,
or LaserWriter update. vou see the corresponding category of printer options in
addition to all the categories described in this section. For information about
networking options, see Chaprer 12, “Nerworking the Apple 11,” starting on page 271.

Making changes to the desktop Control Panels

When you want to make changes to a Control Panel, click the icon of a Control Panel vou
want to change, and click Open. You can also open the icon by double-clicking it, or by
clicking it and then pressing Return.
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You may have to scroll to find the Control Panel icon you want. You can also use the up
and down arrows to search the list.

The Control Panel opens in a window that lists its options, ( You can open as many
Control Panels as you like, dragging the windows to other locations on the desktop to suit
your convenience, )

The technique you use to change a setting depends on the option:

= Options that have only two settings—on or off—use a checkbox. An X in the checkbox
indicates that the option is turned on,

To change an option represented by a checkbox, click the box to add or remove the X.

= Options that have two or more settings use 2 pop-up menu or radio buttons. In pop-
up menus, the current setting is displayed in a box to the right of the option name.
Other settings remain out of sight until vou display the menu. (You can tell that an
option uses a pop-up menu if a shadow appears behind the box to the right of the
option name. )

To change an option represented by a pop-up menu, position the pointer on the
current setting (or on the option name), press the mouse button to display the pop-up
menu, drag through the menu until the setting you want is highlighted, and then
release the mouse button. The pop-up menu disappears, and the new setting appears
in the box. If vou do not want to make a choice, drag outside the menu and release the
mouse button. The default setting for any pop-up menu is shown in italics,

Radio buttons are small circles to the left of option settings. You can tell that a setting is
currently selected if it has a solid black circle inside the button. To select a setting that
uses radio buttons, click inside the button next to the setting you prefer.

= Options that have a continuous range of settings (such as the sound volume level) use
a scroll bar. The position of the proportional scroll box within the scroll bar indicates
the current serting relative to the entire range.

To change an option represented by a scroll bar, drag the scroll box to a new location.
(Clicking the scroll arrows or the gray areas above and below or to either side of the
scroll box will also change the setting.)

= Some options use windows to list all possible selections—highlighting the current
selection. An example is the DC (for Direct-Connect) Printer Control Panel, The options
listed in the window depend on which printer updates you've installed on the startup
clisk.
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Tor change a selection in a window, click the new selection.

= Time options require you to select what you want to reset (such as the year, the month,
or the dare), and then click arrows—up or down—until vou reach the appropriate
setting.

Important Some of the changes you make in the control panel do not take effect until
YOU Festart vour computer, -

Working with individual Control Panels

This section describes the desktop Control Panels. Some of them, clearly noted in the
section headings, are available only from the desktop—not from the text Control Panel.
Others are available from the text Control Panel. but with different names. If you see no
qualifving note in the heading, you can assume that a Control Panel is available from both
the desktop and the text Control Panel,

Keep in mind that when an option is described as “turned off,” the checkbox for the
option is not selected. (That is, the checkbox is not marked with an X.)

DC Printer
& Note DC Printer is found only in the desktop Control Panels.

If you print with a local printer (that is, a printer connected directly to your computer), you
use the DC Printer Control Panel (for Direct-Connect) to specify the printer's tvpe and the
port to which the printer is connected. In addition to selecting a port in the Select a Port
window, vou must make sure that the port is activated in the Slots Control Panel (see
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page 191), and that the port is configured properly in the Printer Port or Modem Port
Control Panel,

— o= mne =
) = e - |
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OC Printer

Seleot a Printer Tupe

The Select a Printer Type window lists all types of printers for which vou installed a local
printer update. (For more information, see “Adding capabilities to a System 6 startup disk,”
on page 22.)

General

# Note The General Control Panel is found only in the desktop Control Panels. Many of
these functions can also be set in the text Control Panel under Kevboard, Mouse, and
Svstem Speed. o

This Control Panel includes a number of options you can customize.
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Menu Blinking

This option controls the number of times that a menu command blinks when vou choose it.
The blinking indicates that the command has been selected; you may prefer to have more
blinks to be certain vou've made the choice vou intended or fewer blinks so that the
computer can start the operation more quickly.

Crrsor Flash

This option lets vou adjust the interval between flashes of the cursor or insertion point. If
the interval is so long that the insertion point isn't noticeable enough, change to a faster
setting. If the interval is so short that the insertion point is distracting, change to a slower
setring.

System Speed

You use the System Speed option to set the computer's speed. Fast refers to a maximum
speed of 2.8 megahertz (MHz), the top speed possible on the Apple 116s without the
addition of an accelerator card accessory, Normal refers to a maximum speed of 1 MHz,
the top speed of earlier models of the Apple 11 family.

Change the setting to Normal only when the fast speed throws off an application’s
timing or keeps it from running properly. If you change from Normal to Fast after starting
up an application, vou may have to restart the computer for the Fast setting to take effect.

Mouse Speed

When you move the mouse across vour desk, the pointer moves a corresponding distance
across the screen. Increasing the Mouse Speed setting makes the pointer move farther for
the same movement of the mouse—giving the impression that the pointer moves faster.
This feature is especially useful if you're short on desk space.

Double Click

If your attempts to double-click don't accomplish what they're supposed to, you should
change to a slower or faster setting,
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Monitor

When vou use text-hased applications, the Monitor option lets you choose from several
character sets that allow the monitor to display special characters required in languages
other than English.

Kevboard

The way kevs are laid out on 4 typewriter's kevboard is not the same in every country—and
for good reason. Different languages use letters with varying frequency; for example,
French uses the letter ¢ much more often than English does. So French keyboards have the
Q key in a more accessible location than the upperleft corner.

# By the way Inaddition to the Keyboard option in the General Control Panel, there are
a number of kevboard features vou can customize in the Kevboard Control Panel. o

Even in the United States, kevboard layout isn't universal. Most people learn to type with
the Quwerty kevboard, named after the first six keys on the top row of letters ( properly
called the Sholes keyboard).

You may have learned with the Dvorak keyboard—a kevboard arranged 1o increase
tvping speed and efficiency by locating the most frequently used keys in the home row. The
Dvorak keyboard is also called the American Simplified Keyboard. (See Figure 7-1.)

With the Keyhoard option you can set your Apple 1165 to recognize any of a number of
standard kevboard layouts, including the Dvorak keyboard. So if you're used to typing with

AEPEDDBDDDDET @E

Figure 7-1 The Dvorak kevhoard lavout
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something other than the Qwerty kevboard, vou won't have to go back to the hunt-and-
peck stage to use vour Apple 11Gs.
Translation

When the Translation option is set to Standard, you can use the Option key in conjunction
with other keys to generate international language characters. This feature has an effect in
graphics-based applications only.

In most cases, holding down the Option key while vou press another key generates a
special character automatically. A few commonly used diacritical marks require a two-step
Process:

Hold down the Option key while you press the E key to generate the ™"
diacritical mark.

The diacritical marks available on the Apple 1168 are shown over the corresponding
keyhoard character on the kevboard. The following characters are available: €, ii, i, f, and
on your kevboard next to the spacebar, is .

Type the letter to which you want to add the diacritical mark.

The letter with its mark appears.

Alphabetize DAs

When this option is selected, vour desk accessories appear in alphabetical order.

Keyboard

The Kevboard Control Panel lets you customize the way your keyboard responds when you
press the kevs. You can adjust a variety of keyboard features.

Speed

When you hold down a key instead of pressing and releasing it, the key repeats, like
thissssssssssss. You use the Speed option to change the speed at which keys repeat.
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Delay

You use the Delay option to change the amount of time it takes from the time vou first hold
down a key until the key starts repeating. You can also turn off the repeat feature,

Dual Speed

When you hold down any arrow key, the insertion point moves continuously in the
direction of the arrow. Using the Dual Speed option, vou can double the speed at which the
insertion point moves,

First, set Dual Speed to Fast. Then, when you want to use the faster speed. hold down
the Control kev while vou press the arrow key vou want. { When Dual Speed is set to Fast,
the cursor’s speed is normal except when you hold down the Control key.)

Kevboard Buffering

The keyboard buffer keeps track of kevstrokes when the computer is busy and can't deal
with them immediarely. The buffer can keep track of up to 19 keystrokes, (After that.
keystrokes are ignored.) This feature lets vou type a series of instructions to the computer
while the computer is doing something else—performing calculations, for example.

Important Some applications designed for use with both the Apple lle and the Apple [1Gs
won't work when Keyboard Buffer is turned on. If you have trouble using an Apple Ile—
compatible application, try turning this option off.
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Shift Caps/Lowercase

Ordinarily, when you press Caps Lock, every character you type is capitalized; to get
lowercase characters, vou must release Caps Lock.

If vou're tvping a document that's mostly uppercase but has an occasional lowercase
character. it can be inconvenient to have to keep releasing the Caps Lock key. The Shift
Caps/Lowercase option makes typing such a document easier.

When this option is turned on, press Caps Lock and begin tvping vour document.
Whenever vou need a lowercase letter, press one of the Shift keys as you type the letter.

Fast Space/Delete

When you hold down the Space bar, the space character repeats like any other character,
and you get a row of spaces. Likewise, when vou hold down the Delete key, successive
characters are deleted until you release the key.

When Fast Space/Delete is turned on, you can double the speed of spacing and
deleting. For the faster speed, hold down the Control key while you hold down Space or
Delete.

Keyboard Mouse

Keyboard Mouse options let you customize the way the pointer behaves when you're using
the Mouse Keys feature (not the mouse attached to your keyboard). (For information on
using Mouse Keys, see page 247.) If the Mouse Keys feature is not activated, these options
have no effect.

® [nitial Delay lets vou change the amount of time it takes from the time vou first hold
down a key until the key starts repeating. This setting affects only keys used as Mouse
Keys.

» Acceleration lets vou change the amount of time it takes for the pointer to reach its
maximum speed when using Mouse Keys.

= Speed lets you change the maximum speed at which the pointer will move when using
Mouse Keys.
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Media Control
¢ Note Media Controlis found only in the desktop Control Panels.

o If vou used the Installer 1o add one of the media control updates to vour
mlw startup disk, the Media Control Panel allows vou to set up connecrions
L3 5 to multimedia equipment: the AppleCD SC CD-ROM, and the Pioneer

Media Ctrl  2000.and 4200 families of laserdisc plavers. You select a channel, the type
of media device to which the channel is connected, and the port through
which the communication occurs. For more information about the
Media Control Panel, see Chaprer 11, “Controlling Multimedia Devices,”
starting on page 171.

Modem Port and Printer Port

Most of the ports on the back panel of the Apple T1Gs are set up to work with a particular
type of device, at one speed and in one format. But the modem port and the printer port
let you connect a wide variety of devices, each with its own special requirements, You can
change the settings for these ports with the Modem Port and Printer Port Control Panels.
The oprions in each category are the same; this shows the Modem Port Control Panel.

\\ EC1== Hodem Port ———

\E;l‘:.h Device Type: Your Cord

Farity:

Baud:
Hodem Port Lne enth TR

st sty
[l belete LF after CR

Add LF after CR

Echo
] Buffering
i DCD Handshake
. D58/0TR Hondshake
Printer Port [T 40N/40FF Hondshake
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& Network users If your Apple 11Gs is part of a network, you see fewer options for the
port through which vou made the network connection, Whenever slot 1 or slot 2 is set to
AppleTalk, only four options appear for the corresponding port. For example, if slot 1 1s set
to Applelalk instead of Printer, vou see only four Printer Port options,

The modem port is preset to work with the Apple Personal Modem. The printer port is
preset towork with the ImageWriter and LaserWriter printers, as well as with the many other
serial printers that receive information in the same way.

If vou have a modem or printer from a manufacturer other than Apple. you may need
to modify the settings for the port to match the requirements of your modem or printer.
This is known as “configuring the port.” Try using vour modem or printer before changing
any of the settings. If it works, vou've saved yourself some time. If it doesn't, the problems
vou notice (lost characters and so on) may help vou figure out which settings need to be
adjusted. (See vour printer or modem manual for troubleshooting solutions. )

# By the way If you do change vour settings, you can always restore them to the default
settings by clicking the Standard Settings button. &

Table 7-1 Standard Setting

Function Modem Printer
Piwrity None None
Baud 1200 Baii
Line Lenath Unlimired Unlimited
Dt/ Stop H-1 8-1
Delete LF after CR* Off Off
Add LF after CR Off On
Buffering Off Off
Echo Off Off
DCD Handshake On On
DSRDTR Handshake On On
XON/XOFF Handshake Off OfFf

ULF ts an abbreviaton for line feed; CR s an abbreviation foe carmage return,
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Some applications automatically regulate the transfer of information to a peripheral device,
overriding the current settings for a port. If an application asks vou to supply details about
how the printer or remote computer wants to receive information (using terms such as
baud, data bits, and stop bits), it will use the settings you give it, overriding the Control
Panel settings for the port.

Some applications present a list of printer types from which they ask you to choose. If
that's the case, you know that the application uses the settings you give it, overriding the
Control Panel settings for the port.

¢ Tip Ifyour printer isn't on the application’s list, try selecting each of the printers on the
list andl then printing, Your printer may have the same configuration as one of those on the
list. If your document comes out the way you expected it to, just select that printer each
time you want to print, and you won't need to configure the printer port. e

If an application doesnt ask for details about the settings needed to communicate with the
remote computer—or if it doesn’t present vou with a list of printer types to choose from—
the application will use the modem port or printer port Control Panel settings.

The following sections explain what the various specifications mean and how to decide
what settings to choose. 1f you don't understand some of the settings, just follow the
recommendations given at the end of each section.

Farity

To make sure that your data isn't misinterpreted or garbled during transmission, some
devices expect to receive one extra bit after every character. Thar bit is called the parity bit.
The word parity derives from the Latin word for equal, and parity checking is a way of
making sure that what's sent matches what's received. If it doesn't match, the receiving
computer asks the sender to retransmit or announces an error.

If the transmitting and receiving computers agree on odd parity as a way of checking for
errors, your computer must append an extra bit (either 0 or 1) so that the character has an
odd number of 1's. For example, in the American Standard Code for Information
Interchange (ASCII), the 7-bit code for the letter A is 1000001, which has an even number
of I's. The computer appends an extra 1 to make the total of 1's an odd number. The
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receiving computer checks the total number of 1's in each character. If thar total is odd,
chances are the message is OK; if it's even, there was an error in transmission.

If the computers agree on even parity, the computer appends an extra bit (again, 0 or
1) to make the total number of 1's an even number.

You can select one of three parity settings: Odd, Even, or None. Most devices don't use
parity checking, so if you're unsure about what to select, choose None.

Baud

The rate of data transmission is measured in a unit called baud, which is roughly equal to
hits per second. The Apple llas can send and receive information at speeds ranging from 50
baud 10 19,200 baud. It’s important to make sure the computer and the printer or modem
agree in advance on the rate at which the bits will be traveling,

You usually find baud listed on a specifications page in the manual that came with your
printer or modem. When you know what baud the device uses, select the same rate for the
computer by using the Baud option.

Line Length

The Line Length option determines the number of characters your printer will print per line
before generating a return character (returning to the left margin to start a new line),

Many applications let you set the line length within the application. If that's the case—
or if you find the computer adding return characters where they don't belong—choose
Unlimited and the computer won't try to control line length.

If, on the other hand, your printer ignores the right margin and prints right off the page,
vou can use the Line Length option to insert a return character after every 40, 72, 80, or 132
characters.

If vou're connecting a modem, leave the line length set to Unlimited.

Data/Stop

The computer sends and receives each character of data through the modem port or
printer port as a string of bits. There are several systems for representing a character; some
take five bits, some six, seven, or eight. These bits convey actual information and are known
as data bits.
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There are also different ways of indicating that the string of bits representing 4 character
has ended: some systems require one bit, some two. These bits mark the completion of a
character, so they are known as stop bits.

The manual that came with your modem indicates how many bits the modem uses to
represent a character (it's often 8) and how many bits i uses to indicate that it has stopped
sending one character and is about to send the next (it can be 1 or 2).

In the text Modem Port Control Panel, this option is called Data/Stop Bits.

Delete LF after CR

Some printers and applications automatically generate a line feed (LF)—that is, thev go
down to the next line—after each return character. Others don't.

Ifyou try printing a document and everything comes out unintentionally double-
spaced, you may need to cancel the extra line feed. Start with the easiest solution, which is
to turn off the application’s line feed setting, If that doesn’t work, turn on the Delete LF after
CR option in the Modem Port Control Panel. If neither of those suggestions solves the
problem, turn off the automaric line feed switch on the printer. (For instructions on turning
off the line feed switch on the printer, consult the manual that came with your printer or
ask your service provider for assistance.)

If you're connecting a modem, this option should be turned off.

Add LF after CR

I you try printing a document and all the lines print on top of each other, you may need to
add a line feed after each carriage return.

Start with the easiest solution, which is to turn on the application’s line feed setting. If
that doesn't work, turn on the Add LF after CR option in the Control Panel. If neither of
those suggestions solves the problem, turn on the automatic line feed switch on the printer,
(For instructions on turning on the line feed switch on the printer, consult the manual that
came with vour printer or ask vour authorized Apple service provider for assistance.)

If vou're connecting a modem, this option should be twrned off.

Echo

When you send a message through vour modem, you can have the modem display the
message on your own screen as well as sending it to the remote computer, This is called
echoing.

186 Chapter 7 Using the Desktop Control Panels



In most cases, vou won't need to turn on the Echo option because the computer vou're
sending the message to will send a copy of the message back to your computer as a way of
confirming that it received your message. If vou turn on the Echo option and the other
computer sends a copy, vou see double—two characters for every one you send.

How do vou know whether to have vour modem echo the message vou send? If the
remote computer uses a full-duplex modem. it will send a copy of the message back to vour
computer. Most information services use full-duplex modems, If vou're communicating
with a full-duplex modem, turn off the Echo option.

If the remote computer uses a half-duplex modem, on the other hand, it won't send a
copy of the message as it receives it, 1f you're communicating with a half-duplex modem
and vou want your computer to display vour message on the screen as it's sent, turn on the
Echo option.

If vou don't know what kind of modem is on the other end of the phone line, turn on
the Echo option. Then, if vou find that every character in your outgoing message shows up
twice, turn the option off again.

Buffering

The buffer is a special area in RAM that holds information until the computer or peripheral
device is ready to deal with it.

Ifvou lose information when vou use yvour modem, turn on the Buffering option. If you
don't lose information, leave this setting off unless the manual that came with your modem
tells you to turn it on,

Handshake signals

When vour computer begins to communicate with another computer via a modem, it sends
a signal saving, in effect, “I'm about to send you some information.” And the other
computer responds with a signal saving, in effect, “I'm ready when you are” or “Give me a
second to catch up.” These exchanges are called handshake signals.

DCD, DSR/DTR, and XON/XOFF are all handshake signals. DCD stands for Data Carrier
Detect, DSR for Data Set Ready, and DTR for Data Terminal Ready, XON and XOFF are ASCI
characters. XOFF tells the transmitting device to halt transmission of characters. XON tells
the transmitting device 1o resume transmission of characters.
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Don't change these settings unless the manual that came with vour modem specifically
tells vou to set them in a particular way. Clicking the Standard Settings button will set all of
the modem selections 1o the default setting.

Monitor

The Monitor Control Panel lets you customize the way information is presented on the
screen, Most of the options are geared primarily toward text-based applications. (These
settings can also be made in the text Control Panel under Display.)
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If you're using a color monitor, set this option to Color. If vou're using a monochrome
monitor, set this option to Monochrome. This setting only effects composite video but can
also impact the quality of the image.

Columns

When vou're using applications that display information in text mode, the Apple 11Gs can
display either 40 columns or 80 columns per line of text. If you choose 40 columns, the
characters are twice as wide as the characters vou get when you choose 80 columns, The
characters are bigger and therefore easier to read. In the 80-column mode, more of the
document vou're working with appears on the screen, and the document more closely
resembles a typewritten document.

If you use your Apple Hes with word-processing or spreadsheet application programs,
it's usually a good idea to set the Columns option to 80. In fact, some applications require
an 80-column display.

Some applications override the Control Panel serting. For example, many games and
educational applications are designed for a 40-column display.
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Text/Back/Border

Ifyou have a color display, you can choose from 16 screen colors for your text, background,
and border. If you have a monochrome monitor, vou can choose among black, white, and
14 shades of gray,

The text and background color settings affect only text-based applications. The border
color setting affects all applications,

One category of color monitors, called composite color monitors, switches to dark-
and-light mode to display text. (These monitors don't have high enough resolution to
display text clearly in color))

When you're using a composite color monitor with a text-based application, the text
and background colors you selected show up as shades of gray instead of colors. Only the
border is displaved in color.

¢ By the way Some graphics-hased applications display text in a portion of the graphics
screen—usually the bottom four lines of the screen. When you're using a composite color
monitor with such an application, vou will see the text and background colors that you
selected. »

Printer Port
' The Printer Port options are the same as the Modem Port options. See
Q-F “Modem Port and Printer Port,” on page 182.

Printer Port
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RAM

The RAM Control Panel lets you set up a RAM disk and a RAM cache—both of which can
help make the computer work more efficiently.

M i —Fr
...... RitH Disk:  RAM Coche:
Memory in nse: 1614K
Availoble memory: 561K
Mox block size: EgK
I Resize ofter reset
RAM Disk

You can designate a portion of the memory in vour Apple 11Gs to be used as a RAM disk—
that is, as random-access memory that the computer treats as a disk. For more
information on RAM disks, see page 110,

- Important Anew RAM Disk setting doesn't take effect until vou shut down and switch off
the computer, and then start up again. As a result, decreasing the maximum RAM disk size
won't erase what's already stored on the RAM disk during the current work session, but
once you shut down the computer the contents of the RAM disk will be erased.

If your computer has ROM 3, the RAM Control Panel provides an option called “Resize after
reset.” When selected, this oprion allows you to restart yvour computer after making
changes to the RAM Disk setting—instead of shutting down and switching off the computer.
Nevertheless, it is good practice to shut down and switch off power to your computer after
changing the RAM Control Panel settings.

RAM Cache

Found only in the desktop Control Panel, the RAM Cache option lets you set aside (or
cache) part of the computer’s RAM for use by the operating svstem, The operating system
uses the memory in the cache to store information about the location of files on vour disks
(directory information). By storing this information in RAM the first time a file is opened
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dluring a work session, the operating system can find the information much more quickly
the next time.

SetStart

Found only in the desktop Control Panel, the SetStart Control Panel lets vou choose an
application to open automatically at startup. You can choose the Finder option, the Current
Application option (that is, the application you were using when you opened the SetStart
Control Panel), or the Select Application option (to see a list of available applications). The
next time you start up the computer, the application you specify in the SetStart Control
Panel opens automatically,

e
M Start up with:
setStart

Slots

The Slots Control Panel options let you activate the slots and ports in your computer. And
you can use the Startup option to change your startup disk drive.

D=Slts=—
Slot 21
Slot 82;
Slot 83;
Slot 8y:
Slot 2y
$lot 86:
Slot 8],
Startup;
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Activating slots and ports

Applications designed for Apple I computers that don't have ports expect to find
peripheral devices connected to slots inside the computer. In order for such software to
work with the Apple [1cs, each port on the Apple 116s is designed to emulate, or act like, a
slot containing a card,

Because each port emulates a specific slot, you can't have both the port and the
corresponding slot active at the same time. You activate one or the other by setting the Slots
options accordingly. When a slot is activated, the words Your Card replace the words
describing the port.

. Important Changes to the Slots options won't take effect until vou restart the
computer,

It's a good idea to make a note when vou change a slot setting, That way vou won't have to
return to the Slots Control Panel to see whether the slot or the port is activated. Fill in the
chart on the inside back cover of your manual with the slot arrangements vou make.

The following list summarizes the appropriate settings for your slots. For each slot, only one
setting is possible at a time. If none of the corresponding conditions applies for a given slot,
it doesn't matter what setting you use for the slot.
= Slot 1 (corresponds to printer port)
If vou have a printer (or any serial device other than a modem) connected to the
printer port, set to Printer,
If you have a modem connected to the printer port, set to Modem.

Ifyour Apple 11Gs has ROM 3 and is part of a network, and if you made the AppleTalk
network system connection through the printer port, set to AppleTalk.

If vou have a device connected to an interface card in slot 1, set to Your Card.
= Slot 2 (corresponds to modem port)

o Ifyou have a modem (or any serial device other than a printer) connected to the
modem port, set to Modem.

If you have a printer connected to the modem port, set to Printer.
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If vour Apple 11Gs has ROM 3 and is part of a network, and if vou've made the
AppleTalk network system connection through the modem port, set to AppleTalk.
1+ Ifyou have a device connected to an interface card in slot 2, set to Your Card,
= Slot 3 (corresponds to built-in text display)
Unless the manual that came with a peripheral device specifically recommends
installing its interface card in slot 3, leave slot 3 empty and leave the slot set to Text
Display (or, in the text Slots Control Panel, to Built-in Text Display).

On earlier models of the Apple 11 family, slot 3 was used for 80-column cards—cards that
made it possible to display text in the 80-column mode instead of the standard mode at
that time, 40-column, By contrast, the Apple 11Gs has built-in 80-column capability.
To allow earlier Apple 11 software to work with the Apple 11Gs, the built-in 80-column
capability was designed to emulate a card in slot 3. Using slot 3 for an interface card
interferes with the computer’s simulation of an 80-column card in that slot, and may
interfere with text display as a result,

= Slot 4 (corresponds to kevboard/mouse port)
 Ifvou have a mouse or other device connected to the kevboard/mouse port (either

directly or via the keyboard), set to Mouse Port,

o Ifyou have a device connected to an interface card in slot 4, set to Your Card.

Important Even if slot 4 is set to Your Card, the computer will recognize a keyboard
connected directly to the keyboard/mouse port. Some applications won't recognize any
devices other than a keyboard connected directly to the kevboard/mouse port.

= Slot 3 (corresponds to disk drive port for 3.5-inch drives)
- Ifyou have one or more 3.5-inch disk drives connected to the disk drive port, set to
Smart Port.

2 Ifyou have a device connected to an interface card in slot 3, set to Your Card,

¢ Note Ifyou've connected a UniDisk 3.5-inch disk drive to a card in slot 5. you must set
Svstem Speed to Normal in the General options, (This does not apply to the Apple 11 3.5
Disk Controller Card.) »
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= Slot 6 (corresponds to disk drive port for 5.25-inch drives)
7 Ifyou have one or more 3.25-inch disk drives connected to the disk drive port or if

vou have vour 5.25 drive daisv-chained to a 3.5 drive, set to Disk Port,
If you have a device connected to an interface card in slot 6, set to Your Card.

= Slot 7 (no corresponding port)
If your Apple 11Gs is part of a network and you made the AppleTalk network system
connection through the printer or modem port, set to AppleTalk. (This setting is
optional—you have access to AppleTalk even if slot 7 is set to Your Card—but some
network-aware applications may expect slot 7 to be set to Applelalk and will have
compatibility problems if that isn't the case. )

If you have a device connected to an interface card in slot 7, set to Your Card.

Changing the startup drive

When you switch on the Apple 1IGs (and assuming your startup slot is set to the default
setting Scan), the first thing the computer does is check its slots for a disk drive controller
card—an interface card that controls one or two disk drives. It looks first in the highest-
numbered slot. If it doesn't find a disk drive card there, it looks in the next-highest-
numbered slot, and so on until it finds one, When it iinds a disk drive card, it checks the
disk drives connected to that card for a startup disk. This method of looking for a startup
device is called scanning,

This process occurs even if your disk drives are connected to ports. (From the
computer's point of view, ports look just like slots with cards in them.) A 5.25-inch drive
connected to the disk drive port looks like a disk drive connected to a card in slot 6. A
3.5-inch drive connected to the disk drive port looks like a disk drive connected 1o a card
in slot 5.

For example, if you have both tvpes of drives connected to the disk drive port, the
computer looks for a startup disk in the 5.25-inch drives before it looks for one in the
3.5-inch drives. That's why vou can remove the disks from your 5.25-inch drives and open
the disk drive doors if you want the computer to start up from a disk in a 3.5-inch drive.

There may be other times when vou want to bypass a disk drive connected to a higher-
numbered slot and start up from a disk drive connected to a lower-numbered slot. If a hard
disk drive is connected to the higher-numbered slot, for example, vou can't bypass it in the
same ways you can bypass 5.25-inch disks.
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However, you can use the Startup option to change vour startup drive. Simply change
the Startup setting from Scan (the standard setting) to the number of the slot
corresponding to the device you want to start up from, For example, if you are using hard
and floppy drives, with your hard drive in slot 6 or 7, setting startup to slot 5 will cause the
computer to start up from the floppy drive rather than the hard drive.

In addition to Scan and the slot options, vou can set Startup to RAM Disk, ROM Disk. or
AppleTalk once the option is installed. Starting up from a RAM disk means restarting the
computer with an application or system disk image that you've copied onto the RAM disk.
Given the amount of memory the GS/0S operating system requires, however, starting up
from a RAM disk usually isn't practical.

Starting up from a ROM disk means starting up from an application permanently stored
on a memory expansion card. There are no applications stored on the Apple Ias Memory
Expansion Card. so unless vou've purchased a memory expansion card from another
manufacturer, you shouldn't set Startup to ROM Disk.

Starting up from AppleTalk means starting up from a file server volume, For more
information, see “Starting up over the network without a local disk,” on page 284, and
“Starting up over the network with a local disk,” on page 288.

It's 4 good idea to make a note of your startup slot (on the inside back cover of this
guide). That way vou won't have to return to the Slots Control Panel to see which slot is
your startup slot.

Sound

Depending on the applications and peripheral devices vou have, you can use your
computer to play sounds and even simulate human speech. The computer also uses sound
whenever it alerts vou with a beep.

n Sl ———=
iy Vol
Sound

&2 Give visuel indication of sounds

Fuent [ Sustem Beep -}

Sound | Mot ossigned |
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You use the Sound options to adjust the volume level of sounds produced by the
computer and to change the pitch of the computer's beep. Drag the scroll box to adjust the
settings. For each change, vou hear an example beep. Keep adjusting until you re satishied
with the volume and pitch.

Giving Visual Indication of Sounds

If vou have difficulties hearing the alert beeps made by the system, vou can have the border
around the desktop flash when an alert is sounded.

Assigning sounds and events

Using the Event and Sound pop-up menus, you can assign unique sounds to specific
COmputer system events.

Time
¢ Note These settings are found under Clock in the text Control Panel. o

You use the Time options to set the computer’s built-in calendar and clock. You can also
change the format in which the date and time are displayed.

=i ==
Time fou 5 of this year.

361 doys left in this year.

@) HWDD/YY @) AWM
CO0/HNAYY (O 24 Hour
IR/ HN/TD

i Sendort Time
I By brghs Time
= Auto doylight sovings

Use the radio buttons to select the way vou want the date to appear—month/day/year.
day/month/vear, or vear/month/day, Radio buttons are also used to select how time is
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displayed—12 hour (AM./2M.) Or 24 hour, Your svstem will automatically make adjustments
for Daylight Savings Time—simply check the hox next to the Auto davlight savings option.
Otherwise, you can select Standard Time or Davlight Time by clicking the appropriate radio
burton.

To adjust the setting for time and date, click on the hour, minute, or second (or month,
day, or vear) and click the up or down arrows until the desired setting is displayed.

Once you've set the date and time correctly, you won't need to change these settings
very often. The clock is even programmed to account for the extra day in leap years.

Time settings in the desktop Time Control Panel take effect immediately. If you notice
that the clock isn't keeping accurate time, ask your authorized Apple service provider to
install a new battery.

Installed networking options

If vou installed anv networking updates, the Control Panels will display icons for the
corresponding options—AppleShare, Namer, Network Printer, and so on. For information
on selecting network devices and services in the desktop Control Panels, refer to
Chapter 12, "Networking the Apple Ilcs,” on page 271.

Leaving the Control Panels

When you've changed all the settings you want, you're ready to leave the Control Panels.
Close all open Control Panel windows. If you want to, you can leave individual Control
Panels open, having closed others (including the Control Panels window itself ).

Leaving the Control Panels 197



COOCOOCRGGEGGEGEG

COOEGGG

COEOG66

VA XL 2 22



Using the Archiver

The Apple 1Gs Archiver is a flexible tool that you can use to back up and restore the
information vou store in Ales. Archiver allows vou to back up an entire volume or 1o back

up selected files from a volume, and to later restore those volumes or files

If vou don't have a hard disk, you may want to skip this chapter. Backing up 3.5-inch or 5.25-
inch disks ro other disks of the same size is most easily done via the Finder. For information
about making copies of files and disks, see “Copying a disk,” on page 97 in Chapter 4, and

“Moving and copying files and folders,” on page 122 in Chapter 5

This chapter contains information on these topics
= ppening the Archiver program

®  setting Archiver preferences

® backing up entire volumes

*  hacking up hle-by-file

» restoring files from Archiver fle-by-fle backups
= restoring volumes from entire volume Archiver backups

= marking Ales automatically



Learning about backup and restore operations

This chapter uses the term polume to refer 10 a disk or server where files can be stored, the
terms drive and device 1o refer to the physical device that receives the backup, and disk
and tape to refer to the physical media that you insert in the drive or device.

The Apple 11Gs Archiver program makes it easy to transport a large amount of
information between different systems. It lets vou back up information from any GS/0S-
compatible source volume (including CD-ROM discs and AppleShare volumes). You can
back up to a disk drive, a tape drive, or a GS/0S file on a device connected to an Apple [1Gs
computer or on an AppleShare volume. Archiver can automatically accommodate naming
differences required by different file systems. (For more information about file systems and
translators, see page 109.)

When you back up to drives that use removable media, Archiver keeps track of the
various pieces—the backup set. Later, when vou insert media for restoring, Archiver
recognizes the proper order of the backup set; it prompts you for the proper piece of the
backup set at the proper time, making it impossible for you to disturb the restoration by
inserting the wrong piece of media at the wrong time.

When you back up to disks, Archiver automatically erases or formats the destination
media, adding to the reliability of the backup procedure. And when you back up to disks in
an Apple 3.5 Drive, special Archiver backup routines provide extraordinary speed,

If Archiver encounters a piece of unusable destination media, it allows you to try
another disk or tape without restarting the entire backup operation. If Archiver encounters
a write error while backing up to a file, the backup stops.

In the case of file-by-file backup, if Archiver encounters a read error during the actual
backup process, it reports the error, and gives vou the option to continue or discontinue
the backup procedure. Archiver also gives you the option of an uninterrupted backup,
which records read errors but continues the procedure. Any errors that occur are reported
in the error summary window after the backup is completed.
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Entire volume backup and restore

Volume backup is useful only when you plan to restore to the same hard disk or to volumes
of the same size (such as floppy disks). You won't have room to restore your volume to a
smaller disk, and—because the process over-writes an entire volume—restoring to a larger
disk wastes space that becomes unavailable.

If yvou select a ProDOS or HFS volume for backup, Archiver can perform a “smart”
backup—saving you time and disk space by backing up only those blocks that contain data.
When you select any other local volume—such as DOS 3.3, Pascal, or High Sierra—Archiver
backs up all blocks of the volume. (To back up AppleShare files, you must use the file-by-
file method.)

You can restore your entire volume backups to any volume that is large enough to
contain the volume vou want to restore, provided it is not the startup volume and contains
no open files.

When vou perform an entire volume backup procedure, Archiver provides the option
to compress the backup. If vour primary concern is speed, vou can disable the compression
option.

File-by-file backup and restore

File-by-file backup gives you the Hexibility to back up as few or as many hiles as vou like. After
you have made your first file-by-file backup, vou can then back up files on an “as needed”
basis; Archiver will automatically identify files that have been modified since your last
backup. That way, you don't have 1o take the time 1o back up all vour files. When you use
the file-by-file method, Archiver doesn't reguire that you restore all the files you back up;
vou can select the files you want to restore. You can also restore files to any other volume
(as long as it has adequate space) without over-writing the contents of that volume.

You can have Archiver automatically select your files for backup or restore—from a set
of criteria that vou define, based on any combination of fife type, name of file, or
modification date.

An Archiver backup keeps vour files organized as well as secure. As you back up files
from a volume, Archiver maintains the folder structure of the original volume.
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Opening the Archiver Program
This discussion assumes your Archiver program is located on the SystemTools2 disk.

| insert the SystemTools2 disk in a disk drive.

-

Open the SystemTools2 disk icon.

3 Copy the Archiver program to your hard disk.

For instructions on copying fles and folders, see Chapter 5, “Working With Files and
Folders,” starting on page 117.

.-L'.‘-..

Eject the Systemlools? disk from the disk drive.

I

Open the Archiver icon on your hard disk.

When vou see the Welcome to Archiver screen, vou're ready to begin working with Archiver.

Welcome to Archiver!

(O Back up entire volume

Archiver (@ Back up files
O Restore backup

(E)

Setting Archiver Preferences
Archiver preferences are set to accommodate most user’s needs. If—after you use the

Archiver program—you find that vou have special requirements, Archiver allows you to set
preferences for the way you backup and restore.
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Follow these steps to set Archiver preference options:

Choose Preferences from the Special menu.

The Archiver Preferences screen appears, with preset options that are designed to
accommodate most users.

Preferences
For bockup:
<] Verify disks after writing
[_|Erase destination mediawithout osking
(=] Interrupt bockup for file read error
] Compress volume bockup
(5] Volume bock up only blocks in use

For restore

flways reploce files with duplicote nomes
Tronslote illegal filenomes outomotically

Pse these sextings: @ now (O olways

CeeD) C® )

Note that the Preferences menu command is available from any of the main backup or
restore screens, as well as from the Welcome to the Archiver screen.

Set your backup preferences.

The backup options are described here with explanations of their appropriate uses. An Xin
the checkbox indicates that the option is turned on.

s Verify disks after writing: Turning this option off is not recommended. Do so only if
you are backing up a large amount of data to disks in an Apple 3.5 Drive, and you don’t
want Archiver to take the time after backup to verifv that the disks were written and can
he read. All other disks or tapes are automatically verified.

»  FBrase destination media without asking: Turn this option on if you don't want
Archiver to prompt vou for confirmation that each destination volume can be erased
and formatted for Archiver backup use.

o Interrupt backup for file read error: Turn this option off if you want file-by-file backup
to proceed uninterrupted even if read errors occur. Such errors are then summarized
in an error window after backup is complete. Reading and writing errors always cause
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an entire volume backup to quit, so you will have to use file-by file backup if the Archiver
encounters errors during an entire volume backup.

®  Compress volume backup: Compression of entire volume backup conserves space on
vour destination disks or tapes. Compression takes extra time, S0 vou may want to turn
the option off if your primary concern is backup speed.

»  Volume backup only blocks in use: Turning this option off is not recommended. Do
so only if vou want to back up all the blocks of a ProDOS or HFS volume, regardless of
whether they are marked as in use in the directory. Note that this option does not apply
t0 DOS 3.3, Pascal, or High Sierra volumes; all blocks from volumes of these file systems
are always written. ( You can back up AppleShare files only by using the file-by-file
method.)

3 Set your restore preferences.

There are two restore preferences; they affect file replacement and translation.

= Always replace files with duplicate names: Turn this option on if vou dont want
Archiver to ask you to confirm replacement of files of the same name on the destination
volume.

= lianslate illegal filenames awtomatically: Turn this option on when you want
Archiver to translate filenames from two different file systems. When the option is off,
vou are prompted to provide names for the backup files and folders that require
translation. (If you're working with only one file system, this option is not relevant.)

4 Set your preference for the Archiver settings.

Ifyou want the option settings to define only the currvent backup or restore operation, click
Now. The settings will not be saved when you leave Archiver. You need to reset your
Preferences the next time vou open the Archiver application.

If you want the options settings to he stored for all subsequent uses. click Always. Note that
these settings will only be saved by the copy of Archiver currently in use, and cannot be
used if vou run Archiver from a write-protected volume.

5 When you've set all your preferences, click OK.

You can now turn to the appropriate section in this chapter which describes the action
vou'll be performing.
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Backing up an entire volume

Entire volume backups must be restored to a volume at least as large as the backup volume,
Restoring to a volume that is larger will permit vou to use the data, but unused space will
be unavailable. To prevent this, use standard-size volumes, such as Hoppy disks or a hard
disk of the same size as the volume you backed up, However, even hard disks of the same
size have various block configurations; it's best to use entire volume backup only for
backups of the same hard disk to which you intend to restore.

~. Important Do not use the volume backup feature to back up a hard disk before
partitioning that volume. If you plan to partition vour hard disk or restore to another hard
disk, use file-by-file backup and select all files rather than using the volume backup.

# Note Entire volume backup can be performed only on a local volume. That is, it can
never be performed on an AppleShare volume. Data on AppleShare volumes can be backed
up only by using the file-by-file method. e

Follow these steps to back up an entire volume with Archiver:

1 Open the Archiver program.

2 Click Back up entire volume, and then click OK.

In a moment, you see a window that prompts you for information about the backup
operation you want to perform.

Volume Backup

Backup from: [IEHER

‘Hard Disk
Bockup to; @) Device =]
G V2
(Contains :Bockupl)

((toncel ) ([ BockUp. J)
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3 Click the Volume button or press Tab until the name of the volume you want to
back up appears in the top section of the window.

4 Select the destination option you want to use for your backup material.
If vou want to back up to a disk or tape drive, select the Device option on the left. If the
device displayed at the right of the window is not the one you want to use for vour backup,
click the Device button or press the Right Arrow kev until the correct device appears.
Clicking the Identify button activates the “in use” light on most devices, which makes it easy
to distinguish between similar drives of the same type.

Important Archiver will not back up to 5.25-inch disk drives or AppleShare volumes when
the Device option is selected. .

If vou want to back up to a file, select the File option to back up to a GS/0S file. Then click
the File button; vou see a dialog box that prompts you to name the file, locate a place 1
store it, and save the file. Follow these steps:

I, Ifyou like, tvpe a name for the file, (You can also accept the default name provided by
Archiver.) Archiver will not allow you to create this file on your source volume.

2. Click the Volumes button to see a list of all available volumes,

3. Select the volume on vour destination drive and click Open. (You can also open a
volume by double-clicking.)

4. Open any folders necessary to locate a place for storing your new file. (Select a folder
and click Open, or double-click a folder.)

5. Ifyou want to create a new folder to store vour file, click in the text box to position the
insertion point, type a name for the folder, and click the New Folder button,

6. Once vou've located a place to store it, type a name for vour file, and click Save.

5 When you have set the volume to back up and located the destination device or
file, click the Back Up button or press Return.
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The Entire Volume Backup window appears, listing the source and destination volumes you
have selected, and noting the size of the material to be backed up.

Entire Volume Bockup

Source: :Hord.Disk
Bestination: DEV2
Bockup Size: 14,908K butes

Enter o comment for this backup set:

If vou have a large amount of material to back up, be sure you have enough disks or tapes
to insert, or that there is enough room on your destination media to complete the backup,
If you're backing up to a 3.5-inch drive, you may need to have a number of blank disks
handy. Be sure that the media you are using is not write-protected and that there is no data
you want to keep since the backup will over-write anything that is on the media.

It's good practice to rotate your backup media. That is, instead of using the same disks or
tapes again and again to back up a volume, use one set for your first backup; then use a
different set for your next backup. Rotate the two (or more) sets. That way, if something
happens to vour most recent backup, vou still have an earlier version of your volume,

Ifvou are not backing up to a file and you choose a hard disk as a destination device,
Archiver asks you to confirm that you want the contents replaced. You can cancel and
choose a different destination device, or you can continue with the operation.

If you are backing up to a file, make certain your destination device has enough free space
to store the backup file.

If you want to enter a comment for your backup set, type it in the first text box.

Entering a comment will help vou identify your backup set when you restore. Your
comment can be anything you want, as long as it's no more than 40 characters long. Dates
and the name of the volume are useful for distinguishing backups.

Archiver also assigns a name to each piece of media in the set. The first piece will be named
ARCHIVER.00001, the second, ARCHIVER.00002, and so on.
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7 Click Begin or press Return.

1f your backup is large enough to require more than one disk or tape, vou're prompted to
insert additional media as needed. A “thermometer” bar indicates the progress of the
backup.

Ifyou click Cancel or press the Escape key, you may have to wait 2 moment while Archiver
recognizes vour request. You'll be asked to confirm that you want to discontinue the
operation. If you want to proceed, you can click Continue; the backup will proceed.

If Archiver encounters an unusable disk or tape, you see a message asking you to try
another disk or tape or to cancel the backup operation.

A Warning If Archiver encounters a source error, the backup stops. Your source volume is
probably damaged: Archiver cannot back it up. In such a situation, it's best to perform a file-
by-file backup so that you can restore your files to a volume that is in good condition. You
may want to try another drive, just to make sure that the problem is not with the drive
you're using.

If Archiver encounters a destination error while backing up to a file, either your
destination media or your destination device may be the problem. Reformat your media
and try again. If the backup fails a second time, replace your destination media. If you are
still unable to back up your volume, your destination device may be defective; try another
device, a

8 When you see a dialog box indicating a successful backup operation, click Quit
or press Return.

To return to the Welcome to Archiver screen for another backup or restore operation, click
Continue.

Backing up file-by-file
Follow these steps to back up selected files with Archiver:

1 Open the Archiver program.
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2

3

4

Click Back up files, and click OK or press Return.

In a moment, you see the Selected Files Backup window, which prompts you for
information about the backup operation you want to perform.

Selected Files Bockap
Backup from: [T
‘Hard.Disk
Bockup to: @ Device lerint]
Cifile

DEv2
(Contains :Bockupl)

[ Concel ) { Files. )

Click the Volume button or Tab key until the name of the volume that contains
the files you want to back up appears in the top section of the window.

Click the destination option you want to use for your backup material.

If vour want to back up to a disk or tape device. and the device displayed at the right of the
window is not the one you want to use for your backup, click the Device button until the
correct device appears. Clicking the Identify button activates the “in use” light on most
devices, which makes it easy ro distinguish between similar drives of the same type.

Important Archiver will not back up to 5.25-inch disk drives or AppleShare volumes when
the Device option is selected. ~

If ou want to back up to a file, select the File option to back up to a GS/OS file. Then click

the Files button; vou see a dialog box that prompts you to name the file, locate a place to

store it, and save the file. To locate the place you want to store your file, follow these steps:

1. Click the Volumes button to see a list of all available volumes,

2. Select the volume on vour destination drive and click Open. (You can also open a
volume by double-clicking it,)

3. Open any folders necessary to locate a place for storing your new file. (Select a folder
and click Open, or double-click a folder.)
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4. Ifyou want to create a new folder to store vour file, click in the text box to position the
insertion point, type a name for the folder, and click the New Folder button.

3. Once vou've located a place to store it, type a name for vour file, and click Save. (Do not
use a filename that already exists on vour backup volume.)

\J

When you have set the volume to back up and located the destination device or
file, click the Files button or press Return.

A dialog box appears, asking if you want to use a saved file list. The first time you back up
selected hles, vou won't have such a list. Click No to continue the program. (You learn how

to create a saved file list in step 6.)

A message appears, telling you that the directory of the source volume is being read; then
a window appears, with the disk directory.

o File (i1 Speeial

Directery of Hord.Disk (13,037K butes)
To be bocked up to QEV2

“ & Prol0s

En System E
D Icons
35 BRSIC Sustem

< 3 Finder Dato

+ 3 Finder Root
£ Club Mewsletter b
0 Gomes 1 l
= Robin L
£m Dale L

— File info

ProD0S B application (SO0FF) 402 files morked
1,481 bytes 13,037K bytes
Hodified on Hon, 10/20/91, 1448 | RApprox. 33 disks needed . .

6 Mark the files you want to back up.
Marking files is a two-step process. First vou select a file by clicking it once; then vou click
the Mark button (or press Command-M). Likewise, to unmark a file, vou select it. and then
click Unmark (or press Command-1). Pressing Command-A will select all files for marking
or unmarking, Some visual cues help vou keep track of which files are marked:
= Acheckmark appears next to the name of a file to indicate that it has been marked.
= Acheckmark appears next to a folder that has been marked (selecting all its files).
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= Afolder icon changes to an open folder when the folder is opened by double-clicking,
The icon changes back to a closed folder when the folder is closed by double-clicking,

s Afolder appears gray when some—or all—of its files are marked, but the folder irself is
not marked.

# Note If you have used Archiver to back up files from this volume before, any files vou
have created or modified since the last backup are automatically marked for backup. You
can unmark such files if you like. o

As you select files, the File Info box in the lower-left corner lists type, size, and date
information about the file or group of files currently highlighted.

To the right of the File Info box, vou see the total number of files marked, their cumulative

size, and an estimate of the number of 3.5-inch disks or tapes that will be needed for the

backup. If you are backing up to a file no estimates will be given.

Ty mark or unmark files, select their filenames and then click either the Mark or the Unmark

button. The following selection procedures are available:

s Toselect wo or more consecutive files, select the first filename and then hold down one
of the Shift keys while vou select the last filename.

= T select two or more files that aren't grouped together; select the Arst flename, and
then hold down the Command key while you select each additional filename.

w  Toselect all the files in a folder, select the folder name.

w o select any (or all) of the files in a folder, double-click the folder to open it. The files
it contains appear indented below the folder; you can select them in the usual way.

16 have files marked automatically according to criteria that you define, follow the steps

in “Marking files automatically,” on page 218 later in this chapter.

To save the files you've marked as a Saved File List, choose Save File List from the File menu.
You'll be prompred to name the Saved File List, which retains all the filenames and their
hierarchy, the state of opened and closed folders, and the marked or unmarked status of
the files. You can then conveniently back up these files again at 4 later time.
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7 When you finish marking all the files you want to back up, click Back Up or press
Return.

The File Backup window appears, listing the source and destination you have selected, and
noting the cumulative size of the files 1o be backed up.

If you have a large amount of material to back up, be sure you have enough disks or tapes
to insert, or that there is enough room on your destination media to complete the backup.
If vou're backing up to a 3.5-inch drive, vou may need to have a number of blank disks
handy. Be sure that the media you are using is not write-protected and that there is no data
you want to keep on the media since the backup will over-write anything that is on the
media.

It's good practice to rotate your backup media, That is, instead of using the same disks or
tapes again and again to back up your files, use one set for your first backup; then use a
different set for your next backup. Rotate the two (or more) sets. That way, if something
happens to your most recent backup. vou still have an earlier version of your files,

8 If you want to enter a comment for your backup set, type it in the first text box.

Entering a comment will help you identity vour hackup ser when you restore and
distinguish it from other backup sets. Your comment can be anything you want, as long as
it's no more than 40 characters long, Dates and the name of the volume are useful for
distinguishing backups.

Archiver also assigns a name to each piece of media in the set, The first piece will be named
ARCHIVER.00001, the second. ARCHIVER.00002, and so on.

O Click Begin.
If you're backing up to a 3.5-inch disk drive or a tape drive, you're prompted to insert disks
and tapes as needed. A “thermometer” bar indicates the progress of the backup.
Ifyou click Cancel, you may have to wait a moment while Archiver recognizes your request.
Then you're asked to confirm that vou want to discontinue the backup. If you want to
proceed with the backup, click Continue. If vou click Stop to discontinue the backup you
will return to the starting screen of the Archiver program.
If Archiver encounters an unusable disk or tape, vou see a message asking you to try
another disk or tape or to cancel the backup operation.
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If Archiver encounters errors during the backup operation, what happens depends on the

setting you selected via the Preferences command in the Special menu (see page 202):

* [fyou accepted the “Interrupt file backups for file read errors” setting, you see a
message informing you that the file could not be read, and asking you if you want to
continue or discontinue the backup. If vou continue, Archiver records the read errors.
When the backup is complete, Archiver gives you the option to see a list of all files that
could not be successfully archived. You may want to make a note of such files.

» [fyou deselected the “Interrupt file backups for file read errors” setting, Archiver
doesn't interrupt the backup to report the read error. Read errors are recorded and
reported when the backup is complete. You may want to make a note of files that are
not archived.

= I Archiver encounters an error while backing up to a file, either your destination
media or your destination device may be the problem. Reformat your media and try
again. If the backup fails a second time, replace vour destination media. If vou are still
unable to complete the backup, your destination device may be defective; try another
device.

10 when you see a dialog box indicating a successful backup operation, click Quit.

When the operation is complete, vou are notified if errors occurred and asked if you want
to see the error summary window. If you open the error summary window, you can click
on any of the files listed to see the specific error encountered when reading that file.

You can click Continue to return to the Welcome to Archiver screen for another backup or
restore operation.

Restoring files from Archiver file-by-file backups

Follow these steps to restore files with Archiver:
1 Open the Archiver program.

2 Click Restore backup. Then click OK or press Return.
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In a moment, vou see the Restore window, which prompts you for information about the
restoration vou want to perform.

Restore
Hestore from: @) Device | =1
S

DEY2
(Contoins :Bockupl)
Backup set comment: (insert Archiver disk_)

Disk/Tape number:
Total hackup size:

Restore to:

(Cancel ] ([ Files. |

3 Click the source option you want for the backup set you want to restore.

If you want to restore from disk or tape, click the Device button or the Right Arrow key
until the name of the device that contains your backup set appears on the right.

If you want to restore the backup set from a file. select the File option to restore from a
GS/0S file. Click the File button; a dialog box appears that allows you to specify the location
of the backup file you want to restore.

Important You must insert the first piece of media from your backup set and select it
before Archiver can begin the restoration. If you insert the wrong disk, Archiver prompts
vou to insert the first one. If you can't locare all the pieces of your backup set, Archiver
cannot complete the restoration.

HE~

Click the Folder button.

A dialog box appears, prompting vou to locate and name a new folder to which vou can
restore the backed up files.

R R

Name the new folder and where it is to be created, and click OK (or press
Return),
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Important Make sure that there is enough free space on the destination device to hold all
of the material vou intend to restore.

O  Click Files.

A window appears with a directory that lists the files in your file-by-file backup set.

o File (a1 Specinl

Bockup set: Hemo bockups (3,005 bytes)
To be restored to Kard Disk:Club Newsletter:DalesHemas

[ RevisedMemo
O3 ClubHemo
[ HewHemo

3 Memol

T

~— File infg —M8M8M8

Folder (S00F) 0 files marked

Shyes X ber
Wodified on Sun, 172692, 1330

7 Mark the files you want to restore,

You don't have to restore all the files in your backup set. You mark or unmark files for
restoration in the same way vou mark or unmark them for backup. Follow the guidelines
on page 210, or—if you want your files marked automatically according to criteria you
define—follow the instructions for marking files automatically, page 218

As you select files, the File Info box in the lower-left corner lists size, date, and type
information about the file or group of files currently highlighted.

To the right of the File Info box, you see the total number of files marked, and their
cumulative size.

8 When you finish marking all the files you want to restore, click Restore.

A window appears, listing the source and destination you have selected, and noting the
cumulative size of the files to be restored.

O Click Begin.
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You are prompted to insert disks or tapes as needed. A “thermometer” indicates the
progress of the restore operation.

Ifvou click Cancel, vou may have to wait a moment while Archiver recognizes your request.
Then vou're asked to confirm that you want to discontinue the restore procedure. If you
want to proceed with the restoration, click Continue.

A Warning If Archiver encounters an error, the restoration stops; a message tells vou
whether the error occurred on the destination or the source device.

If Archiver encounters a source error; vour backup set is probably damaged; Archiver
cannot restore it, You may want to ey another drive, just to make sure that the problem is
not with the drive you're using,

If Archiver encounters a destination error, either your destination media or vour
destination device may be the problem. Reformat your media and try again. If restoration
fails a second time, replace your destination media. If you are still unable to restore, vour
destination device may be defective; trv another device. &

10 when you see a dialog box indicating a successful restore operation, click Quit.

You can click Continue to return to the Welcome to Archiver screen for another backup or
restore operation,

Restoring volumes from entire volume Archiver backups

Follow these steps to restore entire Archiver volume backups:

1 Open the Archiver program.

2 Click Restore backup, then click OK or press Return.
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In a moment, you see the Restore window, which prompts you for information about the
restoration you want to perform.

Restore
Restare froa: gh\du | (k) =
File
= tmmiﬁmmi
Backup set comment: {insert Rrchiver disk. )
Disk/Tape number:

Total bockup size:

Restore to:

((Concel ) ((_files. )

If necessary, click the Device button or the Right Arrow key until the name of the
device from which you want to restore your material appears at the top right of
the window.

If you want to restore the material from a file, click File. A dialog box appears, prompting
you 1o specify the file from which you want to restore your data,

Click the Volume button or press Tab to select the volume to which you want to
restore your data.

The selected volume must be large enough to hold all of the data vou are restoring.

Warning The selected volume will be completely overwritten by the restoration process.
Even its name will be the same as that of the volume originally backed up. Make sure that
the volume you select doesn't contain data you want to keep. If you are in doubt, quit
Archiver and use the Finder to confirm that all of the files are expendable. Back up any files
you need. a

Click Restore or press Return.

Unless vou have set the preferences 1o not notify you, a message appears, asking you to
confirm that you want to replace your destination volume with the contents of the volume
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backup. After checking to make sure you've specified the correct source and destination
volumes, click Continue.

The Restore window appears, listing the source and destination volumes you have selected,
and noting the size of the volume to be restored.

O Click Begin.
You'll be prompred to insert disks or tapes as needed.
A “thermometer” indicates the progress of the restore operation.

If vou click Cancel, you'll be asked if you want to continue or discontinue the operation.

A Warning If Archiver encounters an error, the restoration stops; a message tells vou
whether the error occurred on the destination or the source device.

If Archiver encounters a source error; your backup set is probably damaged: Archiver
cannot restore it. You may want to try another drive, just to make sure that the problem is
not with the drive vou're using.

If Archiver encounters a destination error, either your destination media or your
destination device may be the problem, Reformat your media and try again, 1T restoration
fails a second time, replace your destination media. If you are still unable to restore, your
destination device may be defective; try another device. a

7 When you see a dialog box indicating a successful restore operation, click Quit.

You can click Continue to return to the Welcome to Archiver screen for another backup or
restore operation,

Marking files automatically

When you back up or restore using the file-by-file method, vou can have the files marked
(or unmarked) automatically according to criteria you define. The Auto-Mark dialog box lets
you combine options including file rypes, file names, and last modification date, to identify
the files vou want to mark (or unmark).

218 Chapter 8 Using the Archiver



Follow these steps to have Archiver mark your files automatically:

Click the Back up button in the Selected Files backup window or click the

Restore button in the Restore window.

If you're backing up files, follow steps 1-3, starting page 208.

If vou're restoring files, follow steps 1-6, starting page 213.

A window appears listing the files you can select.

Click Auto.

The Auto-Mark window appears, with a number of pop-up menus that allow you to set
criteria for files 1o be marked (or unmarked) automarically.

o file i

Special

of Hard.

Hete-Nark
files whese_
nome begins with _§ | ]
Cimo  [J0R
[Tnmee Begins with [ ]
CIad TR
i_e-EI"Il-I"J” With ] | ]

((toncel ) L ox )

Choose whether to mark or unmark files.

If vou want to mark files, the current setting of the first box—Mark—is correct.

If you want to unmark files, position the pointer on the Mark hox;, hold down the mouse
button to display the pop-up menu, drag to the Unmark setting, and then release the
mouse button, The pop-up menu disappears, and the new setting appears in the box.
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4 Use the upper set of boxes to define your first criterion.

You choose a category from the box on the left, and then specify selection criteria
information in the box on the right.

Buto-Mark
files whose..

[ J
nome ends with
nome contuing 1
file type is I
mod dote is ofter
mod dote is before { |

( Concel } I 0K |

Position your pointer on the first box in the left column where the current setting is shown,
then hold down the mouse button to display the pop-up menu, drag to the setting vou
want, and release the mouse button. You can choose from these options:

®  Filetype is Use this option 1o select all files in the selection window that match the file
type you then designate in the corresponding box in the right column. When you
choose the file type is option, the box on the right becomes a pop-up menu, allowing
vou to choose the file type vou want.

«  Name begins with, comtains, or ends with Use one of these options to select all files
that start with, contain, or end with the character or characters you type into the
corresponding box in the right column.

»  Modification date before or after Use these options to select all files that were
modified before or after the date vou set in the corresponding box in the right column.
When vou select either of the modification date options, the box on the right displays
a date format. Select the month, day, vear, or time, and then click the arrows—up or
down—until you reach the setting you want.

5 If you want to add to your file selection criteria, click @i or or and continue in
the second and third sets of boxes.

Clicking and will mark files that belong to the logical intersection of the criteria vou
describe in the boxes,
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Clicking or will mark files that belong to the union of the criteria you describe in the boxes.

For example, if you want to mark all Apple 116s word-processor files that were modified
after January 1, 1991, whose names begin with the letter “J." you're looking for files in the
intersection of those categories. You'll select the word and.

1f you use the qualifier, or; vou'll mark all the files in each of the categories. In the example,
vou end up with a much larger selections of files: all Apple [1Gs word-processor files, all files
that were modified after January 1, 1991, and all files whose names begin with the letter “J.”

If you were to select and between the first two criteria of the example, and then select or
between the last two, the example selection would mark all Apple 11Gs word-processor files
that were modified after January 1, 1991 and all files that have filenames beginning with the
letter “]."

O When you've finished defining your criteria, click OK.

The files that match your criteria are marked or unmarked, as you have specified.

& Note Auto mark can be used repeatedly to specify various groups of files or
interspersed with manual file selection,

/[ Continue your backup or restoration process.

If you are backing up files, go to step 8 of “Backing up files,” page 212.

If you are restoring files, go to step 9 of “Restoring files,” page 215.
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Using the Advanced Disk Utility

The Advanced Disk Utility is primarily used for hard disks and provides convenient disk
preparation functions. It even allows you to prepare a hard disk for use on a Macintosh

computer.
Ifyou don't have a hard disk and you don’t want to zero any disks, vou can skip this chapter.

This chapter contains information on these topics:

» understanding and launching the Advanced Disk Utility
» nitializing a disk

= erasing a disk

= zeroing a disk

= partitioning a hard disk

» getting information about a disk



Understanding Advanced Disk Utility Functions

The Advanced Disk Utility (ADU) program includes four functions: initializing, erasing,
zeroing, and partitioning.

+ Note You can erase and initialize any disk by using the Finder (as long as the disk is not
the startup disk). Zeroing a disk—in effect, erasing all of the data on a disk—is available only
in the Advanced Disk Utility. Partitioning—that is, dividing a SCSI hard disk into separate
sections—can be done only in the Advanced Disk Utility. If you want to hard format a disk
that you plan to connect to a Macintosh computer, you can do so only by creating a single
partition in the Advanced Disk Utility. o

[fyou think of the information you want to store on your disk as so many cars to be parked,
a brand new disk is like a parking lot with no lines to divide the spaces. There's no
organizational structure for the information, and the computer can't find data without such
a structure. That's why disks must be prepared to store information.

Here's how the four functions of the Advanced Disk Utility fit into the parking lot analogy:

= Initializing a disk is like painting lines to separate the parking spaces and then adding
anumber to each space: It divides the disk into discrete areas (called tracks and sectors)
and establishes an organizational system (called a file system) to keep track of what
information goes in which space.

= Frasing a disk is like removing all the cars from the parking lot: The tracks and sectors
remain, so the disk is able to receive new data from any application that uses the file
system chosen during the erasing procedure.

= Zeroing a disk is like removing the cars and painting over the numbers of the parking
spaces. Only the tracks and sectors remain; the file system is eliminated. A disk that has
been zeroed must be initialized again before it can store information,

» Fartitioning a hard disk is like dividing one large paved surface into several smaller
parking lots. Each partition can be initialized with its own file system, just as each of the
smaller parking lots can be numbered with its own numbering system. You can even
establish a partition in HFS format so that vou can use the hard disk on a Macintosh
computer.
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Launching

[nitializing

Apple 1165 Advanced Disk Utility vll

( Zero. ] [Initiolize.) | [ Disk ]

( Info ) ( Erase. ) [T

The disk name is Hord.Disk

Figure 9-1 The Advanced Disk Utility screen

the Advanced Disk Utility

Keep in mind that you cannot perform ADU functions on the startup disk. It may be
necessary 1o change the startup slot setting in the Slots Control Panel so that the computer
will start up from a drive other than the disk on which you'll be using ADU functions. For
instructions, see “Changing the startup drive,” on page 194 in Chapter 7.

The Advanced Disk Utility is located on the Systemlools! disk.

All four functions start from the Advanced Disk Utility screen, shown in Figure 9-1. To
get to this screen, locate the Adv.Disk.Util icon and double-click it to launch the program.

From the Advanced Disk Utility, you can initialize, erase, zero, or partition a disk. You
can also use the Info button to get information about any disk. Go on to the appropriate
section for further instructions.

Initializing a disk prepares it to receive information. It divides the disk into tracks and
sectors (sections where information can be stored) and writes a file system on the disk.
Applications that use the file system can then store and find data on the disk.

Warning Initializing erases all data on a disk. Don't initialize a disk if it contains any
information you want to keep. A
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Initializing a disk with the Advanced Disk Utility has exactly the same effect as initializing a
disk with the Finder. Unless you're already using the Advanced Disk Utility for another
reason, it’s generally more convenient to use the Initialize command in the Disk menu of
the Finder when you want to initialize a disk.

# Note Ifyour hard disk is not partitioned, initializing it in the Finder or in the Advanced
Disk Utility imposes a hard formar, after which the hard disk will no longer work with a
Macintosh computer unless you repartition it. If you want a hard format (usually only when
your hard disk has been used before and you need to ensure its reliability) and vou plan to
connect your hard disk to a Macintosh computer, vou can do so by creating one partition
on your hard disk. Turn to “Partitioning,” on page 231. «

The following instructions assume that vou're starting from the Advanced Disk Utility
screen. If you aren't, follow the steps in “Launching the Advanced Disk Utility” earlier in this
chapter.

Follow these steps to initialize a disk:

1 Select the disk you want to initialize.

Click the Disk button (or press Tab) until the name of the disk you want to initialize appears
at the bottom of the Advanced Disk Utility screen. (It may be necessary to eject the
System.Disk disk or the SystemTools? disk and insert the disk you want to initialize.)

I~

Click Initialize.

You see a dialog box asking vou to name vour disk.

3 Type a name for the disk, using the appropriate naming conventions.

Be sure to follow the naming rules on page 91. Should you deviate from the rules, they will
appear at the bottom of the dialog box for reference, If you want to keep the existing name,
2o on to the next step.
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4 If necessary, select a file system and a disk format.

The list on the left of the dialog box shows the file systems available on the startup disk.
(Unless vou have installed a file system translator for the HFS operating system, you'll see
only ProDOS here. For information about file system translators, see page 109.)

The list on the right shows disk formats or disk sizes, depending on the type of disk you're
trving to initialize.
When initializing a 3.5-inch disk in an Apple 3.5 Drive, you're given a choice of two formats:
800K 2:1 and 800K 4:1. The 2:1 and 4:1 labels refer to the number of rotations used to read
data from the disk.

s [ you'll be using the disk primarily in an Apple 3.5 Drive, accept the highlighted
option, 800K 2:1.

w [fyou'll be using the disk in both Apple 3.5 Drives and UniDisk 3.5-inch drives, select
the BOOK 4:1 option.

= Ifyou'll be using the disk primarily in a UniDisk drive, select the 800K 4:1 option,

& By the way The easiest way 1o tell the difference berween Apple 3.5 and UniDisk
drives is by the color: UniDisk drives are white, and Apple 3.5 Drives are platinum (the same
color as the computer). Each type of drive is also identified on its underside.

IFyou have an Apple SuperDrive connected to an Apple I 3.5 Controller Card in your Apple
1IGS, you will also be able to format vour disk at 1.4 MB.

When initializing a high-density floppy disk or a hard disk, you have a choice of two formats:
1:1and 2:1. The 1:1 option is more efficient; select the 2:1 option only if you're using an
Apple SuperDrive (connected to an Apple 11 3.5 Controller Card) or an earlier model SCSI
card (such as the Apple 11 SCSI Card). If you're using the Apple 11 High-Speed SCSI Card for
your hard drive, select 1:1. (If you're not sure about your card's requirements, check the
manual that came with the card.)

¢ Note Hard disk interleave options are presented only if the disk being initialized has
not been partitioned.
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Erasing

5 Click Initialize or press Command-Return.

After a few moments you return to the Advanced Disk Utility screen. A message at the
bottom of the screen tells you whether the initialization was successful. If initializing was
not successful, see the troubleshooting information on page 313.

If you want to partition, initialize, erase, or zero another disk, turn to the appropriate set of
instructions. If vou're finished using the Advanced Disk Utility, click Quit or choose Quit
from the File menu (or press Command-Q),

If you want to remove all the files from a disk vou should erase it. When you erase a disk.
an empty directory is written to the disk. When you open the disk icon on the desktop, file
and folder icons no longer appear—because it is the directory that lets vou see files and
folders on a disk. The files are still there, bur without a directory they're invisible—and
inaccessible, unless yvou know how to find the data on a disk without a disk directory.

Erasing a disk with the Advanced Disk Utility has the same effect as erasing a disk with
the Finder, Unless you're already using the Advanced Disk Utility for another reason, it’s
generally more convenient to use the Erase command in the Disk menu of the Finder when
you want to erase a disk.

Ifyou're using a floppy startup disk and you used the Installer to install the “File System:
HEFS FST” update, the Advanced Disk Utility allows you to select the file svstem with which
you plan to use the disk after you erase it. Otherwise, the disk will be in the ProDOS format.

¢ Note If vou want to completely destroy the data on a disk so that no amount of
software manipulation can ever recover it, you should zero the disk rather than erase it. For
instructions, see “Zeroing,” on page 230 later in this chapter. &

The following instructions assume that you're starting from the Advanced Disk Utility
screen. If you aren't, follow the steps in “Launching the Advanced Disk Utility,” on page 225
earlier in this chapter.

228 Chapter 9 Using the Advanced Disk Utility



I~

Follow these steps to erase a disk:

Select the disk you want to erase.

Click the Disk button (or press Tab) until the name of the disk you want to erase appears
in the description at the bottom of the Advanced Disk Utility screen. (It may be necessary
to eject the System. Disk disk or the SystemToolsI disk and insert the disk you want to
initialize.)

¢ By the way If the selected disk has not been initialized, the Erase button is dimmed
and you can't erase the disk. «

Click Erase.

You see the Erase dialog box.

Erose device APPLEDISKI 5B

This operation will destroy all of the
information on this disk.

(_toncer ) [ frose )

The window on the left shows the available file systems; the one for which the disk was
initialized is highlighted. Select the one for which you plan to use the disk after you erase it.

The window on the right shows the size of the disk.

Type a name for the disk, using the appropriate naming conventions.

Be sure to follow the naming rules on page 91. When you begin typing, a summary of the
naming rules appears at the bottom of the dialog box for reference. Should you deviate
from the rules, a message appears telling you the name given is unacceptable—try again. If
you want to keep the existing name, go on to the next step.
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Zeroing

4 Click Erase or press Command-Return.

Aftera moment you return to the Advanced Disk Utility screen. A message at the bottom of
the screen tells you whether the erasing was successful. If erasing was not successful, see
the troubleshooting information on page 313.

If you want to initialize, erase, zero, or partition another disk, turn to the appropriate set of
instructions. If vou're finished using the Advanced Disk Utility, click Quit or choose Quit
from the File menu (or press Command-Q)).

Zeroing a disk wipes out everything on the disk. Unlike erasing, zeroing eliminates not only
the disk directory, but also all the files and the file system. Only the tracks and sectors
remain, and a character pattern is written to them—making it impossible to recover the
dara. After zeroing, a disk must be reinitialized before it can receive new data.

In most cases, erasing a disk is sufhcient. But there may be times when you need to zero
a disk rather than erase it. If you have highly confidential information that you want to
destroy, for example, erasing may not be a sufficient precaution,

Since erasing removes only the disk directory (leaving the files invisible but intacr),
someone with a lot of computer knowledge may be able to reconstruct the files on an
erased disk. When you zero a disk, on the other hand, the computer actually writes over all
the data (along with the file system), so no one can reconstruct the information that was
there without special hardware.

Because zeroing involves writing over everything on a disk, it can take a long time—
especially if you want to zero a large-capacity disk such as a hard disk or a hard disk
partition. As a result, you probably won't want to zero disks unless it's important to do so.

The following instructions assume that you're starting from the Advanced Disk Utility
screen. Ifyou aren't, follow the steps in “Launching the Advanced Disk Utility,” on page 225
carlier in this chapter.
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Follow these steps to zero a disk:

1 select the disk you want to zero.

Click the Disk button (or press Tab) until the name of the disk you want to zero appears at
the bottom of the Advanced Disk Utility screen. (It may be necessary to eject the
System. Disk disk or the SystemIools] disk and insert the disk you want to zero.)

| S

Click Zero.

A dialog box appears warning you that zeroing will destroy everything on the disk and may
take a long time.

3 Click Zero to proceed with the zeroing operation.

You see the messages “Setting up buffers” and then “Zeroing disk...This could take a while”
at the bottom of the Advanced Disk Utility screen,

When zeroing is complete, a message at the bottom of the screen tells you whether the
operation was successful. If zeroing was not successful, see the troubleshooting
information on page 313.

4 Reinitialize the disk.

When zeroing is complete, you must reinitialize the disk before it can receive new darta.
Follow the steps on page 227,

If vou want to initialize, erase, zero, or partition another disk, turn to the appropriate set of
instructions. If you're finished using the Advanced Disk Urility, click Quit or choose Quit
from the File menu (or press Command-Q),

Partitioning

When vou partition a hard disk, you are in effect dividing it into a number of smaller disks.
The physical hard disk doesn't change, of course, but the computer recognizes each

partition as if it were a separate disk. You can initialize, erase, or zero one partition without
affecting the others. And you can even use different file systems on the different partitions.
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Hard disk icon Hard disk partition icon
Figure 9-2 Hard disk and hard disk partition icons

For example, you might want to use part of your hard disk for the ProDOS file system, and
part for the HFS file system. That way, you can store your data from the Macintosh
environment on the same disk as your data from the ProDOS environment. If you have an
external hard disk, vou can connect it to either your Apple 11Gs or to a Macintosh computer
providing a complete interchange of data.

A Warning Once vou connect vour hard disk to a Macintosh computer, you must run the
Apple HDSC Setup program from the Macintosh and use the “Update” function to update
vour disk with necessary information. Refer to the manual that came with vour HDSC Setup
utilities. &

Partitions have their own icons (see Figure 9-2), which look similar to hard disk icons but
represent the fact that the partition is part of a hard disk, and not a physically separate disk.
A partition icon functions like any other disk icon; vou can select it and use the commands
in the Disk menu to initialize, erase, or verifv the corresponding partition, and all the same
restrictions apply to it as apply to other disk icons,

¢ Note Itis possible for a hard disk to have only one partition. In this case, it will still have
a regular hard disk icon. «

Using Partitions

If you have a SCSI hard disk larger than 32 megabytes (MB) and want to initialize it for use
with ProDOS 8 applications, you can use partitions to take advantage of the disk’s full
storage space.
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Under the ProDOS file system, the number of partitions allowed on a device varies from 8
to 32, depending on the size of the device. Table 91 illustrates how these rules apply to
hard disks of various sizes.

Table 9-1 Maximum partitions available in various hard disk capacities

Disk size Maximum partitions
20 MB 8
4 MB 8
R MB ]
100 MB 8
256 MB 8
320MB 10
512MB 16
640 MB 20
8OO MB 25
1 GB and up 32

You may find it convenient to use partitions simply as an organizational device. If two
people use a hard disk, for example, you may want to create a partition for each person.
If you've already partitioned your hard disk with the HDSC Partition program on the Apple
11 SCSI Card Utilities disk, you don't need to repartition it with the Advanced Disk Utility.
But there are two potential advantages to doing so:

* You can create an HFS partition making your hard disk compatible with Macintosh
computers. However, you must make vour first partition a ProDOS volume if vou want
1o use the drive as your startup drive for vour Apple IIGs.

* Ifyou're using a large capacity hard disk (over 128 MB), the larger number of partitions
allowed by the Advanced Disk Utility may let you take advantage of storage space that
would be wasted if you used the HDSC Partition program.

The HDSC Partition program lets you have up to four partitions of 32 MB each
corresponding to a single SCSI card. With the Advanced Disk Utility, on the other hand, vou
can have as many as 32 partitions on each SCSI hard disk connected to the SCSI card
provided you have the disk capacity. (See Table 91 for details.)
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Important Partitioning erases all the data on all partitions on a hard disk. For that reason,
partitioning is something you probably want to do only when you first install a new hard
disk.

Note that ProDOS 8 applications can use no more than 14 devices. If you have a large

number of devices connected to your computer, this may limit the number of ProDOS 8
partitions that will function with ProDOS 8.

If you should ever need to repartition a hard disk, be sure to make a backup copy of
everything on the disk first. The Apple 1165 Archiver on your SystemTools2 disk makes it easy
to back up a hard disk. It accommodates file system differences, including naming
variations, and maintains the structure of your files in the backup. The Archiver copies vour
data onto sets of 3.5-inch disks, onto another hard disk, or onto tape, For more information,
see Chapter 8, “Using the Archiver,” starting on page 199.

You can also use the backup programs on the Apple I SCSI Card Utilities disk or the
Apple 11 High-Speed SCSI Card Utilities disk, or you can even use the Finder to back up your
hard disk onto another hard disk or onto sets of 3.5-inch disks.

Partitioning your hard disk

The following instructions assume that you're starting from the Advanced Disk Utility
screen. If you aren't, follow the steps in “Launching the Advanced Disk Utility,” on page 225
earlier in this chapter.

Follow these steps to partition a hard disk:

1 Select the hard disk you want to partition.

Click the Disk button (or press Tab) until the name of the hard disk you want to partition
appears at the bottom of the Advanced Disk Utility screen. (You won't be able to partition
any disk already in use, such as the startup disk or the disk from which you launch the ADU
program. ) If the hard disk has not vet been initialized, the message at the bottom of the
screen says “Uninitialized or no disk in drive.”

If you're repartitioning a hard disk, select any partition of the hard disk.
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2 Click Partition.
You see a dialog box reminding vou that partitioning will destroy all data on all partitions on
the hard disk and asking whether you really want to partition the hard disk.

Click Cancel if vou want to stop the partitioning process.

3 Click OK to continue with the partitioning operation.

You see the Partition dialog box.

T —
C= )

Crartition ) [9]

= UNTITLEDL (104%)

WM

Note that the dialog box has a button labeled Partition. This button saves all changes you
make in the dialog box. Don't click this button until you've created, named, and sized all
the partitions you want. Once you click this button, you won't be able to add, delete, or
resize any partitions without starting the partitioning process over from the beginning.

4 Name the first partition.
When the Partition dialog box first appears, it includes only one partition, called
UNTITLEDI. (1f the hard disk has been partitioned before, you may see the names of the
existing partitions.)
This name appears in both the partition list (the window in the upper-left corner) and in
the name box below the partition list.

Tvpe a new name for the partition. Although partitions have no naming conventions, the
name you type will appear as the default name when vou initialize the volume. At that point
(step 13), you need to follow conventions for the file system vou select for your volume. If
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vou want the partition and the volume to have the same name, keep the appropriate file
system naming conventions in mind as you name the partition,

Once you assign a name (o a partition, you can't change it without repartitioning the entire
hard disk. You can change the name of the icon that corresponds to the partition—just as
vou can rename any other disk icon in the Finder. However, although you may rename the
icon, the name you see in the partition dialog box is the one vou originally assigned.

5 Set the partition’s size.

The bar graph to the right of the partition list shows how the space on the hard disk is

divided. A different color (or shade of gray if you have a monochrome monitor) is used for

each partition you create.

The scroll bar to the right of the four buttons lets you change the size of the selected

partition. You can change the partition size in increments of 0.5 MB. To change the size,

reposition the scroll box within the scroll bar using any of the following methods:

= To move through the scroll bar one increment (that is, 0.5 MB) at a time, click the
upper scroll arrow (to increase the size) or the lower scroll arrow (1o decrease the size).

= 1o move through the scroll bar four increments (that is, 2.0 MB) at a time, click the
shaded area above the scroll box (to increase) or below the scroll box (to decrease).

= 1o move quickly through the scroll bar, drag the scroll box to the desired location.
(Then, if necessary, use the previous techniques to adjust the partition size.)

When you reposition the scroll box within the scroll bar, the corresponding segment of the

bar graph changes to reflect the new percentage of total space allocated to the selected

partition.

6 Press Return to confirm the name and size you specified.
The partition name changes from UNTITLED]1 to the name you provided in step 4.

7 Click New to create the next partition.

A new partition named UNTITLED! appears in the list. (If you didn't rename the previous
UNTITLED1 partition, the new partition will be named UNTITLEDZ.) In addition, the bar
graph now shows a new partition, in the new color (or shade of gray). The scroll box in the
scroll bar also shows the new partition’s color.
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11

Ifall of the available space has been used on the hard disk, vou will not be able to click New
again; go on to step 12,

Name the new partition.

Type a new name.

Set the new partition’s size.

Reposition the scroll box in the scroll bar (using any of the methods described in step 5) to
the partition size you want.

IFyou try to assign more than the total amount of unassigned space on the hard disk, you
hear a beep and the ADU will automatically adjust the size to the remaining space.

Press Return to confirm the name and size you specified.

Skip to Step 13 if this is all vou want to do.

Repeat steps 7 through 10 to create additional partitions as needed.

Create only as many partitions as you really need. The more partitions vou use, the slower
your computer's access to information on the hard disk will be.

Keep in mind that eight is the maximum number of partitions for disks of 300MB or less
(see Table 9-1 on page 233).

When all space on the hard disk has been allocated, the Partition dialog box looks like this:.

Partitionl (40%)

—Partition 2 (51%)
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12 Make any final changes to partition names and sizes.

If you change vour mind about a partition name, or decicle that a partition should be larger
or smaller, select the name in the partition list and make the necessary change. (Be sure to
press Return to confirm the change.)

If you've already allocated all the space on the hard disk and then decide that you want o
enlarge a partition, you must first select a different partition and reduce its size accordingly.

If you decide to eliminate a partition altogether, select its name in the partition list and click
Delete. ( You can delete all but one partition; when you have only one remaining, the Delete
button is dimmed.)

Before you go on to step 13, make sure that you've allocated all the space on the hard disk.
Any space left unallocated when you click Partition will be wasted—unless you go back and
repartition the entire hard disk.

l?} Click Partition.

A dialog box appears for the first partition. The window on the left shows the available file
systems. If you installed the HFS file system translator, you'll see ProDOS and HFS.
Otherwise, you see only the ProDOS file system. Select a file system for your volume.
Remember that the first partition must be initialized as a ProDOS volume if you plan to use
the hard disk as a startup drive. (For information on installing translators, see Chaprer 2,
“Using the Installer,” starting on page 19)

If the partition name you assigned doesn’t follow naming conventions for the file system
you assign to this volume, type a name that follows the appropriate rules.

The window on the right shows the size you assigned this partition.

Initiolize device APPLESCSL.HO0Z.00

v (RO )

FraD0s

O

& This operotionwill destroy all of the
information on this disk.
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# Note Ifyou've set up only one partition, a dialog box appears, asking vou if you want a
hard format. Click No unless vou require a hard format to ensure that any detectable defects
are removed from the disk. After the hard format, a dialog box appears, asking if you plan
to connect your disk to a Macintosh computer. If vou click Yes, special additional formatting
requires about 128K on your hard disk. If you click No, the button you click in step 14 is
Erase, instead of Initialize. o

In some cases, you may see a message stating that ADU was unable to load the Macintosh
driver, and that HFS partitions will not be usable on Macintosh computers. Should you
receive this or other error messages, turn to the troubleshooting information starting on
page 313.

Click Initialize or press Command-Return.
The partition is initialized for use with the file system selected above.

After a moment, the same dialog box appears for the next partition.

¢ Note Ifyou click Cancel instead of Initialize, the partition will still be created, but it
won't be initialized, and its icon won't be given the name you assigned in the Partition dialog
box., To initialize the partition later, follow the instructions in “Initializing,” on page 225
earlier in this chapter.

Repeat step 14 for each additional partition.

When you've initialized the last partition, you return to the Advanced Disk Utility screen. A
message at the bottom of the screen tells you whether the partitioning was successful, If
partitioning was not successful, see the troubleshooting information on page 313.

If you click the Disk button (or press Tab) to cycle through the available volumes, you see
a partition icon corresponding to each partition you created. If you clicked Cancel in step
14 for any partition, the message at the bottom of the screen will say “Uninitialized or no
disk in drive” when that partition is selected.

If you want to partition, initialize, erase, or zero another disk, turn to the appropriate set ¢
instructions. If vou're finished using the Advanced Disk Utility, click Quit or choose Quit
from the File menu (or press Command-Q)).
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Getting information about a disk

| RN

Whenever the Advanced Disk Utility screen is visible, you can easily get all the important
information you might want to know about the disk. You can see the name of the disk, the
size of the used portion of the disk, the amount of room still available, the file system, and
the name of the device that contains the volume. If the disk you want to know about is a
hard disk, you can also see a list of the names of all the partitions it contains, If the disk is
write-protected, you see a lock icon next to the disk icon.

Follow these steps to get information:

From the Advanced Disk Utility screen, select the disk about which you want
information.

Click the Disk button (or press Tab) until the name of the disk appears at the bottom of the

Advanced Disk Utility screen.

Click Info.

You see the Info dialog box.

Disk: ‘Hord.Disk
DI 5. 15103K

Rvailable: 3737K

File system: ProDOS

Device nome: APPLESCSI HDOL.0@
Partitions:

No partitions on this disk

z

If the selected disk is a hard disk partition, the Partitions window lists the names of all the
partitions on that hard disk. (If any of the partitions have not been initialized, the Partitions
window lists the device name as the partition’s name.) If the disk is not part of a partitioned
device, the Partitions field displays the message “No partitions on this disk.”

When you're looking at the Info dialog box for a hard disk partition, you can click any other
partition name in the Partitions window to see the information about that partition.
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3 Click OK or press Return.

You return to the Advanced Disk Utility screen.

If you want to initialize, erase, zero, or partition a disk, turn to the appropriate set of
instructions. If you're finished using the Advanced Disk Utility, click Quit or choose Quit
from the File menu (or press Command-Q).

In the Advanced Disk Utility, the Finder, and the Archiver backup and restore program, you
have all the tools vou need to work with the disks you can use with your computer. For
information about initializing and erasing disks with the Finder, see Chapter 4, “Working
With Disks,"” starting on page 83. For information about backing up and restoring
information with the Archiver program, see Chapter 8, “Using the Archiver,” starting on
page 199,
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Using Universal Access

System 6 software includes programs designed to ensure universal access—that is,
solutions that make Apple computers available to children and adults with special needs. If
you have difficulty using the kevboard or the mouse or reading the monitor’s screen, these
programs may provide the assistance vou need. The applications in this chapter are also
useful to anyone who needs greater visual precision when using drawing applications, and
to those who have an optional ADB device (such as a drawing tablet or child’s keyboard)

attached to the computer.

Easy Access provides alternative ways to use the mouse and keyboard; Video Keyboard

provides an alternative on-screen keyboard: and CloseView magnifies the images displayec

on the screen.

This chapter contains information on these topics:
= kevboard and mouse assistance with Easy Access
* alternative text entry with Video Keyboard

= easier screen viewing with CloseView



@ Note I[fyou do not need the features provided by these tools you should not install
them because they consume memory and reduce the system speed. &

Keyboard and mouse assistance with Easy Access

Easy Access is a set of keyboard utilities with two features, Sticky Keys and Mouse Keys, that
assist people who have difficulty typing with both hands or with manipulating the mouse.
These features are also useful to anyone who wants to use the kevboard with one hand or
to have complete control over very fine movements of the pointer.

[f your computer has ROM 01, you can use Sticky Keys only when vou start up from
GS5/0S or use a GS/0S application. Although Sticky Keys is built into ROM 3 computers,
you can see its visual indicators only when you've installed Easy Access on your startup disk
and you're working with an application that uses the desktop interface. Mouse Keys
requires the use of the desktop interface.

# Note You can determine which ROM version your machine has by checking the ROM
number shown at the bottom of the screen when you first turn on your GS,

Ifyou use the Installer to create or update a system disk for a 1.4 MB drive or a hard disk
drive, Easy Access will install automatically if earlier versions have been previously installed
(if you are upgrading to System 6, for example). If you use an 800K floppy disk to start up
your computer, there is not enough room to install the program on your startup disk. For
instructions about using the Installer, see Chapter 2, “Using the Installer.”
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Using Sticky Keys

The Sticky Keys feature of Easy Access lets you type combination keystrokes, consisting of
one or more modifier keys and one additional key, without actually pressing the keys
simultaneously. The modifier keys affected by Sticky Keys are:

= Shift key

= Command key

*  Option key

= Control key

All of the other keys on the keyboard are nonmodifier keys.

If you're working with an application that uses the desktop interface, one of three Sticky
Keys icons appears at the far-right end of the menu bar when Sticky Keys is active.

'I.l'| This icon means Sticky Keys is ON.
This icon means the modifier key you just pressed is SET. The next key
o you press will be included as part of 2 combined keystroke. Typing a
nonmodifier releases the SET modifier.

This icon means the modifier key you just pressed twice is LOCKED,

s which is useful when you want to use the same modifier to enter several
different commands. For example, you might want to do a lot of copying
and pasting. Press the Command key twice to LOCK it, then alternately
type C (for Copy) and V (for Paste). To unlock the modifier, press it once.
The icon will change back to the ON icon.

Any time you press a modifier key, the icon changes to reflect your new options.

@ Note The visual indicators are in the software only; they are not built into the ROM. »
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To use Sticky Keys, follow these steps.

| Towmon Sticky Keys, press and release one of the Shift keys five times in
succession without moving the mouse.

If you happen to bump or move the mouse during this sequence, you need to start over,

2 Press the modifier key to set the modifier.

For example, press the modifier Command key once (notice the SET icon).

3 If necessary, press another modifier key.
Some commands require that you press two modifier keys before you press the
nonmodifier key.

When vou enter a three-key command (such as Command-Shift-B), the Command key stavs
set when vou press Shift (another modifier), but is released when vou type B (a

nonmodifier).

4 Press the nonmodifier key to complete the command.
Tepe & (a nonmodifier) o complete a Command-A command, The menu bar icon will
change back 1o the ON icon,

'3 To turn off Sticky Keys, press the Shift key five times again.

You can also turn off Sticky Keys by pressing a modifier key and a nonmodifier key at the
same time. (The Control-A combination is handy because the keys are close together.)
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Using Mouse Keys

If you feel more comfortable using the keyboard to give instructions to the computer—or
if you have difficulty using the mouse—you can activate the Mouse Keys feature, which lets
vou move the pointer, click, press, drag, double-click, Shift-click, or Command-click entirely
from the keyboard.

You can customize the responsiveness of the Mouse Keys feature using the Keyboard
Control Panel.

To use Mouse Keys, follow these steps:
To activate Mouse Keys, hold down the Command and Shift Keys.
Without releasing the first two keys, press, and then release, the Clear Key.

To turn off Mouse Keys, press the Clear key.

# Problems with combined keystrokes? If you have difficulty with combined
keystrokes, activate the Sticky Kevs feature first, as described in the previous section. «

Using the numeric keypad to move the pointer

When Mouse Keys is activated, the numbers surrounding the number 3 on the numeric
keypad let you move the pointer in the corresponding direction. To move the pointer
straight up, for example, hold down the 8 key; to move the pointer diagonally up and to the
left, hold down the 7 key; and so on. (See Figure 10-1.)

When you hold down a number key, the movement of the pointer begins slowly and then
accelerates until it reaches a maximum speed. If you want to move the pointer by small
increments, you can press and release the appropriate number key as many times as
needed.
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Figure 10-1 Moving the pointer with Mouse Keys

[ising the numeric keyboard to move by larger increments

Normally, the pointer moves by one pixel each time vou press and release a number key.
If you want to increase this increment by as much as ten times, follow these steps:

1 Press the asterisk (*) key on the numeric keypad.
2 Press a number key from 1 1o 9 (or press 0 for 10) to multiply the increment by

that number.
If you want to return to an increment of one pixel, press the asterisk key twice.,
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Using the numeric keypad to click, drag, and make other mouse movements.

Follow these steps to implement Mouse Key features:

1o click, position the pointer and then press and release 5.

16 press, position the pointer and then press and hold down 5.

To drag, position the pointer and press 0 to begin dragging; use the numeric keypad to
move the pointer, and press 3 when you want to end dragging.

1o double-click, position the pointer and then press and release 5 twice in quick
SUCCESs100n.

1 Shift-click, position the pointer and then hold down one of the Shift keys while you
press 5. (Or, if Sticky Keys is activated, you can press the keys separately.)

1o Command-click, position the pointer and then hold down the Command key while
you press 3. (Or, if Sticky Keys is activated, you can press the keys separately.)

¢ Not quick enough? If you're not able to press 5 quickly, you can set the double-click
option in the General Control Panel to the slowest setting. For more information, see
“General,” on page 176. &
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Alternative text entry with Video Keyboard

The Video Keyboard desk accessory provides a fully capable on-screen keyboard for
entering text through Apple 11Gs applications, Video Kevboard allows vou to manipulate the
standard mouse or alternative pointing devices, such as the head-controlled mouse, to do
anvthing vou can do with a physical kevboard. Designed particularly for individuals who
cannot use a standard hardware keyboard, the Video Keyboard can also be useful in
situations where a hardware kevboard is impractical or cumbersome,

To install Video Kevboard into your system, choose the “Special Aids: VideoKeyboard”
update from the Customized Installation option of the Installer. For instructions about
using the Installer, see “To add capabilities,” in Chapter 2.

Video Keyboard uses both the Keyboard and Translation settings in the General Control
Panel. For more information about these settings, see General,” on page 176.

Important Always open Video Keyboard before you launch an application. Problems may
arise with some applications if Video Keyboard is opened from within the program, .

The Apple 11Gs does not recognize Video Keyboard as the active window, so characters vou
type with Video Keyboard always go to the current active window. This means you can have
the Video Keyboard active and still work on other documents or programs.

Follow these steps to use Video Keyboard:

1 Before you launch the application you want to use, turn on Video Keyboard by
choosing it from the Apple menu.

A window containing a kevboard image appears in the lower-left corner of the screen.
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Move the Video Keyboard window to any position on the screen by selecting its
title bar and dragging, just as you would move any other window.

If the lower-left corner is a good position for you, leave the Video Keyboard window where
iis.

Launch the application you want to use and position the insertion point where
you want to insert text,

Move the pointer over the key you want to type and press the mouse button.

The key becomes highlighted when it is selected, and it shows up at the insertion point in
your document,

To close the Video Keyboard window, click the close box.

¢ Note Video Keyboard remains activated until you turn it off. That means that even if
you quit the application you're using and launch another one, Video Keyboard remembers
its position, and is ready to work with the next application. e

Video Keyboard Techniques

There are several techniques you can use to accomplish the same tasks as you can with the

hardware keyboard.

* Torepeat a key continuously: Move the pointer over the key, and then press and hold
down the mouse button. When you release the mouse button or move the pointer away
from the selected key, the auto repeat stops.

( You can select the speed ar which kevs repeat by using the Speed option in the
Keyboard Control Panel. For more information, see Speed,” on page 179.)

« 16 use a modifier key (Command, Control, Option, or Shift): Click the modifier key
once and then click a nonmodifier key to complete the command. The modifier key
remains selected until the nonmodifier key is clicked.

* o lock a modifier key when you want to use it for several different
commands: Double-click the key. To unlock it, click it again,
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Modifier keys can also be used together for 3-key commands, Click the first modifier
key, then click the next one; the two keys remain selected until vou click a nonmodifier
key. If you change your mind, deselect a modifier key by clicking it.

The Caps Lock modifier key behaves differently from other modifier kevs. A single click
selects it, and it remains selected until clicked again.

» 1o use Shift-click or Command-click: Double-click the Shift key or Command key to
lock it, and then use the mouse to select or drag an object. To unlock the modifier key,
click it again,

» o add a numeric keypad to the keyhoard: Click the Zoom box in the upper-right
corner of the title bar. Clicking the Zoom box again removes the numeric keypad.

Key Caps

Video Keyboard key caps (key legends) show what will be typed when a given key is
selected. When the Shift, Option, or Caps Lock modifier keys are selected, the key caps
show how the modifiers affect these kevs,

For example, when the Option key is selected, the key caps will display the Option
characters. If both Shift and Option keys are selected, the key caps display the Option-Shift
characters, Figure 10-2 shows the Shift, Option, and Shift-Option character sets.

Ifyou set Translation to *None” (in the General Control Panel), the Key Caps lavout will
not change when you click any of the modifier keys.
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Option-Shift characters

Figure 10-2 Key caps displays of Option, Shift, and Option-Shift characters

This key sequence will enohle
the 40780 column text screen!

Cancel ()

Figure 10-3 Dialog box carrying text screen warning

A Warning While using the Video Keyboard, if vou enter the text Control Panel by pressing
Command-Control-Esc, vou see the dialog box in Figure 10-3. If vou operate the computer
using only a pointing device, click Cancel. Don't enter the text Control Panels because the
Video Keyboard cannot be used there and you will have no way to manipulate the
computer. A
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Easier screen viewing with CloseView

The CloseView desk accessory makes the screen easier to
view, or read, for people who have difficulty with standard-
sized screen images. It can also be useful for anyone who
wants to get a much closer look at the screen.

With CloseView, you can magnify any screen image 2 to 12
times. You can also reverse the screen display to make
images appear white-on-black instead of black-on-white.

When you use CloseView, you work with applications,
desk accessories, and the Finder in the same way you do
without CloseView. When the magnification is activated, the
program automatically follows vour keystrokes and mouse
movements without interfering with the application,

A Warning Some applications do not support CloseView. If
you are unsure about whether a program supports
CloseView, contact the application publisher. A

To install CloseView in your system, choose the “Special Aids:
CloseView™ update from the Customized Installation option
of the Installer. For instructions about using the Installer, see
Adding capabilities to a System 6 startup disk,” on page 22 in
Chapter 2.

254 Chaprer 10 Using Universal Access



Follow these steps to use CloseView:

| choose Closeview from the Apple menu.

The CloseView window appears.

(=== C(loseView™

(O 0n Magnification:
@ 0ff vig [ O E

@ Black Onbhite |2 0ff
(O White On Black | =] Key Equivalents

= Aipple Computer, Inc. 1990-92

2 Select the CloseView options you want to use.

* On and Off buttons: Click the appropriate button to
activate or deactivate CloseView. When you click On, a
black box will appear showing the area to be magnified.

= Magnification buttons and pop-up menu: Click On or
Off to activate or deactivate screen magnification. To select
a different magnification power, position the pointer on
the current setting, hold down the mouse button to
display the pop-up menu, drag through the menu until the
setting you want is highlighted, and then release the
mouse button.
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() 0n Magnif

@ 0ff vig |0
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@ fipple Computer, Inc. 1990-92 lgx
X

When magnification is turned off, but CloseView is on, you
see the CloseView frame (a heavy box covering a portion
of the screen). The frame moves when you move the
pointer on the screen; it works like a magnifying glass,
marking off the portion of the screen that will be

magnified.
0O = Hard.Disk Bz
ProD0S 12 items 15.1 MB used 5.2 MB free

[

Icons  Club.Newsletter

Victor Dale
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When magnification is turned on, the screen fills with the
portion of the screen that is inside the frame.

]

BASIC.System \ Games

1 [

Robin Jay

€ Losing track of your location? If you have difficulty
keeping track of your location at higher magnifications, you
can use Command-Option-X to turn off magnification or
Command-Option-Down Arrow to decrease

magnification. &

= Black on White and White on Black: Click these buttons

to change the display to either black-on-white (default) or
to white-on-black (inverted). If CloseView is turned on,
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the change takes place immediately; you can try each
option to discover which is easier for you to see.
= [Jse Key Equivalents: The Key Equivalents box is preset
for shortcuts you can use to modify CloseView settings.
Command-Option-O turns CloseView on or off.
= Command-Option-X turns magnification on or off.
- Command-Option-Up Arrow increases magnification
power.
- Command-Option-Down Arrow decreases
magnification power.
- Command-Option-I inverts the current display from
black-on-white to white-on-black, and vice versa.
(If you don't want to use these key equivalents, click in the
Key Equivalents box to deselect it.)
= Help: Click this button to open a window of information
that may help you to use CloseView.

3 After setting CloseView options, close the CloseView
window.

You can now return to your application and work as usual.
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Resources for adaptive technology

For more information about adaptive technology for individuals with disability, vou may
want to consult these resources:

= [Independence Day: Designing Computer Solutions for Individuals with Disability by
Peter Green and Alan Brightman,

»  Apple Computer Resources in Special Education

»  Apple Il Guide
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11

Controlling Multimedia Devices

Multimedia is a term that refers to the integration of text, graphics, sound, and live video—
brought together and displayed in a way that allows you to access and combine as many of
the elements as you like. Svstem 6 software includes programs designed to allow you to

control multimedia devices through vour computer.

This chapter contains information on these topics:
s  the Media Control Panel

» the Media Controller desk accessory

» the CD Remote desk accessory

s the VideoMix desk accessory



Media Control

The Media Control Panel and the Media Controller desk accessory work together to provide
computer control of compact discs and laserdisc players. They allow you to set up
connections and control vour own combinations of sounds, pictures, and graphics from
vour computer desktop.,

To use the Media Control Panel and the Media Controller desk accessory on an Apple 11Gs

computer, you must use the Installer ro add updates to your startup disk. System 6 provides

all the files vou need to use the AppleCD SC or AppleCD SC Plus CD-ROM players, and

Pioneer laserdisc players. Use this list to decide what updates to install for the equipment

you plan to use:

= Forthe AppleCD SC or AppleCD SC Plus, use the “Media Control: AppleCD SC™ update.

w  Jorthe Pioneer 2000 family (which includes the 3030), use the “Media Control: Pioneer
2000" update.

= Forthe Pioneer 4200, use the “Media Control: Pioneer 4200 update.

= [For hoth laserdisc plavers and the AppleCD SC or AppleCD SC Plus, use the “Media
Control: Everything” update.

For instructions on using the Installer 1o add updates, see Chaprer 2, “Using the Installer.”
For instructions on connecting the equipment to your Apple LGS computer, see the
manuals that came with the equipment,

Once vou've connected the equipment and installed the appropriate updates, you're
ready to work with the Media Control programs via the desktop.
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Setting connections with the Media Control Panel

To configure the Apple 1165 to work with your specific media devices, choose Control Panels
from the Apple menu; then select the Media Control icon (it’s listed “Media Crrl™) and click
Open. You can also double-click the Media Control icon to open it.

rl

Media Ctrl

EO== Hetia itr] ==

Select o Media Channel:
®1010300
QIO OTO8

Pioneer 2000
Pioneeri200

=

Select o Port:

J o
W

Follow these steps 1o set a media connection:

Click one of the eight buttons to select a media channel.

You can choose any available channel.

When a connection has been made on a channel, the channel button is displayed in red. If
vou want to clear a previously configured channel, click the Clear Channel button at the
bottom of the screen.

The media device and port options display all available media devices and ports.

Select a device from the list of available devices.

Select a media port from the list of ports.

When you've set your connection for each piece of media equipment you're using, you
must close the Media Control Panel window for the settings 10 1ake effect.
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Controlling equipment with the Media Controller

Once vou have assigned a media device to a channel via the Media Control Panel, vou can
use the Media Controller desk accessory to control the device while running other
applications. To get to the Media Controller desk accessory, choose it from the Apple menu

Abowut the Finder
Help i

VIDE
)
DISPLAY
D

I}

CLOSE VIEW
Contral Panels
Find File

Colouloter
Media Control ler

Video Keyboord
VideoMin

AUOI0

0 ][> [

You see the Media Controller options, which look very much like the options you may have

on a remote control device in your home, and have these functions:

* The Channel buttons let you select one of eight media channel devices, You must first
set the channel connections by using the Media Control Panel

* The More button gives vou additional options:

16 see the In and Out options, click the More button once. These options allow you
to select particular time segments to play. After double-clicking the In text box, tvpe
the time for the beginning of the segment vou want to play. Then select the Out text
box and type the time for the ending of the segment vou want to play. Click Runto
play the selected segment.

You can also specify a segment by playing the disc. As it plavs, click In when play
reaches the beginning of the desired segment; click Out when play reaches the end
of the desired segment. Click Run to play the selected segment,

Iy see the additional options, click the More button again. You see three options:
Access Lock (which prevents disc ejection), Video Display (which displays the

remaining time or frames), and Volume Control.
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= The Video button controls whether or not you display a running laserdisc video on the
desktop.

s The Display button allows vou to see the time or the number of the frame the CD or
laserdisc is currently playing,

= The Record button initiates record mode if the device has a record function. This button
is dimmed because the devices do not currently support this function; however, the
design allows for future support of such devices.

= The Eject button stops the device and ejects the disc.

* The Stop button stops play and the location is set back to the starting location,

«  The Audio buttons turn on and off the audio channels, and correspond to the left and
right audio channels.

* The Step buttons move backward or forward one frame button (if the device has such
a capability).

* The Play burton plays forward at normal speed.

* The Track buttons let you skip backward or forward by chapter or track.
= Ifyou're skipping backward. you go to the beginning of the previous chapter or

track. If you are not at the beginning of a chapter or track, you skip to the beginning

of the current chapter or track. If you're on the first chapter or track, you skip to the
beginning of the last chapter or track.

o Ifvou're skipping forward, you go to the beginning of the next chapter or track. If
vou are at the end of the last chapter or track, you skip to the first chapter or track.
=  The Scan buttons scan forward and backward.

= The Pause button initiates pause mode: clicking Play returns the device to play mode.

CD Remote

CD Remote is a desk accessory that allows you to control the AppleCD SC Plus or Apple
CD SC drives to play your audio CDs. To use CD Remote on an Apple 11GS computer you
must use the Installer to add an update to your startup disk. One update provides all the
files needed to use the AppleCD SC or AppleCD SC Plus drives; install the “Drive: CD-ROM™
update.
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VideoMix

For instructions on using the Installer to add updates, see Chapter 2, “Using the
Installer.” For instructions on connecting the AppleCD SC equipment to vour Apple 11GS
computer, see the owner’s guide that came with the equipment.

Once you've connected the equipment and installed the update, you're ready to work
with the equipment via the desktop.

Complete instructions for using CD Remote are described in the AppleCD SC Owner's
Guide.

Important CD Remote is not designed for working with data tracks; its function is to work
with audio tracks. However, if vou are working with a disc that has data and audio tracks,
vou can use the disc as if it were strictly an audio disc. CD Remote simply skips over the data
tracks,

The VideoMix desk accessory lets vou adjust the combination of graphics and video made
possible with the Apple 11 Video Overlay Card. The card allows vou 1o superimpose a
computer image on a video image. For example, you might use computer graphics 1o
display text that describes video scenes or objects. The card works with any of the existing
painting, drawing, and animation software that vou can use on vour Apple 1iGs—in fact, vou
can use it with virtually any Apple 11 software.

To use the VideoMix desk accessory, vou must have an Apple 11 Video Overlay Card
installed in your computer and you must use the Installer to add the “Media: VideoMix”
update to vour startup disk.

For instructions on using the Installer to add updates, see Chapter 2, “Using the
Installer.” For instructions on connecting the laserdisc players and installing the video
overlay card, see the manuals that came with the equipment.

Once you've made the connections and added the appropriate update, you're ready to
use the VideoMix desk accessory to make adjustments to the video and graphics displays.
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Selecting key color

Creating an overlay with the Apple 11 Video Overlay Card requires you to select a control
color, called the key color. The key color is transparent to the incoming video and is
treated separately from the other colors. All colors not designated as the key color are
treated as a group and are called non-key colors, The key color indicates where the video
input signal will be displayed on the screen. For example, if the key color is black, the video
input signal shows through only where black is displayed on the screen. Where any other
color is displaved, the video will not show through and those areas will display the
computer generated graphics.

You can select the key color from the screen or from the options on the VideoMix color
palette, Follow these steps:

Choose VideoMix from the Apple menu.

The VideoMix key color window appears, displiving a color palette with
el ) sixteen different colors.

CLOSE YIIW
Control Ponels
Find File
Celoulator
Medio Controller
Video Kevboord

Select the color you want for your key color.
If you want a color from the palette, click the color you want.

Ifyou want to pick a color from the screen, click Pick From Screen. A hand with a pointing
finger replaces the arrow pointer on the screen. With the hand pointer in the computer
graphics area of the screen, click the color of vour choice from any that appear on the
screen. The color vou select appears in the color palette as the key color.
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Setting the video/graphics mix

You can use the VideoMix desk accessory to adjust the mix of video and graphics to create
the effects vou want. Follow these steps:

1 From the VideoMix window, click the Video/Graphics Mix button.

A window appears with two slider controls, one for the key color, and one for non-key
colors, The slider controls allow vou to change the dissolve value of both the key and non-
key colors,

2 Move the sliders to any of their seven positions to adjust the mix.

If you move ihe sliders to the top of the slidebars (where you see the word Graphics), vou
select 0% dissolve for the key and non-key colors—resulting in the elimination of all video
display on the screen.

If vou move the sliders to the hottom of the slidebars (where vou see the word Video), you
select 100% dissolve for the key and non-key colors—resulting in the elimination of all
graphics display on the screen. (You can redisplay the graphics by pressing the Escape key.)

You can move each slider independently to achieve a variety of display effects.

3 Click OK to save the video/graphics mix you want.

You can click Cancel 1o return to the key color palette without saving a mix.

Adjusting the tint

You can use the VideoMix desk accessory to adjust the tint and color of the video image to
vour preference. Follow these steps:

1 From the VideoMix key color window, click the Video Adjust button.

A window appears with a box set to the key color so that the current video image is shown.
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2 Adjust the tint and the color to your preference.

Position the pointer on the up or down arrows for each setting. Press, and hold until the
image in the box corresponds to the tint and color you want.

3 Click OK to save the tint and color adjustment.

For further details about using the Apple 1 Video Overlay Card and the VideoMix software,
see the Apple Il Video Overlay Card Owner's Guide.
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Networking the Apple I1IGS

[f you use vour Apple 11GS computer at home, chances are you're using it as a stand-alone
computer. If vou use your computer at school or at work, however, it may be part of a

network. a system of interconnected computers and peripheral devices, such as printers

and file servers. This chapter tells vou how to use System 6 with a network

Although System 6 allows you to start up directly into ProDOS 8 without waiting for GS/OS
to load, the chapter generally assumes you are working with GS/0S. You can skip reading
this chapter if vou don't work on a network. If you are a network administrator, refer to the
documentation that came with your Apple If Setup disk for information about

administrative tasks

This chapter contains information on these topics:

learning about the AppleTalk Network System
* using an AppleShare File Server

» using folders on a hle server volume

* logging off a file server

= printing over the nerwork



+ Note Ifyou will be starting up directly into ProDOS 8, refer to the Apple lle
Workstation Card User’s Guide for information about ProDOS 8 applications that let you
log on, select printers, and perform other nerwork rasks. o

Learning about the AppleTalk network system

The Apple 1165 is designed to be part of the AppleTalk network system, which can
include other types of personal computers, such as the Apple lle, any of the Macintosh
family of computers, UNIX*/Open System, and MS-DOS computers. It can also include
peripheral devices such as LaserWriter and ImageWriter printers.

To connect devices to an AppleTalk network system, vou can use one or more LocalTalk
Locking Connector Kits, which include all the cables and connectors necessary to link
devices to the network.

If your computer is part of an existing network at your school or office, there may be a
network administrator who maintains the network. Tvpical duties of the network
administrator include making the physical connections between devices on the network,
setting up and maintaining any file servers and print servers on the network,
troubleshooting whenever network users encounter problems, and answering questions
about network services.

If some procedures in this chapter require decisions that you can't make about the
network, or if you don't have all the networking information that you need, see your
network administrator.

Network types

The AppleTalk network system includes a number of network types, such as LocalTalk and
Etherner. All AppleTalk network types use the same AppleTalk protocols, or rules for
exchanging information, which are built into your Apple 1IGs computer, the Macintosh
computer, and the LaserWriter printer, These protocols can be added (with special interface
cards) to the Apple lle computer, the ImageWriter printer, and MS-DOS compatible
computers. Regardless of the network type used by a workstation (a computer
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functioning as part of a network), it can gain access to the services of the AppleTalk nerwork
system transparently.

The various network types can be pulled together into a unified, larger system called an
internet. Networks within the internet can be grouped together into zones. Subdividing a
large internet into zones makes access to network devices and services more convenient
and efficient.

The advantages of networking

When your computer is part of an AppleTalk network system, you can share peripheral
devices such as printers, eliminating the need for an individual printer for each user.

An AppleTalk network system can also include AppleShare print servers—specially
configured Macintosh computers that store documents waiting to be printed, allowing
several people to send documents to be printed at the same time. You'll learn more about
using AppleShare print servers later in this chapter.

Members of an AppleTalk nerwork system can share applications and exchange mail,
documents, and other information electronically by using AppleShare file servers—
specially configured Macintosh computers that allow network users to store and share
information. A single Macintosh computer can be used as both a print server and a file
server.

System 6 also allows you to share files with any Macintosh computer that is set up with
Macintosh System 7. If Macintosh computers on your network are configured with earlier
versions of system software, you will be able to store and share information only via
AppleShare file servers.

Here are a few examples of ways vou might use an AppleShare file server:

= To read or post messages in a class or departmental “bulletin board" folder.

= To keep frequently used electronic forms (such as expense reports, travel advance
requests, and payroll documents) in a folder from which employees can copy as
needed.

= To maintain documents that change frequently (such as student rosters, company
address lists, and client databases).

= o share public-domain software with other network users (or copyrighted software, if
the copyright statement or a special license allows multiple use).
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You'll learn about setting up AppleShare file servers later in this chaprer.

An overview of AppleShare file servers

AppleShare is the file server software that includes a set of network services that gives vou
access to resources on an AppleTalk network system. Along with the AppleShare file server
software, a file server includes a Macintosh computer with one or more hard disk drives that
lets you store large amounts of information. AppleShare file servers provide storage and
sharing of applications and data files for AppleTalk network system users,

File server volumes

Each hard disk that's part of a file server is known as a volume. File server volumes function
logically in much the same way as any other kind of disk. When contrasted to file server
volumes, disks connected directly to your computer are sometimes called local disks.

When you mount a file server volume, its icon appears on your desktop. You can open
the icon just as you would open any other disk icon, and you can use the file server volume
the same way you use other disks—creating folders, opening applications, saving
documents, and so on. An added benefit of file server volumes is that more than one
network user can have access to them at the same time.

If Macintosh computers on your network are configured with System 7 software, Apple
11GS System 6 allows you to share files with them in almost the same way vou work with
other file server volumes. The only limitation is that you cannot start up from such volumes.
(You'll learn more about starting up directly over the network later in this chapter.)

¢ CD-ROM volumes and other locked volumes Your file server may include locked
volumes, such as CD-ROMs, whose contents can't be changed. A locked volume functions
much the same as a write-protected 3.5-inch or 5.25-inch disk. You can't create folders or
save documents on a locked volume because you can't alter its contents,
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Logging-on alternatives

When you want access to one or more file server volumes, you go through a process called
logging on. For instructions on how to install the described updates on the Apple 11Gs
computer, see Chapter 2, “Using the Installer,” starting on page 19.

You can log on to a file server in four ways:

»  From a hard disk that includes the AppleShare softivare and the Finder You create
such a disk by installing the “System 6: Hard Disk or FDHD" update, along with the
“Network: AppleShare” update, When you start up with the disk, the Finder is your
startup application. You can then use the AppleShare Control Panel to log on to a file
server and select file server volumes, as explained in “Logging on to a file server from
the AppleShare Control Panel,” on page 280.

= From a floppy disk that includes the AppleShare software, but not the Finder You
create such a disk by installing the “Network: AppleShare, 3.5" Disk” update. Although
the disk does not include the Finder, it does allow you to use the AppleShare Control
Panel to log on toa file server, and then to select an application, as explained in “Logging

on to a file server from the AppleShare Control Panel,” on page 280.

s Querthe network (with a local disk) You create such a disk by installing the “Network:
Local Startup” update (so named because it enables network startup from a local disk).
Because some of the information needed for network startup is loaded from the floppy
disk, this method s faster than network startup without a local disk. You bypass the
Finder, logging on to a file server and launching whatever startup application the
network administrator has assigned to you,

Network startup from a local disk is useful primarily in classroom settings, where a
teacher may want to have control over the application from which a student starts up.
It is explained in “Logging off without the Finder,” on page 300.

= Directly over the network (without a local disk) You can start up this way if you've
installed the “Network: Server Startup” update on the startup volume of the file server.
When you switch on the computer, you automatically log on to a file server and launch
whatever startup application the network administrator has assigned to you.
The advantage of this method is that it doesn’t require a disk drive; the disadvantage is
that it can take somewhat longer than starting up with a local disk. This way to log on is
explained in “Starting up over the network without a local disk,” on page 284, and
“Starting up over the network with a local disk,” on page 288.
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When you're running the Finder, you can also create your own log-on shortcut by using
EasyMount, a Finder extension included with System 6. EasyMount is installed automarically
when you install your networking update.

To set up your shortcut, choose Create Server Alias from the Extras menu after selecting
the server icon in the Finder. (An alias is a small file that gives vou quick access to the item
with which it's associated—in this case, the server.) A dialog box appears, allowing you to
name your alias and locate it wherever you like—just as you would do with any normal file.
From then on, you can log on to the server by double-clicking the alias. Note that you also
have the option to save your alias with 4 password; if you do, access to the server alias is
open. (That is, someone else could log on to the server without knowing your password.)
When vou're finished using the volumes on a file server, vou go through a process called
logging off. as explained in “Logging off a file server,” on page 300.

Registered users and guests

A file server is like a central storeroom for files. Because vou may want some files or folders
10 be private—or to be available only 1o a specific group of network users—the AppleShare
File Server software provides a security system to make sure that only the appropriate
people have access to information stored on file server volumes,

When the network administrator set up your file server, he or she probably created a list
of registered users. If vou're a registered user of a file server, your administrator has
assigned vou a user name and a password. When vou log on as a registered user, your
user name identifies you to the file server, and your password (a unique word or set of
characters that no one else knows) lets you confirm that you're who you say you are.

Your file server administrator may also have set up groups of one or more registered
users, The members of an AppleShare group usually need access to the same information.
For example, teachers may need to share information among themselves, but restrict that
information from students.

Even if vou're not a registered user of a file server, you can log on as a guest, unless the
file server has been set up to allow access only to registered users, Guests are given the user
name <Any User> and do not need a password. When vou log on as a guest, you don't
have access to restricted information, but you can use public files and folders. Anything you
create or store on a file server volume while logged on as a guest is available to all network
users, including other guests.
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Access privileges

The AppleShare File Server softrware has a feature called access privileges to let users
restrict access 1o information in particular folders. When a registered user creates a folder
on a file server volume, the folder is automatically set up as a private folder. The registered
user is the owner of the folder, and he or she controls the access to its contents. Only the
registered user can see or change what's in the folder unless he or she gives other users
access Lo it.

You'll probably store some private information on a file server—for example, payroll or
personnel records, students’ grades, and so on, But you may also store information that you
want to share, either with certain users on the network or with everyone on the network.
Access privileges let you set up different restrictions for different folders.

For an explanation of the different access privileges and the FolderPriv Control Panel,
see “Serting access privileges for a folder” later in this chapter.

AppleShare-aware applications

An application is AppleShare-aware if it can be used safely with an AppleShare file server.
With an AppleShare-aware application, a user should be able to launch the application from
the file server. In addition, a user may be able to store documents on the file server so that
several persons can simultaneously have access to those documents, without inadvertently
destroying each ather’s work.

In addition to being AppleShare-aware, each application falls into one of four categories:
= single-user/single-launch

*  single-user/multi-launch

*  multi-user/single-launch

*  multi-user/multi-launch
If you want to share applications on an AppleShare file server, it's best to use multi-launch

applications, If you aren't sure whether an application is AppleShare-aware, see the manual
that came with the application.
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Naming rules

AppleShare file servers use the HFS file system. The following rules apply when you name
files and folders on a file server volume:

= The name can have no more than 31 characters.
= You can't use a colon (:) in the name.

¢ Remember If you move an item from a file server volume to a ProDOS disk, the item
must have an acceptable ProDOS name. If you've installed the “FST: HFS” update and you
are moving an HFS file to an HFS partition or disk, you can use HFS naming rules, which
are the same as AppleShare naming rules,

If you'll be sharing items with Apple lle users on the network, however, you should
follow the ProDOS naming restrictions described in “Renaming icons,” on page 75. When
you drag an item from a file server volume to a local disk, vou may see a dialog box
informing you that the item’s name is unacceptable and suggesting a new name.

What you need to get started

Ifyour network already includes an AppleShare file server, you only need 1o install software
on the file server and on vour Apple 11Gs startup disks to begin working with network
services.

If your Apple 11GS isn't connected to a network, and you want to connect to your
network, see your network administrator or refer to the Locallalk Cable System Owner's
Guide or the AppleShare File Server Administrator’s Guide available from your authorized
service provider.

The preliminary set-up information in this chapter refers to AppleShare file server disks
that you must have available. The disk you need depends on the setup procedures that
you'll be following.

If vou're creating 3.5-inch network startup disks, vou'll need the disks thar came with
the Apple 11Gs System 6 software, as well as a blank disk for each network user.

In addition, if you'll be using your Apple 11GS with an AppleShare file server, you must
have the software that came with your AppleShare product package.
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Using an AppleShare File Server

If your Apple T1GS is part of a network, you probably have access to an AppleShare file
server—a Macintosh computer that has one or more hard disks used exclusively for storing
and sharing information.

If your network includes one or more AppleShare file servers, read this section for
instructions on using the file server,

Copving Apple 11 applications to an AppleShare file server

You copy Apple 11 applications to  file server volume in the same way that you copy other
items. For instructions, see “Placing copies of files and folders on a different disk,” on
page 125. Network users who start up with a local AppleShare startup disk are free to open
any application to which they have access on the file server. For these users, you can store
applicarions in any folder with the appropriate access privileges.

Make sure that the applications you copy to the file server are AppleShare-aware
applications—that is, applications designed specifically to work on an AppleShare file
server. If they aren't, there may be restrictions on how you can use the applications on a
network. Ifyou aren't sure whether a particular application is AppleShare-aware, check with
the software publisher or with your authorized service provider.

Set the access privileges so that the appropriate users will have access to applications.
For instructions, see “Setting access privileges for a folder,” on page 289.

. Important Before you copy any copyrighted applications to a file server volume, be sure
to obtain the appropriate license from the manufacturer. Sharing applications on a file
server without express permission is a violation of copyright law.

When vou copy setup files or desk accessories that will be used by those who start up over
the network, refer to the following guidelines in deciding where on the file server to store
the applications:

= [fasetup file is to be shared by everyone, copy it into the System.Setup folder.
= Ifa desk accessory is to be shared by everyone, copy it into the Desk.Accs folder.
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* Ifasetup file or a desk accessory is to be used only by an individual user, copy it into
the Setup folder inside the individual's folder, which is inside a folder called Users on
the file server startup volume.

¢ Note For network startup with a local disk, the System.Setup and Desk.Accs folders
are located on the floppy disk. For network startup without a local disk, they're located
inside the System folder on the file server startup volume. o

If network users will start up with a disk, you also need to use the AppleShare Admin
program to set startup applications for individual users, as explained in AppleShare File
Server Administrator’s Supplement for Apple 11 Workstations.

Logging on to a file server from the AppleShare Control Panel

Follow these steps to log on to an AppleShare file server from the AppleShare Control
Panel:

1 start up your Apple IlGs with a startup disk on which you have installed the
“Network: AppleShare” or “Network: AppleShare, 3.5" Disk” update.

Forinstructions on installing one of the AppleShare updates on a startup disk, see “Installed
networking options,” on page 197.

If vou start up from a disk that includes the Finder, you see the Finder desktop.

If vou start up from a disk that doesn't include the Finder, vou'll see the System 6 Program
Launcher dialog box with a list of available applications. Click Cancel.

I~

Choose Control Panels from the Apple menu.

The control panel window appears on vour screen,
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3 Open the AppleShare Control Panel icon.

When vou select the AppleShare Control Panel, the AppleShare options appear.

== hppleShore =Fie0F=—s
E m:%ﬂ N Seleot a file server:
‘J English

AppleShare Foreign Languoges

=3

&l

fppleTalk Zones:
First Floor West
Fourth Flaor East
Fourth Floor West
Second Floor Fost

User Nome:
[Jenna Woodul |

4 If necessary, select the zone that contains the file server you want to log on to.
If your network isn't divided into zones, or if the desired zone is already selected, skip to
step 3.
To select a zone, simply click its name in the AppleTalk Zones window, A list of the file
servers in that zone appears in the window labeled “Select a file server.”

# By the way You can use the keyboard 1o select zone or file server names. Select the
list by pressing the Tab key until a thick black border surrounds the list. Then either use the
up or down arrows, or type the first few characters of the name to select it. «

Y Click the name of a file server in the window labeled “Select a file server”.
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0 Click OK.
You see this dialog box.

Connect to the file server
‘Foreign Longuoges’ os:

O Guest
@) Registered User

Nome: | Jenna Woodul |

Fassword: E:' (Serombled)

[ Comcel JU 0K )

Specify whether you want to log on to the file server as a guest or as a registered
user.

« Ifyouwantiolog on as a guest, click the Guest button (or press Command-G) and then
click OK.

*  [fvou want to log on as a registered user; click the Registered user button (or press
Command-R), type your password and then click OK. If vou don't know vour password,
check with your network administrator.

8 Select the file server volumes to which you want access.

To select a single file server volume, click its name. To select additional file server volumes,
hold down the Command kev as you click each additional name. (If vou don't have access
privileges for a file server volume, its name will be dimmed.)
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9 you want automatic access to one or more file server volumes each time you

10

'Foreign Longuoges'

Select the server volumes you want:

fGerman | =
Spanish .
Latin 1}

Checked volumes ( 5= Jwill be
ppened ot system stortup time,

() Save Hy Hame Dnly
@) Save i Name ond Passward

Quit ‘ 0K '

start up the computer, click the check box to the right of the volume names.

Two new options appear in the dialog box for selecting file server volumes. The Save My
Name Only option is selected.

If vou want the computer to ask for your password before logging you on to the
selected server or servers each time you start up, leave the Save My Name Only option

selected,

If you want the computer to hypass asking for yowr password when it logs you on to
the selected server or servers each time you start up, select the Save My Name and

Password option.

Click OK or press Return.

The dialog box disappears and you return to the AppleShare Control Panel. Close the
AppleShare Control Panel, and then close the Control Panels window.

Warning Choosing the second option will permit anvone who turns on your computer
access to the network and vour files on the server. A

If vou started up from a disk that includes the Finder, the icon of each file server

volume you selected now appears on the desktop.

If vou started up from a disk that doesn't include the Finder, you see the names of the
server volumes that appear in the Program Launcher window.
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Starting up over the network without a local disk

The main advantage of starting up over the network without a local disk is that you don't

need a local disk drive. Your network administrator has stored all the necessary software on
the file server to let you start up and use your Apple 1IGs. The network administrator also
selects whether you start up with the ProDOS 8 or the GS/OS operating system,

Follow these steps to start up over the nerwork:

1 stant up (or restart) the computer.
You see a series of messages indicating that the computer is starting up over the network
and looking for file servers.

If your network is divided into zones, or if there is more than one file server on your
network, you see 4 screen similar to this one.
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If your network isn't divided into zones and there is only one file server on the network,
you see the screen shown in Step 4, Proceed to step 5.
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If you want to select a new zone, press the Esc key.

You see this screen.
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The name of the current zone (if your network is divided into zones) appears near the top
of the screen. If the current zone is the one you want—or if the network doesn't have
zones—proceed 1o step 4.

Select a new zone.

Use the Down Arrow or Up Arrow key to highlight the name of the desired zone, and then
press Return.

You see a file server selection screen (similar to the one in Step 1) for the new zone.

Select a file server.

Use the Down Arrow or Up Arrow key to highlight the name of the file server you want to
log on 1o, and then press Return.

You see the log-on screen. The “Log on as a Registered User"” option should be highlighted.
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5 Specify whether you want to log on as a guest or as a registered user.
* [fyou want to log on as a guest, use the Down Arrow key to highlight “Log on as a
Guest” and press Return.
If the file server has only one volume, you'll see the “Welcome to the 11Gs™ screen
while the computer launches your startup application over the network. You're
logged on automatically, so you can skip the rest of this procedure.
- Ifthe file server you selected bas more than one volume, vou'll see the selecting file
server volumes screen. Go on 1o step 8.
® [fyou want to log on as a registered user, press Return. You'll be asked to supply your
user name and password in the lower half of the screen, as shown.
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§ Type your user name.
Be sure to type your user name as it was given to you by the network administrator—though
vou don’t need to worry about matching uppercase and lowercase letters. If you make a
mistake, use the Delete key and retype. When the name is correct, press Return.

¢ Keyboard shortcuts Pressing Control-X clears the entire line; pressing Control-Y
Clears all characters between the insertion point and the end of the ling; pressing
Control-R restores the previous content of the line.
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7 Type your password.
As you type, asterisks appear in place of characters so that no one can see your password
as you type it.
Type vour password exactly as it was given to vou by the nerwork administrator—be sure to
match uppercase and lowercase letters. If you think you've made a mistake, use the Delete
key to erase the asterisks and then retype the password.
When the password is correct, press Return.

If the file server has only one volume, you see the “Welcome to the IIGS” screen while the
computer launches vour startup application over the nerwork. You're logged on
automatically, so you can skip step 8.

If the file server you selected has more than one volume, you see the selecting file server
volumes screen. Go on to step 8.
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8 Select the file server volumes to which you want access.

The startup volume is automatically selected (with a checkmark) and cannot be deselected,
Your network administrator will tell you which other volumes, if any, you need to select.

To select a volume, press the Down Arrow to highlight the volume's name, then press the
Left Arrow key (or Space bar) to add a checkmark. (Pressing the Left Arrow key again
removes the checkmark. )

When all the volumes you want are selected, press Return. You see the “Welcome to the
168" screen while the computer launches your startup application over the network.
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Starting up over the network with a local disk

Ifyou'll be logging on with a local disk, vour network administrator will probably create
your startup disk for you. If you don't have the appropriate startup disk, check with your
administrator or you can create such a disk by installing the “Network: Local Startup”
update.

You also need to make sure that your startup slot is set to the slot corresponding to the
disk drive in which you insert the startup disk. For instructions, refer to Chapter 7, “Using
the Desktop Control Panels.”

The process for logging on with a local disk is similar to the process for starting up over
the network without one; however, it is faster than starting up over the network because
part of the necessary system information loads from the local disk.

Follow these steps to log on to the network with a local disk:

1 start up (or restart) the computer with your AppleShare startup disk.

You see the "Welcome to the 11Gs” screen,

2 The process you follow depends on what screen you see next.

» Ifyou see the following screen. follow steps 2 through 8 in the preceding section,
“Starting up over the network.”
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»  [fyou see the following screen, follow steps 5 through 8 in the preceding section,
“Starting up over the network.”
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As you go through the appropriate steps in “Starting up over the network,” there will be
slight differences in what you see on the screen—for example, you won't see the message
“Welcome to the lGs™ in step 7 or step 8—but the sequence vou follow will be the same.

Using folders on a file server volume

Your network file server may contain a vast amount of information. Folders organize that
information so that you can store, share, and secure it in the most efficient way,

Setting access privileges for a folder

Because file server volumes represent shared storage areas, you may want to set access
privileges for vour folders to make sure that only the appropriate people have access to the
information stored there, You can set access privileges for a folder only if you are the
registered user who owns it or if it is owned by <Any User>.

You can use access privileges in many ways. In a school setting, for example, you might
want to set up a “bulletin board” folder for announcements, where only teachers can post
announcements but where all network users can read announcements.
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In creating customized access to a folder, vou must decide which network users (if any)
have the following access privileges:

= See Folders; The privilege to see the folders (if any) in vour folder.

= See Files: The privilege to see, open, and copy documents and applications (if any) in
your folder.

*  Make Changes: The privilege to make changes to your folder's contents, including
removing, renaming, or deleting contents as well as adding files or folders.

When you set access privileges for a folder, you must decide which of the following user
categories should have each access privilege:

= Nobody means no one has access, including vou (although the owner or administrator
can change the privileges so either can get access).

= (wner means you (unless you transfer ownership of the folder).

= Group means any single AppleShare group the network administrator has created; vou
can designate a group of which vou are not a member.

= Owner & Group means you (unless vou transfer ownership of the folder) and any single
AppleShare group the network administrator has created; you can designate a group of
which you are not a member,

» FEveryone means all network users, including guests.

¢ An example Areacher might want to create a folder where students in his or her class
can turn in an essay, Students in the class should not be able to read the essays that have
been turned in, and students from other classes should not be able to add anything to the
folder.

In creating this folder, the teacher would assign the See Folders and See Files privileges
to Owner and the Make Changes privilege to Owner & Group. (The teacher must also
assign a group to the folder—in this case, the group of students in the class. Because only
the network administrator can create groups, the teacher should first ask the administrator
to set up the appropriate group.)
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If you find that vou assign the same privileges to all or most of the folders you create, vou
can use the FolderPriv Control Panel to create a default set of privileges that are assigned to
all new folders vou create. See “Setting up default folder privileges,” on page 298,

The icon of a folder on a file server volume will look different from icons on local disks,
depending on what access privileges the owner of the folder has assigned you. There are
five icons used for folders on file server volumes:

A plain folder icon (like the icon used for folders on local disks) means
that vou are not the owner of the folder bur that you can open the folder.
(In other words, you have the See Files privilege, the See Folders
privilege, or both.)

A folder icon marked with a black tab means that you can set access
privileges for the folder's contents. The folder is owned either by you or
by <Any User>.

A dimmed folder icon means you have no access privileges for the
contents of the folder.

Adimmed folder icon with an arrow means that you have the Make
Changes privilege for the folder but not the See Folders and See Files
privileges, This folder is called a drop folder because you can drop off
documents for the owner, but you can't open the folder to see its
contents, For instructions on creating a drop folder, see “Setting up
default folder privileges,” on page 298,

Adimmed folder icon marked with a black tab means that you have no
access privileges for the contents of the folder but that vou or <Any
{'ser> owns the folder and thus can change the folder’s access
privileges. For more information on this type of folder, see “Setting
access privileges for a folder.” on page 289.
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When vou open a folder, icons representing your access restrictions appear below the title
bar of the window and to the left of the information about directory contents. In the
example illustration (Table 12-1), the icons mean that the user is not allowed to see files,
not allowed to see folders, and not allowed to make changes. Such icons may appear
individually or in combination, depending on the restrictions that apply to the folder that's
open on the desktop.

Table 12-1 Menu bar icons showing access privileges you don't have

When you see You know that

Eng ‘li“.l {‘lll'!'l see Iht' L'I‘ll'll Ih'td ftl|l.|t'l‘ﬁ

% You can't see the enclosed files
Eg You can't make changes to the folder's contents
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Figure 12-1 A typical hierarchy of folders on a volume

Figure 12-1 shows a typical hierarchy of folders on a volume, organized by class. You may
organize your folders in any way vou choose.

Follow these steps to set access privileges for a folder:

Select the folder icon and choose Icon Info from the Special menu, or press
Command-I.

You see a window showing a set of spiral bound cards
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2 Click the Access tab at the bottom of the Info notebook.

You see the Access card.

|

Chols ) C Mt!tnmtmlhlﬂu )
[“General J[ Where || Comment ]| Access

¢ Note The Access tab appears only when you select a file server volume or a folder on
a file server volume and choose Icon Info. It doesn't appear when you select a file on a file
server volume and choose Icon Info.

3 If you want to, use the pop-up menu on the left to set access privileges.

The pop-up menu provides shortcuts for setting access privileges. Position the pointer on
the box, and hold down the mouse button. A pop-up menu appears, listing the five possible
settings. Drag through the list until the setting you want is highlighted, then release the
mouse button,

Choosing any of the menu items except Custom automatically makes appropriate access
changes in the pop-up menus on the right. The following notes explain your options:

»  Public: Allaccess privileges are automatically set to Evervone. That is, evervone on the
network can see this folder and its files, and can make changes to them.

= Private: All access privileges are automatically set to Owner. That is, only you can see
this folder and its files, and can make changes to them.

»  Drop folder: See Folders and See Files are set to Owner; Make Changes is set to
Everyone. A drop folder allows users to drop off documents for you. Once a document
is dropped off, only you can see its icon and open it. In other words, a drop folder works
much like a locked mailbox or a suggestion box. When you see a drop folder in its
directory window, it appears like any other locked folder you own—that is, it has a lock
icon to the left of its name and it has a black wab. But when other users see the folder in
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its directory window, they see a shaded folder with an arrow pointing to it—indicating
that it is a drop folder.

How a drop older icons appears Howa drop folder icon appears
foy the owner (o Gther users

& By the way Users who work with an application that has a Save or Save As directory
dialog box won't be able to use these features to save a copy of a document in your drop
folder. (To do so they would need to have See Folders privilege, and the folder would no
longer be a drop folder.) They must to use the Finder to drop off a copy of the document. &

= Bulletin Board: See Folders and See Files are set to Everyone; Make Changes is set to
Owner. A bulletin board folder allows any user to open and read documents. The person
who maintains the bulletin board folder is the only one who can make changes to the
contents of the folder, so he or she is the only person who can post or change
documents. When vou see a bulletin board in its directory window, it appears like any
other folder.

= Custom:  This setting doesn't provide a shorteut; it allows you to customize your
settings. If you won't be customizing, skip to step 5.

To customize settings, use the pop-up menus on the right to set access privileges.

For each setting, position the pointer on the menu box, and hold down the mouse button.
A pop-up menu appears, listing the five possible settings. Drag through the list until the
setting you want is highlighted, then release the mouse button.

+ Safeguarding the contents of a folder To safeguard the contents of a folder on afile
server volume—making it impossible for anyone, including you, to accidentally erase the
information it contains, set the Make Changes privilege to Nobody., (Before you do so, make
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sure the folder already contains the information you want to keep.) Note that safeguarding
the contents of a folder doesn't prevent the folder from being renamed or moved. To do
that, you need to lock the folder, as explained in “Locking a file or folder.” on page 131.

I

Click the appropriate button to apply the changes.

= [fyouwant to assign the same set of access privileges to all the folders within this folder
as well, click the Apply to Enclosed Folders button.

s [fyoudon't want to assign the same set of access privileges to all the folders within this
Jolder as well, just click the Apply button.

6 Close the Info window.

Your folder now carries its new access privileges.

Transferring ownership of a folder
If you are the owner of a folder, you can transfer ownership to another registered user or
t0 <Any User>. Once you give away ownership of a folder, only the new owner will be able
to change the access privilege settings.

Note that if <Any User> is the owner of a folder, any registered user can claim
ownership of that folder. Once someone claims ownership of a folder created by a guest, he
or she will be the only person able to change the folder’s access privilege settings.

Follow these steps to transfer ownership of a folder:

1 Open the Access card.

For instructions, follow steps 1and 2 on page 293 o reach the Access card screen.

I~

If you want to, make any changes to the access privileges for the folder.

For instructions, see “Setting access privileges for a folder,” on page 289.

3 Drag across your user name to select it.
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Type the name of the registered user to whom you want to transfer ownership of
the folder.

If you want to give ownership of the folder to all network users, tvpe <Any User>
instead of a registered user name (or just leave the name blank).

Click the appropriate button to apply the changes.

= [fyou want to assign the same set of access privileges to all the folders within this folder
as well, click the Apply to Enclosed Folders button.

» Ifvoudon't want to assign the same set of access privileges to all the folders within this
Jfolder as well, just click the Apply button.

A dialog box appears asking you to confirm that you want to change ownership of the
folder. Click OK.

Close the Info window.

Assigning a group to a folder

If vour network administrator has set up groups on the network, you can assign a group to
any folder you create. Assigning a group merely indicates what group you want to associate
with the folder—vou still need to set access privileges for the Group (or the Owner &
Group) category before members of the group have access to the contents of the folder,

Your network administrator may also have assigned you to a primary group—that is,
a group with which your folders are associated unless you specify otherwise. (Primary
groups are particularly useful when much of your work is likely to be shared by the same
subset of network users.) When you create a folder, the primary group is set as the folder’s
group—but you're free to change that designation to another group if you prefer. Even
when your primary group is associated with a folder, members of that group will not have
access to the folder unless you set access privileges accordingly.
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Follow these steps to assign a group to a folder (or 1o change to a different group):

1 Open the Access card.

For instructions, follow steps 1 and 2 on page 296 to reach the Access card.

I~

Drag across the current group name (if any) to select it.

Or, if there is no group name, click anywhere in the box to the right of the word Group to
position the insertion point in the box.

3) Type the new group name exactly as it was given to you by the network

administrator.

4 1 you want to, make any changes to the access privileges for the folder.
For instructions, see “Setting access privileges for a folder,” on page 289.

S Click the appropriate button to apply the changes.

= Ifyou want to assign the same privileges to all the folders within this folder, click the
Apply to Enclosed Folders button,

» If you don't want to assign the same privileges to all the folders within this folder, just
click the Apply button.

6 Close the Info window.

Setting up default folder privileges

If you find that you assign the same folder privileges to most of the folders vou create, you
can use the FolderPriv Control Panel to set up default privileges that will be automatically
assigned to all your new folders. Follow these steps:

| choose Control Panels from the Apple menu.

The Control Panels window appears.
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Select the FolderPriv Control Panel, and click Open.

It may be necessary to scroll through the column until the FolderPriv Control Panel is
visible. (You can also double-click the icon to open it.)

EO=hlderPriv=i—Fnu=
= o Use Server Defaults
FGIﬂEI‘FFiU Huster [ 'I'fﬂ-.Tr_e—'i

See Folders: | Punet Sl i
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1 Buner is {finy User

Click in the Use Server Defaults checkbox to deselect it.

If you want to use the server defaults, leave the checkbox selected and close the FolderPriv
Control Panel,

Set your default privileges.

To use the pop-up menus, position the pointer on the setting box, hold down the mouse
button, and drag through the list until the desired setting is highlighted.

For more information about the settings, see “Setting access privileges for a folder,” on
page 289,

If vou want your folders to be open to all, click in the Owner Is <Any User> checkbox.

Close the FolderPriv Control Panel and the Control Panels window.

All folders you create are automatically assigned the default privileges you have set, unless
you assign them individually. For information about assigning privileges to an individual
folder, see “Setting access privileges for a folder,” on page 289.
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Logging off a file server

You can log off a file server in four ways:

* Ifyou started up from an AppleShare startup disk using the Finder, follow the
instructions in the next section, “Logging off in the Finder.”

= f'you started up from an AppleShare startup disk without the Finder, follow the
instructions in the next section, “Logging off without the Finder.”

= If you started up over the network (with or without a local disk), and if the network
administrator bas installed the Server Quick Logoff program, follow the instructions
in the section, “Logging off with Quick Logoff,” on page 301.

= Il vou started up over the network (with or without a local disk), and if the network
administrator bas not installed the Server Quick Logoff program, follow the
instructions in the section, “Logging off without Quick Logoff,” on page 301.

Logging off in the Finder
Follow these steps to log off a file server when you're using a Finder-based AppleShare

startup disk:

1 Quit the application you're using if you haven't already done so.

You return to the Finder desktop.

2

Drag the icons of all file server volumes to the Trash.

The icons disappear from the desktop, and you're automatically disconnected from the file
SCIvern
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Logging off without the Finder

There are two ways to log off if you're using an 800K AppleShare startup disk that doesn't
include the Finder.
* Ifthe application you're using allows you to give an eject command, do so.

s Ifyou cannot give an eject command, shut down your computer.

Logging off with Quick Logoff

To log off without the Finder when the administrator has installed the Server Quick Logoff
program. simply quit the application you're using. You're automatically logged off the file

server, and vou return to one of the screens shown (depending on whether vour network
is divided into zones and whether there is more than one file server on your network).
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From there, you (or any other registered user or guest) can log on to another file server.
Or you can shut down the computer.
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Logging off without Quick Logoff
Follow these steps 1o log off without the Finder when the administrator has not installed
the Server Quick Logoff program:
1 Quit the application you're using.
You see the log-off screen.

O Heklabars Startus ] 0 —

Faturn tn rtartus eREliceridsn

Fhut Down

Salmces T focest  J

2 Press Return to accept the “Log off from file servers” option.

You're automatically logged off the file server, and you return to the screen shown
(depending on whether your network is divided into zones and whether there is more than
one file server on your network).

From there, you (or any other registered user or guest) can log on to another file server,

# About the other options The “Return 1o startup application” option starts up the
computer with vour startup application, just as if vou had logged on again. Select this
option if vou accidentally quit your startup application and want to return to i.

The Shut Down option works like the Shut Down command in the Finder: it logs vou
off all file servers, ejects any disks in your local disk drives, and shuts down the computer.
A message on the screen lets you know that it's safe to switch off the computer's power,
and a button on the screen gives vou the option to restart,

If someone else wants to use the computer, he or she can start up over the network by
clicking the Restart button. If no one else wants to log on after vou, switch off the
mmpulr?r. *
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Printing over the network

This section describes the printing capabilities available to you when your network includes
a network printer—either an ImageWriter or a LaserWriter printer.

Network printing appears much the same as printing with a local printer (a printer
connected directly to your computer), with the added advantage that network users can

share printers.
Follow these steps to choose a network printer:
1 start up the computer with a startup disk on which you have installed the

appropriate network printer update (AppleTalk ImageWriter, AppleTalk
ImageWriter L(), or LaserWriter).

I~

Choose Control Panels from the Apple menu.

The Control Panels window appears.

3 Select the NetPrinter Control Panel, and click Open.

It may be necessary to scroll through the column until the NetPrinter Control Panel is
visible. You can also double-click the icon to open it,

EO== Net Printer ==

Printer:

Letterheod
Three-Hole Paper
Legol Bond
Administration

Hét Frint_er

Fourth Floor East
Fourth Floor West
Second Floor Eost

User Nome:
[ Jenna Woodul ]
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< If the preset option is not the type of printer you want, position the pointer on
the setting box, hold down the mouse button, and drag through the list until the
correct setting is highlighted.

If you've installed only one network printer update, you can click OK to accept the preset
option,

I

If necessary, select a zone.

If vour network is divided into zones, the name of your zone is highlighted. If vou want to
use a printer in a different zone, simply click the name of the zone. If there are more than
four zones in your network, you may need to scroll through the window to find the zone
yOu want.

6 If you selected LaserWriter in step 4, and if you're using an application that
doesn’t support the desktop interface or doesn’t support the LaserWriter, click
the ImageWriter Emulator button.

The ImageWriter Emulator button is available only if you selected LaserWriter.

The ImageWriter Emulator is a program that makes it possible to use a LaserWriter with any

application designed to print with an ImageWriter. Clicking the ImageWriter Emulator

button tells the computer to install this program in the memory of the LaserWriter.

You see the message, “Checking for presence of the ImageWriter Emulator.”

= [f someone bas chosen the printer from an Apple Il computer since the printer was
last switched on, you'll see the message “The ImageWriter Emulator is already installed
in the selected printer.” Click OK in the dialog box and go on to step 8.

= [f no one has chosen the printer from an Apple Il computer since the printer was last
switched on, vou see the message “Downloading the emulator.” When the message
disappears, the ImageWriter Emularor has been installed on the selected printer.

8  Close the NetPrinter Control Panel.
9 Close the Control Panels.

You're now ready to print your document. Select Print from the File menu or follow the
instructions that came with your application to print vour document.
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Related books and manuals

The following manuals from Apple Computer, Inc., provide additional information about
the Apple 11Gs, the AppleTalk network system, and AppleShare File Server software.

The LocalTalk Cable System Owner’s Guide provides guidelines and instructions for
planning, setting up, and maintaining the physical connections between network
devices on an AppleTalk network system with LocalTalk cables.

The AppleShare File Server Administrator s Guide explains how to set up and maintain
a Macintosh computer (with AppleShare File Server software and one or more hard
disks) as an AppleShare file server.

The AppleShare File Server Administrator’s Supplement for Apple I Workstations
explains special procedures you must follow in order to give Apple Il computers access
to an AppleShare file server, When the Administrator's Supplement makes reference to
the AppleShare llcs User's Guide, you should refer to the AppleTalk Network User's
Guide for the Apple 1lcs instead.

The AppleShare Print Server Administrator's Guide explains how to set up and
maintain a Macintosh computer (with AppleShare Print Server software and one or
more hard disks) as an AppleShare print server. (You can use a single Macintosh
computer as a file server and a print server.)

The Aristotle Administrator s Guide explains how to set up the Aristotle menu software
on an AppleShare file server, (Aristotle is special software, designed for classroom use,
that lets teachers determine which applications are available when students logon toa
file server.)

The Apple 1 Workstation User s Guide explains how to use the workstation card and its
accompanying software. Refer to it if you plan to start up with ProDOS 8.
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Troubleshooting

This chapter helps vou deal with the unexpected. When you're using vour computer, things
may not always happen as vou expect them to. Don't think of unexpected events as
mistakes—think of them as learning opportunities, The more adventurous you are, the

more likelv you are to come across new possibilities—and to learn from them.

The first section of this chapter lists unexpected situations vou may encounter when trying
to start up applications. Subsequent sections are grouped by these topics: Control Panels,
disks and disk drives, kevboard and mouse operations, modems, monitors, networking,
printers and printing, and starting up (or restarting) the computer. The final sections

describe a short diagnostic test vou can run to make sure the computer isn't faulty, and list

additional sources of help if the suggestions in this chapter don't explain what happened.

Within each section, specific situations dre described in italic text, with the likely causes and

recommended solutions immediatelv following.



Applications

This section discusses situations that may occur when starting up an application, using an
application, saving a document, or quitting an application. Other unexpected situations
that occur when starting up an application are covered later in this chapter in “Starting Up,”
on page 333.

Starting up an application

Here are some situations you might encounter when starting up an application.

The computer can't successfully run an application that you try to launch
from the Finder.

One of the following mav be the cause:

The application is incompatible with Svstem 6. Check with the dealer from whom you
purchased the application or the application’s publisher. If the application is
incompatible, vou can still use it if vou start up directly from the application disk.

The application requires more memory than your computer has. An Apple 1168 with
ROM 3 has one megabyte (MB) of random-access memory (RAM); an Apple 11Gs with
ROM 01 has 256 kilobytes (K) of memory. Some Apple 1168 applications require more.
You can add the necessary memory to your computer with an Apple Ils Memory
Expansion Card and one or more Apple 11 256K Memory Expansion Kits. Third-party
memory boards that permit even larger amounts of RAM are available.

The application is incompatible with a peripheral interface card vou've installed in vour
computer. Whenever you want to use the application, first use the Control Panel to
change the setting for the slot containing the peripheral interface card from Your Card
to the corresponding port.
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You open a document by double-clicking, and an application other than the
one you intended is opened.

The Finder does not associate the document with the application. Do the following;

= Hold down the Option key when opening the document. The Finder will let you select
the application to launch.

= Hold down both the Option key and the Control key and the Finder will retain the
association and launch the correct application the next time you open the document.

Using an application

Every application has its own set of messages, geared toward explaining the unexpected
situations users may encounter. In many applications, the error messages are self-
explanatory; they tell you what happened and what you need to do in order to continue.
But in some applications, the messages may seem cryptic, requiring you to look up the
meaning of the message in the manual that came with the application.

This section lists a few unexpected situations that might occur with any application
vou're using.

You can’t get to the text Control Panel menu by pressing Command-Control-
Esc.
Your application probably uses a version of ProDOS earlier than version 1.2, which doesn't

give you access 1o the text Control Panel. Have your authorized service provider upgrade
the application to a more recent version of ProDOS,

The text Control Panel menu appears unexpectedly.

You tried 1o get to the text Control Panel menu earlier from an application that didn't let
you. The computer retained your request and complied as soon as possible. Choose Quit
from the text Control Panel menu. Ask your authorized service provider to upgrade the
version of ProDOS on vour application disk so you can use desk accessories with the
application.
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Your application works with an Apple lle but not with your Apple 11Gs,

Some applications designed to work with both the Apple Ile and the Apple IIGS cannot
exchange information with the Apple 11Gs at a fast rate, If the System Speed setting in the
Control Panel is at Fast, set System Speed to Normal and try again. If that doesn't help, ask
your authorized service provider if there’s a version of the application designed for the
Apple TIGs.

The screen is full of 2’s or meaningless characters.

The application you're using was designed for earlier models of the Apple II family, Leave
the application disk in the disk drive, press Command-Control-Esc, choose Alternate
Display Mode from the text Desk Accessories menu, and press Return, When you're
finished using the application, choose Alternate Display Mode again to restore the standard
display.

Saving a document

In addition to reading the troubleshooting suggestions in this section, you may need to
consult the manual that came with your application for advice specific to the application,

Your application asks for the slot and drive of the disk where you want to
save the document, but your drive is connected to the disk drive port.

Earlier models of the Apple I family didn't have ports, so the logical way to identify the
location of a disk was by slot and drive. If your application was designed for such a machine,
it will probably ask you for slot and drive numbers.

The first two 3.5-inch drives connected to the disk drive port correspond to slot 5; the
third and fourth 3.5-inch drives connected to the port correspond to slot 2. The 5.25-inch
drives connected to the disk drive port correspond to slot 6. When vou have two drives of
the same type, the drive that is connected to the disk drive port is drive 1; the second drive
is drive 2.
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Your application saves everything to drive 1, but you want it to save lo
drive 2.

The application is saving to the default, or preset, drive—the drive it is configured to use.
Read the manual that came with your application to find out how to change the default

drive. Some applications have a command called Select Volume or Set Prefix that lets you
specify the drive where you want 1o save documents.

Quitting an application

Whenever possible, you should quit an application rather than just switching off the
computer. If your application doesn’t have a Quit command, try one of these methods. Start
with the first method in the list, and try them in order until vou find one that works.

®  Press Command-Q (for Quit),

= Press Control(.

= Press().

= Check your application manual for other methods.

*  [nsert a different startup disk in your startup drive and press Command-Control-Reset.
If none of these methods works, eject all disks, and then switch off the computer. You
can then restart your computer with another application or with your system disk.

Control Panels

This section discusses situations that may occur when you are working with the desktop
Control Panels.

A change you made in a Control Panel doesn't seem to have taken effect.

One of the following may be the cause:

» Ifvou made a change to the Slots options, the change doesn't take effect until vou
restart the computer. As soon as vou restart, the new setting will be in effect.
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= Ifyou made a change in RAM disk size, the change doesn’t take effect until you shut
down the computer, switch it off, and then start it up again. (Or, if your computer has
ROM 3, and if you turned on the “Resize after reset” option, the change will take effect
when vou restart the computer with or without switching off the power.)

= [nsome cases, the change you make 1o a Control Panel doesn'’t take effect until you
close the Control Panel window.

The Control Panels desk accessory—if any are installed on the startup disk—
is dimmed in the Apple menu, and you can't get to the text Control Panel
menu by pressing Command-Control-Esc.

You've installed one or more system updates on the current startup disk. Until vou restart
vour computer. desk accessories are not available. Click Quit, and then click Restart System.
When vou next see the desktop, all vour desk accessories will be available to you.

There aren’t as many Printer Port or Modem Port options as you expect.

The Printer Port and Modem Port options displayed in the Control Panel depend on the slot
settings for Slot 1and Slot 2, respectively, If either slot s set to AppleTalk, fewer options will
be displaved for the corresponding port.

When using a pop-up menu to change a setting in a desktop Control Fanel,
you don't see the setting you want.

When there are more settings in a pop-up menu than can fit on the screen at once, a black
arrow at the top or bottom of the menu lets vou know that there are more settings in that

direction. Drag through the menu until the pointer reaches the arrow. More settings scroll
into view. When the desired setting is highlighted, release the mouse button.

All the Control Panel options revert to their original settings (the ones set at
the factory).

Restoring the standard frequency settings (Option-Control-Reset, then 2) causes the
Control Panel options to revert to their original settings. Reset the Control Panel options. If
they revert to their original settings again, the computer's battery is running low. Have your
authorized service provider replace the battery.
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The clock in the Time options of the Control Panel no longer keeps accurate
lime.

The computer’s hattery is running low. Have vour authorized service provider replace the
battery.

Disks and disk drives

This section discusses situations that may occur when you work with the Advanced Disk
Utility or initialize disks in the Finder, as well as other situations you may encounter when
you work with 3.5-inch, 5.25-inch, or hard disk drives.

Advanced Disk Utility

Here are some situations vou may encounter while using the Advanced Disk Utility.

You can't erase, initialize, or zero removable media because the appropriate
buttons are dimmed in the Advanced Disk Utility screen.

One of the following may be the problem:
» The selected media is write-protected. If you want to erase, initialize, or zero it, follow
these steps:
1. Eject the media.
The Advanced Disk Utility screen displays the next available volume.

(3

Remove the write-protection.

For instructions, see “Write-protecting a disk,” on page 94 in Chapter 4, or refer to
the manual that came with your removable media.

3. Reinsert the media.

4. Click the Disk button until the media is selected.

The Erase, Initialize, and Zero buttons will no longer be dimmed.
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*  Theselected media is a locked partition. If you want to erase, initialize, or zero it, follow
these steps:
1. Quit ADU.
2. Unlock the partition. (You unlock a partition in the same way you unlock a file or
folder. For instructions, see “Unlocking a file or folder,” on page 132.)
3. Start up ADU.
4. Click the Disk button until the partition is selected.
The Erase, Initialize, and Zero buttons will no longer be dimmed.
»  The selected disk is the startup disk. If you want to erase, initialize, partition, or zero the
disk, follow these steps:
1. Shut down the computer.
2. Start up the computer with a different startup disk.
3. Launch ADU.
4. Click the Disk button until the disk is selected.
The Erase, Initialize, and Zero buttons will no longer be dimmed.

= The selected disk is a network server: You cannot perform operations on such a disk.

You can't partition a disk because the Partition button is dimmed.

»  The selected disk is not a SCSI bard disk or SCSI bard disk partition. Other types of
disks—3.5-inch disks, 5.25-inch disks, RAM disks, file server volumes, non-SCSI hard
disks—can't be partitioned.

®  One or more of the partitions on your SCSI bard disk could be locked. Quit ADU and
unlock the locked partition(s). ( You unlock a partition in the same way you unlock a file
or folder. For instructions, see “Unlocking a file or folder,” on page 132.) Then start up
ADU, and click the Disk button until the disk or partition is selected.

The Partition button will no longer be dimmed,
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Initializing a disk in the Finder

Here is a situation you may encounter when initializing a disk.

The Initialize command is dimmed.

One of the following is the cause:

You haven't selected any disk icon. Select the icon of the disk you want to initialize,
then choose Initialize from the Disk menu.

The disk you want to initialize is write-protected (as indicated by the symbol of a lock
to the left of the disk icon's name). If the disk is removable, ¢ject it, remove the write-
protection, and reinsert the disk. (For instructions on removing write-protection, see
“Write-protecting a disk,” on page 94 in Chapter 4.) Then select the disk icon and
choose Initialize from the Disk menu. If the disk is a locked partition, unlock it. (You
unlock a partition in the same way vou unlock a file or folder. For instructions, see
“Unlocking a file or folder.” on page 132.)

You're trying to initialize a file server volume or a disk that can't be altered (such as a
CD-ROM). These kinds of disks can’t be initialized.

Using 3.5-inch and 5.25-inch disk drives

Here are situations vou might encounter when using 3.5-inch and 5.25-inch disk drives.

The Finder doesn't recognize all the disk drives connected to the disk drive
port.

One of the following may be the cause:

If vou have more than one type of drive, you've connected the drives in the wrong
order. Apple 3.5 Drives must come first in the daisy chain, followed by UniDisk 3.5-inch
disk drives, and then Apple 5.25-inch Drives.

Shut down and switch off the computer, wait at least 15 seconds, and then reconnect
the drives in the correct order.
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® lou've connected more drives to the disk drive port than the computer can recognize.
(The disk drive port can accommodate a maximum of two Apple 3.5 Drives, four
UniDisk 3.5 drives, and two Apple 5.25 Drives. But it cannot accommodate more than
four disk drives in all.)

Shut down and switch off the computer, wait at least 15 seconds, and remove the
necessary drives to conform with the configurations described above.

= You baven't installed the correct driver for your disk drive.
Use the Installer to add the correct driver to vour startup disk. (For instructions, see
Chapter 2, “Using the Installer.”

s The slot settings for slots 5 and 6 are set incorrectly.
To see 3.5-inch drives, make sure that slot 5 is set to Smart Port, To see 5.25-inch drives,

make sure slot 6 is set to Disk port. (For instructions, see Chapter 7. Don't forget 1o
restart the computer so that the changes vou make will take effect.)
The Finder doesn't recognize all the disks inserted in the disk drives.

You haven't installed the correct file system translator for the disk vou've inserted. For
example, if vou insert an HFS disk without having installed the HFS FST, the Finder won't
recognize your disk.

Use the Installer to install the correct FST. (For instructions, see Chapter 2.)

The Finder sees only 800K when you're using a bigh-density disk.

In order to see all 1.4 MB of vour high-density disks, vou must connect the SuperDrive 10
the Apple 3.5 Disk Controller Card. If the SuperDrive is connected to the port on your
Apple Gs, only 800K will be seen.

Using a hard disk

Here is an unexpected situation you might encounter when using a hard disk.
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A bard disk icon doesn’t appear on the Finder desktop when you start up the
computer,

One of the following may be the cause:

The bard disk, or anotber device on the SCSI chain, isn't switched on. In order for the
Finder to recognize a hard disk, the hard disk and all devices on the SCSI chain should
he switched on and up to speed before you start up (or restart) the computer.

Switch on the hard disk, wait about 10 seconds for it to come up to speed, and then
restart the computer.

The Control Panel setting for the slot containing your SCSI card isn't set to Your Card.

Use the Control Panel to change the slot setting to Your Card. Then restart the
computer. When you see the Finder desktop, the hard disk icon should appear.

You haven't installed the SCSI bard disk driver on your startup disk. Use the Installer
to add the driver to vour startup disk. (For instructions, see Chapter 2.)

More than one SCSI device is set to the same SCSI device number. Check the SCSI
device numbers according to the instructions in the manual that came with the SCSI
card.

There's only one SCSI device attached to the SCSI card, but you've used two SCSI cable
terminators on the device. When you're connecting only one SCSI device, you should
use only one SCSI cable terminator. (Note that the Apple High Speed SCSI card has
built-in termination. )

Shut down the computer, switch off the computer and the SCSI hard disk, wait at least
30 seconds, and then reconnect the SCSI cables and cable terminators according to the
instructions in the manual that came with the SCSI card.
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Keyboard and Mouse Operations

This section discusses unexpected situations that may occur when vou attempt to perform
keyboard or mouse operations.

The Delete key doesn't delete characters.

Earlier models of the Apple Il family didn't have a Delete key, so applications designed for
them use some other key or combination of keys to delete text. Often the Left Arrow key
erases the text to the left of the cursor. If that doesn't work, consult the manual that came
with your application for instructions.

The insertion point doesn't move when you press the arrow keys.

Earlier models of the Apple II family didn't have the Up Arrow and Down Arrow keys, so
applications designed for those machines use some other way of moving the insertion
point. Many applications use the Esc (Escape) key in combination with 1 for up, J for left, K
for right, or M for down. Consult the manual that came with your application for
instructions.

The insertion point does’t move past the last line of your document.
That's how the application is meant to work. Press Return to move the insertion point

beyond the last line of your document and continue typing.

When you press a key, the corresponding character appears more than once
on the screen.

Set the Speed setting in the Kevboard Control Panel of the desktop Control Panels to give
vourself a longer delay before keys repeat. (In the text Control Panel, this option is called
Repeat Speed. ) For information, see “Kevboard,” on page 179.

The application says to press a key but doesi’t respond when you do.

One of the following may be the cause:

= The kevboard isn't plugged in. Switch off the computer, wait at least 15 seconds, and
then connect the kevboard securely to the kevboard port.
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= Ifthis situation occurs immediately upon starting up the application, the application
may be one that requires you to type everything in uppercase letters. (Earlier models
of the Apple 1T family didn't give vou the option of typing lowercase letters.) Press Caps
Lock and try pressing the key again.

The application tells you to press the Solid Apple key (also represented as the
& Ley), but there’s no such key on the keyboard.
On some earlier models of the Apple 11 family, the Option key was marked with the symbol

of a solid apple and was called the Solid Apple key. Press Option whenever the application
tells you to press the Solid Apple key.

The application tells you fo press the Option key in combination with other
keys, but pressing Option doesn't work.

In the General Control Panel, change the Translation setting from Standard to None.

The computer doesn't keep track of keystrokes.

If you're using an application that was designed for the Apple lle, the kevboard buffer may
not work with your application. (Some early Apple lle applications don't support buffering
of keystrokes.) Deselect the Keyboard Buffering option in the Keyboard Control Panel
whenever vou're using this application. (For more information, see “Keyboard,” on

page 179.)

When typing in a text mode application, unexpected characters appear on
the screen.

You may have changed the Monitor or Keyboard option in the General Control Panel of the
desktop Control Panels to a setting other than USA, (These options are called Display

Language and Keyboard Layout in the text Control Panel.) Use either the text Control Panel
or the desktop Control Panels to change the settings back to USA.
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When typing a password (or other case-sensitive material), no characters
appear.

You are typing lowercase characters. Press the Caps Lock key and retype the characters, The
reverse situation may also occur. If lowercase is required, make sure Caps Lock is not
activated.

When you move the mouse across the desk, the pointer on the screen moves
in the opposile direction.

The mouse should be positioned with the cable pointing away from vou. The Apple logo
should be toward you,

You run out of room to move the mouse on the desk before the pointer on the
screen reaches its destination.

Lift the mouse off the desk and move it back to the center of your work surface. The pointer
won't move until you put the mouse back on the desk and move it,

If you encounter this difficulty frequently, you may want to change the Mouse Speed
option in the General Control Panel of the desktop Control Panels. { The same option is
called Mouse Tracking in the text Control Panel.) For more information, see "Keyboard
Mouse,” on page 181 in Chapter 7.

Double-clicking doesn’t work the way you expect.

You can adjust the amount of time the computer waits for the second click ofa double click.
(See “Keyboard Mouse.” on page 181 in Chapter 7 for an explanation.) Change the Double
Click option in the General Control Panel to a setting better suited to your own speed of
double-clicking.

The mouse won't respond,

One of the following may be the cause:

*  The mouse is not connected properly to the keyboard or to the mouse port, or the
keyboard is not connected properly to the keyboard port. Switch off the computer,
wait at least 15 seconds, and secure the keyboard and mouse connections.
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Modems

»  The mouse port (also called the keyboard port or the Apple Deskiop Bus port) is not
activated in the Slots options of the Control Fanel. Change the setting for Slot 4 from
Your Card to Mouse Port as described in Chapter 7.

Here are some unexpected situations vou might encounter when using a modem.

Every character appears twice on the screen when you're sending a message.

Your Apple I1GS is echoing every character you send on the screen, and the other computer
is echoing every character it receives back to your screen., Deselect the Echo setting in the
communications application (or in the Modem Port Control Panel).

A line of meaningless characters appedrs on the screen when you send or
receive messages over phone lines.

One of the following may be the cause:

= The computer on the other end of the phone line is sending information to your
computer in a form your computer can't understand. 1f you're trying to connect to
an information service, check the materials you received from the service to see what
specifications the other computer is using, and check the data bits, stop bits, and parity
settings in your communications application and in the Modem Port Control Panel. For
more information, see “Modem Port and Printer Port,” on page 182 in Chapter 7.

= The baud rate is set incorrectly in the terminal program. Follow the instructions in
the manual that came with vour terminal application and make sure that the baud rate
entered in the application matches the baud rate supported by your modem.

= Someone is trying to use another extension on the telephone line (or, if your telephone
is on a party line, someone else is trying to use the telephone). Try again when the line
is available,
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Characters are lost during information exchange.

One of the following may be the cause:

= There's oo much noise or distortion on the phone lines to transmit information at the
speed you're using. Sign off and reestablish communication. If that doesn't work,
change to a lower baud, if possible, on both the sending and the receiving end. If the
receiving modem does not support the lower baud rate, the connection will not be
made; the sending modem sets the baud for the connection.

»  Buffering is turned off (This is likely to be the cause if you're losing only an occasional
character.) Turn on the Buffering option in the Modem Port Control Panel.

Information you send through the modem doesn't appear on your screen.

The other computer isn't echoing information back ro your computer as it receives i,
probably because it's using a half-duplex modem. Turn on the Echo setting in the
communications application (or in the Modem Port Control Panel).

¢ Exception Many communications applications that use passwords turn off the Echo
setting while you're entering your password. (That way, no one can watch the screen to
learn your password as you type it.)

Your communications application works with a modem connected to a
Super Serial Card, but not with a modem connected to the Apple l1GS modem

port.
One of the following may be the cause:

= The modem port is configured incorrectly. Check the specifications in the manual that
came with the modem and then use either the communications application or the
Modem Port Control Panel to reconfigure the port correctly.

= Your communications software works only in conjunction with a particular
integrated circuit on the Super Serial Card. Either use a Super Serial Card or get a
communications application designed for the Apple 11Gs.
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Monitors

You lose the connection with the remote computer or information service.

Your telephone has a call-waiting feature and someone is phoning you. When you're ready
to reestablish the connection, dial the temporary cancellation code for the call-waiting
feature. One of the two codes below will probably work:

*  On most call-waiting systems, 1170 is the appropriate code.

= Dialing *70 is an alternative code to use.

This section discusses unexpected situations that you may encounter with your monitor.

The image on the screen is rolling or out of alignment.

The Apple 11Gs is sending signals to the monitor according to the standard for most
countries (50 hertz) instead of the United States standard (60 hertz), or vice versa, Press
Option-Control-Reset. Then press either 2 (to restore the standard U.S. setting) or 3 (to
restore the other setting), When vou reset the frequency, all other Control Panel options
revert to their original settings, so vou must go to the desktop Control Panels and
reconfigure your system to match your individual preferences.

The text on the screen is fuzzy or unreadable.

One of the following may be the cause:

»  The contrast is too bright or too dim.  Adjust the contrast knob on your monitor.

= The monitor cable isn't properly plugged into the computer. Switch off the computer,
wait at least 15 seconds, and then secure the connection.

= The software is set incorrectly. Change the monitor setting to “Monochrome™ in the
Monitor Control Panel.

»  loi're using a composite color monitor and the application is displaying text in the
St-coltemn mode,  1f the application gives you a choice between 40-column and 80-
column display, choose 40, If the application doesn't give you a choice, change the
Columns setting in the Control Panel to 40,
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Text and background colors are so similar that the text is unreadable.

First try adjusting the contrast and brightness on your monitor. If that doesn't improve the
contrast, you can restore the original Control Panel settings for text and background by
pressing Option-Control-Reset and then 2 (for the United States) or 3 (for other countries).
If there still isn't enough contrast, try changing the Type option in the Display menu of the
text Control Panel to Color, even if you're using a monochrome monitor.

Little apples and check marks appear instead of uppercase, inverse text.

The apples and check marks are called MouseText, MouseText characters replaced a
redundant set of characters in earlier models of the Apple 11 family. Older applications using
that redundant character set will now display MouseText characters in place of uppercase,
inverse text. The MouseText characters don't affect the way an application works, so if they
don't bother vou, go ahead and use the application. If they do bother you, ask your
authorized service provider or the manufacturer of the application if a newer version of the
application is available.

There isn't enough contrast between colors on the display.

The application was designed for earlier models of the Apple II family, The Apple LGS
generates slightly different colors. Try changing the Tvpe option in the Display menu of the
text Control Panel or the Monitor Control Panel of the desktop Control Panels to the
opposite setting, (The display type doesn't have to march the kind of monitor you're using, )

The screen is full of 2's or meaningless characters,

The application you're using was designed for earlier models of the Apple 11 familv. Leave
the application disk in the disk drive, press Command-Control-Esc, choose Alternate
Display Mode from the classic desk accessories menu, and press Return. When you're
finished using the application, choose Alternate Display Mode again to restore the standard
display.
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You can't get color display even though youw're using a color monitor:

One of the following may be the cause:
»  The monitor is set to monochrome (dark-and-light) mode. Change the switch on your
monitor to color mode.,

»  The software is set incorrectly. Change the monitor setting to “Color” in the Monitor
Control Panel,

= You're using a composite color monitor with a text-based application. Unlike RGB
color monitors, composite monitors can't display 80-column text clearly in color mode,
so they may switch automatically to monochrome mode for text-based applications. You
get color display when you use graphics-based applications.

The 40-column display changes to an 80-column display and clears the
screen when you press Control-Reset.

You've changed the Columns option in the display Control Panel to 80, but the application
you 've just been using can display text only in the 40-column mode. Pressing Control-Reset
puts vou back in the 80-column mode. You don't need to do anything further, unless you
prefer the 40-column mode. (In that case, simply change the setting in the display Control
Panel.)

Networking

This section discusses situations that may occur when you are working on a network,
including setup, starting up, and using an AppleShare file server.

Network Setup

If setup is not properly accomplished, or network communication is interrupted, you may
encounter these situations.
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You can't find the AppleShare file server you want in the desktop Control
Fanels.

One of the following may be the cause:

= AppleShare isn't installed on your startup disk. Add AppleShare to your startup disk
(for instructions, see Chapter 2, “Using the Installer,” starting on on page 19) or see
vour network administrator,

= The computer’s slot settings are incorrect in the Control Panel. 1f your computer has
ROM 3, and if it's connected to the network via the printer port, Slot 1 should be set to
AppleTalk. If your computer is connected to the nerwork via the modem port, Slot 2
should be set to AppleTalk, It's recommended—but not required—that you set slot 7 to
AppleTalk as well. For more information, see “Activating slots and ports,” on page 192
in Chapter 7.
If your computer has ROM 01, and if it's connected to the network via the printer port,
Slot 1 should be set to Your Card, Slot 2 can be set to either Your Card or Modem Port,
and Slot 7 must be set 1o AppleTalk.

If your computer has ROM 01, and if it's connected to the network via the modem port,
Slot 1 should be set to Printer Port, Slot 2 should be set to Your Card, and Slot 7 must
be set to AppleTalk. (Note that Slot 1 must not be set to Your Card in this case.)

= The file server isn't selected in the Control Panel. Follow the instructions in “Logging
on to a file server from the AppleShare Control Panel,” on page 280 in Chapter 12,

= Alotof people may be using the file server or the network. Wait 15 or 20 seconds after
you select the AppleShare icon in the Control Panel—or after selecting a zone in the
AppleShare options—and see if the desired file server appears in the list.

»  The file server has been shut down. 1tis sometimes necessary for the network
administrator to shut down the file server to perform certain administrative tasks. Ask
the administrator when the file server will be available again.

»  Communication on the Locallalk network bas been interrupted. Ask the network
administrator to check for disconnected LocalTalk cables between your computer and
the file server you're trying to use.

s The file server is in a different zone. Make sure the correct zone is selected in the
Control Panel.
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You can't find your zone in the Control Panel,

Communication on the LocalTalk network may have been interrupted. Ask the network
administrator to check for disconnected LocalTalk cables between vour computer and the
file server vou're trving to use.

Network, Starting up or Logging On

This section lists unexpected situations vou may encounter when trving to start up over the
network or log on to an AppleShare file server with a startup disk that doesn't include the
Finder,

You can’t use certain features or files, or an error message refers to an
attempt to open a file with *CDEV” in the pathname.

All file servers in your zone may not have been updated with current software. All servers
that have Apple I1 startup service enabled should be running the same version of the Apple
11 Setup disk; all file servers from which users start up should be running the same version

of system software. Check with your network administrator to make sure the latest software
is installed on all the file servers in the zone,

Although attempting to start up with ProDOS, you start up with GS/0S.

One of the following may be the cause:
= Al file servers in your zove may not bave been updeated with current software. Check
with your network administrator.

» Inalab situation, you may bave been at a different machine when you first selected
to start up with ProDOS 8, The setting is saved in the first computer’s memory and
doesn't affect other machines.

You get a message saying that an application isn't a ProDOS 8 application.

Although you selected ProDOS 8§ startup, your startup application is a GS/08 application.
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After selecting a startup application from the server’s administration
program, you start up in the Finder.

An update not intended for networking has been installed on the file server. Install the
“Network: Server Startup” update instead.

An error message says that “the user is unknown” or “login is disabled.”
One of the following may be the cause:
»  The user name may be misspelled. Check with the network administrator.

= With AppleShare 3.0, vour may have exceeded the limit for login attempts. Ask the
nerwork administrator to re<enable the login feature for you.

Using an AppleShare file server

This section lists unexpected situations you may encounter when trying to use an
AppleShare file server.

You try to change your password, and get an unknown error,

The administrator has set a minimum number of characters for the password; you are trying
to use a password that is too short.

Although you try o eject a file server volume (by dragging it to the Trash, for
example), it stays mounted.

Your application or the system has a file open on the server volume. Try closing documents
or quitting the application. If vou started up directly over the network, and you're trying to
eject your startup volume, you have to quit the application and log off. If the administrator
has installed the Server Quick Logoff program, simply quit the application you're using;
vou're automatically logged off the file server.

# Note In general, the security features of AppleShare 3.0 aren't recognized by Apple 11
networking software. Although the server enforces security properly, misleading messages
(or no messages at all) may be displayed on the Apple lIGs. &
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Printers and Printing

This section discusses unexpected situations you may encounter when printing your
documents. Be sure to familiarize yourself with the printing procedure for the application
VOU dre using.

The printer doesn't print.

One of the following may be the cause:

If your printer bas a select button, it basn’t been turned on. This button determines
whether the printer is accepting instructions from the computer. (Sometimes you want
to control line feed and form feed manually; the select button lets you switch between
manual and automatic operation.) Make sure the button is set to On and try printing
dgain,

The printer isn't switched on. Switch the printer on and try printing again.

The printer isn't plugged into a power source. Make sure the power cord is connected
securely to the printer and that the plug is inserted fully into a grounded outlet. Then
try printing again.

The printer isn't properly connected to the computer. Switch off the computer, wait at
least 15 seconds, and secure the connection. Then try printing again.

The slot corresponeing to the port to which you've connected the printer cable isn't set
to Printer. See “Slots,” on page 191 in Chapter 7 for instructions on changing the slot
setting.

The printer port (or the modem port) is configured incorrectly. See “Modem Port and
Printer Port,” on page 182 in Chapter 7 for instructions on reconfiguring the port.

The correct printer and port are not selected in the DC Printer or NetPrinter Control
Panels. For instructions, see “DC Printer,” on page 175 in Chapter 7.

If vou are printing with an interface card, the card's settings are not properly set. See
the manual that came with your card.

The printer's dip switch settings are not properly set. For instructions, see the manual
that came with vour printer.
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® You're using the wrong kind of cable. (Different kinds of printers need different
cables.) Take the cable to your authorized Apple dealer and ask whether you need a
different kind of cable.
If vou're printing with a network printer or a local LaserWriter printer, see the additional
suggestions at the end of this section.

The printer produces a line of meaningless characters that bear no
resemblance to your document,

Any of the following may be the cause:

s The printer port (or the modem port) is configured incorrectly. See “Modem Port and
Printer Port,” on page 182 in Chapter 7 for instructions on reconfiguring the port.
Specifically, check the baud rate setting; it should be set to 9600 baud for the
ImageWriter or LaserWriter printers. The correct rate setting for StyléWriter printers is
19,200 baud. If you're using another printer, check your manual for the correct baud
rate setting.

* Ifyouare printing with an interface card, the card's settings are not properly set. See
the manual that came with your card.

s The printer cable is loose. Switch off the computer, wait at least 15 seconds, and then
secure the connection,

= [fyour application presents you with a list of printer types, the selected type may not
match your printer type. Select the correct printer tvpe. (If your printer type isn't
listed, select each type in turn and try printing. If your printer uses the same
configuration as one of the types on the list, your document should print successfully
when that type is selected.)

The ImageWriter printer produces pairs of meaningless characters.

The ImageWriter printer has a built-in debug mode that prints the hexadecimal characters
being sent from the computer. You can tell that the printer is in debug mode if vou see pairs
of characters in the ranges 0—9 and A~F. When you turned on the computer, you may have
inadvertently pressed the Select button at the same time—invoking the debug mode. Turn
the printer off and then turn it on again and be careful not to press the Select button.
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You expect a document to be single-spaced. but it prints with double or triple
spacing, or it prints with blank lines between the graphics.

Either of the following may be the cause:

= Anextra line feed is being inserted by the application, the printer, or the
Apple llgs. Start with the easiest solution, which is to change the application's line feed
setting to Off. If that doesn't work, deselect the Add LF after CR setting in the Printer
Port Control Panel of the desktop Control Panels. If neither of those suggestions solves
the problem, turn off the automatic line feed switch on the printer. (For instructions on
turning off the line feed switch on the printer, consult the manual that came with your
printer or ask vour authorized service provider for assistance.)

= low're trying to print a document that is too wide for the printer to support. Change
the margins of your document and trv again.

Lines are printing on top of each other

No line feed instruction is being sent to the printer after the carriage return instruction.
Start with the easiest solution, which is to change the application’s line feed setting to On.
If that doesn’t work, select the Add LF after CR setting in the Printer Port Control Panel of
the desktop Control Panels. If neither of those suggestions solves the problem, turn on the
automatic line feed switch on the printer. For instructions on turning on the line feed switch
on the printer, consult the manual that came with your printer or ask vour authorized
service provider for assistance.

Your computer is part of the Applelalk network system. but you can't print to
Yyour usual network printer.

One of the following may be the cause:

= You baven't installed the appropriate network printer update on your startup
disk. See your Network Administrator.

= After installing the appropriate network printer update, you removed a different
networking update (either another of the network printer updates or the AppleShare
update) from your startup disk. Removing any networking update deletes certain files
that all networking updates share. Reinstall the desired network printer update or see
your Network Administrator,
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The computer’s slot settings are incorrect in the Control Panel. 1f your computer is
connected to the network via the printer port, Slot 1 should be set to AppleTalk. If your
computer is connected to the nerwork via the modem port, Slot 2 should be set to
AppleTalk. It's recommended—but not required—that you set slot 7 to AppleTalk as well.
For more information, see “Activating slots and ports,” on page 192 in Chapter 7.

= The printer isn't selected in the Net Printer Control Panel. 1f you haven't selected a
printer in the Net Printer Control Panel, follow the instructions in Chapter 12, If you
have selected a printer but find that you can't print, someone may have switched off the
printer in the meantime. If that's the case, switch on the printer and select it again in
the NetPrinter Control Panel. Verify selection by checking to see that the printer select
light is on.

= Someone bas renamed the printer. Ask your network administrator and the other

network users whether they have changed the printer’s name, When you know the new
name, use the NetPrinter Control Panel to select the printer by its new name.

= Communication on the Locallalk network bas been interrupted. Ask the network
administrator to check for disconnected LocalTalk cables between vour computer and
the network printer you're trying to use.

= The printer's dip switch settings are not properly set for AppleTalk. For more
information, check the manual that came with your printer.

You can't print with a LaserWriter.

If none of the solutions given earlier in this section seems to help, one of the following may
be the cause:

= You baven't installed the LaserWriter update on vour startup disk. Follow the
instructions on installing updates Chapter 2 or see your Network Administrator.

»  The compuder’s slot settings are incorrect in the Control Fanel, 1f vour computer is
connected to the network via the printer port, Slot 1 should be set to AppleTalk. If your
computer is connected to the network via the modem port, Slot 2 should be set to
AppleTalk. It's recommended—but not required—that vou set slot 7 to AppleTalk as well.
For more information, see “Activating slots and ports,” in Chapter 7.

*  The printer was switched off, and no one bas installed the ImageWriter Emulator in
the printer’s memory since it was switched on again. Select the printer in the
LaserWriter options in the Net Printer Control Panel of the desktop Control Panels and
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click the ImageWriter Emulator button. (For more detailed instructions, see “Choosing
a network printer” in Chapter 12.)

» You don't have a LocalTalk connector box connected to both the computer and the
printer: You can't connect a LocalTalk cable directly to a computer or a peripheral
device—you must attach a connector box to each device, and then connect the two
connector boxes with a LocalTalk cable.

Starting Up

This section discusses unexpected situations you may encounter when you attempt to start
up your computer.

Nothing appears on the screen when you switch on the power.

Go through the following checklist to try to identify the cause:

1. Check the power lights on the monitor and computer. If they are on, the computer and
monitor are plugged into a power source. If not, check the plugs. If you're using a
power strip, make sure it is plugged in and switched on.

2. Make sure the monitor is connected to the computer.

3. Make sure the computer is switched on.

4. Make sure the monitor is switched on.

5. Check the monitor’s contrast and brightness settings. If you think one of these settings
may be the cause, see the owner's guide that came with your monitor for instructions.

The image on the screen is rolling or out of alignment.

Hold down the Option and Control keys while vou press and release the Reset key (the key
marked with a triangle). Then press 2, This procedure restores the standard frequency
settings for the United States so that your monitor will receive signals from the computer
at the proper frequency. It also restores all the default Control Panel settings, so you may
need to go o the desktop Control Panels to make some changes after following this
procedure.
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Your disk drive doesn't start when you switch on the computer:

One of the following may be the cause:

= Thedisk drive is not connected to the computer: Switch off the computer, wait at least
15 seconds, and check to make sure the disk drive is properly connected.

v The Control Panel setting for the startup slot may be incorrect. See "Changing the
startup drive,” on page 194 in Chapter 7 for more information. Then use the Slots
Control Panel to change the startup slot as necessary.

The computer tries to start up using the “wrong” disk.

Unless you've used the Control Panel to change the startup slot, the computer will attempt
to start up from a disk in the disk drive connected to the highest-numbered slot or
corresponding port.

A5.25-inch disk drive connected to the disk drive port corresponds to Slot 6. A 3.5-inch
disk drive connected to the disk drive port corresponds to Slot 3. Additionally, only Drive
1 in any slot can be the startup device.

Put your startup disk in the disk drive that the computer is using as the startup drive.
(Make sure that the door of any 5.25-inch disk drive is open if you want to start up from a
3.5-inch disk.) Or change the Startup setting in the Control Panel to correspond to the
device you want to use as a startup drive.

# Special cases When you 've installed an Apple Il Memory Expansion Card in one of
the computer’s internal slots but you haven't copied a startup application onto the card,
you see a message telling you that the computer can't start up from the memory expansion
card, and the computer will scan the lower-numbered slots for a startup disk. If it finds a
startup disk, it starts up from that disk. If it doesn't, you see the message “Check startup
device!”

If the startup slot in the Slots Control Panel is set to Applelalk but no startup file server
volume is available in your zone, the compurer will scan all the slots for a startup disk. If it
finds a startup disk, it starts up from that disk. If it doesn't, you see the message “Check
startup device!” This happens either when the appropriate software has not been installed
on the file server or when the file server has been shut down.
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The computer doesn't recognize a UniDisk 3.5-inch drive.

Any of the following might be the cause:

You baven't installed the necessary update for the UniDisk drive on your current
startup disk.  (This update may not be included on other startup disks.) Use the
Installer, as described in Chapter 2 starting on page 19, to install the UniDisk upcdate on
each startup disk.

The UniDisk drive is connected to a controller card specifically designed for the
UniDisk drive, but the corresponding slot setting in the Slots Control Panel is not set
to Your Card. Change the slot setting to Your Card. For more information, see
“Activaring slots and ports,” on page 192 in Chapter 7.

The UniDisk drive is connected to a disk drive controller card, but the System Speed
option in the General Control Panel is set to Fast. Change the Svstem Speed to Normal.
For more information, see “General,” on page 176 in Chapter 7.

The computer doesn't recognize your Apple 3.5 Drive.

Either of the following might be the cause:

You've connected one or more UniDisk drives before the Apple 3.5 Drive in the daisy
chain of drives connected to the disk drive port. Switch off the computer, wait at least
15 seconds, and then reconnect the disk drives so that the UniDisk drives come after all
Apple 3.5 Drives in the chain.

The Apple 3.5 Drive is connected to the disk drive port, but slot 3 is set to Your Card in
the Slots Control Panel. Change the Slot 5 setting to Smart Port, For more information,
see “Slots,” on page 191 in Chapter 7.

The computer doesn't recognize your Apple SuperDrive,

Either of the following might be the cause:

The SuperDrive is connected to the Apple 3.5 Controller Card, but Slot 5 is not set 1o
Your Card. Change the Slot 5 setting to Your Card. For more information, see “Slots,”
on page 191 in Chapter 7.

Slot 5 is set to Your Card, but the SuperDrive is not comnected to the Apple 3.5 Controller
Card. Switch off the computer, connect the SuperDrive to the Apple 3.5 Controller
Card, and restart your computer.
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The computer doesn't recognize your Apple 5.25 Drive (or a disk in your

Apple 5.25 Drive),

Either of the following might be the cause:

= The Apple 5.25 Drive is connected to the disk drive port, but slot 6 is set to Your Card
in the Control Panel. Change the Slot 6 setting to Disk Port. For more information, see
“Slots,” on page 191 in Chapter 7,

= |If the disk drive icon appears on the desktop but the icon of the disk vou inserted
doesn't appear, close the disk drive door, then double-click the disk drive icon 1o open
it. The disk icon should appear.

The computer doesit't recognize your hard disk.

One of the following may be the cause:

»  The bard disk isnw't switched on. In order for the Finder to recognize a hard disk, the
hard disk must be switched on and up to speed before you start up (or restart) the
computer.

Switch on the hard disk, wait about 10 seconds for it to come up to speed, and then
restart the computer,

= You haven't installed the necessary SCSIbard disk update on your currvent startip
disk. (This update may not be included on other startup disks.) Use the Installer, as
described in Chapter 2, to install the SCSI hard disk update on each startup disk.

= The Control Panel setting for the slot containing vour SCSI card isn't set to Your Card.
Use the Slots Control Panel to change the slot setting to Your Card, (See "Slots,” on
page 191 in Chapter 7.) Then restart the computer. When vou see the Finder desktop.
the hard disk icon should appear.

= More than one SCSI device is set o the same SCSI device number: For instructions on
setting SCSI numbers, see the hardware manual that came with your computer.

= The connection is not properly terminated. For instructions on proper connection,
see the manuals that came with vour hard disk and your SCSI card. Keep in mind, for
example, that the Apple 11 High-Speed SCSI Card has built-in termination.
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You see only a square bracket and the insertion point,

One of the following is probably the cause:

= [ trying lo restart the computer by pressing Command-Control-Reset, you released
Command and Control oo soon after pressing and releasing Reset. Try again, being
sure to follow these steps:
1. Hold down Command and Control.
2. Without releasing Command or Control, press and then release Reser.

3. When vou hear a beep (or, if the volume level is turned all the way down in the
Control Panel, when the screen’s border flashes), release Command and Control.
= The program on the disk isn't self-starting  You're most likely to run into this situation
if you're using programs written by friends. acquired through a user group, or copied
from a bulletin board. Trv typing PR# __ (the blank space being the slot number which
vou have set for your startup disk) and press Return. If that doesn’t work ask the person
who gave you the application how to start i,

The computer begins to start up, but fails; you see an error message or a heep
indicating failure.

If vou recently added any desk accessories or setup files (INITS), restart the computer and
hold down the Shift key until you see the message “No Inits/DA’s.” In the Finder, remave
the recently added desk accessories or setup files.
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If you think there’s a serious problem

If you're having a problem that vou haven't been able to solve with any of the suggestions
in this chapter, try repeating whatever vou were doing and see if the same thing happens
again. You may simply have made a keystroke or mouse movement without realizing it

If the same thing happens when vou repeat the same steps, you may want to run a short
diagnostic test to make sure there isn't a serious problem with your computer.

/. Important If vou have changed any settings in the Control Panels (as explained in
Chapter 7, “Using the Desktop Control Panels,” on page 171), they will be restored to the
original settings—the ones set at the factory—when you run the diagnostic test. You must
return to the desktop Control Panels if you want to change them back. 2

Follow these steps to run the diagnostic test:

1. With the power on, hold down the Command, Control, and Option keys while you press
and release the Reset kev,
Or, if the power is off, simply hold down Command and Option while you switch on the
computer’s power.

2. Wait for a message on the screen giving the results of the test.

After about 35 seconds vou should see the message “System Good.” If you see the
message “System Bad” followed by a string of letters, make a note of the letters and
contact your authorized Apple service provider.

3. Ifyour system is good, restart your computer.
Insert a startup disk in your startup drive, then hold down Command and Control while
vou press and release Reset.
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If you need more help

If this chapter hasn't provided an explanation for an unexpected situation or event, there
are a number of places you can turn for more information.

Often the best source of help is another Apple 11 user. If vou know people who have had
alot of experience with Apple IT computers, check with them to see if they can explain what
vou're experiencing. (A good way to meet other Apple 11 users is through an Apple user
group.)

Your authorized Apple service provider should also be able to answer most questions
vou have about the Apple 11Gs.
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Appendix: System Messages

This appendix helps yvou deal with the unexpected messages you mav encounter while

using your computer. Things may not always happen as vou expect them to. but the
messages here and their explanations should help yvou to use your Apple 11Gs computer

more effectively

This chapter is arranged alphabetically according to the actual screen message. You can also

refer to the Troubleshooting chaprer starting on page 307, if you need more help

Within each section, the text of the messages are described in italicized text, with the likely

causes and recommended solutions immediately following



A,B

Access error. Cannot change file.”

When vou're installing an update on a file server volume, you don't have the Make Changes
privilege for the file server volume or the System folder on the file server volume. Or, if
you're installing an application update in a folder, vou don't have privileges for the folder.

If you're the network administrator, log on and install the update; otherwise, ask the
administrator to install the update for vou.

‘Access not allowed.”

The file server will not be recognized if vou have no privileges. The folder will be dimmed
if you don't have access.

An application can't be found for this document.”

You tried to open a document, but the Finder is unable to associate the document with any
application. Click OK. To open this document, vou must open the application used to create
it. Double-click the application icon, and then open the document from within the
application,

‘An update has altered system files on the startup disk. You cannot quit the
Installer without restarting your system.”

When you click Quit in the Installer, you've installed one or more system updates on the
current startup disk. In order for the computer to recognize those updates during the
current work session, you must restart the computer. Click the Restart System button. The
computer restarts from the current startup disk, and in a few moments vou return to the
Finder desktop.

If you inadvertently installed a system update on the current startup disk and you want
to remove it before proceeding, click Cancel. Then select the name of the unwanted system
update in the window on the left and click Remove. The Installer removes the update from
the current startup disk. When vou quit the Installer, vou see the same message alerting vou
that the Installer has altered svstem files on the current startup disk. Click Restart System,
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Important Removing an update that vou've installed is not always the same as not having
installed it in the first place. When you install the “Network: AppleShare 3.5" Disk™ update,
for example, there isn't room for all system files, so the Installer creates an abbreviated
version by removing certain files. Subsequently removing the AppleShare on 3.5" Disk
update cannot reinstate the files that have been deleted—it can only remove the files that
have been added. =

AppleShare. FST requires AppleShare. Please enable Applelalk in the Control
Panel, install AppleShare on the hoot disk and re-boot the system.”

When you start up (or boot) the computer, one of the following is the cause of this message:

= The slot settings in the Control Panel are not set up for access to the Applelalk network
system. Press Return to continue starting up. When the computer finishes starting up,
use the Slots Control Panel to change the appropriate slot settings.

If your computer is connected to the network via the printer port, Slot 1 should be set
to AppleTalk. If your computer is connected to the network via the modem port, Slot 2
should be set to AppleTalk. For more information, see “Activating slots and ports,” on
page 192 in Chapter 7.

= Ifyou're starting up over the network (rather than from a local disk), make sure of the
following:

If your computer has ROM 01, the following slot settings apply:

If your computer is connected to the network via the printer port, Slot 1 should be
set to Your Card. If vour computer is connected to the network via the modem port,
Slot 1 should be set to Printer Port, Slot 2 should be set 1o Your Card, and Slot 7
should be set to AppleTalk.
= If your computer has ROM 3, it is recommended—but not required—that Slot 7 be
set 1o AppleTalk,
When vou restart the computer after changing the slot settings, vou shouldn't see the
message again,
= Some of the AppleTalk or AppleShare files are missing from the current startup disk.
Press Return to continue starting up. Then use the Installer to reinstall the networking
updates vou need. See Chapter 12, “Networking the Apple 11Gs,” starting on page 271
for more information.
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vou don't remember which drive is your startup drive, see “Identifying Your Startup
Drive” in the manual that came with your Apple 116s.)

= There'sa nonstartup disk in the startup drive. Eject the disk, insert a startup disk in its
place, and press Command-Control-Reset to restart the computer with the application
on the new startup disk. (If you don’t remember which drive is your startup drive, see
“Identifying Your Startup Drive” in the manual that came with vour Apple 11Gs.)

= The Control Panels setting for the startup slot is incorrect. See “Changing the startup
drive,” on page 194 in Chapter 7 for more information. Then use the Slots Control Panel
to change the startup slot as necessary.

This message can also appear when you try to start up from the RAM disk. Although it's

possible to start up from a RAM disk (assuming you're not starting up “cold,” after having

switched off the computer), the amount of memory required by the GS/0S operating

system usually makes this method of starting up impracticable.

“Completely replace the contents of ‘DESTINATION DISK [NAME]" with the
contents of ‘SOURCE DISK [NAME]'?"

This message doesn't indicate any problem—it’s only to confirm that you want to erase
everything on the destination disk (the disk that you're copying onto) and replace it with
the contents of the source disk (the disk that you're copying from ). If that's what you
intended, click OK, Otherwise, click Cancel.

“Contact the network administrator: An error occurred launching the

startup path.”

You probably don't have the appropriate access privileges to launch the startup application.
Make a note of the startup pathname given in the message, and then ask the network

administrator to make sure vou have the proper access privileges.

“Contact the network administrator: This path does not contain a ProDOS 8
startup application: ( pathname)”

Your computer is set to start up with ProDOS, but your startup application is not a ProDOS
8 application. The network administrator can set up the application properly or use the
Network Control Panel to make your computer start up with GS/0S.
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“Contact the network administrator. This startup path was not found.”

The pathname of vour startup application is incorrect. Either one or more names within the
pathname have changed, or the access privileges to the file server volume or one of the
folders have changed.

Make a note of the startup pathname given in the message. and then ask the network
administrator to set your startup application again.

“Device write-protected.”

When a disk is write-protected, vou can’t make any changes to it. Remove the write-
protection or use a different disk to save your document. If the manufacturer write-
protected this disk, vou probably shouldn't save documents on it.

Depending on the action you're trying to take, you may be offered an opportunity to
try the action again. For example, when you try to copy files 1o a write-protected disk, you
see a dialog box that allows you to remove write-protection and then click Try Again.

For instructions on removing write-protection, see “Write-protecting a disk,” on page 94
in Chapter 4.

“Disk Directory Full.”

The disk on which you're trying to install an update already has the ProDOS 8 maximum of
51 items in the main directory. This situation can occur either when you're trying to install
an application update in the main directory or when you're trving to install a system update
and the disk doesn't already include a System folder.

Click OK. If you were trying to install an application update, you may want to install the
update in a folder. If you were trying to install a system update, vou must return to the
Finder and either discard at least one item from the disk or nest at least one item within a
folder. Then run the Installer again and install the desired update.
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“Disk Full.”

When creating a new folder in which to install an application update, vou don't have enough
room on the disk 1o accommaodate the new folder. Either use another disk or create space
on this disk. (To create space, quit the Installer and use the Finder to copy files to another
disk, drag files vou no longer need on this disk into the Trash, and choose Empty Trash from
the Special menu.)

If you want to know how much room is available on a disk and how much room a folder or
file takes up, quir the Installer. After starting up with a disk that includes the Finder, select
the desired disk, folder, or file icon and choose Icon Info from the Special menu. The size
information you see depends on what type of icon you selected,

* Ifyou selected a disk icon, the Size line on the General card shows the amount of space
used and the amount of space available on the disk.

» Ifyou selected a folder icon, the Size line on the General card shows the message “use
calculate icon. . .” Click the icon of a calculator at the lower-right corner of the General
card. In a moment, the Size line shows the amount of space the folder’s contents take
up on the disk, both in bytes and in kilobytes (K).

s Ifvou selected a file icon, the Size line on the General card shows the amount of space
the file takes up on the disk. in both bytes and kilobytes (K).

“Disk icons can't be dragged with file or folder icons for this operation.”

When dragging icons to copy them, vou tried to drag a disk icon and a file or folder icon at
the same time. To perform this operation, you can drag either disk icons or file and folder
icons, but not both simultaneously.

Click anvwhere on the Finder desktop to deselect all selected icons. Then try again.

“Duplicate filename.”

When vou try to save a document on a disk, vou tried to use a name that you've already
used for a document on that disk. If the version vou're trying to save is a revised version of
the one that's already on the disk, and you want the revised version to replace the older
version, then confirm that you want to replace the existing document. But if you used a
duplicate name by mistake and want to retain the original document, give the new
document a different name and repeat the save procedure.
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Error message numbered $0044, 0046, or SO04E.

Errors $0044 and $0046 indicate that a file was not found either because you don't have the
proper access privileges on a network volume (ask the nerwork administrator to give you
the necessary privileges), or because some software is missing from network or non-
network disks (try reinstalling software).

Error message $004E indicates access denied, usually because access privileges are not
set correctly. It can also occur because a file on a network or non-network disk was locked
or already opened by some other program.

Error message numbered $0201-out of memory.

You have used all of the available memory. Try starting up without setup (initialization) files;
vou can bypass them by starting up while pressing the Shift key. If the problem persists, try
reducing RAM disk size, removing unneeded drivers, desk accessories, setup files, or file
system translators. You can also expand the memory size of your computer if removing
items is not feasible. If you decide to remove setup files, remove only those that you have
installecl. The system requires the following files: TS2, TS3, Tool. Setup, Resource. Mgr, and
Sys.Resources.

“GS/OS can't read this disk (in device [ DEVICENAME]). Do you want to
initialize it?”

You've inserted a blank disk that has never been initialized or a disk that is damaged. 1f vou
want to initialize the disk, click Continue. Otherwise, click Eject. (If you decide not to

initialize a 5.25-inch disk, open the disk drive door and remove the disk after vou have
clicked Eject.)
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“GS/0S does not recognize the file system on this disk (in device
[.DEVICENAME]). Do you want to initialize it?”

You've inserted a disk that was initialized for an operating system that GS/0S can't

recognize, or a disk on which the directory is damaged. If you want to erase everything on
the disk and initialize it, click Continue. Otherwise, click Eject. (If vou decide not to initialize
45.25-inch disk, open the disk drive door and remove the disk after vou have clicked Eject.)

I J, KL, M, N, O

“1/0 Error”

1/O stands for input/output. The computer is having trouble exchanging information with
a peripheral device, usually a disk drive. Any of the following might be the cause:

The disk drive door of a 5.25-inch drive is open. Shut the door and try again.

The printer or disk drive isn't plugged in or bas a loose connection. Switch off the
computer, wait at least 15 seconds, and check to see that all devices are connected
securely.

Wou may not bave inserted the correct disk. Eject the disk to make sure it's the correct
one. Ifit's not, insert the correct disk and repeat what you were doing just prior to
seeing the error message.

Your disk drive is connected to a card in slot 1, 2. or 3 and the System Speed option is
set to Fast in the Control Panel. Software designed for earlier models of the Apple 11
family requires that Disk Il controller cards be in slots 4, 3. 6, or 7 or that Svstem Speed
be set to Normal, Either switch the Svstem Speed setting to Normal or connect your
disk drive to slot 4, 3, 6, 0r 7.

Adisk may be physically damaged, or its file system may be corrupted. Copy fles to
another disk (copy them file-by-file rather than by dragging the disk icon to another
disk) and then discard the damaged disk.
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“lllegal filename.”

When you try to save a document on a disk, filename refers to the name of vour document.
An illegal filename is one that doesn't conform to the application's rules or the rules of the
file system. In most cases, the system prompts you to rename correctly by stating naming
conventions. Different applications have different requirements, but you shouldn’t have
any problem if vou use a filename that starts with a letter, has 15 characters or fewer, and
uses only letters, numbers, and periods.

“Initialization failed.”

Your disk is probably damaged. Click OK. Then discard the disk, insert anather disk, and try
again.

“Initialization failed! There was an error trying to initialize the partition.”

When partitioning a hard disk, you may be using defective media or a defective device. Try
another piece of media. Ifyou continue to receive the error message, hard format your disk
drive by initializing it via the Finder or the Advanced Disk Utility. If you still have the
problem, take vour drive to an authorized service provider.

“Initialization of the disk ‘DISK NAME' bas been canceled. It will not be
displayed in the Finder.”

When partitioning a SCSI hard disk, vou clicked Cancel in the Initialize dialog box for the
partition. The hard disk has been partitioned but this partition hasn't been initialized. Use
the Advanced Disk Utility to initialize the partition, as explained in “Initializing,” on

page 225 in Chapter 9.

“Insert Disk: <any disk name>".

One of the following is the cause:

*  The disk named in the message isn't in a disk drive. If you're installing with only one
disk drive, vou'll see these messages frequently during the installation process. [f vou're
installing with two disk drives, vou'll see these messages occasionally during the
installation process.
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Eject a disk from a disk drive, insert the disk named in the message. The installation
proceeds.

w  The disk named in the message is in a disk drive but bas been renamed. When they 're
being used as the source of updates, the installation disks must be named as supplied
by Apple. If they aren't, the Installer doesn't know where to look for the necessary files,
Click Cancel, Then click Quit (or choose Quit from the File menu) to quit the Installer:
When vou return to the Finder desktop, rename the necessary source disk icons. Then
run the Installer again and install the necessary updates. The message should not
appear again except when the computer is prompting vou to swap disks.

& Tip If you have a two-drive system, installation will proceed faster if you eject the
system dlisk or the system tools disk and leave the disk you're updating in a disk drive,

“Invalid Patbname Syntax.”

When creating a new folder in which to install an application update, vou provided a folder
name that doesn't conform to the naming rules for the file system. Click OK, and then
provide a valid name. (For information on naming rules, see “Renaming icons,” on page 75
in Chapter 3.)

“SCS device requires a driver. Please install the SCSI driver on hoot disk and
re-hoot system”

When starting up the computer, the current startup disk (or boot disk, in computer jargon)
doesn't include the SCSI Hard Disk update. Press Return to continue starting up. When the
computer finishes starting up, use the Installer to add the SCSI Hard Disk update to the
current startup disk. (For instructions on using the Installer, see Chapter 2 starting on
page 19 of this manual.)

When you quit the Installer, a dialog box appears letting vou know that you must restart
(or re-boot, in computer jargon) the computer. Click Restart System. In a few moments you
see the Finder desktop, and the computer recognizes your hard disk.

PO, RS 351



‘Syntax Error.”

This is a general-purpose message indicating that the computer didn't understand the last
BASIC language instruction it tried to perform. Check your typing. Sometimes you see this
message when you type something in lowercase letters and the application expects it in
uppercase letters. Try pressing Caps Lock and typing your entry again.

“System error $0201 occurred,”

The system has run out of available memory. This can be caused by attempting to log on to
a network with insufficient memory or by setting the RAM disk to too large a size.

If you get this message while trying to open the AppleShare Control Panel, vou don't have
enough memory. Try the following;

= Close some windows.

= Start up while holding down the Shift key (bypassing setup files).

»  Remove some initialization files or desk accessories. Remove only setup files that vou
have installed. The system requires the following files: TS2, T53, Tool.Setup,
Resource.Mgr, and Sys.Resources,

» Install more memory.

If vou've set the RAM disk size too large, the amount of memory allocated doesn't leave
enough memory available for the application you're trying to run. If the message appears
when you're starting up with a Finder-based startup disk, there isn't enough available
memory to run the Finder.

If necessary, press Return. Then press Command-Control-Esc 1o go to the Desk
Accessories menu. (You may need to press Command-Control-Reset before you're able to
press Command-Control-Esc.) From there, use the text Control Panel to reduce the size of
your RAM disk so that enough memory will be available for the application you're trying to
use. (For instructions, see the manual that came with your computer.)
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“The application APPLICATION NAME’ can'’t be found for this document.”

The Finder is able to associate the document with an application but is unable to find that
application, Click the Locate button to direct the system to the location of the application.

Also, check to make sure you have inserted the disk that contains the application. If the
application is on a 5.25-inch disk, make sure the disk drive door is closed. Then click Try
Again.

If you know you don't have the application on a disk, click Cancel. If the application has
been renamed or moved to a different disk or folder, click Cancel, open the application
icon, and then open the document from within the application.

“The attempted connection to the server’s volume bas failed.”

You don't have access to one of the file server volumes you tried to connect to. Ask the
network administrator to give you the necessary access privileges for that volume, or log on
to a different volume.

“The changes to some folders could not be applied (access privileges error).”

You clicked Apply to Enclosed Folders but you don't own one or more folders inside the
selected folder.

Click OK. Then click the Apply button if you want to apply the new access privileges to
the volume. If you want to change the privileges for enclosed folders that you own, select
each folder separately and change the privileges. For instructions, see “Setting access
privileges for a folder,” on page 289 in Chapter 12.

“The disk ‘DISK NAME” is write-protected.”

You can't copy anything to the destination disk if it's write-protected. If you want to
continue with the copying procedure, eject the write-protected disk, remove the write-
protection, reinsert the disk, and click Try Again. Otherwise, click Cancel.

Forinstructions on removing write-protection, see “Write-protecting a disk,” on page 94
in Chapter 4.

T 353



“The disk ‘DISK NAME" may be damaged.”

Click OK, Reinsert the disk and try initializing again. If you get the same message. discard
the disk, insert another disk, and try initializing.

“The disk directory is full. Can’t complete this operation.”

You already have a total of 51 files or folders in the main (disk) directory, the maximum
number that ProDOS allows. Move some files into folders, drag files and folders vou don't
need into the Trash, or copy some files and folders onto another disk and then remove
them from this disk.

# Note When “Save Finder information onto disk” is selected in the Preferences dialog
box, the Finder maintains three (normally invisible) files in the disk directory of any startup
disk. These files contain information of use only to the Finder. When "Hide invisible files”
is selected in the Preferences dialog box, the Finder shows two fewer items in the disk
directory than are actually there. In that case, the disk directory is full when 49 items appear
in the directory. Also, the item count does not include items that are on the desktop. e

“The disk in device [.DEVICENAME] appears to be in [FILE FORMAT]. A [FILE
FORMAT] File System Translator is required to use this disk”
You've inserted a disk for which the system has no file system translator installed. The

system tries to identify the file format as best it can.
Do not click Initialize unless vou are willing to lose the contents of the disk.

If the disk you inserted is an application disk that uses the Pascal or Apple 11 DOS 3.3

operating svstem, you can still use the application if you follow these steps:

1. Click Eject.

2. Choose Shut Down from the Special menu of the Finder. You see a dialog box listing the
shutdown options. “Turn off system power” should be selected.

3. Click OK or press Return. The computer shuts down, and any disks you were using are
ejecred,

4. Reinsert the application disk in the startup drive.

-

Click Restart. The application opens.
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When appropriate, you can also install one of the FSTs in your system. See Chapter 2, “Using
the Installer,” starting on page 19 for more information on installing the appropriate FSTS.

“The disk is full. Can't complete this operation.”

When vou're trying to copy folders or files to the RAM disk, there isn't enough memory
allocated to the RAM disk to contain the items you're trying to copy. Click Cancel. Then, if
you want to, increase the size of the RAM disk to accommodate the items, (For instructions,
see “Setting RAM disk size,” on page 111 in Chapter 4.)

When working with files and folders, you have run out of room on this disk. Either use
another disk or create space on this disk. (To create space, copy files to another disk, then
drag files vou no longer need on this disk into the Trash and choose Empty Trash from the
Special menu.)

1f you want to know how much room is available on a disk and how much room a folder
or file takes up, select the disk, folder, or file icon and choose Icon Info from the Special
menu. The size information vou see depends on what type of icon you selected.

= Ifyou selected a disk icon, the Size line on the General card shows the amount of space
used and the amount of space available on the disk.

= [fvou selected a folder icon, the Size line on the General card shows the message “use
calculate icon . . ." Click the icon of a calculator at the lower-right corner of the General
card. In a moment, the Size line shows the amount of space the folder’s contents take
up on the disk, both in bytes and in kilobytes (K).

»  [fyou selected a file icon, the Size line on the General card shows the amount of space
the file takes up on the disk, both in bytes and in kilobytes (K).

“The file/folder ‘FILE NAME’ already exists and is locked (or contains items
that are locked). Replace it anyway?”

When moving or copying a file or folder, you tried to move or copy an item that has the
same name as one of the following items in the destination folder or destination disk
directory: a locked file, a locked folder, or an unlocked folder that contains a locked item.

[Fvou want to replace the item in the destination folder, click Yes. If you don't want to
replace the item but want the Finder to continue moving or copying any other items you
selected, click No. If you want to stop the moving or copying operation altogether. click
Cancel.
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“The file/folder ‘FILE NAME' is copy-protected and can't be copied.”

When copying a file or folder, vou have tried to copy an item that is copy-protected. If you're
copying several files or folders, click Skip File. Otherwise, click Cancel.

“The file/folder ‘FILE NAME is locked (or contains items that are locked).
Remove it anyway?”

When dragging a file or folder to the trash, you have tried to throw away a file or folder that
is locked or a folder that contains locked items. If that's what vou intended, click Yes. If you
don't want to remove the item but want to continue removing other selected items, click
No. If vou want to stop the operation, click Cancel.

“The filename ‘FILE NAME' is already used.”

While duplicating a file or folder, vou have chosen a name for a duplicate file or folder that
already exists for an item in the destination folder or disk directory. To choose another
name, simply type the new name and click OK. To skip this item and duplicate the next item
vou selected, click Skip File, To cancel the duplicating operation, click Cancel.

“The filename ‘ICON NAME" is unacceptable to the destination file system.”

When vou're copving or renaming an icon, this message appears if the name of the icon
doesn't conform to the naming rules for the file system used by the destination disk.

If you're renaming an item on a local disk (as opposed to a file server volume), follow the
ProDOS or HFS naming rules described in Chapter 4. If vou're renaming an item on a file
server volume, follow the AppleShare naming rules described in Chapter 12,

“The folder ‘FOLDER NAME' can’t be moved into itself or into one of its ouwn
folders.”

When maving or copying folders, you have nested a folder inside another folder and then
attempted to copy the outer folder into itself or into the window of the nested folder.

For example, suppose vou created a folder called Lesson.Plans and placed a folder
called January.Plans inside that folder. If you then tried to drag the Lesson.Plans folder icon
on top of the January.Plans folder icon or into the January.Plans window, or tried to drag
the Lesson.Plans folder icon into the Lesson.Plans window, vou would see this message.
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If you're moving or copying several items, click Skip File to go on to the next item.

Otherwise, click Cancel.

“The item name ICON NAME' is unacceptable to the destination file system.”

This message is encountered when attempting to copy a file with an invalid name for the
current operating system. This can occur when copying HFS files to your computer either
from a floppy disk or an AppleShare file server.

When copying an item to a local disk, you're trying to copy an item with a name that is
acceptable to the source disk file system (used on a file server volume or a Macintosh) but
not to the destination file system (used on the local startup disk). You have several options:

The suggested name is a translation of the AppleShare name into an acceptable name.
If you want to accept the suggested name, click OK.

Ifvou don't like the suggested name, type a new name that conforms to the file system
naming rules (described in Chapter 4), and then click OK.

If you're copying several items and want to skip this item, click the Skip File button.

If you're copying several items and want all names that don’t conform to file system’s
naming rules to be translated automatically, click the “Translate bad file names™ button.

If you're copying several items and want to skip all items whose names don't conform
to the file system’s naming rules, click the “Skip bad file names™ button.

If vou decide to cancel the copying operation altogether, click Cancel.

“The pathname is too long to complete the operation.”

When copying, moving, or creating items in a nested folder, the complete pathname
(including the colons used to separate parts of the name) cannot exceed 222 characters.
Shorten the names of one or more of the nested folders involved, or use fewer levels of
folders.

“The server is not responding. You cannol connect to it.”

There's a problem with the file server itself or with the network cables. Ask the network
administrator to check the server and cables and resolve the problem.
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“There isn't enough room on ‘DESTINATION DISK NAME to copy the contents
of ‘SOURCE DISK NAME"."

There isn't enough room on the destination disk to copy all the files and folders on the
source disk. Click Cancel, Then either try copying the disk again using a different
destination disk, or drag selected files and folders onto the destination disk.

You can also use the Icon Info menu option to find out how much room is available on a
disk and how much room a file or folder takes up. To do so, select the desired disk. folder,
or file icon and choose Icon Info from the Special menu. The size information you see
depends on what type of icon you selected.

» Ifvou selected a disk icon, the Size line on the General card shows the amount of space
used and the amount of space available on the disk.

= Ifyou selected a folder icon, the Size line on the General card shows the message “use
caleulate icon . ..." Click the icon of a calculator at the lower-right corner of the General
card. In a moment, the Size line shows the amount of space the folder’s contents take
up on the disk, both in bytes and in kilobytes (K).

» Ifyou selected a file icon, the Size line on the General card shows the amount of space
the file takes up on the disk, both in bytes and in kilobytes (K).

“This disk could not be initialized.”

When using the Advanced Disk Utility, you've tried to initialize the startup disk. Because
files on the startup disk are open and in use, it isn't possible to initialize the startup disk. If
vou want to initialize the disk, quit the Advanced Disk Utility, shut down the computer, and
restart with a different startup disk. Then initialize the disk using either the Initialize
command in the Disk menu of the Finder or the Advanced Disk Utility.

“There isn't enough room on ‘RAM DISK NAME' to copy the contents of
SOURCE DISK NAME'."

When trying to copy the complete contents of a disk to the RAM disk, you haven't allocated
enough memory to the RAM disk to accommodate the disk vou're trving to copy. Click
Cancel. Then, if you wish, increase the size of the RAM disk to accommodate the items. (For
instructions, see “Setting RAM Disk Size” in Chaprer 4.)
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“This device appears unreliable. The partition map may be incomplete.”

When partitioning a hard disk, you may be using defective media or a defective device, Try
another piece of media, If you continue to receive the error message, hard format your disk
drive by initializing it via the Finder or the Advanced Disk Utility. If you still have the
problem, take vour drive to an authorized service provider.

“This file server uses an incompatible version of the AFP protocol. You cannot
connect to it”
The file server is not running AppleShare File Server software version 2.0 or later, Ask the

network administrator to upgrade the file server to the current version, or log on to a
different file server that is running a compatible version of the software.

“This file server does not use a recognizable logon sequence. You cannot
connect to il.”

The file server is not running AppleShare File Server software version 2.0 or later. Ask the
network administrator to upgrade the file server to the current version, or log on to a
different file server that is running a compatible version of the software.

“This file system won't use the entire disk.”

When partitioning a SCSI hard disk larger than 32 MB, you've allocated more than 32 MB 1o
a single partition, but the ProDOS file system doesn't recognize part of any hard disk
partition in excess of 32 MB. This message appears when the Initialize dialog box for that
partition appears. Click Cancel. Then return to the Advanced Disk Utility screen and
repartition the hard disk, being sure to create partitions no larger than 32 MB.
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“Unable to load the Macintosh driver. HFS partitions will not be usable on
Macintosh computers.”

When partitioning a hard disk, you most often get this message because the drive doesn't
have an internal Apple [D (as may be the case with an early Apple drive or a product from
another company), and you have not placed the “Generic Mac SCSI” file in the Drivers
folder located inside your System folder. Third-party drive manufacturers usually provide
the file for their products. If you have an early Apple drive, format it first via the Macintosh,
using the HDSC Setup program, which automatically provides the necessary file,

Less commonly, the message occurs even when you have properly placed the file
described above or you are partitioning a drive that has an internal Apple ID. In such cases,
either the Macintosh driver can't be read from the ADU file because of a device error, or
there is not enough memory to load the file,

“Unable to install the HFS boot driver. This device appears unreliable.”

When partitioning a hard disk, you may be using defective media or a defective device. Try
another piece of media. If you continue to receive the error message, hard format vour disk
drive by initializing it via the Finder or the Advanced Disk Utility. If vou still have the
problem, take your drive to an authorized service provider.

“Unable to Load ProDOS.”

Any of the following could be the cause:

= The system files on the startup disk are incomplete. Try a different startup disk.

s The startup disk is missing the ProDOS file. Try a different startup disk. (If you're using
a hard disk as a startup disk, vou need to install the “Latest System Files™ update on the
hard disk. For instructions, see Chapter 2, “Using the Installer.”)

= The System Speed option in the Control Panel is set to Fast, which may be interfering
with the application. Use the General Control Panel to change the System Speed setting
to Normal. For more information, see “General” in Chapter 7.
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“UniDisk 3.5 requires a driver. Install UniDisk 3.5 driver on boot disk and re-
boot system.”

You've connected a UniDisk 3.5-inch disk drive, but the current startup disk (or boot disk,
in computer jargon) doesn't include the UniDisk 3.5 update. Press Return to continue
starting up. When the Finder desktop appears, use the Installer to add the UniDisk 3.5
update to the current startup disk. (For instructions on using the Installer, see Chapter 2 of
this manual.)

When you quit the Installer, a dialog box will appear letting you know that you must
restart (or re-hoot, in computer jargon) the computer. Click Restart System. In a few
moments you'll see the Finder desktop, and the computer will recognize your UniDisk
drive.

“Uninitialized or no disk in drive.”

When using the Advanced Disk Utility, vou have selected an item that is either an empty
5.25-inch disk drive, or a hard disk or hard disk partition that has not been initialized. If you
want to work with a 5.25-inch disk, insert the disk in the disk drive and close the disk drive
door. If you want to initialize the selected hard disk or hard disk partition, click Initialize.

“Unknown user or log on is disabled. Please retype the name or contact the
network administrator.”

One of the following may be the cause:

» You made a typing error when supplying your user name. Try typing the name again.

»  The network administrator gave you an incorrect user name. Check with the
administrator to make sure you're using the correct name.

* You aren't allowed to log on to that file server. Ask the network administrator whether
you have access to the file server in question.

o ou'retrying to log on as a guest to a file server that doesn't allow guests to bave access.
Ask the network administrator whether guests can have access to the file server in
(question.
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“WARNING: This update makes a 3.5-inch disk into an AppleShare disk. Files
will be removed. Install any desired printer driver separately (only one will
Sit). Do NOT install this update on your only copy of the system disk.”

When you're installing the “Network: AppleShare, 3.5" Disk” update, because of space
constraints, a 3.5-inch disk cannot accommodate the complete system files and AppleShare.
The update gives you an abbreviated version of the system files, removing all but the bare
essentials. Be sure you aren't installing this update on your only copy of the system disk. (In
fact, vou'll probably want to install it on a blank disk.)

If you want to install the update, click Perform This Update, Otherwise, click Skip This
Update,

“WARNING: Install this update only on non-server disks. This update installs
system files for starting up over the network. Some files, including the Finder,
are removed. Proceed with caution.”

When vou're installing the “Network: Local Startup™ update, it creates a disk that lets you
start up directly from a file server but does not give vou access to the Finder. If the disk on
which you're installing this update contains the Finder, the Finder will be removed during
the installation. Be sure you aren't installing this update on your only copy of the system
disk. (In fact, you'll probably want to install it on a blank disk.)

If you want to install the update, click Perform This Update. Otherwise, click Skip This
Update,

“WARNING: Install this update only on a file server’s startup volume. This
update installs sysiem files for starting up over the network. Some files,
including ProDOS, are removed. Proceed with caution.”

The “Network: Server Startup” update is installed on the startup volume of a file server, so
network users can start up directly from a file server without using a startup disk in a local
disk drive. This update should be installed only on the startup volume of a file server, and
only by the network administrator.
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If you want to install the update, click Perform This Update. Otherwise, click Skip This
Update.

“You are attempting to replace a file with a folder or vice versa. Should il be
replaced?”

When moving or copying files or folders. vou have instructed the Finder to replace an irem
on the destination disk with an item on the source disk that has the same name. But one of
the items is a file and the other is a folder.

If you want to replace the item on the destination disk, click Yes. If you want to leave
the original item on the destination disk and continue moving or copying other items, click
No. (In this case, the item will not be moved or copied.) If you want to discontinue the
moving or copying operation altogether, click Cancel.

“You do not bave the SCSI driver on your system disk . . . Therefore, you
cannol partition this device.”

When you open the Advanced Disk Utility and choose Initialize/Erase from the File menu,
you've connected a SCSI hard disk, but the current startup disk doesn't include the SCSI
Hard Disk update, Click OK, then choose Quit from the File menu. When the Finder

desktop appears, use the Installer to add the “SCSI Hard Disk” update to the current startup
disk, (For instructions on using the Installer, see Chapter 2 of this manual.)

“Your startup configuration bas not been set up properly. Contact the
network administrator.”

The file containing the name of your startup application, prefix (if any), and printer (if any)
is damaged. Ask the network administrator to set a valid startup application, prefix, and
printer.
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If you need more help

Refer to the Troubleshooting chapter starting on page 307 in this manual.
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Glossary

access ‘1o get information from something, such as a file
server volume or an information service

access privileges The privileges. given 1o or withheld
from network users, to open, change, or delete folders
and hles stored on an AppleShare file server. By setting
access privileges, vou can control who may use the
information stored on a file server

acoustic-coupler modem A type of modem with a
cradle that uses a standard telephone handset to send and
receive information. Compare direct-connect modem

active window The frontmost window on the deskiop;
the window whose title bar is highlighted with four
horizontal lines, You make a window active in order 1o
pertorm your next action there. To make a window active,

click anvwhere in the window

adaptive device Any device that meets someone’s
special needs for using a computer; examples of adaprive
devices are Braille kevboards and printers, breath-
operated kevboards, and speech synthesizers

ADB Acronvm for Apple Desktop Bus, A port on the back
panel of the Apple 11Gs for connecting the kevboard, the
mouse, and other ADB devices. It's called a “bus” because
the signals sent by several devices can “ride” the same
cable

Advanced Disk Utility A program on the Apple 1GS
Svstenilbols] disk that lets vou prepare disks to receive
information. You can use the program to partition hard
disks and to zero, initialize, and erase 3.5-inch disks, 5.25-
inch disks, hard disks, hard disk partitions. and RAM disks.

American Simplified Keyboard Sce Dvorak kevboard

analog RGB color monitor Atype of color monitor that
accepts separate analog signals for the primary colors red,
green, and blue. (Hence the RGB in the name.) The
intensity of each primary color can vary continuously,
making it possible to display many shades and tints of

| :]i i,

analog signal A signal that varies continuously over time
rather than being sent and received as a sequence of

dliscrete values or levels. Compare digital signa

ANSI Acronvm for American National Standards Institute
An organizaton that sets standards for many technical
fielids and provides the most common stanclards for
personal computers,

<Any User> The user name assigned 1o everyone who
logs on to an AppleShare hle server as a guest

App‘c kf}' Oni |:.:1L‘1'_-\|1[ e 11 kevboards, a2 name used for
the Command key



Apple menu In graphics-hased applications, the menu
at the leftmost end of the menu bar, whose title is
represented by the Apple logo (a multicolored, striped
apple symbol). The Apple menu contains the desktop

vou've installed in the Desk Accessories folder within the
System folder on your startup disk.

Apple 1 The prototvpe for the Apple I family of
computers; designed by Apple Computer cofounder Steve
Wozniak.

Apple SCSI cable system The connective hardware
used to link Small Computer System Interface (SCSI)
devices to a computer and to one another. See also SCSI,

AppleShare-aware application A program designed to
be used with AppleShare file servers,

AppleShare file server A combination of AppleShare
File Server software, one or more hard disks, and a
Macintosh computer that allows network users to store
and share applications, folders and documents over the
AppleTalk network system. The same Macintosh computer
can be used as both an AppleShare file server and an
AppleShare print server.

AppleShare print server Acombination of AppleShare
Print Server software and a Macintosh computer that
stores documents sent to itover the network and manages
the printing of those documents on a printer. The same
Macintosh computer can be used as both an AppleShare
print server and an AppleShare file server.

Applesoft BASIC The Apple Il “dialect” of the BASIC
programming language; Applesoft BASIC is built into all
Apple Il computers. See also BASIC,

AppleTalk network system A group of interconnected
computers and peripheral devices, together with the
software and connective hardware needed to link them, I1f
vour computer is part of an AppleTalk network system, you
can share peripheral devices and network services (such
as an AppleShare file server) with other nerwork users.
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Apple I A family of computers, including the Apple 11GS,
the Apple Ile, the Apple e Plus, the Apple lic, the Apple [I
Plus, and the Apple I1.

Apple 11 SCSI Card  An interface card that you install in
one of the slots on the main circuit board so that you can
connect Small Computer System Interface (SCSI) devices
1o the Apple 11Gs, the Apple lle, and the Apple I Plus. See
also SCSL.

application program Any computer program designed
for a particular purpose, such as home finance, education,
or word processing. Application programs are often
referred 1o as applications for short. Compare system
software.

arrow keys The kevs in the lower-right corner of the
Apple 168 keyboard. In many applications, you use the
arrow keys (sometimes called the cursor keys) 1o move
the insertion point or cursor in the direction indicated by
the arrow.

arrow pointer Scc pointer.

ASCII Acronym for American Standard Code for
Information Interchange; pronounced "ASK-ee.” A
communications code that defines the way letters,
numbers, and punctuation marks are represented by the
computer.

assembly language A programming language verv
close 1o the language of electrical impulses that is the
“native tongue” of the Apple 11Gs. The native assembly
language for the Apple 11GS is the 65816 instruction set.

audio digitizer A peripheral device that converts sound
input from a stereo system, an electronic instrument, or 4
microphone into a form that the computer can process,
save on a disk, and play back. (Once the sounds are in
digital form, they can be edited.)

auto-repeat The automatic repetition of the keys on the
Apple 11Gs kevboard; if vou hold one key down, the
computer will keep generating that character until you
release the key or press another key. You can turn off the
auto-repeat feature using the Control Panel,



backspace To move the insertion point or cursor 1o the
left by pressing the Delete key (which generally erases as
it backspaces) or the Left Arrow key (which generally
backspaces without erasing).

backup copy A duplicate of a disk or file, which vou
make as a safeguard in case anything happens to the
original, Making a backup copy of a disk or file is like
making a photocopy of a paper document.,

backup set A collection of duplicate disks or files, See
backup copy.

BASIC Acronym for Beginners All-purpose Svmbolic
Instruction Code. A version of BASIC called Applesoft
BASIC is built into your Apple HGs.

baud The rate of transmission used in exchanging
information between a computer and its peripheral
devices, or between two computers.

BBS (bulletin board system) A computerized version
of the bulletin boards frequently found in supermarkets;
places to leave electronic messages and to advertise things
vou want to buy or sell, One thing vou can get from a
computerized bullerin hoard that vou can't get from g
corkboard is free software, See public-domain software,

binary system A numbering system in which every
number is expressed as a combination of 0's and 1's. The
binary system is perfectly suited to computers because the
computer's microprocessor is made up of switches—like
light switches—that are either on or off. On is usually
represented as the number 1, off as (0

bit Contraction of the words hinary and digit. The
smallest item of useful information a computer can
handle, usually represented as a 1 or a 0. Eight bits equal
one byre,

block A unit of data storage or transfer usuallv equivalent
to 512 bytes—or roughly 512 characters.

boldface A name given to type that is heavier than the
plain text type with which it is used.

boot Sec start up.

buffer An area of memory where information is kept
until the computer or a peripheral device is ready to deal
with it.

bug An error in an application program or system
software. According to computer industry folklore, the
expression was coined in the early days of computing,
when a moth once got inside a room-size computer and
caused the computer to break down.

bulletin board On an AppleShare file server, a folder
that all users can see the contents of but that only the
owner can change. A bulletin board folder functions in
much the same way as a cork board in a classroom or
office. Not the same as bulletin board system (BBS).

bus A path along which information is rransmitted
clectronically in a computer or berween a computer and
its peripheral devices.

button In graphics-based applications, a rectangle with
rounded corners that appears in a dialog box. You click
buttons to designate. confirm, or cancel an action. See
also mouse button,

byte A sequence of eight bits that represents an
instruction, a letter, a number, or a punctuation mark,

cache Memory set aside to increase the efficiency and
operating speed of the computer. Compare RAM cache.

Cancel button A button that appears in many dialog
boxes. Clicking the Cancel button cancels whatever
ACHVILY s In progress.

Caps Lock key A kev that vou can lock into place so that
letters you tvpe will come our capitalized. Caps Lock
affects only alphabetic kevs—not numbers or symbols.
card A circuit board that vou can install in a slor inside
the Apple LGS to expand the computer's memory, give the
computer the means to communicate with a peripheral
device, or add some capability to the computer.
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carriage return (CR) A nonprinting character that tells
the computer or printer to end one line of text and stan
another. In word-processing applications, carriage returns
are frequently used 1o end paragraphs, Even though vou
usually can't see them, vou can delete carriage returns the
same way vou delete other characters.

catalog See directory.

CDA See classic desk accessory.

CDEV Abbreviation for Control Panel Device. A category,
such as General, Kevhoard, or Slors, of options vou can
change in the desktop Control Panels, System 6 treats

each CDEV as an independent Control Panel, and allows
more than one to be displayed at the same time.

CD-ROM  Acronym for compact disc read-only memory.
A disc that uses laser technology to store approximately
5500 megabytes of data, A CD-ROM is like a phonograph
record in that you can play it but you can't record
information on ir.

CD-ROM drive A device, such as the AppleCD SC, that
reads the information from a CD-ROM and transmits the
information to the computer.

character A letter, number, or other symbol,

character generator The integrated circuit responsible
for printing characters on the screen in text mode.

character set The letters, numbers, and symbols that
can be generated by pressing kevs on a keyboard.

checkbox The small box associated with an option in a
dialog box: when clicked, the check box activates or
deactivates the option. ( When an option is activated, an X
appears in the checkbox.)

chip An electronic circuit—including components and
interconnections—entirely contained in a single picce of
semiconducting material, usually silicon. Same as
integrated circuit.
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circuit board A board containing both embedded
circuitry and a collection of attached integrated circuits,
The computer’s main circuit board, interface cards, and
memory expansion card are all examples of circuit boards.

circuitry A network of wires, integrated circuits,
resistors, and other electronic devices and connections,
over which electrical impulses travel,

classic desk accessory (CDA) A “mini-application” that
you can use without leaving your main application. Classic
desk accessories are available from the Desk Accessories
menu, which you can reach by pressing Command-
Control-Esc whenever the computer is on.

Clear key A key on the numeric keypad. Pressing Clear
deletes the selected item.

click To position the pointer on an object on the screen,
then press and quickly release the mouse button,

Clipboard The holding place for whart you last cut or
copied; a buffer area in the computer’s memory.
Information on the Clipboard can be inserted ( pasted)
into documents.

clock rate The rate at which bits move from one internal
component to another.

close box The small box on the farleft end of the title
bar af an active window. Clicking the close box closes the
window,

Color menu In the Finder and other graphics-hased
applications, a menu that lets you color the background
and outline of icons.

color monitor A display device that lets you display text
and graphics in color

column In text-based applications, a way of designating
the number of characters that fit on the computer’s
display. A column is one character wide.

command An instruction that vou give to the computer.



Command key The key on the Apple 1165 kevhoard
marked with both the outline of an apple (@) and a
propeller symbol (38), See modifier key.

communications software Applications that make it
possible for your computer 1o exchange information with
other computers and with information services over
telephone lines.

compatibility The condition under which devices or
programs can work with each other. For example, the
Apple 16 can run many applications developed for earlier
models of the Apple [ family. Those applications are said
to be compatible with the Apple 11Gs.

composite color monitor A monitor that uses
compaosite signals to display information. Also called an
NTSC color monitor,

composite signal A video signal that includes both

display information and the synchronization (and other)
signals needed to display it.

computer An electronic device that performs
predefined ( programmed) compurarions at i high speed
and with great accuracy; a machine that is used to store,
teansfer, and transform information.

computer system A collective term for a computer and
evervthing attached to it

configure To change software or hardware actions by
changing settings. For example, you use the Control Panel
to configure the printer port so that vour computer will
send information to the printer in a format that the printer
can understand.

Control key See modifier key,
controller card See disk drve controller card.

Control Panel A desk accessory that lets you set the
time of the built-in clock and tailor certain features of vour
computer system to suit your individual preferences.
There are two versions of the Control Panel, see text
Control Panel and desktop Control Panels.

coprocessorcard A card that includes a microprocessor
which overrides or works with the microprocessor on the
main circuit board. The main reason for using a
coprocessor card is to be able to work with disks initialized
for other operating systems.

copy-protect To make it difficult for someone to
duplicate a disk. Not the same as write-protect.

CPM Abbreviation for Control Program for
Microprocessors. An operating system that works with the
B0B0 microprocessor. You can run CPM software on the
Apple LGS by installing a Z80 card.

CPU (central processing unit) The “brain” of the
computer; the microprocessor that actually performs the
computations in machine kainguage. Some people use the
term CPU 1o refer to the entire component—the
computer—that includes the central processing unit.

CR See carriage return.

cursor A blinking underline, rectangle, or other symbol
that marks your place on the screen, It shows you where
vour next action will take place. Properly called an
insertion point, Compare pointer,

cursor keys The kevs (usually called the arrow keys) in
the lower-right corner of the Apple 11Gs keyboard; in many
applications, you use these keys 10 move the insertion
point or cursor in the direction indicated by the arrow.
cut Toremove text or graphics from a document by using
the Cut command. The most recent “clipping” is stored on
the Clipboard of the Apple 11GS so that you can paste it
somewhere else if vou wish,

daisy-chain To connect a series of peripheral devices so
that the first device is attached directly to the computer,
the second device is attached to the first device, and so on.
data Information, especially raw or unprocessed
information.
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database application A rvpe of application that helps
vou keep track of lists of information, Darabase
applications make it easv to recall and update information
and to create reports using subsets of information.

data bit A hit in a communication transfer that conains
actual information. Compare stop bit.

data disk A disk that contains your work—letters,
budgets, pictures, and so on—but that contains no
application programs. Compare program disk; startup
disk.

Data Carrier Detect (DCD) A handshake signal used to
regulate the How of data between the computer and a
peripheral device,

Data Set Ready (DSR) A handshake signal used 1o
regulate the flow of data between the computer and a
peripheral device,

Data Terminal Ready (DTR) A handshake signal used
to regulate the flow of data between the computer and a
peripheral device.

debug Tolocate and correct "bugs —errors or the causes
of problems or malfunctions in a compurter program. See
also bug,

dedicated server Acomputer that is used exclusively as
a file server, print server, or both, (The same computer
cannot be used as both a server and a workstation on the
network at the same time. )

default A preset response or setting, used unless you
specify something different.

defenestration The act of throwing something through,
from, or out of a window, Not recommended for any part
of yvour Apple [1GS system,

Delete key A kev on the Apple 1Gs keyboard used in
many applications to erase the character 1o the left of the
CUrsOr or insertion point,
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desk accessory A “mini-application” that you can use
without leaving vour main application. See also classic
desk accessory; new desk accessory.

desktop In graphics-based applications, the computer’s
working environment on the screen. In the Finder, for
example, the desktop displays the Menu bar, Trash icon,
the icons of any disks to which vou have access, and the
windows of any disks or folders you've opened.

desktop Control Panels The new desk accessory
version of the Control Panel, which is part of System 6, is
available through the Apple menu of the Finder (or any
graphics-hased application that supports the Apple
menu). The desktop Control Panels (Slots, Time, and so
on) are treated as independent CDEVs by System 6 and
more than one can be displayed at the same time. See also
CDEV, Control Panel; compare text Control Panel.

destination disk The disk onto which you are copyving
or moving data. ( The source disk is the disk from which
you're copying or moving data.)

destination folder The [older into which vou're

copyving or moving data. ( The source folder is the folder
from which vou're copying or moving dara,)

device Sce peripheral device.

diacritical A mark, point, or sign attached to a letter to

indicate phonetic use or value, or to distinguish it from
another letter.

dialog box A box that the Apple 1165 displays to request
information or ask vou to confirm an action. In many
cases, dialog boxes containing warnings are accompanied
by a beep.

digital signal A signal that is sent and received as a
sequence of discrete values or levels rather than
continuously, Compare analog signal,

digitizer See audio digitizer; graphic digitizer,



dimmed command A commund that you can’t choose
under the present circumstances,

direct-connect modem A modem that vou plug
directly into a phone jack. With i direct-connect modem,
the computer automates the process of dialing and
answering the telephone when you're connecting to a
remote computer. Compare acoustic-coupler modem.

directory A list of all the files on a disk or in a folder.
Sometimes called a catalog. See also subdirectory.

directory dialog box A special vpe of dialog box, used
in graphics-based applications, that allows you to open,
save or relocare a file.

disk A flat, circular magnetic surface, made either of
metal or of plastic coated with iron oxide. You can buy
applications prerecorded on disks, and you save your
work on blank disks, See also 5.25-nch disk; hard disk;
3. 5-inch disk.

disk drive A peripheral device that loads information
saved on a disk into the memory of the computer and
saves information from the memory of the computer onto
a disk.

disk drive controller card A circuit board that provides
the necessary circuitry to connect disk drives to the
Apple TGS, (You can connect 3.5-inch and 5.25-inch disk
drives directly to the disk drive port on the back panel of
the Apple 1G5, so a disk drive controller card isn't
required.)

disk drive light A light, usually on the front of a disk
drive, that comes on when the drive is loading information
from a disk or storing information on a disk. Sometimes
called an in-use light. When the light is off, it's safe to insent
or eject disks. When the light is on, don't remove the disk
in the drive.

Disk menu A Finder menu that lists commands that
affect whole disks—commands like Initialize, Erase, Verify,
and Eject.

disk name The name of a disk or its main directory.
Compare pathname.

disk operating system Scc operiting systen.
display A general term used to describe what you see on
your screen when vou're using a computer or to describe
the monitor itself.

document A discrete collection of information you
create with an application. Examples of documents are
memos, pictures, and budgets. Compare file

DOS 3.3 One of several operating systems that can be
used with the Apple T1Gs. DOS is an acronym for Disk
Operating System; 3.3 is the version number.

double-click To position the pointer where vou want an
action to take place, and then press and release the mouse
button twice in quick succession without moving the
mouse.

Double Hi-Res A graphics mode that can display
information using a rectangular array of 560 horizontal by
192 vertical dats for black and white and for 16 colors.

Down Arrow key A kev on the Apple 1168 keyboard
used in many applications to make the insertion point or
cursor move down one line.

download To send a file from one computer to another

drag To position the pointer on something, press and
hold the mouse button, move the mouse, and then release
the mouse button. When vou release the mouse button,
vou either highlight a selection or move an object to a new
location.

drive Sce disk drive.

drive number The number indicating 1o which
connector on  disk drive controller card a particular drive
is connected.

drop folder On an AppleShare file server, a folder that
only the owner can see the contents of but that all users

can add contents to. A drop folder functions in much the
same way as a locked mailbox or suggestion box,
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Dvorak keyboard A keyboard lavout designed o
increase typing speed and efficiency by locating the keys
used most often in the home row, Also called the
American Simplified Keyboard. Compare Qwerty
kevboard.

echo A copy on your own screen of a message you send
vig 2 modem. The echo can come from the remote
computer (the computer on the other end of the phone
line) or from vour own computer,

Edit menu A menu in most graphics-based programs
that lists editing commands such as Copy, Cut, and Pasre.

8-bit processor A microprocessor that can work with 8
bits of data at a time,

80-column card Aninterface card that makes it possible
for some models of the Apple 11 to display text in 80-
column form instead of the standard 40-column form,
(The Apple TIGS has built-in 80-column display capability,
50 it doesn't require an BO-column card. )

80-column display A text mode in which B0 characters
per line (rather than 40) are displayed on the screen.

eject To remove a disk from a disk drive

Enter key A kevon the numeric keypad that confirms a
choice or tells a program vou're ready to proceed. (In
mast cases, the Return key also serves this function.)

error message A message that appears on the
computer's screen to alert vou to a failure in the
communication process. Error messages are often
accompanied by beeps.

Esc key A key on the Apple 11aGs keyboard used in many
applications to get back 1o a menu or to cancel a
procedure that's in progress, (Esc is an abbreviation for
esgipe.)
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even parity An error-checking system in which the
sending device adds an extra bit, set to 0 or 1 as necessary,
to make the toal number of 1 bits add up o an even
number. The receiving device then counts the 1 bits. If the
total is an even number, the receiving device assumes that
the message came through intact. Compare odd parity.

Everyone Ausercategory towhich you can assign access
privileges. This category includes all registered users and
guests (if guests are allowed access 1o the file server
volume in question),

Extras menu A Finder menu that lists Svstem 6 Finder
extensions—programs that add functionality to the Finder.

file Anamed collection of information stored on a disk—
either information created by a user, or prerecorded
information such as an application program or a system
file. Compare document.

file management A general term for copying files,
deletng files, and other housekeeping chores involving
the contents of disks.

File menu A menu in most graphics-based applications
thar lists commands affecting whole documents or
applications—commands like Open, Save, Print, and Quit.

filename The name you give your file (document)
before vou save it to a disk.

file server A computer, equipped with special software
and one or more mass storage devices (such as hard
disks), that allows computer users in a network to store
and share applications, documents, and other
information.

file server volume A disk connected to o file server that
network users employ to store and share information,

file system A system for organizing the sections on a
disk so that your application can keep track of where data
is storedd, You must initialize any disks you'll be using with
a particular application for use with that application’s file
system,



Finder An application that helps vou manage the way
information is stored on disks. The Finder also lets vou
move guickly from one application to another,

firmware Programs stored permanently in read-only
memary (ROM),

5.25-inch disk A disk 5.25 inches in diamerer, with a
storage capacity of 143K (the equivalent of about 70 pages
oftext). For many years, 5.25-inch disks were the only tvpe
of disks you could use with Apple I computers, Compare
3.5-inch disk.

folder A subdirectory or an icon that represents a
subdirectory. Folders give you a visual representation of
documents that you have grouped together on a disk.

font Acomplete set of characters in one design, size, and
stvle,

format The physical division of space on a disk into
sections—somewhat like parking spaces in a parking lor—
where information can be stored. A disk's format is
established as part of the initalization process,

40-column display A rext mode in which 40 characters
per line (rather than 80) are displaved on the screen.

freeware Public-domain software that vou can receive at
no cost, Bulletin board services are a good source of
freeware,

FST ( file system translator) A program that tells
GS/08 how to read and write data to disks that use a
particular file svstem, such as AppleShare or HFS.

function A built-in formula you can use in a spreadsheet
to calculate an average, a square root, and so on.

function key A key that tells an application to carry out
4 particular activity or function (print a document, save a
document, and so on). Some applications use the number
kevs on the numeric kevpad as function keys.

garbage A string of meaningless characters that bears no
resemblince to vour document. Garbage characters are
often an indication that your computer and periphera
device are using different bauds or data formats,

graphic digitizer A peripheral device that converts
photographic images into a form that the computer can
process, save on a disk, display on the screen, and print.
(Once an image is in digitized form, itcan be edited.)

graphics application Any application program in which
you work with graphics; examples are art applications,
business graphics applications, and clip-art applications.

graphics-based application An applicarion that uses a
graphics mode to display information, In most graphics-

based applications, the mouse rather than the kevboard is
the primary means of communication with the computer.

graphics mode A way of displaying text and graphics on
the screen, In a graphics mode, images are formed by
patterns of dots.

graphics tablet A device for drawing pictures. A special
pen sends out signals that are detected by wires in the
tabler and sent as x and v coordinates 1o the screen.

group (1) A named collection of registered users of an
AppleShare file server. Groups can be designated only by
the network administrator. (2) A user category to which
vou can assign access prvileges. This category includes
any registered users who are members of the group
associated with the folder,

GS/0S The current operating system for the Apple Has,

guest Someone who logs on to an AppleShare file server
without providing 4 registered user name or password,
The user name assigned to someone who logs on as a
guest Is <Any User>.

hand-operated controls Peripheral devices, such as
jovsticks and game paddles, used in games and simulation
applications to move objects on the screen.

handshake signal A signal that regulates the flow of
dara berween the computer and peripheral devices.

hard copy A printed copy of an electronic document,
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hard disk A storage device that can hold much more
information than a 3.5-inch disk ora 5.23-inch disk. Unlike
3.5-inch and 3.25-inch disks, a hard disk is sealed into its
drive and is not removable.

hard disk partition A division of the hard disk that is
recognized by the system as a separate disk, Partitions are
created using the Advanced disk utility.

hard format Dividing the physical space on a disk into
sections according to a pre-defined physical reference
point, See format,

hardware Those parts of the computer system that you
can see and touch, The computer, the peripheral devices,
the cables used 1o connect them, and the cords that
supply them with power. Compare software.

Help window A window that contains useful
information, usually defining or clarifying terms or
functions of the program being used.

hertz (Hz) The unit of frequency of vibration or
oscillation, defined as the number of eyvcles per second.
Named for the physicist Heinrich Hertz. The frequency
setting used for monitors in the United Seates 15 60; the
setting used in most other countries in 50,

HFS (Hierarchical File System) The file svstem used
by the Macintosh computer, HFS is one of the file systems
currently support by G5/0S.

highlight Ty make something visually distinct. For
example, when vou select an icon, it becomes
highlighted—the outline and icon name are white on a
black background rather than the usual black-on-white,

Hi-Res A graphics mode that can display information
using a rectangular array of 280 horizontal by 192 vertical
dots.

home control device A peripheral device that allows
your computer to regulate the iemperature of your home,
turn lamps on and off, monitor smoke detectors or burglar
alarms, or control 2 number of other household
appliances.
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home row The row of keys on the keyhoard where the
fingers rest when they aren't reaching for other keys. In
the standard keyboard layout, the home row contains A, 5,
D, F. G, and so on. In the Dvorak kevboard lavout, the
home row contains the most frequently used keys (A, O, E,
U, L, and 50 on).

Hz See hernz.
I-beam See insertion point.

icon (1) In graphics-based applications, a symbol on the
screen that represents a disk, a document, or something
else you can select. (2) A svmbol on the back panel of the
computer that shows vou where to plug in a peripheral
device.

information service A large database that vou can
subscribe to, letting vou receive news, stock prices,
electronic mail, or other services via your modem.,

initialize o divide a disk into sections where
information can be stored and to write a file svstem on the
disk so that an application can keep track of where data is
located. Disks must be initialized before you can save
information on them.

INITS (initialization files) See setup files.

input Information traveling into the computer (like
kevpresses and mouse movements).

insertion point A blinking vertical or horizonral line that
marks your place on the screen, The insertion point shows
vou where your next action will take place. Also called the
cursor, Compare pointer.

Installer A program on the Apple 1Gs Install disk that
lets vou add or remove capabilities from your startup
disks. For example, if you're connecting a SCSI hard disk,
vou neecd 1o install the “SCSI Hard Disk” update to your
startup disks,

integrated circuit An electronic circuit—including
components and interconnections—entirely contained in
a single piece of semiconducting material, usually silicon.
Often referred roas a chip.



interface The way things communicate. See also parallel
interface; serial interface; user interface.
interface card A circuit board thar you plug into one of

the slots in the Apple 1G5 to link cenain peripheral
devices to the computer.

internet Two or more networks connected 1o form a
larger network.

inverse characters Characters that appear in the
opposite format from normal, For example, if characters
are ordinarily light on a dark screen, inverse characters
would show up as dark on a light screen. Inverse
characters are used as a form of highlighting,

1/O (input/output) Refers to the means by which
information is exchanged by the computer and its
peripheral devices.

1/O error message A message vou see when there's a
problem with the way information is being exchanged by
the computer and its peripheral devices.

jacket The covering that protects a 5.25-inch disk,

joystick A peripheral device that maves creatures and
objects in games,

justify To format a page of text so that the left margin,
the right margin, or both margins are a constant width for
all lines,

keyboard A peripheral device that provides a common
way 1o communicate with the computer. The computer’s
kevboard looks like the keyboard on a typewriter, but the
keys on a compurer kevboard can be programmed for
many uses.

keyboard buffer A special part of memory where
keypresses are stored until the computer is ready to act on
them.

key color The designated color through which the video
input signal displays on the screen.

keypad Sce numeric kevpad.

kilobyte (K) A unit of measure for computer memory;
1 kilobvte equals 1024 bytes, See also byte; megabyie.

laser printer A printer that produces typeset-quality text
and graphics using laser technology.

Left Arrow key A key on the Apple 11Gs kevboard used
in many applications to move insertion point one
character to the left. {In some applications, the cursor or
insertion point erases characters as it moves to the left.)

LF The character that instructs the computer to advance
1o the next line, ( The event generated by the LF character
is called a line feed—hence the abbreviation LF)

light pen A peripheral device shaped like a pen that
sends instructions to the computer when vou point to
choices on the screen. Light pens work only with
applications designed 1o receive input from them,

line break The end of a line of text on the screen or on
a printed page. You can force a line break by pressing
Return, or vou can let the application break lines for vou,
line feed An advance to the next line. See also LF,

load To transfer data or programs into the computer
from a disk.

local disk Any disk in a disk drive connected directly 1o
the computer. Compare file server volume.

local printer A printer connected directly t1oa computer
and available only from that computer. See also Direct
Connect. Compare network printer.

LocalTalk connector box A picce of hardware,
consisting of a small box with an attached cable, that you
use to connect your computer 1o the AppleTalk network
system,

log off To end a work session on an AppleShare file
server,

log on To identify yourself to an AppleShare file server
from a workstation.
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Lo-Res A graphics mode that can display information
using a rectangular array of 40 horizontal by 48 vertical
blocks.

machine language The binary language of 0's and 1's
that is the only language the computer uses. All other
programming languages, like BASIC, must be translated
into this binary code before the computer can process
them.

main circuit board A large circuit board that holds
RAM, ROM, the microprocessor, custom integrated
circuits (chips), and other components.

mainframe computer A central processing unit or
computer that is much larger and more powerful than a
minicomputer or a personal computer (microcompuier).
Mainframe computers are sometimes called mainframes
for short.

main menu The first menu you see in text-hased
applications. The main menu presents the application’s
top level of options,

Make Changes The access privilege that allows
someone 1o make changes o a folder's contents.

mass storage device A device such as a hard disk or a
CD-ROM that can store much more information than 3.5-
inch or 5.25-inch disks.

megabyte (MB) A unit of measure for computer
memory; 1 megabyte equals 1,048,576 bytes (each byve
being enough memory to represent a single character),
See also byvte; kilobyte,

megahertz (MHz) One million cveles per second.

memory Integrated circuits (chips) that store
instructions for the microprocessor. There are two kinds
of memory temporary memory (called random-access
memory or RAM) and permanent memory (called read-
only memory or ROM), The contents of RAM disappear
when you switch off the power; the contents of ROM

do not.
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memory expansion card An interface card that vou
install in the memory expansion slot in the Apple I1Gs 1o
increase the computer's random-access memory.

menu A list of choices presented by an application.

menu bar In graphics-based applications, the horizontal
strip at the top of the screen that contains menu titles,

menu title [n graphics-based applications, a word,
phrase, or picture in the menu bar that designates one
menu. When you point to a menu title and hold down the
mouse button, vou can see the commands in the menu.

MHz (megahertz) One million cycles per second.

microprocessor The “hrain” of the computer; the
integrated circuit that performs the actual caleulations,
Also called the central processing unit (CPU). The

Apple 1168 has a 65C816, 16-bit microprocessor.

MIDI (Musical Instrument Digital Interface)

A software and hardware standard set by the music
industry that allows different electronic instruments 1o
communicate with one another and with computers. The
Apple MIDI Interface is a device that plugs into the
modem port of the Apple LGs and lets you use vour
computer as a music synthesizer or as a control device for
electronic musical instruments.

mode A state that determines the computer’s behavior.
See also graphics mode: text mode.

modem Short for modulator/demodulator. A device that
links your computer 1o another computer or t an
information service over phone lines. See also acoustic-
coupler modem: direct-connect modem.

modifier key A key that generates no events of its own
but changes the meaning of other keys or of mouse
actions. The modifier keys on the Apple IIGS kevboard are
Command, Control, Option, and Shift.

monitor A peripheral device that displays instructions
from the applicarion to you on a screen and shows what
vou've typed into the computer’s memory,



monochrome monitor A black-and-white, amberand-
black, or green-and-black monitor.

mount Comparable to inserting a floppy disk, mounting
a network volume allows vou to see the volume icon and
1o gain access to the contents according to the privileges
assigned.

mouse The small device you roll around on a flat surface
next 1o vour computer. When you move the mouse, the
pointer on the screen moves correspondingly.

mouse button The button on top of the mouse. You
press the mouse button to choose commands from menus
or when you want to move items around on the screen.

Mouse Keys One of the Easy Access components that
emables the numeric kevpad to provide mouse functions,
such as moving the pointer, clicking, dragging, and
pressing.

MouseText Special characters, including check marks
and little apples, used in some text-based applications.
MS-DOS The operating system for applications designed
to run on 1IBM PCs and compatible computers. You can run
MS-DOS software on the Apple I1Gs by installing a PC
Transporter card.

music synthesizer A device that can generate 4 variety
of sounds, including simulations of traditional musical
instruments.

NDA (new desk accessory) A “mini-application” that
you can use without leaving vour main application. New
desk accessories are available from the Apple menu
whenever vou're using the Finder or any graphics-based
application that supports the Apple menu.

nest o store in a folder one or more levels removed
from the main (disk) directory. You can nest items in
folders within folders within folders.

network A group of computers linked wogether so that
their users can share information and peripheral devices

network administrator The person who sets up,
maintains, and troubleshoots a network.

network printer Any printer, connected to a network,
that can be shared by network users. Compare local
printer or Direct Connect.

network services A capability, such as file sharing or
printing, provided by special software on  network.
Nobody A user category to which you can assign access
privileges. This category excludes all registered users and
guests—even the folder's owner,

NTSC Abbreviation for National Television Standlards
Committee. An organization that defines the standard
format for transmitting broadcast video signals in the
United States.

NTSC color monitor Sce composite color monitor.

numeric keypad The number keys, on the right side of
the Apple I1Gs keyboard, that are laid out like the keys on
a caleulator. In most cases, you can use these keys
interchangeably with the number keys on the top row of
the keyboard. Some application programs use the keys of
the numeric kevpad as special function keys,

OCR Abbreviation for oprical character reader. A
peripheral device that scans pages of typed or typeset text
and “reads” the characters into the computer.

odd parity An errorchecking system in which the
sending device adds an extra bit, set to 0 or 1s necessary,
to make the total number of 1 bits add up to an odd
number. The receiving device then coumts the 1 bits. Ifthe
total is an odd number, the receiving device assumes that
the message came through intact, Compare even parity,

open To make available, You open documents in order to
work with them. In the Finder, opening an icon causes a
window displaying the contents of the icon to appear on
the desktop.

Open Apple key On older Apple Il keyboards, the name
for the Command kev.
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operating system A set of programs that, among other
things, controls the way information is loaded into
memaory, the way the computer works with that
information, the way information is stored on a disk, and
the way the computer communicates with a printer and
other peripheral devices. GS/OS, ProDOS 16, ProDOS 8,
DOS 3.3, and Apple Pascal are some of the operating
systems available for the Apple TiGs.

Option key Akey on the Apple 11Gs kevboard that, when
pressed in conjunction with another key, creates a special
effect. ( The Option key controls the operation of other
keys but has no effect if pressed alone.) On older Apple 11
keyboards, this key was labeled @ and was called the Solid
Apple key. Compare Command key; Control key.

output Information traveling out of the computer.

owner (1) The registered user who created or was
assigned ownership of a folder on an AppleShare file
server volume. (2) A user category towhich vou can assign
access privileges. This caregory includes only the folder's
awner, (If the folder is owned by <Any User>, however,
all network users will have the privileges assigned to the
Owner category.)

Owner & Group A user category to which vou can
assign access privileges. This category includes the owner
and any registered users who are members of the group
associated with the folder.

parallel device A printer or other device that sends and
receives data several bits at a time over several separate
wires, Compare serial device.

parallel interface Aninterfuace in whichacomputer and
a peripheral device exchange information several bits at a
time along several separate wires. Compare serial
interface.

parallel printer A printer that receives information
from the compurter several bits ar a time each over its own
wire. A parallel printer must be connected to the

Apple 116 through an interface card. Compuare serial
printer.
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parity A way of checking data to make sure that bits of
data didn’t get lost or garbled during transmission. See
also even parity; odd parity.

Pascal (1) One of several operating systems that can be
used with the Apple 11Gs. (2) A structured programming
language taught in high school and college computer-
stience courses because it stresses a systematic approach
to problem solving,

password A secret word that gives vou, but no one else,
access to your data on a file server or 1o messages sent 1o
you through an information service.

paste To insert a copy of the contents of the Clipboard—
whatever was last cut or copied—at the insertion point.

pathname The complete name of a document,
beginning with the name of the disk (sometimes called the
volume name), followed by the names of any
subdirectories or folders the document is in, and the name
of the document itself. It's called a pathname because it
describes the path or route to the document.

peripheral device A device that's connected to the
computer, such as a printer or a modem.

peripheral interface card Sce interface card.

pixel Contraction of the phrase picture element. A dot
on the screen, used in graphics mode to form gext and
graphics.

plotter A device that prints charts and graphs by means
of pens whose movements are programmed.

pointer In graphics-hased applications, a marker that
moves across the screen when you move the mouse
across your desk. Compare insertion point and cursor.

pop-up menu A menu of options (for example, in the
desktop Control Panels) in which only the selected option
is visible unless vou press the mouse button to make the
other options “pop up.”

port Asocket on the back panel of the Apple 11Gs for
connecting peripheral devices.



prefix A partial pathname—the name of the disk and, if
vou like, the name of one or more subdirectories or
folders. Applications that ask vou to type a pathname
usually let vou set a prefix so that you don't have to tvpe
the complete pathname every time you want to work with
documents on a particular disk or in a particular
subdirectory or folder. Once a prefix is set, all vou do is
type the rest of the pathname.

press (1) To position the pointer on something and then
hold down the mouse button without moving the mouse.
(2) To hold down a key on the keyboard,

primary group The AppleShare group with whom a
user most often shares folders and documents stored on a
file server. Primary groups are specified by the network
administrator,

printer A device that produces a paper copy of the
information vou create using the computer.

ProDOS Acronvm for Professional Disk Operating
System. One of several operating systems for the

Apple LGS, See also operating system.

program (v.} To write instructions for o computer,

(n.) A set of instructions that tells a computer what to do.

program disk A disk that contains an operating system
and a self-starting application program.

programmer A person who writes computer programs
prompt A character displayed on the screen to indicate
that the user can take some action, For example, a bracket
prompt (]) is used in the Applesoft BASIC programming
language.

proportional scroll box The white box in a scroll bar
The position of the proportional scroll box in the scroll bar
indicates the position of what's in the window relative to
the entire directory or document. The size of the box
relative 1o the size of the bar indicates how much of the
window is visible.

protocols An agreed-upon formal hardware or software
handshaking between two electronic devices. See
handshake signal.

public-domain software Sofrware that is not
copyrighted. You can get it at user group meetings or
through computer bulletin boards. See also freeware;
shareware.

pull-down menu A menu that is hidden until you use
the mouse to press its title.

Qwerty keyboard The most commonly used kevboard
lavout in the United States. named for the first six letiers
in the top row of letter kevs. Also called the Sholes
keyboard. Compare Dvorak keyboard.

radio button A small circle on sereen that you click o
tlesignate an action or setting. When a radio button is “on,”
a dot appears within the circle.

RAM (random-access memory) Memory 1o which the
contents of individual locations can be referred in an
arbitrary or random order. RAM usually refers to that part
of memory available for programs and documents that the
computer reads from a disk; the contents of RAM are lost
when the computer is turned off. See RAM disk, Compare
ROM,

RAM cache A part of the computer’s random access
memory where programs store frequently used
instructions,

RAM chip An integrated circuit that you install on your
memory expansion card when upgrading the card’s
memory.

RAM disk A cross between a disk and random-access
memory. Like a disk, it must be initialized before vou can
put files on it and must be addressed by its disk name or
by its slot number. Like RAM, it offers fast access to
information but cannot store information permanently—
everything is erased from the RAM disk when vou switch
off the computer’s power,
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read To transfer information from a disk into the
computer’s memory.

read-only The privilege to transfer information from a
disk into the computer’s memory, but not 1o record
information on a disk.

read/write The privilege 1o both transfer information
from a disk into the computer’s memory and record
information on a disk.

registered user A user of an AppleShare file server who
has been given a user name and password by the network
administrator,

remote computer The computer on the other end of
the phone line, You can use your Apple 11GS, a modem,
and a communications application to communicate with a
remate computer—across the street or on the other side
of the globe.

Reset key The kev on the Apple 1168 keyboard marked
with a triangle. You can press Reset in combination with
Command and Control 1o restant the computer.

resolution The degree of clarity of your display. An RGB
color monitor has better resolution than a composite
color monitor,

Return key A key on the Apple lGs keyboard that you
press to move the insertion point to the beginning of the
next line. The Return key is also used in many applications
to accept choices or to indicate that you've finished doing
something and are ready to proceed.

RGB color monitor A tvpe of color monitor that can
display text in color and in 80-column formar. (RGB is an
abbreviation for red, green, blue—the three primary
colors from which all screen colors are derived.)

Right Arrow key A key on the Apple 11GS kevboard used
in many applications to move the insertion point one
character 1o the right.
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ROM (read-only memory) Permanent computer
memory. Applesoft BASIC is stored in ROM, as are other
programs that regulate communication between the
microprocessor and other parts of the computer system.
Compare RAM.

ROM disk ROM chips on a memory expansion card that
can contain application programs.

root level The “highest” or “volume” level of a
pathname. See also directory, pathname, and
subdirectory.

row A horizontal arrangement of character cells (in text
mode) or pixels (in graphics mode) on the screen.

save Tostore an application or data on a disk, as opposed
to storing it temporarily in the memory of the computer.

scan To search in the slots of the computer for a disk
drive controller card. The computer scans when you first
switch on the power. It looks first in slot 7 (or the
corresponding port): if it doesn't find a startup device
there, it proceeds to the next-highest-numbered slot until
it finds a starwp device,

screen The part of the monitor where information is
displayed.

scroll To move through a document so that vou can see
a different part of it.

scroll arrow  An arrow on either end of a scroll bar.
Clicking the scroll arrow moves the document one line in
the direction indicated. Pressing the scroll arrow causes
continuous scrolling.

scroll bar A rectangular bar along the right side or along
the bottom of a window. Clicking in the scroll bar or
dragging the proportional scroll box causes what's visible
in the window to change.

SCSI Acronym for Small Computer System Interface,
pronounced “SKUH-zee.” An industry standard interface
that provides high-speed access to petipheral devices and
allows them to be daisy-chained to a single port or card,



sector Part of a track on a disk.
See Files The access privilege that allows someone to

open and copy the documents and applications in a folder.

See Folders The access privilege that allows someone to
see the folders in a folder,

select In graphics-hased applications, to designate
where the next action will take place. To select something,
vou click it or drag across it to highlight it.

select button A button on 4 printer that determines
whether the printer should accept data from the
computer or instructions from other buttons on the
printer control panel (like the line feed button and the
form feed button).

serial device A device that sends and receives data one
hit at a time over a single wire. Compare parallel device.
serial interface An interface in which a computer and a
peripheral device exchange information one bit at a time
along a single wire. Compare parallel imerface.

serial port One of two ports (the printer port and the
modem port) on the back panel of the Apple 1G5 designed
for serial devices.

serial printer A printer that receives information from
the computer one bit at a time, over a single wire.
Compare parallel printer.

setup files Files that define functionality for the system
or for applications. Also called initialization files or INITs,
setup files are located in the System Setup folder inside
the System folder.

shareware Public-domain software that vou can try out
for free, but for which vou're obligated to pay either a
stipulated fee or a donation of vour choosing if vou decide
L0 COoNtiNUE using it.

Shift-click To hold down the Shift kev as vou click 1o
select items on the screen, Shift-clicking lets vou select
multiple items that are not grouped together on the
screen.

Shift key A key on the Apple 11Gs keyboard that you can
press in combination with another kev to get an uppercase
lenter or the upper character on a two-character key,

Sholes keyboard The most commonly used kevboard
kyout in the United States, named for Christopher Sholes,
the inventor of the typewriter. Also called the Qwerty
kevboard, Compare Dvorak kevboard.

simulation A computerized representation of
something in action.

16-bit processor A microprocessor that can work with
16 bits of information at a time.

65C816 The 16-bit microprocessor used in the
Apple TlGs,

size box A box on the lowerright corner of some active
windows that lets vou resize the window:

slash A character (/) that’s often used to separate the
parts of a pathname.

slot Along, narrow socket inside the Apple UGS thar lets
vou connect 4 printer or other peripheral device to the
computer by plugging in an interface card.

slot number The number indicating which slot a
particular device is connected 1o, There are seven general-
purpose slots on the main circuit board for connecting
peripheral devices to the computer. They are numbered
from 1 to 7, with 1 on the left as vou face the front of the
computer. If your device is connected 1o a port instead of
aslot, you can identify the device by the slot number that
corresponds to the port.

SmartPort A software protocol for communicating with
peripheral devices, such as 3.5-inch or 5.25-inch drives.
software Instructions, usually stored on disks, that tell
the computer what to do. Compare hardware.

Solid Apple key The name for the Option key on older
Apple kevboards, The name derives from the fact that the
key was marked with the filled-in symbol of an apple (@)
rather than the word Option.
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source disk The disk from which vou are copying or
moving. ( The destination disk is the disk onto which
you're copying or moving, )

source folder The folder from which vou're copving or
moving. (The destination folder is the folder into which
yOu're Copying or moving. )

Space bar The bar at the bottom of the kevboard.
Pressing the Space bar inserts a space character in your
text at the insertion point.

space character A 1ext character whose representation
is 4 space. You generate the character when you press the
Space bar,

Special menu A Finder menu thar lists a variety of
“housekeeping” commands such as Clean Up, Empty
Trash, and Shut Down.

speech synthesizer An interface card that allows g
computer application to imitate human speech.
spreadsheet application An application that simplifics
arithmetic tasks such as financial planning and cost
estimating. Spreadsheets are laid out in columns and
FOWS,

stand-alone computer A computer that is not
connected to any other computers as part of a network.
Compare workstation,

start up o load an application from a disk into the
memory of the computer. In computer fangon, starting up
is also called “booting.”

startup disk A disk with the necessary software 1o start
up the computer.

startup drive The disk drive in which the computer
looks first for a startup disk.

Sticky Keys One of the Easy Access components that
provides combined kevstroke commands so that the user
doesn't have to hold down more thian one kev at a time,

stop bit A bit used to indicate the end of a character
during data transmission. Compare data bit.
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styled text An application feature that allows vou 1o
change the appearance of on-screen and printed text by
introducing such artributes as italics and underfining.

subdirectory A directory within a directory. You can use
subdirectories to group related documents rogether.
Same as folder.

Super Hi-Res A graphics mode that can display
information using a rectangular array of 640 horizontal by
200 vertical dots in 4 colors ( per line) or 320 horizontal by
200 vertical dots in 16 colors (per line). Up to 256 colors
can be displaved on the screen at one time under normal
circumstances, Special software enables up to 3200 colors
at one time.

Super Serial Card A serial interface card manufactured
by Apple Computer. You don't need to use a Super Serial
Card with the Apple 11Gs because the serial interface is
built in and can be accessed through the printer and
modem ports,

surge protector A device that protects your computer
equipment from damage in the event of a surge of
electrical current. Some power strips have built-in surge
Protectors.

syntax The rules that govern the structure of statements
or instructions in a programming language or in an
Operating system,

syntax error message A message vou see when vou
misspell 3 command or give a command that the
computer can't process.

synthesizer Sce music synthesizer.

SYSOP (system operator) The person who operates 4
computerized bulletin board.

System 1. The name of the folder containing the files
your computer uses 1o start up and manage system-wide
information. 2. See computer svstem,

system disk A disk that contains the operating system
and other system software needed 1o run applications.



system software Software that supports application
programs by managing system resources such as memory
and input/output devices,

Tab Akeyonthe Apple Has keyboard that, when pressed,
moves the insertion point to the next tab marker.

tab marker A character that indicates the position to
which the cursor or insertion point will move when vou
press the Tab key.

tape backup unit A peripheral device (usually a SCSI
device) that lets vou duplicate on magnetic tape the
information on a hard disk. The alternatives ro using a
tape backup device are copying onto a second hard disk
(which requires the purchase of an additional hard disk)
or copying onto a large number of 3.5-inch disks (which is
time-consuming .

telecommunication The exchange of information with
other computers or with commercial information services
over phone lines. To telecommunicate, you need a
computer, a modem, communications software, and a
similar setup on the other end of the phone line,

text-based application An application that uses one of
the text modes 1o display information. In most text-based
applications, the kevboard rather than the mouse is the
primary means of communication with the computer.

text Control Panel The classic desk accessory version of
the Control Panel, which is built into the computer and is
available through the classic Desk Accessories menu. See
also Control Panel; compare desktop Control Panels.

text mode A way of displaying text on the screen. In g
text mode, characters At in a 40-column by 24-line grid or
in an 80-column by 24-line grid.

3.5-inch disk A magnetic disk, 3.5 inches in diameter.
housed in a rigid plastic case. The most common storage
medium used with the Apple 1Gs. A double-sided 3.5-inch
disk can store from 800K 1o 1.4 MB of information.
Compare 5.25-inch disk.

title bar The horizontal bar at the top of a window that
shows the name of the window and lets vou move the
window.

track One of a series of concentric circles that are
magnetically drawn on the recording surface of a disk as
part of the initialization process. Tracks are further divided
into 8 to 12 consecutive sectors,

Trash Anicon that represents the function of discarding
files and folders when you no longer need them.

troubleshooting Diagnosing and solving a problem.
tunneling A new feature of the Svstem 6 Finder. If the
Oprion key is pressed when opening a folder, the Finder
opens the selected folder and then closes what had been
the active window.

Up Arrow key A key on the Apple llas kevboard used in

many applications to make the cursor or insertion point
move up one line.

update A hardware or software capability you can add to
dlisks using the Installer

user group A computer club whose members share
information and public-domain, freeware, and shareware
programs—often programs they've written themselves.

user interface The way information is exchanged
berween a computer and 4 person.

user name A unigue name assigned to a registered user
af an AppleShare file server and used to identify that user
on the network.

video monitor See monitor,

View menu A Finder menu that lets vou change the way
you view the contents of windows on the desktop.

voice input device A device that translates the spoken
word into a form that certain software applications can
Process,

volume See disk: file server volume.
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volume name Sce disk name.

window In graphics-based applications, one or more

areas on the screen showing the contents of disks, folders,

and documents.

Windows Menu A Finder menu that lets you select or
stack the open windows on your desktop.
word-processing application Any application
designed to make writing and editing easier and faster,
workstation A computer vou can use to do your work

and to send and receive information over the network.
Compare stand-alone computer.

write To record information on a disk.

write-protect To prevent changes to the contents of a
disk by covering the notch on the side of a 5.25-inch disk
or by sliding the small plastic tab to uncover the square
hole on a 3.5-inch disk. Not the same as copy-protect,

XOFF An ASCII character that tells the transmitting
device to halt transmission,
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XON AnASCH character that tells the transmitting device
10 resumie rransmission,

Z80 card A coprocessor card that lets you run programs
based on the CPM operating system.

zero To climinate the disk directory, all files and folders,
and the file system from a disk so that no amount of
manipulation can recover the information that was on the
disk. ( When you zero a disk, only the tracks and sectors
remain.) A disk that has been zeroed must be reinitalized
before it can he used to store information,

zone One or more networks, callectively identified by a
zone name, that are part of a larger, interconnected
network. Zones make it easier for network users to find
network devices and services.

zoom box The small box in the upper-right corner of 4
window. Clicking the zoom box expands the window to its
maximum size. Clicking it again returns the window to its
previous size.
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adaptive rechnology 243259
resources 239
Add LF after CR 186
ADU 224
Advanced Disk Unility 224
crasing 228
initializing 225
opening 225
roubleshooting 313
seroing 230
Alphabetize DAs 179
American Simplibied keyboard 178
-'\;||_||l' HDOSAS 26
Apple I Memory Expansion Card 23
Apple 1l Setup 271
e 1 Video Overlay Card 266
1 Workst

Apple meny

non User’'s Guide 305

commands 45
1,_[1|||1- Personal Modem 183

Apple Scanner 24

AppleBowl 25

AppleCD SC Plus 262

."l]\[ﬂL"\]I;Ii'l' file server 273

JUTESS | TIVIICEES

Fi')

L ¥
iMWInge
viWIng 2

opving applications 279

CoOpMgNica appikcanons <Y

FolderPniv 208

folders 289
logzging off 300
logging on 280259
naming rules 278
roubleshooung 328

using 279

AppleShare hle server access

Everyone 290
Group 290
Nobody 290
Owner 290
Owner & Group 290
AppleShare File Server Administrator's
Guide 278, 35
AppleShare File Server Administrator's
supplement for Apple I
Workstanons 35
AppleShare Print Server Ad

Guide 305

NSERILOr's

AppleShare print servers 273
Appleshare-aware applications 277

AppleTalk  272-327H

AppleTalk netw wk system 272

Applelalk protocols 272
Application
Adv. Disk Utility 24
AppleBowl 25
Archiver 24

Installer 19
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synthLAB 25

Teach 25
applications

locating 137

quitting 148

starting up 136

switching 139
Archiver 24

about 200

entire volume backup 205

hle-by-file backup 208

opening 202

restoring entire volume backups 216
restoring hles from Rle-by-hle

backups 213
Archiver preferences 202

Anstotle Administrator's Guide 305

Audio buttons 265

B

backing up entire volumes 205

hackup
entire volume 201
file-by-fle 201, 208
backup preferences
Archiver 203
backup set 200
Baud 185
Buffering 187
Bulletin Board 295
bulletin board folder 289
By Dare command 52
By lcon command 51
By Kind command 52
By Name command 31
By Size command 52
By Small lcon command 51

C

CD Remote 265
CD-ROM players 262
changing

occurrences of word 162

386 Index

Changing icons
background color 81
color 80
outline color 81

Changing the stanup drive 194

Clean Up command 54
Cleaning up icons 74
Clear command 50
clicking 14
clicking to select text 156
Close All command 44
Close command 48
CloseView 27, 254—258
closing

folders 119

windows 66
Color menu 37
Columns (monitor) 188
command

choosing

selecting
comminls

About the Finder 43

By Date 52

By leon 51

By Kind 32

By Name 351

By Size 52

By Small lcon 51

Clean Up

Clear 50

Close 48

Close All 48

Control Panels 47

Copy 49

Cut 49

Duplicae 48

Eject 53

Empty Trash 35

Erase 53

Finder Preferences 55

Help 46

lcon Info 56

Initialize 32

kevboard 45
New Folder 47
Open 47
Paste 49
Print 48
Put Away 48
Select All 50
Show Clipboard 50
Shut Down 37
Stack windows 51
Unda 49
Validate 49
Verify 53
Control Panels 47
changing 173
getting to 172
leaving 197
troubleshooting 311
control panels
AppleShare 280
DC Printer 175
FolderPriv 299
General 170
Kevboard 179
leaving 197
Media Control 182
Modem Port 182
Monitor 188
NetPrinter 303
Network
Printer Pornt 182, 189
RAM 190
SetStart 191
Slots 191
Sound 195
Time 196
Conventions used xv
Copy command 49
copying
AppleShare file server 279
copyrighted applications 279
disks 97—103
files 125



copying applications
AppleShare file server 279
copying disks 98
options 101
copyrighted applications 279
creating documents 151
creating folders 120
Cursor Flash 177
Custom 295
customized installadon 31
customizing 3
Cut commaned 49

D
DataStop 185
DC Printer control panel 175
default folder privileges 298
Delay 180
Delete LF after CR 186
delering text 159
Desclecting icons 70
Desk Ace
Caleulator 25
Find File 25
desk accessory 172
CD Remote 265
Media Comtrol 262
VideoMix 266
deskop Control Panels 171
diacritical marks 179
diagnosing disk problems 106
diagnostic test 338
discarding files and folders  128—130
dlisk drives
Apple 5.25 Drive 23
Apple UniDisk 23
SCSI hand disk 23
SuperDrive 23
roubleshooting 313
disk icons
opening 96
wpes 97
Disk menu 32

disks 224
copying 97—103
copying options 101
copying same size 98
copying to larger size 9

ciecting 104

erasing  103—104, 228—230
handling 106

icons 96

information 240
initializing 9093, 225228, 315
inserting B8
partitioning  231=239
problem diagnosis  106—108
reinitializing 93
storage 106
troubleshooting 313
using 87
verifying 108
write-protecting 94
zeroing  230-231
Display button 265
documents
changing 160
creating 151
printing 147
printing from applications 166
saving 142, 152
saving with new name 165
saving with pathname 145
saving with slot and drive
number 146
double-clicking 16, 177
dragging 16
dragging to select text 156
Drop Folder 204
Dual Speed 180
Duplicate command 48
duplicate copies of files 123
Dvorak kevboard 178

E
Easv Access 27, 24
Easy Updare 28

Echo 186
Edit menu 49
editing 1ext
cutting and pasting 157
Eject button 265
Eject command 53
efecting disks 14
Empty Trash command 53
emprying trash 130
ending work session 147
entire volume
backup 201
restore 201
enrire volume backup 205
Epson/Epson-style printer 23
Erase command 53
erasing disks  103—104, 228230
Ethernet 272
Evervone 290
expansion 4
Exploring new features of System 6 7
Extras menu 57

F
Fast Space/Delee 181
File menu 47
file naming rules 76
file server
folders 289
logging off 300
loggingon 275
file server volumes 274
File System
DOS 33 FST 26
HES FST 2o
Pascal FST 26
File System Translators 109
file-bw-file
backup 201, 208
restore 201
files
about 118
copving 125
discarding  128—130
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duplicating 123
importing 168
locking 131
opening 118
protecting 130
recovering from trash 129
unlocking 132
validating 132
Finder 41
tasks managed 42
Finder Preferences command 55
finding
strings of words 163
words 163
floppy disks
dbout 86
folder privileges 298
FolderPriv 298
folders
about 118
closing 119
creating 120
discarding  128—130
locking 131
moving  122—123
opening 119
pratecting 130
recovering from trash 129
tunneling 120
unlocking 132
font
changing 160
Fonts disk 6
FSTs 109
types 109

G
General control panel 176

getting information about hard disks 240
getting information about icons 78

Group 290
group folders 297
groups 276
guest 27

388 Index

H
handling disks 106
Handshake signals 187
hard disks
about 86
information 240
initializing 225
partitioning 234
troubleshooting 316
Help command 46
HFS naming rules 91
HFS partition 233
High Sierra 201
high-density disks 87
initializing 92, 327

I

Icon Info command 36
leoms 11

application 11

color 80

disk 11

document 11

folder 11

locking 82

unlocking 83
ImageWniter Emulator 304
ImageWriter I printer 23
ImageWriter LQ printer 23
ImageWriter printer 23
importing hies 108
individual Control Panels 175
information about icons 78
Initialize command 32
initializing

hard disks 225

floppy disks 90
initializing disks 90, 225—228

troubleshooting 315
inserting disks B8
inserting text 154
Install disk 20

Installer 19

adding capabilities 33—37

Advanced Disk Utility 24

Apple 5.25 Drive 23

Apple 1 DOS 3.3 file system
transkator 26

Apple I1 Memory Expansion Card 23

Apple 1 Video Overlay Card 24

Apple Scanner 24

AppleCD 5C 24

AppleCD SC drive 23

Archiver Utility 24

Calculator desk accessory 25

CloseView 27

customized installaton option
31—39

Desk Accessories 25

Easy Access 27

easy update option  28—31

Epson/Epson-style printer 23

File System Translators 25

Find File desk accessory 25

fones 26

hardware limitations 31

HFS file system translator 26

ImageWriter I printer 23

ImageWriter LQ printer 23

ImageWriter printer 23

LaserWriter printer 23

media devices 24

aptions 20

Pascal file svstem translator 26

Pioneer 2000 or 4200 kserdisc
plaver 24

printers 23

removing capabilities  37—39

SCSIhard disk 23

SCSI ape drive 23

special aids 27

storage devices 23

StyleWriter priner 23

Teach 25

UniDisk 23

VideoKevboard 27



international language characters 179
interner 273

K
Kev Caps 252
kev color 267
Kevboard 175
Buffering 150
Delay 180
Dual Speed 180
Fast Space/Delete 18]
Keyboard Mouse 181
Shift Caps/Lowercase 181
Speed 179
troubleshooting 318
kevhoard assistance
Easy Access 244
Sticky Kevs 245246
Keyboard Buffering 180
Kevboard control panel 179
kevboard shontuts 45
keyboard types
American Simplified 178
Dvorak 178
Qwenty 178
Sholes 178
kilobyte B

L
LaserWriter printer 23
leaving control pancls 197
Line Length 185
local disks 274
LocalTalk 272
LocalTalk Cable System Owner's
Guide 278, 305

LocalTalk Locking Connector Kits 272
locking

files 131

floppy disks 94-95

folders 131

icons 82

logging off 300

BO0K AppleShare startup disk 300

finder-based AppleShare startup

disk 300

Quick Logoff 301

without Finder 300

without Quick Logoff 301
loggingon 275

AppleShare file server 280289

groups 276

guest 276

registered users 276

troubleshooting 327
logging on options

password 283

M
Macintosh System 7 273
Make Changes 290
marking files 218
Media Control  262—265
Media Control Panel 182, 262
setting connections 263
Media Controller  264=205
Audio buttons 263
Display button 265
Eject button 263
Pause button 265
Play button 265
Record button 265
Scan buttons 265
Step buttons 265
Stop button 265
Track buttons 263
media devices
Apple Scanner 24
megabyie BO
Menu 17
Menu Blinking 177
menus 43
Color 57
Disk 52
Edit 49
Extras 57

File 47

Special 54

View 51

Windows 350
Modem Port 182
Modem Port control panel 182
modem sertings 183
modems

roubleshooting 321
maodifier key 251
Monitor 178

enlarged vpe 254258
Monitor control panel 188
maonitors

troubleshooting 323
more help 339
mount 274
mouse

troubleshooting 318
mouse assistance

Easy Access 244

Mouse Kevs 247249
Mouse Speed 177
mouse techniques

clicking 14

doubleclicking 16

dragging 16

moving 12

pointing 14

pressing 14
MOVINgG

spectl oprions 127
moving folders  122—123
Moving icons 71
Moving the mouse 12
MS-DOS 272
mulimedia 261

N
NDA 172
NetPrinter Contral Panel 28
Nerwork
AppleShare 27
AppleShare, 35" Disk 27

Index 389



Aristotle Update 28
Local Startup 28
Printer Namer 2§
Server Quick Logoff 28
Server Startup 28
network
printing 303304
types 272
updates 27
network access privileges 277
network administrator 271
network updaes
AppleShare 27
Aristotle 28
ATalk ImageWriter 27
ATalk ImageWriter L) 27
LaserWriter 27
Local Sartup 28
Printer Namer 28
Server Quick Logoff 28
Server Startup 28
nerworking 271305
advantages 273
books and manuals 305
default folder privileges 298
folder access privileges  289—296
folder ownership transfer 296
getting started 278
group 297
guests 270
logging on alternatives 275276
naming rules 278
registered user 289
registered users 276
starting up with local disk 288289
starting up with no disk 284287
troubleshooting 325
user categories 290
networking options 197
new applications 8
new desk accessory 172
new features
Applications 8
Control Panel 9

390 Index

desk accessories 9
desktop Finder 7
Installer 8
System 7
New Folder command 47
Nobody 290

0

Open command 47
opening desktop Control Panels 172
Opening icons 72,96
optional capabilities 22
options
Installer 20
Ouner 277,290
Owner & Group 290

P

Parity 184

partitioning disks 231239
Pascal 26

password 276

ask forat log on - 283
Paste commund 49
pasting text 157
pathname 115
Pause button 265
peripherals 22
Pioncer 2000 262
Pioneer 4200 262
placing copies on different disks 125
Plav button 265
pointing 14
ports

activating 192
preferences

Archiver 202

Finder 35
preparing disks 87
pressing 14
primary group 297
Print command 48

Printer
Alalk ImageWriter 27
ATalk ImageWriter LQ 27
LaserWriter 27

Printer Port control panel 182, 189

printers
Epson/Epson-style 23
ImageWriter 23
ImageWriter 11 23
ImageWriter 1O 23
LaserWriter 23
StyleWriter 23

printing
documents 147
from applications 166
network  303—304
troubleshoating 329

Prvaic 294

ProDOS8 272

ProDOS naming rules 91

protecting
files 130
folders 130

Public 204

Put Away command 48

Putting away desktop icons 73

Q

Quick Logoff 301

quitting an application 148
troubleshooting 311

quitting teach 169

Qweny keyboand 178

R

RAM Cache 190

RAM control panel 190

RAM Disk 190

RAM disks  110—115
locating 113
running applications 113
setting sizes 111
using 113



Record button 265
recovering files and folders 129
registered user 289
registered users 276
reinitializing disks 93
removing capabilities 37
Renaming icons 75
replacing text 159
resources for adaptive technology 259
restone

entire volume 201

file-by-file 201
restore preferences

Archiver 204
restoring

entire volume backups 216

file-by-file backups 213
rules

AppleShare 278

file names 76

HFS 91

ProDOS 91

S

save
documents 142, 152
using directory dialog box 143
using a pathname 145
using slot and drive number 146
with new name 163
Scan buttons 265
scrolling techniques 63
See Files 290
See Folders 290
Select All command 50
Selecting lcons 68
grouped 69
not grouped 69
selecting text 155
clicking 156
doubleclicking 157
shift-clicking 156
serious problem 338
SetStan control panel 191

Shift Caps/Lowercase 181
shift-clicking to select text 136
Shales kevhoard 178
Show Clipboard command 50
Shut Down command 57
shutting down 149
size box 62
skill review 10
slor definitions
Slar 1192
Slor2 192
Slar 4 193
Slot4 193
Slot 5193
Slot 6 194
Slot7 194
slot settings 192
slots
activating 192
Slots control panel 191
Sound control panel 195
sounds
visual indication 196
Special Alds
CloseView 27
Easy Access 27
VideoKevboard 27
Special menu 54
special moving options 127
Speed 179
Stack windows command 51
standard modem settings 183
starting applications 136
not using the Finder 138
using the Finder 130
starting Teach 151
starting up
computer 20
over the network 275
troubleshooting 333
starming up an application
roubleshooting 308
starting up on network
troubleshooting 327

startup disk

abourt creating 20

size limitation 22
startup dnve

changing 194
Step buttons 265
Sticky Keys  245—2460
Stop button 263
storage

disks 106
storage devices

Apple 5.25Drive 23

Apple UniDisk 23

SCSI hard disk 23

SuperDrive 23
StyleWriter printer 23
summary of manual xiv
switching applications

not using the Finder 141

using the Finder 139
svnthLAB 25
synthLAB disk 6
System G clisks 56
System Speed 177
system updates 22-37
System.Disk 5
Systemilools] 3
Svstemlools2 6

T
taking care of disks 106
Teach 25, 150
changing fonts 160
changing occurrences of aword 162
creating documents 151
deleting text 159
dragging to select text 156
inserting text 154
printing documents 166
quitting 169
replacing text 159
saving documents under a different
mme 165
starting 151
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Lext
changing fontis 160
deleting 139
iragging 1o select 156
replacing 159
text entry
alternative 250253
Text/Back/Border (monitor) 189
Time control panel 199
Track burtons 263
transferring folder ownership 280

transkation of internal characters 179

trash

emptyving 130
troubleshooting 307
Type (monitor) 188

U
Undo command 49
unexpected messages 341
Universal Access  243—259
UNIX/Open System 272
unlocking

files 132

icons B3
upelares

Installer 22-37

392 Index

user categories
networking 290

user name 276

using in application
troubleshooting 309

using menus 17, 43,45

using RAM disks 113

v

Validate command 49
validating files 132
Verifv command 53
verifving disks 108
Video Keyhoard

alternative rext entry 250253
VideoMix  266—269

key color 267

tint 268

video/graphics mix 268
view

by date 52

by icon 51

by kind 52

by name 51

by size 52

by small icon 51
View menu 51

visual indication of sounds 196
volumes
file server 274

'\x.'
What's in this book  xiv
window 66

active 38

changing size 62

changing view 63

closing 06

cdosing all 67

moving 39

mioving inactive 60

opening 96

pop-up 61

visthle area 063
Windows menu 50
write-protecting 3.5-inch disks 94
write-protecting 5.25-inch disks 94

¥4
zeroing disks 230231
zones 273

Zooming 63



The Apple Publishing Svstem

This Apple™ manual was written and edited
on i desktop publishing system using Apple
Macintosh™ computers and FrameMaker for
the Macintash. Proof pages were created on
Apple LaserWriter® printers, and final pages
were output directly to separated flm. Line
art and chapter openers were creared with
Adobe Nustrator. Screen shots were created
and modified with svstem software and
Studio 8,

Text and display tvpe are Apple’s corporare
font, a condensed version of Garamon.
Ornaments are ITC Zapf Dinghats™ andd
custom symbols designed for Apple
Computer. Some elements, such as compurter
voice, are set in Apple Courier, a fived-width
font.

PostScript™, the LaserWriter page-description
language, was developed by Adobe Systems
Incorporated.



Important information for future reference

Use this space to keep track of some important information
that you'll want to have handy for future reference. (You may
want to use pencil, especially for the slot settings, in case the
information changes in the future.)

Apple llGs serial number
{on the bottom of the computer):

Monitor type and serial number
(usually on the back of the monitor):
Tipe
Sertal number
Slot settings
Slot 1: Slot 5:
Slot 2: Slot 6:
Slot 3: Slot 7:

Slot 4: Startup slot:
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